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Introduction

S) here’s a funny deal: You know how to use Excel. You know how to
create simple workbooks and how to print stuff. And you can even, with
just a little bit of fiddling, create cool-looking charts.

But [ bet that you sometimes wish that you could do more with Excel. You
sometimes wish, [ wager, that you could use Excel to really gain insights into
the information, the data, that you work with in your job.

Using Excel for data analysis is what this book is all about. This book
assumes that you want to use Excel to learn new stuff, discover new secrets,
and gain new insights into the information that you're already working with in
Excel — or the information stored electronically in some other format, such
as in your accounting system or from your web server’s analytics.

About This Book

This book isn’t meant to be read cover to cover like a Dan Brown page-turner.
Rather, it’s organized into tiny, no-sweat descriptions of how to do the things
that must be done. Hop around and read the chapters that interest you.

If you're the sort of person who, perhaps because of a compulsive bent,
needs to read a book cover to cover, that’s fine. I recommend that you delve
in to the chapters on inferential statistics, however, only if you've taken at
least a couple of college-level statistics classes. But that caveat aside, feel
free. After all, maybe Dancing with the Stars is a rerun tonight.

What You Can Safely lgnore

This book provides a lot of information. That’s the nature of a how-to refer-
ence. So [ want to tell you that it’s pretty darn safe for you to blow off some
chunks of the book.

For example, in many places throughout the book I provide step-by-step
descriptions of the task. When I do so, [ always start each step with a
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bold-faced description of what the step entails. Underneath that bold-faced
step description, I provide detailed information about what happens after
you perform that action. Sometimes I also offer help with the mechanics of
the step, like this:

1. Press Enter.

Find the key that’s labeled Enter. Extend your index finger so that it rests
ever so gently on the Enter key. Then, in one sure, fluid motion, press
the key by using your index finger. Then release the key.

Okay, that’s kind of an extreme example. I never actually go into that much
detail. My editor won’t let me. But you get the idea. If you know how to press
Enter, you can just do that and not read further. If you need help — say with
the finger-depression part or the finding-the-right-key part — you can read
the nitty-gritty details.

You can also skip the paragraphs flagged with the Technical Stuff icon. These
icons flag information that’s sort of tangential, sort of esoteric, or sort of
questionable in value . . . at least for the average reader. If you're really inter-
ested in digging into the meat of the subject being discussed, go ahead and
read 'em. If you're really just trying to get through your work so that you can
get home and watch TV with your kids, skip 'em.

I might as well also say that you don’t have to read the information provided
in the paragraphs marked with a Tip icon, either. I assume that you want to
know an easier way to do something. But if you like to do things the hard way
because that improves your character and makes you tougher, go ahead and
skip the Tip icons.

What You Shouldn’t Ignore (Unless
Vou've a Masochist)

By the way, don’t skip the Warning icons. They’re the text flagged with a
picture of a 19th century bomb. They describe some things that you really
shouldn’t do.

Out of respect for you, [ don’t put stuff in these paragraphs such as, “Don’t
smoke.” [ figure that you're an adult. You get to make your own lifestyle
decisions.

[ reserve these warnings for more urgent and immediate dangers — things
that you can but shouldn’t do. For example: “Don’t smoke while filling your
car with gasoline.”
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Foolish Assumptions

[ assume just three things about you:

»* You have a PC with a recent version of Microsoft Excel 2007 installed.
»* You know the basics of working with your PC and Microsoft Windows.

+* You know the basics of working with Excel, including how to start and
stop Excel, how to save and open Excel workbooks, and how to enter
text and values and formulas into worksheet cells.

How This Book Is Organized

This book is organized into five parts:

Part I: Where's the Beef?

In Part I, [ discuss how you get data into Excel workbooks so that you can
begin to analyze it. This is important stuff, but fortunately most of it is pretty
straightforward. If you're new to data analysis and not all that fluent yet in
working with Excel, you definitely want to begin in Part I.

Part 1l: PivotTables and PivotCharts

In the second part of this book, [ cover what are perhaps the most powerful
data analysis tools that Excel provides: its cross-tabulation capabilities using
the PivotTable and PivotChart commands.

No kidding, I don’t think any Excel data analysis skill is more useful than
knowing how to create pivot tables and pivot charts. If I could, [ would give
you some sort of guarantee that the time you spent reading how to use these
tools is always worth the investment you make. Unfortunately, after consulta-
tion with my attorney, I find that this is impossible to do.

Part 11l: Advanced Tools

In Part III, [ discuss some of the more sophisticated tools that Excel sup-
plies for doing data analysis. Some of these tools are always available in
Excel, such as the statistical functions. (I use a couple of chapters to cover
these.) Some of the tools come in the form of Excel add-ins, such as the Data
Analysis and the Solver add-ins.



4 Excel Data Analysis For Dummies, 2nd Edition

[ don’t think that these tools are going to be of interest to most readers of this
book. But if you already know how to do all the basic stuff and you have some
good statistical and quantitative methods, training, or experience, you ought
to peruse these chapters. Some really useful whistles and bells are available to
advanced users of Excel. And it would be a shame if you didn’t at least know
what they are and the basic steps that you need to take to use them.

Part IU: The Part of Tens

In my mind, perhaps the most clever element that Dan Gookin, the author of
the original and first For Dummies book, DOS For Dummies, came up with is
the part with chapters that just list information in David Letterman-ish fashion.
These chapters let us authors list useful tidbits, tips, and factoids for you.

Excel Data Analysis For Dummies, Second Edifion includes three such chap-
ters. In the first, [ provide some basic facts most everybody should know
about statistics and statistical analysis. In the second, [ suggest ten tips for
successfully and effectively analyzing data in Excel. Finally, in the third chap-
ter, I try to make some useful suggestions about how you can visually analyze
information and visually present data analysis results.

The Part of Tens chapters aren’t technical. They aren’t complicated. They're
very basic. You should be able to skim the information provided in these
chapters and come away with at least a few nuggets of useful information.

The appendix contains a handy glossary of terms you should understand
when working with data in general and Excel specifically. From kurtosis to his-
tograms, these sometimes baffling terms are defined here.

Icons Used in This Book

Like other For Dummies books, this book uses icons, or little margin pictures,
to flag things that don’t quite fit into the flow of the chapter discussion. Here
are the icons that I use:

@Lsrg&
g? Technical Stuff: This icon points out some dirty technical details that you
i\ might want to skip.

Tip: This icon points out a shortcut to make your life easier or more fulfilling.
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Remember: This icon points out things that you should, well, remember.

Warning: This icon is a friendly but forceful reminder not to do some-
thing .. . or else.

w2070

Excel2007/2010: This icon indicates specialized instructions you should pay
attention to if you're using one of those versions of Excel.

Beyond the Book

1 Cheat Sheet: This book’s Cheat Sheet can be found online at www.
dummies.com/cheatsheet/exceldataanalysis. See the Cheat
Sheet for info on Excel database functions, Boolean expressions, and
important statistical terms.

+* Dummies.com online articles: Companion articles to this book’s
content can be found online at www.dummies.com/extras/
exceldataanalysis. The topics range from tips on pivot tables and
timelines to how to buff your Excel formula-building skills.

+ Downloadable example workbooks: You can download the example
workbooks I use in this book at www.dummies.com/extras/
exceldataanalysis.

v Updates: If this book has any updates after printing, they will be posted
to www.dummies.com/extras/exceldataanalysis.

Where to Go from Here

If you're just getting started with Excel data analysis, flip the page and start
reading the first chapter.

If you have a bit of skill with Excel or you have a special problem or question,
use the Table of Contents or the index to find out where I cover a topic and
then turn to that page.

Good luck! Have fun!
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In this part . . .

Understand how to build Excel tables that hold and store the
data you need to analyze.

Find quick and easy ways to begin your analysis using simple
statistics, sorting, and filtering.

Get practical stratagems and commonsense tactics for grab-
bing data from extra sources.

Discover tools for cleaning and organizing the raw data you
want to analyze.




Chapter 1
Introducing Excel Tables

In This Chapter
Figuring out tables
Building tables
Analyzing tables with simple statistics
Sorting tables
Discovering the difference between using AutoFilter and filtering

Frst things first. I need to start my discussion of using Excel for data
analysis by introducing Excel tables, or what Excel used to call lisfs.
Why? Because, except in the simplest of situations, when you want to analyze
data with Excel, you want that data stored in a table. In this chapter, I discuss
what defines an Excel table; how to build, analyze, and sort a table; and why
using filters to create a subtable is useful.

What Is a Table and Why Do | Care?

A\\J

A table is, well, a list. This definition sounds simplistic, I guess. But take a
look at the simple table shown in Figure 1-1. This table shows the items that
you might shop for at a grocery store on the way home from work.

As I mention in the Introduction of this book, many of the Excel workbooks that
you see in the figures of this book are available for download from this book’s
companion website. For more on how to access the companion website, see
the Introduction.

Commonly, tables include more information than Figure 1-1 shows. For example,
take a look at the table shown in Figure 1-2. In column A, for example, the table
names the store where you might purchase the item. In column C, this expanded
table gives the quantity of some item that you need. In column D, this table
provides a rough estimate of the price.
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I
Figure 1-1:
Atable:
Start out
with the
basics.
|

|
Figure 1-2:
A grocery
list for

the more
serious
shopper...
like me.
|
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An Excel table usually looks more like the list shown in Figure 1-2. Typically,
the table enumerates rather detailed descriptions of numerous items. But a
table in Excel, after you strip away all the details, essentially resembles the
expanded grocery-shopping list shown in Figure 1-2.
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Let me make a handful of observations about the table shown in Figure 1-2.
First, each column shows a particular sort of information. In the parlance of
database design, each column represents a field. Each field stores the same
sort of information. Column A, for example, shows the store where some item
can be purchased. (You might also say that this is the Store field.) Each piece
of information shown in column A — the Store field — names a store: Sams
Grocery, Hughes Dairy, and Butchermans.

The first row in the Excel worksheet provides field names. For example, in
Figure 1-2, row 1 names the four fields that make up the list: Store, Item,
Quantity, and Price. You always use the first row, called the header row, of an
Excel list to name, or identify, the fields in the list.

Starting in row 2, each row represents a record, or item, in the table. A record
is a collection of related fields. For example, the record in row 2 in Figure 1-2
shows that at Sams Grocery, you plan to buy two loaves of bread for a price
of $1 each. (Bear with me if these sample prices are wildly off; [ usually don’t
do the shopping in my household.)

Row 3 shows or describes another item, coffee, also at Sams Grocery, for $8.
In the same way, the other rows of the super-sized grocery list show items
that you will buy. For each item, the table identifies the store, the item, the
quantity, and the price.

Something to understand about Excel tables

An Excel table is a flat-file database. That flat-
file-ish-ness means that there’s only one table relational database might eliminate this redun-
in the database. And the flat-file-ish-ness also  dancy by having a separate table of grocery
means that each record stores every bit of stores.

information about an item.

Grocery appearing in cells A2, A3, A4, and A5. A

This point might seem a bit esoteric; however,

In comparison, popular desktop database appli-
cations such as Microsoft Access are relational
databases. A relational database stores infor-
mation more efficiently. And the most striking
way in which this efficiency appears is that you
don't see lots of duplicated or redundant infor-
mation in a relational database. In a relational
database, for example, you might not see Sams

you might find it handy when you want to grab
data from a relational database (where the
information is efficiently stored in separate
tables) and then combine all this data into a
super-sized flat-file database in the form of an
Excel list. In Chapter 2, | discuss how to grab
data from external databases.
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Building Tables

A\\J

You build a table that you want to later analyze by using Excel in one of two
ways:

v Export the table from a database.

¥ Manually enter items into an Excel workbook.

Exporting from a database

The usual way to create a table to use in Excel is to export information from
a database. Exporting information from a database isn’t tricky. However, you
need to reflect a bit on the fact that the information stored in your database
is probably organized into many separate tables that need to be combined
into a large flat-file database or table.

In Chapter 2, I describe the process of exporting data from the database and
then importing this data into Excel so it can be analyzed. Hop over to that
chapter for more on creating a table by exporting and then importing.

Even if you plan to create your tables by exporting data from a database,
however, read on through the next paragraphs of this chapter. Understanding
the nuts and bolts of building a table makes exporting database information
to a table and later using that information easier.

Building a table the hard way

The other common way to create an Excel table (besides exporting from a
relational database) is to do it manually. For example, you can create a table
in the same way that I create the grocery list shown in Figure 1-2. You first
enter field names into the first row of the worksheet and then enter individual
records, or items, into the subsequent rows of the worksheet. When a table
isn’t too big, this method is very workable. This is the way, obviously, that I
created the table shown in Figure 1-2.

Building a table the semi-hard way

To create a table manually, you typically want to enter the field names into
row 1, select those field names and the empty cells of row 2, and then choose
Insert=>Table. Why? The Table command tells Excel, right from the get-go,
that you're building a table. But let me show you how this process works.
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Figure 1-3:

The start of |-
something |-
important. |*

Manually adding records into a table
To manually create a list by using the Table command, follow these steps:

1. Identify the fields in your list.

To identify the fields in your list, enter the field names into row 1 in a blank
Excel workbook. For example, Figure 1-3 shows a workbook fragment. Cells
Al, B1, C1, and D1 hold field names for a simple grocery list.

Sheet!

2. Select the Excel table.

The Excel table must include the row of the field names and at least one
other row. This row might be blank or it might contain data. In Figure 1-3,
for example, you can select an Excel list by dragging the mouse from cell
Al to cell D2.

3. Click the Insert tab and then its Table button to tell Excel that you
want to get all official right from the start.

If Excel can’t figure out which row holds your field names, Excel displays
the dialog box shown in Figure 1-4. Check the My Table Has Headers
check box to confirm that the first row in your range selection holds the
field names. When you click OK, Excel re-displays the worksheet set up
as a table, as shown in Figure 1-5.

13
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Figure 1-4:
Excel tries
to figure out
whatyou're
doing.
—

Figure 1-5:

Enter your

table rows

into nicely |-
colored |
rows. |-
I

Create Table ?

Where Is the data for your table?

=$A81:3D82 s

........................

OK Cancel

Sheet!

4. Describe each record.

To enter a new record into your table, fill in the next empty row. For
example, use the Store text box to identify the store where you purchase
each item. Use the — oh, wait a minute here. You don’t need me to tell
you that the store name goes into the Store column, do you? You can
figure that out. Likewise, you already know what bits of information go
into the Item, Quantity, and Price column, too, don’t you? Okay. Sorry.

. Store your record in the table.

Click the Tab or Enter button when you finish describing some record

or item that goes onto the shopping list. Excel adds another row to the
table so that you can add another item. Excel shows you which rows and
columns are part of the table by using color.
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Figure 1-6:

Alittle |

workbook

fragment, |-
compliments |
of AutoFill. |”

Some table-building tools

Excel includes an AutoFill feature, which is particularly relevant for table
building. Here’s how AutoFill works: Enter a label into a cell in a column
where it’s already been entered before, and Excel guesses that you're entering
the same thing again. For example, if you enter the label Sams Grocery in cell
A2 and then begin to type Sams Grocery in cell A3, Excel guesses that you're
entering Sams Grocery again and finishes typing the label for you. All you
need to do to accept Excel’s guess is press Enter. Check it out in Figure 1-6.

Sheet!

Excel also provides a Fill command that you can use to fill a range of cells —
including the contents of a column in an Excel table — with a label or value.
To fill a range of cells with the value that you've already entered in another
cell, you drag the Fill Handle down the column. The Fill Handle is the small
plus sign (+) that appears when you place the mouse cursor over the lower-
right corner of the active cell. In Figure 1-7, I use the Fill Handle to enter Sams
Grocery into the range A5:A12.

15
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Figure 1-7: |-

Another
little

workbook ;

fragment,

compli- |-
ments of the |2
Fill Handle. |~

I

Analyzing Table Information

Excel provides several handy, easy-to-use tools for analyzing the information
that you store in a table. Some of these tools are so easy and straightforward
that they provide a good starting point.

Simple statistics

Look again at the simple grocery list table that I mention earlier in the section,
“What Is a Table and Why Do I Care?” See Figure 1-8 for this grocery list as I use
this information to demonstrate some of the quick-and-dirty statistical tools
that Excel provides.

One of the slickest and quickest tools that Excel provides is the ability to
effortlessly calculate the sum, average, count, minimum, and maximum of
values in a selected range. For example, if you select the range C2 to C10 in
Figure 1-8, Excel calculates an average, counts the values, and even sums the
quantities, displaying this useful information in the status bar. In Figure 1-8,
note the information on the status bar (the lower edge of the workbook):

Average: 1.555555556 Count: 9 Sum: 14
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Figure 1-8: |-
Startatthe |
beginning. |*

This indicates that the average order quantity is (roughly) 1.5, that you're
shopping for 9 different items, and that the grocery list includes 14 items:
Two loaves of bread, one can of coffee, one tomato, one box of tea, and so on.

Sheet! | sheet2 | Sheed

The big question here, of course, is whether, with 9 different products but a
total count of 14 items, you’ll be able to go through the express checkout line.
But that information is irrelevant to our discussion. (You, however, might
want to acquire another book I'm planning, Grocery Shopping For Dummies.)

You aren’t limited, however, to simply calculating averages, counting entries,
and summing values in your list. You can also calculate other statistical
measures.

To perform some other statistical calculation of the selected range list,
right-click the status bar. When you do, Excel displays a pop-up Status Bar
Configuration menu. Near the bottom of that menu bar, Excel provides six
statistical measures that you can add to or remove from the Status Bar:
Average, Count, Count Numerical, Maximum, Minimum, and Sum. In Table 1-1,
[ describe each of these statistical measures briefly, but you can probably
guess what they do. Note that if a statistical measure is displayed on the
Status Bar, Excel places a check mark in front of the measure on the Status Bar
Confirmation menu. To remove the statistical measure, select the measure.

17
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Table 1-1 Quick Statistical Measures Available on the Status Bar

Option What It Does

Count Tallies the cells that hold labels, values, or formulas. In other
words, use this statistical measure when you want to count the
number of cells that are not empty.

Count Tallies the number of cells in a selected range that hold values or
Numerical formulas.

Maximum Finds the largest value in the selected range.

Minimum Finds the smallest value in the selected range.

Sum Adds up the values in the selected range.

No kidding, these simple statistical measures are often all you need to gain
wonderful insights into data that you collect and store in an Excel table. By
using the example of a simple, artificial grocery list, the power of these quick
statistical measures doesn’t seem all that earthshaking. But with real data,
these measures often produce wonderful insights.

In my own work as a technology writer, for example, I first noticed the
deflation in the technology bubble a decade ago when the total number of
computer books that one of the larger distributors sold — information that
appeared in an Excel table — began dropping. Sometimes, simply adding,
counting, or averaging the values in a table gives extremely useful insights.

Sorting table records

After you place information in an Excel table, you'll find it very easy to sort
the records. You can use the Sort & Filter button’s commands.

Using the Sort buttons

To sort table information by using a Sort & Filter button’s commands, click in
the column you want to use for your sorting. For example, to sort a grocery list
like the one shown in Figure 1-8 by the store, click a cell in the Store column.

After you select the column you want to use for your sorting, click the Sort
& Filter button and choose the Sort A to Z command from the menu Excel
displays to sort table records in ascending, A-to-Z order using the selected
column’s information. Alternatively, choosing the Sort Z to A command from
the menu Excel displays sort table records in descending, Z-to-A order using
the selected column’s information.
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Using the Custom Sort dialog box

When you can’t sort table information exactly the way you want by using the
Sort A to Z and Sort Z to A commands, use the Custom Sort command.

To use the Custom Sort command, follow these steps:

1. Click a cell inside the table.

2. Click the Sort & Filter button and choose the Sort command from the
Sort & Filter menu.

Excel displays the Sort dialog box, as shown in Figure 1-9.

In Excel 2007 and Excel 2010, choose the Data=>Custom Sort command
to display the Sort dialog box.

Sort » HEN |
2l Add Level || )X Delete Level | [2 Copy Level Options... [V] My data has headers
Column Sort On Order
Sortby Sforel I v Values v| |Atoz v

[ ox Cancel

3. Select the first sort key.

Use the Sort By drop-down list to select the field that you want to use for
sorting. Next, choose what you want to use for sorting: values, cell colors,
font colors, or icons. Probably, you're going to sort by values, in which
case, you'll also need to indicate whether you want records arranged in
ascending or descending order by selecting either the ascending A to Z
or descending Z to A entry from the Order box. Ascending order, predict-
ably, alphabetizes labels and arranges values in smallest-value-to-largest-
value order. Descending order arranges labels in reverse alphabetical
order and values in largest-value-to-smallest-value order. If you sort by
color or icons, you need to tell Excel how it should sort the colors by
using the options that the Order box provides.

Typically, you want the key to work in ascending or descending order.
However, you might want to sort records by using a chronological
sequence, such as Sunday, Monday, Tuesday, and so on, or January,
February, March, and so forth. To use one of these other sorting options,
select the custom list option from the Order box and then choose one of
these other ordering methods from the dialog box that Excel displays.
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|
Figure 1-10:
Sorting out
your sorting
options.
|

l

Sort Options  ? BN

[licase sensitive:
Orientation
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4. (Optional) Specify any secondary keys.

If you want to sort records that have the same primary key with a second-
ary key, click the Add Level button and then use the next row of choices
from the Then By drop-down lists to specify which secondary keys you
want to use. If you add a level that you later decide you don’t want or
need, click the sort level and then click the Delete Level button. You can
also duplicate the selected level by clicking Copy Level. Finally, if you do
create multiple sorting keys, you can move the selected sort level up or
down in significance by clicking the Move Up or Move Down buttons.

Note: The Sort dialog box also provides a My Data Has Headers check
box that enables you to indicate whether the worksheet range selection
includes the row and field names. If you've already told Excel that a work-
sheet range is a table, however, this check box is disabled.

. (Really optional) Fiddle-faddle with the sorting rules.

If you click the Options button in the Sort dialog box, Excel displays the
Sort Options dialog box, shown in Figure 1-10. Make choices here to further
specify how the first key sort order works.

OK Cancel

For a start, the Sort Options dialog box enables you to indicate whether
case sensitivity (uppercase versus lowercase) should be considered.

You can also use the Sort Options dialog box to tell Excel that it should
sort rows instead of columns or columns instead of rows. You make

this specification by using either Orientation radio button: Sort Top to
Bottom or Sort Left to Right. Click OK when you’ve sorted out your sort-
ing options.

. Click OK.

Excel then sorts your list.
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Using AutoFilter on a table

Excel provides an AutoFilter command that’s pretty cool. When you use
AutoFilter, you produce a new table that includes a subset of the records
from your original table. For example, in the case of a grocery list table, you
could use AutoFilter to create a subset that shows only those items that
you'll purchase at Butchermans or a subset table that shows only those items
that cost more than, say, $2.

To use AutoFilter on a table, take these steps:

1. Select your table.

Select your table by clicking one of its cells. By the way, if you haven’t
yet turned the worksheet range holding the table data into an “official”
Excel table, select the table and then choose the Insert tab’s Table
command.

2. (Perhaps unnecessary) Choose the AutoFilter command.

When you tell Excel that a particular worksheet range represents a table,
Excel turns the header row, or row of field names, into drop-down lists.
Figure 1-11 shows this. If your table doesn’t include these drop-down
lists, add them by clicking the Sort & Filter button and choosing the
Filter command. Excel turns the header row, or row of field names, into
drop-down lists.

Tip: In Excel 2007 and Excel 2010, you choose the Data=>Filter command
to tell Excel you want to AutoFilter.

Drop-down list boxes appear when you turn on AutoFiltering.
|
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3.

Use the drop-down lists to filter the list.

Each of the drop-down lists that now make up the header row can be
used to filter the list.

To filter the list by using the contents of some field, select (or open) the
drop-down list for that field. For example, in the case of the little workbook
shown in Figure 1-11, you might choose to filter the grocery list so that it
shows only those items that you'll purchase at Sams Grocery. To do this,
click the Store drop-down list down-arrow button. When you do, Excel
displays a menu of table sorting and filtering options. To see just those
records that describe items you've purchased at Sams Grocery, select Sams
Grocery. Figure 1-12 shows the filtered list with just the Sams Grocery items
visible.

If your eyes work better than mine do, you might even be able to see a
little picture of a funnel on the Store column’s drop-down list button.
This icon tells you the table is filtered using the Store columns data.

Figure 1-12: |-
Samsand |-

Sams alone. |~

Store

To unfilter the table, open the Store drop-down list and choose Select All.

If you're filtering a table using the table menu, you can also sort the
table’s records by using table menu commands. Sort A to Z sorts the
records (filtered or not) in ascending order. Sort Z to A sorts the records
(again, filtered or not) in descending order. Sort by Color lets you sort
according to cell colors.
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Figure 1-13:
The Custom
AutoFilter
dialog box.
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Undoing a filter

To remove an AutoFilter, display the table menu by clicking a drop-down list’s
button. Then choose the Clear Filter command from the table menu.

Turning off filter

The AutoFilter command is actually a toggle switch. When filtering is turned
on, Excel turns the header row of the table into a row of drop-down lists. When
you turn off filtering, Excel removes the drop-down list functionality. To turn
off filtering and remove the Filter drop-down lists, simply click the Sort & Filter
button and choose the Filter command (or in Excel 2007 or Excel 2010, choose
Data=Filter command).

Using the custom AutoFilter

You can also construct a custom AutoFilter. To do this, select the Text Filter
command from the table menu and choose one of its text filtering options. No
matter which text filtering option you pick, Excel displays the Custom AutoFilter
dialog box, as shown in Figure 1-13. This dialog box enables you to specify with
great precision what records you want to appear on your filtered list.

Custom AutoFilter ? “

Show rows where:
Store

begins with v v
@ and O oOr
- .
Use 7 to represent any single character
Use * to represent any series of characters

| oK ] Cancel

To create a custom AutoFilter, take the following steps:

1. Turn on the Excel Filters.

As I mention earlier in this section, filtering is probably already on
because you've created a table. However, if filtering isn’t turned on,
select the table, click the Sort & Filter button, and choose Filter. Or in
Excel 2007 or Excel 2010, simply choose Data=Filter.
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3

2. Select the field that you want to use for your custom AutoFilter.

To indicate which field you want to use, open the filtering drop-down
list for that field to display the table menu, select Text Filters, and then
select a filtering option. When you do this, Excel displays the Custom
AutoFilter dialog box. (Refer to Figure 1-13.)

. Describe the AutoFilter operation.

To describe your AutoFilter, you need to identify (or confirm) the filtering
operation and the filter criteria. Use the left-side set of drop-down lists to
select a filtering option. For example, in Figure 1-14, the filtering option
selected in the first Custom AutoFilter set of dialog boxes is Begins With.
If you open this drop-down list, you'll see that Excel provides a series of
filtering options:

e Begins With

e Equals

® Does Not Equal

e Is Greater Than or Equal To
e Is Less Than

e Is Less Than or Equal To
e Begins With

® Does Not Begin With

e Ends With

e Does Not End With

e Contains

¢ Does Not Contain

The key thing to be aware of is that you want to pick a filtering operation
that, in conjunction with your filtering criteria, enables you to identify the
records that you want to appear in your filtered list. Note that Excel initially
fills in the filtering option that matches the command you selected on the
Text Filter submenu, but you can change this initial filtering selection to
something else.

In practice, you won’t want to use precise filtering criteria. Why? Well,
because your list data will probably be pretty dirty. For example, the
names of stores might not match perfectly because of misspellings.
For this reason, you'll find filtering operations based on Begins With
or Contains and filtering criteria that use fragments of field names or
ranges of values most valuable.
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Figure 1-14:
Setting up
a custom
AutoFilter.

4. Describe the AutoFilter filtering criteria.

After you pick the filtering option, you describe the filtering criteria by
using the right-hand drop-down list. For example, if you want to filter
records that equal Sams Grocery or, more practically, that begin with the
word Sams, you enter Sams into the right-hand box. Figure 1-14 shows
this custom AutoFilter criterion.

You can use more than one AutoFilter criterion. If you want to use two
custom AutoFilter criteria, you need to indicate whether the criteria are
both applied together or are applied independently. You select either the
And or Or radio button to make this specification.

5. Click OK.

Excel then filters your table according to your custom AutoFilter.

Custom AutoFilter > HEN |

Show rows where:
Store

begins with v | Sams v
®and O or
v v

Use 7 to represent any single character
Use * to represent any series of characters

oK Cancel

Filtering a filtered table

You can filter a filtered table. What this often means is that if you want to
build a highly filtered table, you will find your work easiest if you just apply
several sets of filters.

If you want to filter the grocery list to show only the most expensive items
that you purchase at Sams Grocery, for example, you might first filter the
table to show items from Sams Grocery only. Then, working with this filtered
table, you would further filter the table to show the most expensive items or
only those items with the price exceeding some specified amount.

The idea of filtering a filtered table seems, perhaps, esoteric. But applying
several sets of filters often reduces a very large and nearly incomprehensible
table to a smaller subset of data that provides just the information that you
need.
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Building on the earlier section “Using the custom AutoFilter,” I want to make
this important point: Although the Custom AutoFilter dialog box does enable
you to filter a list based on two criteria, sometimes filtering operations apply
to the same field. And if you need to apply more than two filtering operations
to the same field, the only way to easily do this is to filter a filtered table.

Using advanced filtering

Most of the time, you’ll be able to filter table records in the ways that you
need by using the Filter command or that unnamed table menu of filtering
options. However, in some cases, you might want to exert more control over
the way filtering works. When this is the case, you can use the Excel advanced
filters.

Writing Boolean expressions

Before you can begin to use the Excel advanced filters, you need to know how
to construct Boolean logic expressions. For example, if you want to filter the
grocery list table so that it shows only those items that cost more than $1 or
those items with an extended price of more than $5, you need to know how to
write a Boolean logic, or algebraic, expression that describes the condition in
which the price exceeds $1 or the extended price exceeds or equals $5.

See Figure 1-15 for an example of how you specify these Boolean logic expres-
sions in Excel. In Figure 1-15, the range A13:B14 describes two criteria: one

in which the price exceeds $1, and one in which the extended price equals

or exceeds $5. The way this works, as you may guess, is that you need to use
the first row of the range to name the fields that you use in your expression.
After you do this, you use the rows beneath the field names to specify what
logical comparison needs to be made using the field.

[

+ [samsGrocery  Tomatoss
5 SamsGeocery  Tes

¢ oghesDalry ks Cresm
7 Hughes Dairy  Suttar

2 Wghes Dairy  Milk

) Butcharmans  Lamd

10 [Butchermans  Chicken

13[Price. Extonded
1450 =5 I

e el e - -
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To construct a Boolean expression, you use a comparison operator from
Table 1-2 and then a value used in the comparison.

Table 1-2 Boolean Logic
Operator What It Does

= Equals

< Is less than

<= Is less than or equal to

> Is greater than

>= Is greater than or equal to
<> Is not equal to

In Figure 1-15, for example, the Boolean expression in cell A14 (>1), checks
to see whether a value is greater than 1, and the Boolean expression in cell
B14 (>=5) checks to see whether the value is greater than or equal to 5. Any
record that meets both of these tests gets included by the filtering operation.

Here’s an important point: Any record in the table that meets the criteria in
any one of the criteria rows gets included in the filtered table. Accordingly,

if you want to include records for items that either cost more than $1 apiece
or that totaled at least $5 in shopping expense (after multiplying the quantity
times the unit price), you use two rows — one for each criterion. Figure 1-16
shows how you would create a worksheet that does this.

iy

2 sams Grocary  Bread
Sams Grocery  Coffee

+ 'SamsGrocery  Tomatoss

3 SamsGeocery  Tes

¢ iughesDalry ks Cresm
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Figure 1-17:
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Running an advanced filter operation
After you set up a table for an advanced filter and the criteria range — what I

did in Figures 1-15 and 1-16 — you’re ready to run the advanced filter operation.

To do so, take these steps:

1. Select the table.

To select the table, drag the mouse from the top-left corner of the list

to the lower-right corner. You can also select an Excel table by selecting

the cell in the top-left corner, holding down the Shift key, pressing the
End key, pressing the right arrow, pressing the End key, and pressing
the down arrow. This technique selects the Excel table range using the
arrow keys.

2. Choose Data tab’s Advanced Filter.
Excel displays the Advanced Filter dialog box, as shown in Figure 1-17.

Advanced Filter » IEN |

Action
®) Eilter the list, in-place
) Copy to another location
List range: SAS1:5ES10 e
Criteria range: | SAS13:58515 3
23

Copy to

[_ Unique records only

oK Cancel

3. Tell Excel where to place the filtered table.

Use either Action radio button to specify whether you want the table
filtered in place or copied to some new location. You can either filter

the table in place (meaning Excel just hides the records in the table that
don’t meet the filtering criteria), or you can copy the records that meet
the filtering criteria to a new location.

4. Verify the list range.

The worksheet range shown in the List Range text box — $A$1:$E$10 in
Figure 1-17 — should correctly identify the list. If your text box doesn’t
show the correct worksheet range, however, enter it. (Remember how

I said earlier in the chapter that Excel used to call these tables “lists”?
Hence the name of this box.)

. Provide the criteria range.

Make an entry in the Criteria Range text box to identify the worksheet
range holding the advanced filter criteria. In Figure 1-17, the criteria
range is $A$13:$B$15.
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Figure 1-18: |-
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results. |~

6. (Optional) If you’re copying the filtering results, provide the
destination.

If you tell Excel to copy the filter results to some new location, use the
Copy To text box to identify this location.

7. Click OK.

Excel filters your list . .. I mean table. Figure 1-18 shows what the filtered
list looks like. Note that the table now shows only those items that cost
more than $1 and on which the extended total equals or exceeds $5.

(PR
B

e e

And that’s that. Not too bad, eh? Advanced filtering is pretty straightforward.
All you really do is write some Boolean logic expressions and then tell Excel
to filter your table using those expressions.
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Chapter 2

Grabbing Data from
External Sources

In This Chapter
Exporting data from other programs
Importing data into Excel
Running a web query
Importing a database table
Querying an external database

’ n many cases, the data that you want to analyze with Excel resides in

an external database or in a database application, such as a corporate
accounting system. Thus, often your very first step and very first true chal-
lenge are to get that data into an Excel workbook and in the form of an
Excel table.

You can use two basic approaches to grab the external data that you want
to analyze. You can export data from another program and then import that
data into Excel, or you can query a database directly from Excel. | describe
both approaches in this chapter.

Getting Data the Export-
Import Way

You can usually easily export data from popular database programs and
accounting systems. Excel is the dominant data analysis tool available to
business. Because of this, most database programs and most management
information systems export data in a format that makes it simple to import
the data into Excel later.
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Exporting: The first step

Your first step when grabbing data from one of these external sources,
assuming that you want to later import the data, is to first use the other
application program — such as an accounting program — to export the
to-be-analyzed data to a file.

You have two basic approaches available for exporting data from another
application: direct exporting and exporting to a text file.

Direct exporting

Direct exporting is available in many accounting programs because accoun-
tants love to use Excel to analyze data. For example, the most popular
small business accounting program in the world is QuickBooks from Intuit.
When you produce an accounting report in QuickBooks, the report docu-
ment window includes a button labeled Excel or Export. Click this button,
and QuickBooks displays the Send Report to Excel dialog box, as shown in
Figure 2-1.

Send Report to Exce!

WHAT WOULD YOU LIKE TO DO WITH THIS REPORT?
@ Create new worksheet
@® in new workbook
) In existing workbook
~ i w i
Update an existing worksheet \J How it works

) Replace an existing worksheet

) Create 3 comma separated values (csv) file

|
Figure 2-1:
Begin Advanced...
exporting

The Send Report to Excel dialog box provides radio buttons with which you
indicate whether you want to send the report to a comma-separated-values
file, to a new Excel spreadsheet, or to an existing Excel spreadsheet.

To send (export) the report to an existing Excel spreadsheet, you need to
identify that workbook by entering the workbook pathname and filename

into the text box provided. Or, click the Browse button and use the Open
Microsoft Excel File dialog box that appears (not shown) to identify the folder
and workbook file.
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The Export Report dialog box also includes an Advanced button. Click this
button, and QuickBooks displays the Advanced dialog box (see Figure 2-2)
that you can use to control how the exported report looks. For example, you
get to pick which fonts, colors, spacing, and row height that you want. You
also get to turn on and turn off Excel features in the newly created workbook,
including AutoFit, Gridlines, and so on.

Advanced Excel Options

QuickBooks Options:
Keep the following format options from QuickBooks:

¥ Fonts! ¥ Space between columns
# Colors ¥ Row height

Excel Options:
Tum on the following Excel features:
7 AutoFit (set column width to display all data)
7 Freeze panes (keep headers and ladbels visidle)
« Show Gridlines
Auto Qutline (allows collapsing / expanding)
Auto Filtering (allows custom data filtering)
# Include QuickBooks Export Guide worksheet with helpful advice
¥ Create backup worksheet during update
Printing options:
Show report header:
@ On printed report only
© On printed report and screen
7 Repeatrow labels on each page

In Figure 2-3, you can see how the QuickBooks report looks after it has been
directly exported to Excel.

Okay, obviously, you might not want to export from QuickBooks. You might
have other applications that you want to export data from. You can export
data directly from a database program like Microsoft Access, for example. But
the key thing that you need to know — and the reason that I discuss in detail
how QuickBooks works — is that applications that store and collect data often
provide a convenient way for you to export information to Excel. Predictably,
some application programs work differently, but usually, the process is little
more than clicking a button labeled Excel (as is the case in QuickBooks) or
choosing a command labeled something like Export or Export to Excel.

Therefore, when exporting data from some other program, your first step is
to do a little bit of digging and research to see whether there’s a way to easily
and automatically export data to Excel. This fact-finding shouldn’t take much
time if you use the online Help system.
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Versions of Microsoft Access up through and including Access 2003 include
an Export command on the File menu, and Access 2007 and later versions
include an Export command on its Microsoft Office menu. Choose the Export
command to export an Access table, report, or query to Excel. Just choose
the appropriate command and then use the dialog box that Access displays to
specify where the exported information should be placed.

Exporting to a text file

When you need to export data first to a text file because the other applica-
tion won’t automatically export your data to an Excel workbook, you need
to go to a little more effort. Fortunately, the process is still pretty darn
straightforward.

When you work with applications that won’t automatically create an Excel
workbook, you just create a text version of a report that shows the data that
you want to analyze. For example, to analyze sales of items that your firm
makes, you first create a report that shows this.

The trick is that you send the report to a text file rather than sending this
report to a printer. This way, the report gets stored on disk as text rather
than printed. Later, Excel can easily import these text files.

See how this works in more concrete terms by following how the process
works in QuickBooks. Suppose, for the sake of illustration, that you really
did want to print a list of items that you sell. The first step is to produce
a report that shows this list. In QuickBooks, you produce this report by
choosing the appropriate command from the Reports menu. Figure 2-4
shows such a report.
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The next step is to print this report to a text file. In QuickBooks, you click the
Print button or choose File=>Print Report. Using either approach, QuickBooks
displays the Print Reports dialog box, as shown in Figure 2-5.

Print Reports

Settings  Margins

Send To OneNote 2013 on nul N Options...

Cancel
ASCIl text file >
Help

Note: To install additional printers or to change port

assignments, use the Windows Control Panel. Preview
ORIENTATION. PAOE RANGE
© Portrait @ an
@ Landscape © Pages:

From To:

PAGE BREAKS:

Number of copies: 1
¥ Smari page breaks (widow/orphan control)

¥ Coliate
Page break arer each major grouping

Fitreportto page(s)wide Printin color (color printers only)
Fitreportto page(s) high

Pay attention to the Print To radio buttons shown near the top of the Settings
tab. QuickBooks, like many other programs, gives you the option of printing
your report either to a printer or to a file.
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Figure 2-6:
The Create
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If you want to later import the information on the report, you should print
the report to afile. In the case of QuickBooks, this means that you select the
File radio button. (Refer to Figure 2-5.)

The other thing that you need to do — if you're given a choice — is to
use a delimiter. In Figure 2-5, the File drop-down list shows ASCII text
file as the type of file that QuickBooks will print. Often, though, applica-
tions — including QuickBooks — let you print delimited text files.

Delimited text files use standard characters, called delimiters, to separate fields
of information in the report. You can still import a straight ASCII text file, but
importing a delimited text file is easier. Therefore, if your other program gives
you the option of creating delimited text files, do so. In QuickBooks, you can
create both comma-delimited files and tab-delimited files.

In QuickBooks, you indicate that you want a delimited text file by choosing
Comma Delimited File or Tab Delimited File from the File drop-down list of the
Print Reports dialog box.

To print the report as a file, you simply click the Print button of the Print
Reports dialog box. Typically, the application (QuickBooks, in this example)
prompts you for a pathname, like in the Create Disk File dialog box shown in
Figure 2-6. The pathname includes both the drive and folder location of the
text file as well as the name of the file. You provide this information, and then
the application produces the text file . . . or hopefully, the delimited text file.
And that’s that.

Create Disk File
Savein: | [l Desktop ~ @2 @
5 T Lib H
= ibraries lomegroup
-~
)’ sl System Folder '% System Folder
Recent places .

Steve [] | Computer
Desktop .
- @ Network
System Folde
= e

Libraries

A
Computer
“w
ot Fie name: N ‘ Save
Save as type Text ("ixt) = E
LinesPerPage: [0 | wiah: [80 £
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Importing: The second
step (if necessary)

When you don’t or can’t export directly to Excel, you need to take the second
step of importing the ASCII text file that you created with the other program.
(To read more about exporting to a text file, see the preceding section.)

To import the ASCII text file, first open the text file itself from within Excel.
When you open the text file, Excel starts the Text Import Wizard. This wizard
walks you through the steps to describe how information in a text file should
be formatted and rearranged as it’s placed in an Excel workbook.

One minor wrinkle in this importing business is that the process works differ-

ently depending on whether you're importing straight (ASCII) text or delim-
ited text.

Importing straight text
Here are the steps that you take to import a straight text file:

1. Open the text file by choosing Open from the File menu or by choosing
the Data tab’s Get External Data from Text command.

Excel displays the Open dialog box, shown in Figure 2-7, if you choose
the Open command. Excel displays a nearly identical Import Text File
dialog box if you choose the Data tab’s Get External Data from Text
command.

X} Open
T m« Users » Steve » Desktop v ¢ Search Desktc

P
= [ @

Date modified Type

New folder

H admin € Name
A steve

H Steve's Writing

Organize v

] test2 11/22/201312:45..  Tedt Doce

™ Computer
s Local Disk (C:)
:l' admin (mars)
® admin (venus)
?"' Beth (mercury)
7"' LeDummy (ledur
™ cde (venus)
:l' Steve's Wniting (r

€ Network v <
File name: | test2 v AllExcel Files .

Tools + Open |v Cancel
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]
Figure 2-8:
Step 1 of the
Text Import
Wizard.
|

3

. Choose Text Files from the drop-down list that appears to the right of

the File text box.

. Use the Look In drop-down list to identify the folder in which you

placed the exported text file.
You should see the text file listed in the Open dialog box.

. To open the text file, double-click its icon.

Excel starts the Text Import Wizard, as shown in Figure 2-8.

The Text Wizard has determined that your data is Fixed Width.
If this is correct, choose Next, or choose the data type that best desaibes your data,
Original data type

Choose the file type that best describes your data:
() Delimited - Characters such as commas of tabs separate each field.

Start import at row: 1 3 File origin: 437 : OEM United States v

[[] My data has headers.

Preview of file C\Users\Steve\Desktop\test2.7xT.

Text Import Wizard - Step 1 of 3 » HEM |

n n
]
(4] 12:44 PMPine lake Poxcelain, LIC
15 ] 11/22/13Sales by Customer Detail v
Cancel Next > Einish
5. Select the Fixed Width radio button.
This tells Excel that the fields in the text file are arranged in evenly
spaced columns.
6. In the Start Import at Row text box, identify the row in the ASCII text

file that should be the first row of the spreadsheet.

In general, ASCII text files use the first several rows of the file to show
report header information. For this reason, you typically won’t want to
start importing at row 1; you’'ll want to start importing at row 10 or 20 or 5.

Don’t get too tense about this business of telling the Text Import Wizard
which row is the first one that should be imported. If you import too
many rows, you can easily delete the extraneous rows later in Excel.

You can preview the to-be-imported report shown on the bottom section
of the Text Import Wizard dialog box.
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7. Click Next.

Excel displays the second step dialog box of the Text Import Wizard, as
shown in Figure 2-9. You use this second Text Import Wizard dialog box
to break the rows of the text files into columns.

<F You might not need to do much work identifying where rows should
be broken into columns. Excel, after looking carefully at the data in the
to-be-imported text file, suggests where columns should be broken and
draws vertical lines at the breaks.

Text Import Wizard - Step 2 of 3 » HEM |

This screen lets you set field widths (column breaks).
Lines with arrows signify a column break.

To CREATE a break line, click at the desired position.
To DELETE a break line, double click on the line.
To MOVE a break line, click and drag it.

Data preview
o, P o . 0 . P . @ P
| ftnvoice 07/29/2013 h3 A
) fnvoice 07/01/2014 2
F|g|||'ez-9: invoice 07/01/2014 E
Envoice 07/01/2014 =
Step 2 of the knvoice 07/01/2014 3 v
< >
Text Import
‘Nizard- Cancel < Back I _____ _N ext_{__J] Einish

8. In the Data Preview section of the second wizard dialog box, review
the text breaks and amend them as needed.

e If they're incorrect, drag the break lines to a new location.
* To remove a break, double-click the break line.

¢ To create or add a new break, click at the point where you want the
break to occur.

9. Click Next.

Excel displays the third step dialog box of the Text Import Wizard, as
shown in Figure 2-10.
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Figure 2-10:
Step 3 of the
Text Import
Wizard.
|

This screen lets you select each column and set the Data Format.
Column data format
®) General
O Text all remaining values to text.
(_) Date: MDY " Advanced...
() Do not import column (skip)

Data preview

Text Import Wizard - Step 3 of 3 ? “

‘General’ converts numeric values to numbers, date values to dates, and

Eenaral

nvoice

07/01/2014
07/01/2014

Cancel < Back i\ Finish !

10.

11.

12.

(Optional) Choose the data format for the columns in your new
workbook.

You can pick default formatting from the third Text Import Wizard dialog
box for the columns of the new workbook.

* To choose the default format for a column, click that column in
the Data Preview box and then select one of the four Column Data
Format radio buttons.

e If you choose the Date format radio button as the default for a
column, use the Date drop-down list to choose a Date format.

(Optional) Identify any columns that Excel should not import.

If you don’t want to import a column, select a column in the Data
Preview box and then select the Do Not Import Column (Skip) radio
button.

(Optional) Nit-pick how the data appears in the text file.

You can click the Advanced button (on the third Text Import Wizard
dialog box) to display the Advanced Text Import Settings dialog box, as
shown in Figure 2-11. The Advanced Text Import Settings dialog box pro-
vides text boxes that you can use to specify in more detail or with more
precision how the data in the text file is arranged.

e Choose what symbol is used to separate whole numbers from deci-
mal values by using the Decimal Separator drop-down list.

¢ Choose what symbol is used to separate thousands by using the
Thousands Separator drop-down list.

Click OK after you make choices here; you return to the third wizard
dialog box.
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Figure 2-11:
The
Advanced
Text Import
Settings
dialog box.
I

Figure 2-12:
The
imported
text file in
an Excel
workbook.
I

Advanced Text Import Settings ~ ? EN |

Settings used to recognize numeric data
Decimal separator: | W
Thousands separator: |, v/

Note: Numbers will be displayed using the numeric
settings specified in the Regional Settings control panel.

Reset [v] Trailing minus for negative numbers

[ oK Cancel

13. Click Finish.

Excel imports the text file according to your specifications and places

it into a new Excel workbook, as shown in Figure 2-12. The data prob-
ably won’t be perfectly laid out. Still, when you have very large data
sets, you'll find importing a tremendous timesaver. In general, you won’t
find it terribly difficult to clean up the new workbook. You only need to
delete a few rows or perhaps columns or maybe do a bit of additional
formatting or row and column resizing.

LG w2 Eoeel 7 5 X
h 1on WSERT  PAGELAYOUT  FORMULAS  DATA  REVEW  VEW Sto
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By " €47 E Merge & Cant $-9
! ) A
m .
A 8 o E v H ) X L M P R T \
1 wnoica 13 CastiorochCottaa... Red mug- o 75 s am
2 wwoica 9 CastierociCoMfog... Redmug. 100 4 w0 TH
3 wwolce 9 CastierociCoffee... Painbow 150 255 aws 12730
wwolce 9 CastieroctCoffee... Tellow ™ a» mm a0
wwolce 9 CastieroctCoffee.., s mu 20 3 W 2w
. 9 Castleroch Coffue... Discoun... 1000% 106 1am.e
Sabes Roceipt 2 Castiroci CoMag... Rai 255 295 13657
wwoica 11 CastiernchCottaa... Re 75 50000 93%.57
wwoica 11 Castieroci Coftga... W 20 95957
wwolce 11 Castiaroc Coffee. W 20 37T
wwolce 11 Castiaroch Coffee. W 20 39957
wwolce 11 Castieroch Coffee. W 20 1029957
wwoica 11 Castiornc Cottaa... 0 20 1039557
4 wioica 11 Castiernc Cottaa... 0 20 1056557
wwoica 11 Castieroci Coftse... 00 10 107%.57
wwolce 11 Castiaroct Coffee 100 330000 13293.57
wwolce 3 Castherodh Coffee. 3 L2300 14385.57
Credit Memo 5 CastlerochCoffee.., P a -0 1330957
? wroics T ECAUOOCOMO0... MdMUg. L0076 65000 21757
0 Tot alCastenCoMe  oHose 2,765 2,79557 21.7%6.57
2 Mee sPmace
3 Gareto
Credit Memo /e 1 2w 29 2w
wwolce ; 30 10 Ama00 439703
Ll | @

Importing delimited text files
Here are the steps that you take to import a delimited text file:

1. Choose the File menu’s Open command or click the Data tab’s Get
External Data from Text button.

Excel displays the Open dialog box (refer to Figure 2-7) or the Import
Text File dialog box (which is nearly identical to Figure 2-7).
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|
Figure 2-13:
The first
Text Import
Wizard
dialog box.
]

B3

2. Choose Text Files from the drop-down list.

The drop-down list box you use to choose the type of file you want
appears to the right of the File Name text box.

3. Use the Look In drop-down list to identify the folder in which you
placed the exported text file.

You should see the text file listed in the Open dialog box.
4. To open the text file, double-click its icon.

Excel may be able to guess how the delimited data file organizes its data
and just open the file in the Excel workbook window. Or Excel may start
the Text Import Wizard, as shown in Figure 2-13.

Text Import Wizard - Step 1 of 3 ? HEM |

The Text Wizard has determined that your data is Delimited.

If this is correct, choose Next, or choose the data type that best desaibes your data,
Original data type
Choose the file type that best describes your data:

............

‘:.‘.‘;.Qﬂlﬂ'\ﬂ(d_ - Characters such as commas of tabs separate each field.

() Fixed width - Fields are aligned in columns with spaces between each field.

Start import at row: 1 ++ File origin: 437 : OEM United States v

[C] My data has headers.

Preview of file C\Users\Steve\Desktop\test3.CSV.

, "Iype”, "Date”, "Num", "Memo"”, "Name", "Item", "Qty", "Sales Price", "Amount", "B ~
n Castlexock Coffee House™,,,,,, s, -
ﬂ "Invoice®", "07/29/2013",6"13",, "Castlerock Coffee House",K "Red mug (Red co
[4] "znvoice=, 07/01/2014","9", , "Castlerock Coffee House","Red mug (Red cof:
S] "Invoice*,"07/01/2014","9", , "Castlezrock Coffee House", "Rainbow mug (Rain| v
< >
Cancel Next > I Einish

5. Select the Delimited radio button.

This tells Excel that the fields in the text file are separated by (one or
more) delimiters.

6. In the Start Import at Row text box, identify the point in the delimited
text file that should be the first row of the spreadsheet.

In general, ASCII text files use the first several rows of the file to show
report header information. For this reason, you typically want to start
importing at row 10 or 20 or 5.

Don’t get too tense about this business of telling the Text Import Wizard
which row is the first one that should be imported. You can easily delete
the extraneous rows later in Excel.

You can preview the to-be-imported report shown on the bottom section
of the Text Import Wizard dialog box.
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|
Figure 2-14:
The second
Text Import
Wizard
dialog box.
]

A\

7. Click Next.

Excel displays the second dialog box of the Text Import Wizard, as
shown in Figure 2-14. You use this second Text Import Wizard dialog box
to identify the character or characters used as the delimiter to break the
text into columns. For example, if the file that’s being imported is a tab-
delimited file, select the Tab check box in the Delimiters area.

Text Import Wizard - Step 2 of 3 » HEM |
This screen lets you set the delimiters your data contains, You can see how your text is affected in the
preview below.
Delimiters
(Wit
[ ] semicolon [T Treat consecutive delimiters as one
omma
Mc Text gualifier  * v
[ space
[[] other:
Data preview
ype ate um Memo Name A
astlerock Coffee House
nvoice P7/29/2013 3 astlerock Coffee Hous
nvoice 07/01/2014 astlexock Coffee Hous|
nvoice P7/01/2014 astlerock Coffee Hous|v
< >
Cancel < Back I Next > I Einish

8. Click Next.

The third Text Import Wizard dialog box appears, as shown in
Figure 2-15.

9. (Optional) Choose the data format for the columns in your new
workbook:

® To choose the default format for a column, click that column in the
Data Preview box and then select one of the Column Data Format
radio buttons.

¢ To use the Date format as the default for a column, select the Date
radio button and use the Date drop-down list to choose a Date
format.

The Data Preview box on the second Text Import Wizard dialog box
shows how the file will look after it’s imported based on the delimiters
that you identified. Experiment a bit to make sure that you import the
data in a clean format.
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Text Import Wizard - Step 3 of 3 7 HEM |

This screen lets you select each column and set the Data Format,
Column data format
(O] General

() Text ‘General’ converts numeric values to numbers, date values to dates, and

all remaining values to text.
O Date: MDY v Advanced...

() Do not import column (skip)

Data preview
|
;;;;; 2 ~
Figure 2_15- Pate um Memo Name ~
i nvo. P7/25/2013 p3 Castlerock Coffee Hous|
The mlrd nv: P7/01/2014 B Kastlexock Coffee Hous|
Text Import nvoice P7/01/2014 B Lastlerock Coffee Hous|v
. < .
Wizard
dia|°g box. Cancel < Back |:_‘__'_£i§_.§n _JJ
I

10. (Optional) Identify any columns that Excel should skip importing.

If you don’t want to import a column, select the column and then select
the Do Not Import Column (Skip) radio button.

11. (Optional) Nit-pick how the data appears in the text file.

Click the Advanced command button of the third Text Import Wizard
dialog box to display the Advanced Text Import Settings dialog box.
(Refer to Figure 2-11.) Here, you can specify in more detail how the data
in the text file is arranged.

Click OK to return to the third Text Import Wizard dialog box.
12. Click Finish.

Excel imports the delimited text file according to your specifications.
As with a straight text file, the data probably won't be perfectly laid out.
But you won't find it difficult to clean up the new workbook. A few dele-
tions, a little resizing, and pretty soon the workbook will look the way
you want.

Ouerying External Databases
and Wez Page Tables

Another approach to collecting data that you want to analyze is to extract
data from a web page or from an external database. Excel provides three very
neat ways to grab this sort of external data:
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» You can perform a web query, which means that you can grab data from
a table stored in a web page.

» You can import tables stored in common databases, such as Microsoft
Access.

» You can use Microsoft Query to first query a database and then place
the query results into an Excel workbook.

All three approaches for grabbing external data are described in the para-
graphs that follow.

The difference between importing information that you want to analyze by
using the Open command or Get External Data from Text command (read the
preceding sections of the chapter) and importing information by using the Get
External Data from Web or Get External Data from Access commands (read the
following paragraphs) is somewhat subtle. In general, however, these latter
two commands enable you to grab data directly from some external source
without first massaging the data so that it’'s more recognizable.

Running a web query

One of the neatest ways to grab external data is through a web query. As
you know if you've wasted any time surfing the web, Internet websites pro-
vide huge volumes of interesting data. Often, you’d like to grab this data and
analyze it in some way. And fortunately, Excel provides an easy way to move
such data from a web page into Excel.

With the Excel Web Query tool, as long as the data that you want to grab or

analyze is stored in something that looks like a table — that is, in something
that uses rows and columns to organize the information — you can grab the
information and place it into an Excel workbook.

To perform a web query, follow these steps:

1. Choose the File menu’s New command to open a blank workbook.

You need to place query results into a blank worksheet. Therefore, your
first step might need to be to open a workbook with a blank worksheet.

If you need to insert a blank worksheet into an existing workbook, click
the Insert Worksheet button. This button appears on the bottom edge of
the worksheet next to the sheet tabs: Sheetl, Sheet2, Sheet3, and so on.

2. Tell Excel that you want to run a web query by choosing the Data
tab’s Get External Data from Web command.

Excel displays the New Web Query dialog box, as shown in Figure 2-16.
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]
Figure 2-16:
The New
Web Query
dialog box.
|

N\

|
Figure 2-17:
The Import
Data dialog
box.
]

New Web Query 7 HEM |
{_ o™
Address: | http://wwvav.bls.gov/\web/empsit/ceseesumms v Go « B Lo m E Options...
Click [#] next to the tables you want to select, then dick Import.
suareon: 3 (& B ~
&}
BROWSE CES
EESTABLISHMENT DATA
CES HOME Summary table B. Establishment data, seasonally adj.
CES OVERVIEW ’
Oct. Nov. Dec Jan. f
CES NEWS RELEASES Category 2012 2012 2012 2013 2

CES DATABASES (Over-the-month
change, in thousands)
CES PUBLICATIONS v TE o 160 247 219 148
CES FAQS Total private 217 256 224 164
CONTACT CES Goods-producing 16 43 58 41
Mining and
logging 6 12 7 3 v
SEARCH CES e .- - -~ -
< >
Import Cancel

CES TABLES AND CHARTS + | EMPLOYMENT BY

SELECTED INDUSTRY

[Done I

3. Open the web page containing the table that you want to extract data

from by entering its URL into the Address field.

In Figure 2-16, | show a page from the United States Bureau of Labor
Statistics. The Bureau of Labor Statistics website provides tons of tabu-
lar information, so if you want to play along, go ahead and visit the web-
site at www.bls.gov and poke around until you find a page that shows a
table.

. Identify the table by clicking the small yellow arrow button next to

the table.

Excel places this small yellow right-arrow button next to any tables that
it sees in the open web page. All you need to do is to click one of the but-
tons to grab the data that the arrow points to.

Excel replaces the yellow arrow button with a green check button.

. Verify that the green check button marks the table that you want to

import and then import the table data by clicking the Import button.
Excel displays the Import Data dialog box, as shown in Figure 2-17.

Where do you want to put the data?

Properties... OK Cancel

Import Data  ? BN

(® Existing worksheet:
=5A51 27
() New worksheet

Add this data to the Data Mode
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6. In the Import Data dialog box, tell Excel where to place the imported
web data.

Select the Existing Worksheet radio button to place the table data into
the existing, open, empty worksheet. Alternatively, select the New
Worksheet radio button to have Excel place the table data into a newly
inserted blank sheet.

7. Click OK.

Excel places the table data into the specified location. But I should tell
you that sometimes grabbing the table data might take a few moments.
Excel goes to some work to grab and arrange the table information.
Figure 2-18 shows worksheet data retrieved from a web page table.

1 [ESTABLSHMENT DATA |

2 Sumenary tabla & Establishmenn cata, sasoeally adjusted

O Nov  Dec  Ja e Mar A, Mey  June bl Aug  Sepl  Oat
M2 W2 AR XL B NP A N\ A3 08 213 2Wp) Ap)

0 M7 n9 s 32 W2 199 1%l 8 28 18 24
64 319 154 138 167 19 w0 207 150 212

Figure 2-18:
Imported |
worksheet |-
data froma |-
Web page |-
table.You |3
rock, man. |~

o 12 7 3 . 2 -3 2 3 2 a 5 3

P Web query operations don’t always work smoothly. In this case, you might
want to revisit the web page that displays the table and verify that you clicked
the correct select button. The select button, again, is the small yellow button
with the arrow that points to the table data.

Importing a database table

Another powerful method for retrieving data from an external data source,
such as a database, is to retrieve the information directly from one of a
database’s tables. In relational databases, as in Excel, information gets
stored in tables.
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Figure 2-19:
The Select
Data Source
dialog box.
]

To import data from a database table, follow these steps:

1. Choose the Data tab’s Get External Data from Access command.

Excel displays the Select Data Source dialog box, as shown in Figure 2-19.

] Select Data Source u_
(3) « t [E» Libraies » Documents v & | Search Documents o
Organize v New folder zZv [0 @
B Microsoft Excel Nowme Date modified
Bluetooth Folder 11/22/20131212...  Filefoldes
- Favorites | Custom Office Templates 8/2T/2 0 A F
B Deskiop Excel Data Analysic files 11/ File folde
& Downloads Intuit 1/ |
%] Recent places &) My Data Sources 11/ M File foldes
& SkyDrive Quicken ] F
Scresn Images File foldes
4 Libraries | ] MGCompare.mdb 11/22/2013 1:35 MOB File
<] Documents
J’ Music
b= Pictures
3 videos
v o< >
New Source...
File name: | MGCompare.mdb v Access Databases v
Tools ~ Open Cancel

2. Identify the folder that stores the database from which you will grab

information.

Select the drive and folder where the database is stored using the list
boxes provided by the Select Data Source dialog box.

3. After you see the database listed in the Select Data Source dialog box,

click it and then click Open.
If Excel displays the Select Table dialog box, continue to Step 4.

If Excel doesn’t display the Select Table dialog box but instead displays
the Import Data dialog box (see Figure 2-20), skip ahead to Step 5.

4. If Excel displays the Select Data Source dialog box, select the table that

you want to retrieve information from by clicking it; then click OK.
Excel displays the Import Data dialog box, as shown in Figure 2-20.

5. Select either the Existing Worksheet radio button or the New

Worksheet radio button to tell Excel where to place the information
retrieved from the table.

If you want to place the data in an existing worksheet, use the Existing
Worksheet text box to specify the top-left cell that should be filled
with data. In other words, specify the first cell into which data should
be placed.
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Figure 2-20:
The Import
Data dialog
box.
—

Figure 2-21:
An Excel
work-

sheet with
imported
data.
|

Import Data > HEM |

Select how you want to view this data in your workbook.
(®) Table
_) PivotTable Report

13 ) PivotChart

[ O only Create Connection
Where do you want to put the data?

(®) Existing worksheet:

=5As1 =

() New worksheet

[] Add this data to the Data Model

Properties... ~ oK Cancel

6. Click OK.

Excel retrieves information from the table and places it at the specified
worksheet location. Figure 2-21 shows an Excel worksheet with data
retrieved from a database table in the manner just described.

[ =) Boakd - Exxel TAaLE T 7 5 x
HOME INSERT PAGE FORMULAS nata REVEW vEW |
Tobke Nome &) m [E] Propote
Teble MGCamg! §-8Rumone Dupbcaten <
H X L M N »
0_catepory B premium e -
2 Ms L] 1 Infarmacion No Disponibie 52043 2
MS 8 2 597- 5138 piUH 32084 B
4 Ms L] 2 537-5138 2 08 2
MS 8 3 5115 - 5177 2013 32043 1
Ms L] sy 2013 32043 2
7 MS & 4 5139 8208 2013 S04 1
MS ] 4 5139 8008 2013 52046 2
MS L 5 S161 - S240 2013 52047 1
0 Ms L] 5 5161 - 5240 03 3,047 2
MS 8 6 5161 - 5240 2013 32043 1
12 MS L] 6 5161 - 5240 03 32043 2
3 Ms 15 1 Information Not Available 2013 5073 1
14 MS 15 1 Informacion No Disponible 2013 52073 2
15 Ms 15 2 Information Not Available 2013 SH0M 1
16 MS 1B 2 Informacion No Disponible 2013 32074 2
17 Ms 1 3 Information Not Avallsble 2013 3207 1
13 MS 13 3 Informacion No Disponible 2013 32073 2
5 ms 1 4 Informanon Mot Avallaoh 2015 e 1
w0 MS 15 4 Informacidn No Disponible 2013 5:07% 2
2 MS 13 S Information Not Available 2013 52077 1
22 ms 1 S Informacion No Disponible 2013 52077 2
23 Ms 13 6 Information Not Zvalladle 2013 3207 1
24 MS 1B 6 Informacion No Disponible 2013 327 2
23 MS b0 1 Information Not Zvallable 2013 32079 1

Ouerying an external database

Excel provides one other powerful method for retrieving information from
external databases. You aren’t limited to simply grabbing all the information
from a specified table. You can, alternatively, query a database. By querying
a database, you retrieve only information from a table that matches your
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|
Figure 2-22:
The Choose
Data Source
dialog box.
|

3

criteria. You can also use a query to combine information from two or more
tables. Therefore, use a query to massage and filter the data before it’s actu-
ally placed in your Excel workbook.

Querying is often the best approach when you want to combine data before
importing it and when you need to filter the data before importing it. For
example, if you were querying a very large database or very large table — one
with hundreds of thousands of records — you would need to run a query in
order to reduce the amount of information actually imported into Excel.

Hey, you know what? You can follow along with this discussion even if you
don’t have something like an Microsoft Access database handy. Just do an
Internet search for a publicly available database like the one you might want
to query. For this discussion, for example, I didn’t actually use a real Microsoft
Access database. I just grabbed one from U.S. Government’s official www.
medicare .gov website.

To run a database query and import query results, follow these steps:

1. From the Data tab, choose From Other Sources=>From Microsoft
Query.
Excel displays the Choose Data Source dialog box, as shown in
Figure 2-22.

Choose Data Source

Databases | Queries | OLAP Cubes |

<New Data Source>
Excel Files*
MS Access Database”

Browse...

I,

Options...

f

@I [V Use the Query Wizard to create/edit queries

2. Using the Databases tab, identify the type of database that you want to
query.

For example, to query a Microsoft Access database, click the MS Access
Database entry and then OK.

You can query the results of a query by clicking the Queries tab and
then selecting one of the items listed there.
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Figure 2-23:
The Select
Database
dialog box.
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Figure 2-24:
The Query
Wizard -
Choose
Columns
dialog box.
|

bing Data from External Sources

You can also query an OLAP cube and grab information from that. If
you want to query a query or an OLAP cube, consult with the database
administrator. The database administrator can tell you what query or
OLAP cube you want to grab data from.

3. Select the database.

Excel displays the Select Database dialog box, as shown in Figure 2-23.

Use this dialog box to identify both t
database that you want to query.

he location and the name of the

Select Database n_
Database Name Directories:
IMGComparemd: c:\users'\steve\documents
Cancel
omp =\ A —'
[ Users
(> Steve 4,H°b
> Documents
(2 Biuetooth Folder F . 9""
(3 Custom Office T v
List Files of Type: Drives:
|Access Databases "m v | Iﬁc: ;l Network... |

4. Select the database that you want to query from the directories list

and then click OK.

Excel displays the Query Wizard - Choose Columns dialog box, as shown

in Figure 2-24.

Query Wizard - Choose Columns H
What columns of data do you want to include in your query?
Avaiable tables and columns: Columns in your query:
@ vwapp_MPPF_medigap_plantype_: A > I J
& vwhpp_MPPF_medigap_premiums I ;I
@ vwhpp_MPPF_Medigap_Simple_PI
@ |
= vwPlansByState
@ uPlancRiZinN s ~/
< >
Preview of data in selected column;
o Opor.. | oo |
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Figure 2-25:
The Query
Wizard -
Choose
Columns
dialog box
query infor-
mation is
defined.
|

You use the Query Wizard - Choose Columns dialog box to pick which
tables and which table fields you want to appear in your query results.
In the Available Tables and Columns box, Excel lists tables and fields.
Initially, this list shows only tables, but you can see the fields within a
table by clicking the + symbol next to the table.

. When you see a field that you want as a column in your Excel list,

click its field and then click the right-facing arrow button that points
to the Columns in Your Query list box.

To add all the fields in a table to your list, click the table name and then
click the right-facing arrow button that points to the Columns in Your
Query list box.

To remove a field, select the field in the Columns in Your Query list box
and then click the left-facing arrow button that points to the Available
Tables and Columns list box.

This all sounds very complicated, but it really isn’t. Essentially, all you
do is to identify the columns of information that you want in your Excel
list. Figure 2-25 shows how the Query Wizard - Choose Columns dialog
box looks if you want to build a data list that includes information such
as the type of plan, the state, and the contract year. (The actual data-
base field names are cryptic, of course.)

Query Wizard - Choose Columns n—
What columns of data do you want to include in your query?
Avalable tables and columns: Columns in your query:
3 vwipp_MPPF_medigap_plantype_#/N > simple_plantype j
@ vwipp MPPF_medigap_premiums plh:‘-lwb;( J
) vwhpp_MPPF_Medigap_Simple_P| —J z:(:'-;l_’::,
® vwOigsByState L]
= vwPlansByState
@ aPlancRiZinN s N
< >
Preview of data in selected column.
@‘ Options Next > Cancel

6.

After you identify which columns you want in your query, click the
Next button to filter the query data as needed.

Excel displays the Query Wizard - Filter Data dialog box, as shown in
Figure 2-26.

You can filter the data returned as part of your query by using the Only
Include Rows Where text boxes. For example, to include only rows in
which the state abbreviation field shows CA, click the state_abbrev field
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Figure 2-26:
The Query
Wizard -
Filter Data
dialog box.
|

in the Column to Filter list box. Then select the Equals filtering opera-
tion from the first drop-down list and enter or select the value CA into
the second drop-down list; see how this looks in Figure 2-26.

The Query Wizard - Filter Data dialog box performs the same sorts of
filtering that you can perform with the AutoFilter command and the
Advanced Filter command. Because [ discuss these tools in Chapter 1, |
won't repeat that discussion here. However, note that you can perform
quite sophisticated filtering as part of your query.

Query Wizard - Filter Data ﬁ_
Fiter the data to specify which rows to include in your query.
If you don't want to fiter the data, click Next
Column to filter Only include rows where:
state_abbrey
| ecuuals | Jea =
contract_year @ And C O
I =~ =
Cid CO
I =1/} 2
C (@,
<Back Next > Cancel |

7. (Optional) Filter your data based on multiple filters by selecting the

And or Or radio buttons.

e And: Using And filters means that for a row to be included, it must
meet each of the filter requirements.

¢ Or: Using Or filters means that if a row meets any filtered condition,
the row is included.

8. Click Next.

Excel displays the Query Wizard - Sort Order dialog box, as shown in
Figure 2-27.

9. Choose a sort order for the query result data from the Query Wizard -

Sort Order dialog box.

Select the field or column that you want to use for sorting from the Sort
By drop-down list. By selecting either the Ascending or Descending
radio button, choose whether the field should be arranged in an ascend-
ing or descending order, respectively.

You can also use additional sort keys by selecting fields in the first and
second Then By drop-down lists.
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|
Figure 2-27:
The Query
Wizard -
Sort Order
dialog box.
|

3

|
Figure 2-28:
The Query
Wizard -
Finish dialog
box.
I

Query Wizard - Sort Order

Speciy how you want your data sorted
If you don't want to sort the data, click Next.

Then by

I I

€ hscending
=

Soit by =
T —
. " Descending
| =l
=

Q‘ <Back Next > Cancel |

You sort query results the same way that you sort rows in an Excel
table. If you have more questions about how to sort rows, refer to
Chapter 1. Sorting works the same whether you’re talking about query
results or rows in a list.

10. Click Next.

Excel displays the Query Wizard - Finish dialog box, as shown in
Figure 2-28.

Query Wizard - Finish ﬂ—

‘What would you ke to do nest?

& Retun Data to Microsoft Excel Save Query...

" View data or edit query in Microsoft Query

g‘ <Back [ Fsh | Cancel

11. In the Query Wizard - Finish dialog box, specify where Excel should
place the query results.

This dialog box provides radio buttons, from which you choose where
you want to place your query result data: in Excel, in a Microsoft Query
window that you can then review, or in an OLAP cube. Typically (and
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this is what [ assume here in this book), you simply want to return the
data to Microsoft Excel and place the data in a workbook. To make this
choice, select the Return Data to Microsoft Office Excel radio button.

12. Click the Finish button.

After you click the Finish button to complete the Query Wizard, Excel
displays the Import Data dialog box; refer to Figure 2-20.

13. In the Import Data dialog box, choose the worksheet location for the
query result data.

Use this dialog box to specify where query result data should be placed.

* To place the query result data in an existing worksheet, select the
Existing Worksheet radio button. Then identify the cell in the top-
left corner of the worksheet range and enter this in the Existing
Worksheet text box.

¢ Alternatively, to place the data into a new worksheet, select the
New Worksheet radio button.

14. Click OK.

Excel places the data at the location that you chose.

It’s Sometimes a Raw Deal

By using the instructions that I describe in this chapter to retrieve data from
some external source, you can probably get the data rather quickly into

an Excel workbook. But it’s possible that you've also found that the data

is pretty raw. And so you are saying to yourself (or at least if I were in your
shoes, I would be saying this), “Wow, this stuff is pretty raw.”

But don’t worry: You are where you need to be. It’s okay for your informa-
tion to be raw at this point. In Chapter 3, I discuss how you clean up the
workbook by eliminating rows and columns and information that’s not part of
your data. I also cover how you scrub and rearrange the actual data in your
workbook so that it appears in a format and structure that’s useful to you in
your upcoming analysis.

The bottom line is this: Don’t worry that your data seems pretty raw right
now. Getting your data into a workbook accomplishes an important step.
All you need to do now is spend a little time on your housekeeping. Read
through the next chapter for the lowdown on how to do that.

By the way, if the process of importing data from some external source has
resulted in very clean and pristine data — and this might be the case if
you've grabbed data from a well-designed database or with help from the
corporate database administrator — that’s great. You can jump right into the
data analysis techniques that I start describing in Chapter 4.
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Chapter 3
Scrub-a-Dub-Dub: Cleaning Data

In This Chapter
Editing an imported workbook
Cleaning data with text functions
Keeping data clean with validation

ou will greatly benefit from exploring the techniques often necessary for

cleaning up and rearranging workbook data. You know why? Because
almost always the data that you start with — especially data that you import
from other programs — will be pretty disorganized and dirty. Getting your
data into a clean form makes it easier to work with and analyze the data.

Editing Your lmported Workbook

[ start this discussion with some basic workbook editing techniques. If

you take a look at the workbook shown in Figure 3-1, you see that the data,
although neatly formatted, doesn’t appear as an Excel table. The workbook
shown in Figure 3-1, for example, includes blank columns and rows. The
workbook also uses some columns that are inadequately sized. The width for
column |, for example, is too small to display the values stored there. (That’s
why those #s appear.)

You will often encounter situations like this. The workbook shown in Figure 3-1,
for example, has actually been imported from QuickBooks. You can use several
workbook-editing techniques to clean up a workbook. In the following sections,
[ give you a rundown of the most useful ones.
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Figure 3-1:
This work-

sheet needs |*
tocleanup |
itsact. |~

Jan- Do 33
ary Amount % of SalesAwg Fric COGS  Awi COGS Gross Ma Geoss Margin's

140 e 35005
203 sesmems 8100%
216 sesmsms 29.00%
149 3ETLE  3390%
33 e 32305
167 weawaws 35305
3200%
w10
14.10%
3650%

= 3% 101 30022
A48 4AT0% 1064 500575
1 4% 1957 295800
2.10% 9.7 189943
5 1400% 1913 13,75139
3.20% 1.3 439630

2,07 21014,

2.00%

A\\J

Delete unnecessary columns

To delete unnecessary columns (these might be blank columns or columns
that store data that you don’t need), click the column letter to select the
column. Then choose the Home tab’s Delete command.

You can select multiple columns for multiple deletions by holding down the
Ctrl key and then individually clicking column letters.

Delete unnecessary rows

To delete unnecessary rows, you follow the same steps that you do to delete
unnecessary columns. Just click the row number and then choose the Home
tab’s Delete command. To delete multiple rows, hold down the Ctrl key and
then select the row numbers for each of the rows that you want to delete.
After making your selections, choose the Home tab’s Delete command.

Resize columns

To resize (enlarge the width of) a column so that its contents clearly show,
double-click the column letter box’s right corner or click AutoFit Column
Width on the Format button’s drop-down (Home tab). For example, in
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Figure 3-2, column H is too narrow to displays its values. Excel displays sev-
eral pound signs (########) in the cells in column H to indicate the column
is too narrow to adequately display its values.
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Just double-click the column letter label, and Excel resizes the column so that
it’'s wide enough to display the values or labels stored in that column. Check
out Figure 3-3 to see how Excel has resized the width of column H to display
its values.
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Figure 3-4:
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Figure 3-5:
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You can also resize a column by selecting it and then choosing the Home
tab’s Format=>Column Width command. When Excel displays the Column
Width dialog box, as shown in Figure 3-4, you can enter a larger value into
the Column Width text box and then click OK. The value that you enter is the
number of characters that can fit in a column.

Column Width ?
Column width: | 1171
oK ' Cancel

For you manually inclined fiddlers, you can also resize a column by clicking
and dragging the left corner of the column letter label box. You can resize the
column to any width by dragging this border.

In Excel 2007 and Excel 2010, select the column and use the Home tab’s
Format=>Width command to display the Column Width dialog box and change
the column width.

Resize rows

You can resize rows like you resize columns. Just select the row number label
and then choose the Home tab’s Format=>Row Height command. When Excel
displays the Row Height dialog box, as shown in Figure 3-5, you can enter a
larger value into the Row Height text box.

?

Row Height
Row height: 15

[ OK Cancel

Row height is measured in points. (A point equals 1/72 of an inch.)

In Excel 2007 and Excel 2010, select the row and use the Home tab’s
Format=>Row Height command to display the Row Height dialog box and
change the row height.



Chapter 3: Scrub-a-Dub-Dub: Cleaning Data 6 ’

Figure 3-6:
Format
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Erase unneeded cell contents

To erase the contents of a range that contains unneeded data, select the
worksheet range and then choose the Home tab’s Clear=>Clear All command.
Excel erases both the contents of the cells in the selected range and any for-
matting assigned to those cells.

Format numervic values

To change the formatting of values in a workbook that you want to analyze,
first select the range of what you want to reformat. Then choose the Home
tab’s Number command. When Excel displays the Format Cells dialog box,
as shown in Figure 3-6, choose from its tabs to change the formatting of the
selected range. For example, use choices from the Number tab to assign
numeric formatting to values in the selected range. You use options from the
Alignment tab to change the way the text and values are positioned in the
cell, from the Font tab to choose the font used for values and labels in the
selected range, and from the Border tab to assign cell border borders to the
selected range.

Format Cells ? n—

Number  Alignment Font Border Fin Protection
Category:

Sample

Number 2101425

Accounting General format cells have no speatic number format,

Time
Percentage
Fraction
Saentific
Text
Special
Custom

oK Cancel

The buttons and boxes that appear just above the Number command button
provide for several, convenient, one-click formatting options. For example,
you can click the command button marked with the currency symbol to
format the selected range using the accounting format.
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|
Figure 3-7:
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Copying worksheet data

To copy worksheet data, first select the data that you want to duplicate. You
can copy a single cell or range of cells. Choose the Home tab’s Copy com-
mand and then select the range into which you want to place the copied data.
Remember: You can select a single cell or a range of cells. Then choose the
Home tab’s Paste command.

You can also copy worksheet ranges by dragging the mouse. To do this,
select the worksheet range that you want to copy. Then hold down the Ctrl
key and drag the range border.

Moving worksheet data

To move worksheet data to some new location, select the range that stores
the data. Choose the Home tab’s Cut command and click the cell in the
upper-left corner of the range into which you want to move the worksheet
data. Then choose the Home tab’s Paste command.

You can also move worksheet ranges by dragging the mouse. To do this,
select the worksheet range that you want to copy and then drag the range
border.

Replacing data in fields

One of the most common commands that I find myself using to clean up a list
is the Home tab’s Find & Select command. To use this command, first select
the column with the data that you want to clean by clicking that column’s
letter. Next choose Find & Select=>Replace so that Excel displays the Find and
Replace dialog box, as shown in Figure 3-7.

7 HEN |

Find and Replace

Find  Replace

Find what: Lv]
Replace with: v

Options >>

Eind Next Close

Replace All Replace Find All
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Enter the incorrect text that you want to find in the Find What text box
and then enter the correct text in the Replace With text box. Then click the
Replace All button to fix the incorrect text.

Cleaning Data with Text Functions

Figure 3-8:
Good work-
sheet data;

tough to
analyze.
|

One of the common problems with data that you import is that your text
labels aren’t quite right. For example, you might find yourself with the city,
state, and ZIP code information that’s part of an address stored in a single
cell rather than in three separate cells. Or, you might find that same informa-
tion stored in three separate cells when you want the data stored in a single
cell. You might also find that pieces of information that you want stored as
labels instead are stored as values and vice versa.

What's the big deal, Steve?

Just to give you a quick idea of what | mean here, take a look at Figures 3-8
and 3-9. Okay, this is fake data, sure. But the examples show a common situ-
ation. The list information shown in Figure 3-8 uses unnecessarily lengthy
product names, goofs up some customer names by appending store numbers
to customer names, and then puts all of the city and state information into
one field. Yuk.
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|
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In Figure 3-9, see how I rearrange this information so that it’s much more
easily sorted and filtered. For example, the PRODUCT?2 field abbreviates the
product name by changing Big Bob’s Guide to to just BBgt. The store names
are essentially edited down to just the first word in the store name — an
easy change that enables you to see sales for Bean’s Tackle, Mac’s Shack, and
Steve’s Charters. The ADDRESS information is split into two fields: CITY and
STATE.

Here’s one other important point about Figure 3-9: The rearrangement shown
in Figure 3-9 makes it possible to cross-tabulate the data using a pivot table
(something I talk more about in Chapter 4).

The answer to some of your problems

All the editing performed in Figure 3-9 is performed using text functions, so
here, I discuss these babies.

You can grab a ZIP file from the companion website that includes most of the
Excel workbooks shown in the pages of this book. I mention this because if
you're really curious about how text functions are used in Figure 3-9, you can
grab the actual workbook and check out the formulas. The ZIP file is available
at this book’s companion website. See the Introduction for more on how to
access the website.

Excel provides two dozen text functions that enable you to manipulate text
strings in ways to easily rearrange and manipulate the data that you import
into an Excel workbook. In the following paragraphs, I explain how to use the
primary text functions.
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If you've just read the word function and you're scratching your head, you
might want to review the contents of the Appendix.

By the way, I skip discussions of three text functions that [ don’t think you'’ll
have occasion to use for scrubbing data: BAHTEXT (rewrites values using
Thai characters); CHAR (returns the character represented by an American
National Standards Institute [ANSI] code number); and CODE (returns the
ANSI code represented by character). To get descriptions of these other text
functions, click the down arrow button next to the AutoSum function on the
Home tab and choose More Functions from the drop-down list Excel displays.
When Excel displays the Insert Function dialog box, select the Text entry
from the Or Select A Category box, and then scroll through the list of text
functions that Excel displays in the Select a Function box until you see the
function that you have a question for — most likely, the function that I incor-
rectly assume you don’t need information about.

In Excel 2007 or Excel 2010, you choose the Home tab’s choose Insert=>Function
to display the Insert Function dialog box.

The CLEAN function

Using the CLEAN function removes nonprintable characters text. For exam-
ple, if the text labels shown in a column are using crazy nonprintable charac-
ters that end up showing as solid blocks or goofy symbols, you can use the
CLEAN function to clean up this text. The cleaned-up text can be stored in
another column. You can then work with the cleaned text column.

The CLEAN function uses the following syntax:

CLEAN ( text)
The text argument is the text string or a reference to the cell holding the text
string that you want to clean. For example, to clean the text stored in Cell Al,

use the following syntax:

CLEAN(AD)

The CONCATENATE function

The CONCATENATE function combines, or joins chunks of text into a single
text string. The CONCATENATE function uses the following syntax:

CONCATENATE (textl1, text2,text3,. . .)
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The text1, text2, text3, and so on arguments are the chunks of text that
you want to combine into a single string. For example, if the city, state, and
ZIP code were stored in fields named city, state, and zip, you could create
a single text string that stores this information by using the following syntax:

CONCATENATE (city, state, zip)

If city were Redmond, state were WA, and zip were 98052, this function
returns this text string:

RedmondWAS8052

The smashed-together nature of the concatenated city, state, and ZIP code
information isn’t a typographical mistake, by the way. To concatenate this
information but include spaces, you need to include spaces as function argu-
ments. For example, the following syntax:

CONCATENATE ("Redmond", " ", "WA", " " "9g8052")
returns the text string

Redmond WA 98052

The EXACT function

The EXACT function compares two text strings. If the two text strings are
exactly the same, the EXACT function returns the logical value for true, which
is 1. If the two text strings differ in any way, the EXACT function returns the
logical value for false, which is 0. The EXACT function is case-sensitive. For
example, Redmond spelled with a capital R differs from redmond spelled with
alowercaser.

The EXACT function uses the following syntax:

EXACT (textl, text2)
The text1 and text2 arguments are the text strings that you want to
compare. For example, to check whether the two strings "Redmond" and
"redmond" are the same, use the following formula:

EXACT ("Redmond" , "redmond" )
This function returns the logical value for false, 0, because these two text

strings don’t match exactly. One begins with an uppercase R and the other
begins with a lowercase r.
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The FIND function

The FIND function finds the starting character position of one text string
within another text string. For example, if you want to know at what position
within a text string the two-letter state abbreviation WA starts, you could use
the FIND function.

The FIND function uses the following syntax:

FIND (find text,within text,start num)
The find_text argument is the text that you're looking for. The within
text argument identifies where or what you're searching. The start_num
argument tells Excel at what point within the string it should begin its search.
For example, to find at what point the two-letter state abbreviation WA begins
in the string Redmond WA 98052, use the following formula:

FIND ("WA", "Redmond WA 98052",1)

The function returns the value 9 because WA begins at the ninth position
(because spaces are counted).

The start_num function argument is optional. If you omit this argument,
Excel begins searching at the very beginning of the string.

The FIXED function

The FIXED function rounds a value to specified precision and then converts
the rounded value to text. The function uses the following syntax:

FIXED (number,decimals,no_commas)
The number argument supplies the value that you want to round and convert
to text. The optional decimals argument tells Excel how many places to the
right of the decimal point that you want to round. The optional no_commas
argument needs to be either 1 (if you want commas) or o (if you don’t want
commas) in the returned text.

For example, to round to a whole number and convert to text the value
1234.56789, use the following formula:

FIXED(1234.56789,0,1)

The function returns the text 1, 235.
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The LEFT function

The LEFT function returns a specified number of characters from the left end
of a text string. The function uses the following syntax:

LEFT (text,num_chars)
The text argument either supplies the text string or references the cell hold-
ing the text string. The optional num_chars argument tells Excel how many

characters to grab.

For example, to grab the leftmost seven characters from the text string
Redmond WA, use the following formula:

LEFT ("Redmond WA",7)

The function returns the text Redmond.

The LEN function

The LEN function counts the number of characters in a text string. The func-
tion uses the following syntax:

LEN (text)
The text argument either supplies the text string that you want to measure
or references the cell holding the text string. For example, to measure the
length of the text string in cell 181, use the following formula:

LEN (I81)

If cell I81 holds the text string Semper fidelis, the function returns the
value 14. Spaces are counted as characters, too.

The LOWER function

The LOWER function returns an all-lowercase version of a text string. The
function uses the following syntax:

LOWER ( text)
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The text argument either supplies the text string that you want to convert
or references the cell holding the text string. For example, to convert the text
string PROFESSIONAL to professional, use the following formula:

LOWER ( "PROFESSIONAL")

The function returns professional.

The MID function

The MID function returns a chunk of text in the middle of text string. The
function uses the following syntax:

MID (text, start num,num_char)
The text argument either supplies the text string from which you grab some
text fragment or it references the cell holding the text string. The start num
argument tells Excel where the text fragment starts that you want to grab.
The num_char argument tells Excel how long the text fragment is. For exam-
ple, to grab the text fragment tac from the text string tic tac toe, use the
following formula:

=MID("tic tac toe",5,3)

The function returns tac.

The PROPER function

The PROPER function capitalizes the first letter in every word in a text string.
The function uses the following syntax:

PROPER (text)
The text argument either supplies the text string or references the cell hold-
ing the text string. For example, to capitalize the initial letters in the text
string ambassador kennedy, use the following formula:

PROPER ("ambassador kennedy")

The function returns the text string Ambassador Kennedy.
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The REPLACE function

The REPLACE function replaces a portion of a text string. The function uses
the following syntax:

REPLACE (old_text,start num,num_chars,new_text)

The o1d_text argument, which is case-sensitive, either supplies the text
string from which you grab some text fragment or it references the cell hold-
ing the text string. The start numargument, which is the starting position,
tells Excel where the text starts that you want to replace. The num_chars
argument tells Excel the length of the text fragment (how many characters)
that you want to replace. The new_text argument, also case-sensitive, tells
Excel what new text you want to use to replace the old text. For example, to
replace the name Chamberlain with the name Churchill in the text string
Mr. Chamberlain, use the following formula:

REPLACE ("Mr. Chamberlain",5,11, "Churchill")

The function returns the text string Mr. Churchill.

The REPT function

The REPT function repeats a text string. The function uses the following
syntax:

REPT (text, number._ times)
The text argument either supplies the text string or references the cell hold-
ing the text string. The number._times argument tells Excel how many times
you want to repeat the text. For example, the following formula:

REPT ("Walla",h2")

returns the text string wallawalla.

The RIGHT function

The RIGHT function returns a specified number of characters from the right
end of a text string. The function uses the following syntax:

RIGHT (text, num_chars)
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The text argument either supplies the text string that you want to manipu-
late or references the cell holding the text string. The num_chars argument
tells Excel how many characters to grab.

For example, to grab the rightmost two characters from the text string
Redmond WA, use the following formula:

RIGHT ("Redmond WA",2)

The function returns the text wa.

The SEARCH function

The SEARCH function calculates the starting position of a text fragment
within a text string. The function uses the following syntax:

SEARCH (find text,within text,start num)
The find_text argument tells Excel what text fragment you're looking for.
The within text argument tells Excel what text string that you want to
search. The start _numargument tells Excel where to start its search. The
start_numargument is optional. If you leave it blank, Excel starts the search
at beginning of the within text string.

For example, to identify the position at which the text fragment Churchill
starts in the text string Mr. Churchill, use the following formula:

SEARCH ("Churchill", "Mr. Churchill",b 1)

The function returns the value 5.

The SUBSTITUTE function

The SUBSTITUTE function replaces occurrences of text in a text string. The
function uses the following syntax:

SUBSTITUTE (text,old text,new_text,instances)
The text argument tells Excel what text string you want to edit by replacing

some text fragment. The o1d_text argument identifies the to-be-replaced
text fragment. The new_text supplies the new replacement text.

/1
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As an example of how the SUBSTITUTE function works, suppose that you
need to replace the word Senator with the word President in the text
string Senator Obama.

SUBSTITUTE ("Senator Obama", "Senator", "President")
The function returns the text string President Obama.
The instances argument is optional, but you can use it to tell Excel for
which instance of o1d_text you want to make the substitution. For example,
the function

SUBSTITUTE ("Senator Senator","Senator", "President",1)
returns the text string President Senator Obama.
The function

SUBSTITUTE ("Senator Senator Obama","Senator","President",2)

returns the text string Senator President Obama.

If you leave the instances argument blank, Excel replaces each occurrence of
the o1d_text with the new_text. For example, the function

SUBSTITUTE ("Senator Senator Obama","Senator", "President")

returns the text string Senator Senator Obama.

The T function

The T function returns its argument if the argument is text. If the argument
isn’t text, the function returns nothing. The function uses the following syntax:

T (value)

For example, the formula T (123) returns nothing because 123 is a value. The
formula T ("Seattle") returns Seattle because Seattleis a text string.

The TEXT function

The TEXT function formats a value and then returns the value as text. The
function uses the following syntax:

TEXT (value, format_text)
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The value argument is the value that you want formatted and returned as
text. The format_text argument is a text string that shows the currency
symbol and placement, commas, and decimal places that you want. For
example, the formula

=TEXT (1234 .5678, "$##, ###.00")
returns the text $1,234.57.

Note that the function rounds the value.

The TRIM function

The TRIM function removes extra spaces from the right end of a text string.
The function uses the following syntax:

TRIM (text)

The text argument is the text string or, more likely, a reference to the cell
holding the text string.

The UPPER function

The UPPER function returns an all-uppercase version of a text string. The
function uses the following syntax:

UPPER ( text)
The text argument either supplies the text string that you want to convert
or it references the cell holding the text string. For example, to convert the
text string professional to PROFESSIONAL, you can use the following
formula:

UPPER ("professional™")

The function returns the text string PROFESSIONAL.

The VALUE function

The VALUE function converts a text string that looks like a value to a value.
The function uses the following syntax:

VALUE ( text)

/3
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The text argument either supplies the text string that you want to convert
or it references the cell holding the text string. For example, to convert

the text string $123,456.78 — assume that this isn’t a value but a text
string — you can use the following formula:

VALUE ("$123,456.78")

The function returns the value 123456 .78.

Converting text function formulas to text

You might need to know how to convert a formula — such as a formula that
uses a text function — to the label or value that it returns. For example, sup-
pose you find yourself with a worksheet full of text-function-based formulas
because you used the text functions to clean up the list data. And now you
want to just work with labels and values.

You can convert formulas to the labels and values that they return by select-
ing the worksheet range that holds the formulas, choosing the Home tab’s
Copy command, and then choosing the Home tab’s Pastew>Paste Values com-
mand without deselecting the currently selected range. Note that to get to
the Paste submenu, you need to click the lower half of the Paste command
button.

Using Validation to Keep Data Clean

One useful command related to this business of keeping your data clean is
the Data Validation command. Use this command to describe what informa-
tion can be entered into a cell. The command also enables you to supply mes-
sages that give data input information and error messages that attempt to
help someone correct data entry errors.

To use Data Validation, follow these steps:

1. Select the worksheet range where the to-be-validated data will go.
You can do this by dragging your mouse or by using the navigation keys.

2. Choose the Data tab’s Data Validation command to tell Excel that you
want to set up data validation for the selected range.

Excel displays the Data Validation dialog box, as shown in Figure 3-10.
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3. On the Settings tab of the Data Validation dialog box, use the

Validation Criteria text boxes to describe what is valid data.

Use choices from the Allow drop-down list box, for example, to supply
what types of information can go into the range: whole numbers, deci-
mal numbers, values from the list, valid dates, valid times, text of a par-
ticular length, and so on.

Use choices from the Data drop-down list box to further define your vali-
dation criteria. The Data drop-down list box provides several compari-
sons that can be made as part of the validation: between, not between,
equal to, not equal to, greater than, and so on.

Refine the validation criteria, if necessary, using any of the other drop-
down list boxes available. Nofe: The other validation criteria options
depend on what you enter into the Allow and Data drop-down list boxes.
For example, as shown in Figure 3-11, if you indicate that you want to
allow only whole numbers between a particular range of minimum and
maximum values, Excel provides Minimum and Maximum text boxes

for you to enter or define the range. However, if you select other entries
from the Allow or Data drop-down list boxes, you see other text boxes
appearing on the Settings tab. In other words, Excel customizes the
Settings tab depending on the kind of validation criteria that you define.

4. Fine-tune the validation.

After you describe the validation criteria, either select or deselect (clear)
the Ignore Blank check box to indicate whether blank cells are allowed.

5. (Optional) Consider expanding the scope of the data validation.

Select the Apply These Changes to All Other Cells with the Same
Settings check box to indicate whether the validation criteria should be
expanded to other similar cells.

Click the Clear All button, and Excel clears (removes) the validation criteria.
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Figure 3-11:
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6. Provide an input message from the Input Message tab of the Data
Validation dialog box.

The Input Message tab, as shown in Figure 3-11, enables you to tell Excel
to display a small message when a cell with specified data validation is
selected. To create the input message, you enter a title for the message
into the Title text box and message text into the Input Message text box.
Make sure that the Show Input Message When Cell Is Selected check box
is selected. Look at Figure 3-12 to see how the Input Message entered in
Figure 3-11 looks on the workbook.

TG o v Bad dats amangerment froel with fet functions - Eocel 7T 5 x
h HOME  WSERT  PAGELAYOUT  FORM A vew A Stephen Nebn - [
A v AE SH 3
= 4 T ?
Eésting Tett Fah s Comolifate Whatdt Group Ungreup Suteatal
nections Vadonced  coumis il Duplicass Vabdatio Analysis + . .
et Extesm Dok omeaon san & Fites Dt Yook athoe . -
3794012684 -
a ] c 3 ¥ H | ) M v P R
PRODUCT2 CUSTOMERZ CITY STATE
BBg: Fyfisning 8ean's Redmond WA
BBt FyTisnig. Macs Bemeghsm WA
BBt Fhyfstirg Bean's Redmond WA
BBt Fhyfrsting Bear's Oak Harbor WA
A Tying Fes Sear's Redmond WA
BBg: Tying Fises 8ean's Westport WA
BBg: Tying Fises 8ean's Ok Harboe WA
B84 Tying Flses ear's Rodmond WA
BBt Tying Fhes Bean's Redmond WA
BBt Tying Fes Bear's Oak Harbor WA
BBt Tying Fhes Beur's Redmond WA
BBg Stoalhoad Fahing Sean's Redmond WA
BBgt Stoalhaad Fhing Bean's Wostport WA
s Oak Harboe WA

0
BEgt Staalhoad Fehing Bean’
Mac

Mac

BBgt Steelhesd Fahing Macs Belrgham Wa

B85t Salmon Fishing s Belrgham WA

Bean's Westpoet WA

sear's nedmond WA

g Bean's Recmond WA

BBgiSalmon Fishing  Stews's  Westoort WA
Sheet! | Shewt2 | Sheed




Chapter 3: Scrub-a-Dub-Dub: Cleaning Data

<\®

Figure 3-13:
Create an
annoy-

ing data
entry error
message.

]
]
Figure 3-14:
Britney
would be
proud, you

dunderhead.
|

7. Provide an error message from the Error Alert tab of the Data
Validation dialog box. (See Figure 3-13.)

You can also supply an error message that Excel displays when some-
one attempts to enter invalid data. To create an error message, first
verify that the Show Error Alert After Invalid Data Is Entered check box
is selected. Then use the Style drop-down list box to select what Excel
should do when it encounters invalid data: Stop the data entry on the
user without the incorrect data entry, or simply display an informational
message after the data has been entered.

Just like creating an input message, enter the error message title into
the Title text box. Then enter the full text of the error message into the
Error Message text box. In Figure 3-13, you can see a completed Error
Alert tab. Check out Figure 3-14 for how the error message appears after
a user enters invalid data.

Curious about the options in the Style drop-down list box (as shown in
Figure 3-13)? The style of the error alert determines what command buttons
the error message presents when someone attempts to enter bad data. If the
error style is Stop, the error message box displays Retry and Cancel com-
mand buttons. If the error style is Warning, the error message box displays
Yes, No, and Cancel command buttons. If the error style is Informational, the
error message box displays OK and Cancel command buttons.

Data Validation ? “

Settings | Input Message | Error Alert
V| Show error alert after invalid data is entered
When user enters invalid data, show this error alert:
Style: Titte:
Stop v | Oopsyou did it again
Error message:

Please enter a value between S50
and 100. Please. I'm trying to ask

0 nicely.

Clear All oK Cancel

Qops you did it again

Q Please enter = value bebween 50 and 100, Plesse, I'm brying to sk nicely.

Cancel Help
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In this part . . .

Use PivotTables to cross-tabulate data and gain new insights
into your information.

Extend the power of Excel’s PivotTables by creating your own
customized formulas.

Display cross-tabulated data in a chart for new perspectives
on opportunities and problems.

Customize PivotCharts to make sure your graphical information
communicates the right messages.




Chapter 4
Working with PivotTables

In This Chapter
Cross-tabulating with pivot tables
Setting up with the PivotTable Wizard
Fooling around with your pivot tables
Customizing the look and feel of your pivot tables

perhaps the most powerful analytical tool that Excel provides is the
PivotTable command, with which you can cross-tabulate data stored in
Excel lists. A cross-tabulation summarizes information in two (or more) ways:
for example, sales by product and state, or sales by product and month.

Cross-tabulations, performed by pivot tables in Excel, are a basic and very
interesting analytical technique that can be tremendously helpful when you're
looking at data that your business or life depends on. Excel’s cross-tabulations
are neater than you might at first expect. For one thing, they aren’t static: You
can cross-tabulate data and then re-cross-tabulate and re-cross-tabulate it again
simply by dragging buttons. What’s more, as your underlying data changes, you
can update your cross-tabulations simply by clicking a button.

Looking at Data from Many Angles

Cross-tabulations are important, powerful tools. Here’s a quick example:
Assume that in some future century that you're the plenipotentiary of the
Freedonian Confederation and in charge of security for a distant galaxy.
(Rough directions? Head toward Alpha Centauri for about 50 million light
years and then hang a left. It’ll be the second galaxy on your right.)

Unfortunately, in recent weeks, you're increasingly concerned about military
conflicts with the other major political-military organizations in your corner
of the universe. Accordingly, assume for a moment that a list maintained by
the Confederation tracks space trooper movements in your galaxy. Assume
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that the list stores the following information: troop movement data, enemy
name, and type of troop spaceships involved. Also assume that it’s your job
to maintain this list and use it for analysis that you then report to appropri-
ate parties.

With this sort of information, you could create cross-tabulations that show
the following information:

v Enemy activity over time: One interesting cross-tabulation is to look at
the troop movements by specific enemy by month over a two- or five-
year period of time. You might see that some enemies were gearing up
their activity or that other enemies were dampening down their activity.
All this information would presumably be useful to you while you assess
security threats and brief Freedonian Confederation intelligence officers
and diplomats on which enemies are doing what.

v Troop movements by spaceship type: Another interesting cross-tabulation
would be to look at which spaceships your (potential) enemies are using
to move troops. This insight might be useful to you to understand both
the intent and seriousness of threats. As your long experience with the
Uglinites (one of your antagonists) might tell you, for example, if you know
that Jabbergloop troop carriers are largely defensive, you might not need to
worry about troop movements that use these ships. On the other hand, if
you notice a large increase in troop movements via the new photon-turbine
fighter-bomber, well, that’s significant.

Pretty powerful stuff, right? With a rich data set stored in an Excel table,
cross-tabulations can give you remarkable insights that you would probably
otherwise miss. And these cross-tabulations are what pivot tables do.

Getting Ready to Pivot

To create a pivot table, your first step is to create the Excel table that you
want to cross-tabulate. Figure 4-1 shows an example Excel table that you
might want a pivot table based on. In this list, I show sales of herbal teas by
month and state. Pretend that this is an imaginary business that you own and
operate. Further pretend that you set it up in a list because you want to gain
insights into your business’s sales activities.

Note: You can find this Herbal Teas Excel Data list of herbal tea sales Workbook,
available in the Zip file of sample Excel workbooks related to this book, at the
companion website for this book. You might want to download this list in order
to follow along with the discussion here. See the Introduction for more on
accessing the companion website.
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Running the PivotTable Wizard

You create a pivot table — Excel calls a cross-tabulation a pivot table — by
using the PivotTable command. To run the PivotTable command, take the
following steps:

1. Click the Insert tab’s PivotTable command button.

Excel displays the Create PivotTable dialog box, as shown in Figure 4-2.

Create PivotTable ? “
Choose the data that you want to analyze
@) Select a table or range
TableRange:  SheetlISAST:SDS225 &
(O Use an external data source
Connection name:
I
Choose where you want the PivotTable report to be placed
Figure 4-2: ®) New Worksheet
(O Existing Worksheet
Use the .
. rd t Location: 25
wiza 0 Choose whether you want to analyze multiple tables
set up a :\ Add this data to the Data Model
pivot table. oK —
y
I
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2. Select the radio button that indicates where the data you want to

analyze is stored.

If the to-be-analyzed data is in an Excel table or worksheet range, for
example, select the Table/Range radio button. [ demonstrate this
approach here. And if you're just starting out, you ought to use this
approach because it’s the easiest.

If the data is in an external data source, select the Use an External Data
Source radio button. I don’t demonstrate this approach here because I'm
assuming in order to keep things simple and straightforward that you've
already grabbed any external data and placed that data into a worksheet
list. (If you haven’t done that and need help doing so, skip back to
Chapter 2.)

If the data is actually stored in a bunch of different worksheet ranges,
simply separate each worksheet range with a comma. (This approach
is more complicated, so you probably don’t want to use it until you're
comfortable working with pivot tables.)

If you have data that’s scattered around in a bunch of different locations
in a worksheet or even in different workbooks, pivot tables are a great
way to consolidate that data.

. Tell Excel where the to-be-analyzed data is stored.

If you're grabbing data from a single Excel table, enter the list range into
the Table/Range text box. You can do so in two ways.

¢ You can type the range coordinates: For example, if the range is
cell Al to cell D225, type $A$1:8D$225.

¢ Alternatively, you can click the button at the right end of the Table/
Range text box. Excel collapses the Create PivotTable dialog box,
as shown in Figure 4-3.

Now use the mouse or the navigation keys to select the worksheet
range that holds the data that you want to pivot. After you select the
worksheet range, click the button at the end of the Range text box
again. Excel redisplays the Create PivotTable dialog box. (Refer to
Figure 4-2.)

Create PivotTable ?
Sheet1SA$1:$D5225 =)




click OK.

table in it, as shown in Figure 4-4.
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4. After you identify the data that you want to analyze in a pivot table,

Excel displays the new workbook with the partially constructed pivot
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5. Select the Row field.

You need to decide first which field from the list that you want to sum-

marize by using rows in the pivot table. After you decide this, you
drag the field from the PivotTable Field List box (on the right side of
Figure 4-4) to the Rows box (beneath the PivotTable Field List). For
example, if you want to use rows that show product, you drag the
Product field to the Rows box.

Using the example data from Figure 4-1, after you do this, the partially con-
structed Excel pivot table looks like the one shown in Figure 4-5.
6. Select the Column field.

Just like you did for the Row field, indicate what list information you
want stored in the columns of your cross-tabulation. After you make
this choice, drag the field item from the PivotTable Field List to the

box marked Columns. Figure 4-6 shows the way the partially con-
structed pivot table looks now, using columns to show states.
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7. Select the data item that you want.

After you choose the rows and columns for your cross-tabulation, you
indicate what piece of data you want cross-tabulated in the pivot table.
For example, to cross-tabulate sales revenue, drag the sales item from the
PivotTable Field List to the Values box. Figure 4-7 shows the completed
pivot table after I select the row fields, column fields, and data items.
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Note that the pivot table cross-tabulates information from the Excel
table shown in Figure 4-1. Each row in the pivot table shows sales by
product. Each column in the pivot table shows sales by state. You can
use column E to see grand totals of product sales by product item. You
can use row 11 to see grand totals of sales by state.

Another quick note about the data item that you cross-tabulate: If you select
a numeric data item — such as sales revenue — Excel cross-tabulates by
summing the data item values. That’s what you see in Figure 4-7. If you
select a textual data item, Excel cross-tabulates by counting the number of
data items.

Although you can use pivot tables for more than what this simple example
illustrates, this basic configuration is very valuable. With a table that reports
the items you sell, to whom you sell, and the geographic locations where you
sell, a cross-tabulation enables you to see exactly how much of each product
you sell, exactly how much each customer buys, and exactly where you sell
the most. Valuable information, indeed.

Fooling Around with Your Pivot Table

After you construct your pivot table, you can further analyze your data with
some cool tools that Excel provides for manipulating information in a
pivot table.
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Pivoting and re-pivoting

The thing that gives the pivot table its name is that you can continue
cross-tabulating the data in the pivot table. For example, take the data
shown in Figure 4-7: By swapping the row items and column items (you do
this merely by swapping the State and Product buttons), you can flip-flop
the organization of the pivot table. Figure 4-8 shows the same information
as Figure 4-7; the difference is that now the state sales appear in rows and
the product sales appear in columns.
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Note: As you pivot data within the Excel window, the viewable portion of
the Excel workbook changes. Depending on the sizing of your window and
the data, you may need to scroll around a bit to see your information.

Another nifty thing about pivot tables is that they don’t restrict you to
using just two items to cross-tabulate data. For example, in both the pivot
tables shown in Figures 4-7 and 4-8, | use only a single row item and a
single column item. You're not limited to this, however: You can also fur-
ther cross-tabulate the herbal tea data by also looking at sales by month
and state. For example, if you drag the month data item to the Row Labels,
Excel creates the pivot table shown in Figure 4-9. This pivot table enables
you to view sales information for all the months, as shown in Figure 4-9, or
just one of the months.




Chapter 4: Working with PivotTables 8 9

Figure 4-9:
Use multiple
PivotTable
fields for
rows.
|

Figure 4-10:
You can
filter page
fields.
—

LG . Detaint of herbaltea sabe - Escl FUDTTARLE TO0L 7T & 5 X
h HOME  WSERT  PAGELAYOUT  FORMULAS  [ATA  RDEW  VEW  OQuidBocks  ANALVZE & Stephen Neson - [
FrveaTable Home:  Active Fiekd 1 = e I 13 Cleor - B Fiekds, e, & Sets . [
PuctTishl | [Sumel Sales§ =X =y € CHE  moea- 15 ? 8 = &
! E Insen Irsen Pettesh Chenge Dot Prvcehan Recommendes i ofe Pl
B Optiors D Fek seings Skces Timeine weee B MovePhotTatie PctTaties | Lt uftons Headers
et £etne Fio 1oup . on watiare s o now N
A - £ || sumorsaloss v
A 8 c 3 E F G H X L
— -x
3 (st ko abe - L
4 Rowlabels - fenber Waves Y pie Raspberry Rocket. Shining Seas Grand Total
3 | =Californis sa61 om0 as3 6011 na 637 0832
samaary 158 26 a =0 7
February 9 s & 633 2030
Maren 1355 3386 294 1652 70 136 14513
Az 967 187 u7 s34 @ 656 546
My 264 06 a2 21 o, 129 s
e wr 12 10 DY 2 19 1165
My E] 128 2 s s 728 2e39
3 g 7 918 268 97 e 7 37
14 Septemer an = am 2 5 s 4612
15 =Ovagon 6384 6455 6367 004 08 s a7 Drag fukds batween
Jarwaary 23 a0 310 2 1616 —
Febrary 10 2 302 1 m e w72
March =1 183 7 5e 20 w3 13392 Product s
19| Agra By 57 a7 138 1 ez 2023
May as7 638 40 n 65 693 3665
xne 627 636 269 8 & %66 3015 = hows X VALLES
2l m 82 3 w03 2 176 2640 — —TT
3 Aupest o2 a1 2] =3 s a0 Mont C
24 September a 09 28 m 06 7
23 = Washington =15 s o108 529 o nma

Filtering pivot table data

And here’s another cool thing you can do: filtering. To filter sales by month,
drag the Month PivotTable field to the Filters box. Excel re-cross-tabulates
the PivotTable as shown in Figure 4-10. To see sales of herbal teas by state
for only a specific month — say, January — you would click the down-arrow
button that looks like it’s in cell B1. When Excel displays a drop-down list
box, select the month you want to see. Figure 4-11 shows sales for just the
month of January. (Check out cell Bl again.)
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Figure 4-11:
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To remove an item from the pivot table, simply drag the item’s button back

to the PivotTable Field List or uncheck the checkbox that appears next to the
item in the PivotTable Field List. Also, as | mention earlier, to use more than
one row item, drag the first item that you want to use to the Rows box and
then also drag the second item that you also want to use to Rows Here.

«\"E S
BER

Drag the row items from the PivotTable Field List. Do the same for columns:
Drag each column item that you want from the PivotTable Fields to the
Columns box.

Check out Figure 4-12 to see how the pivot table looks when I also use Month
as a column item. Based on the data in Figure 4-1, this pivot table is very wide
when [ use both State and Month items for columns. For this reason, only

a portion of the pivot table that uses both Month and State column items
shows in Figure 4-12.

Sometimes having multiple row items and multiple column items makes sense.
Sometimes it doesn’t. But the beauty of a pivot table is that you can easily
cross-tabulate and re-cross-tabulate your data simply by dragging those little
item buttons. Accordingly, try viewing your data from different frames of ref-
erence. Try viewing your data at different levels of granularity. Spend some
time looking at the different cross-tabulations that the PivotTable command
enables you to create. Through careful, thoughtful viewing of these cross-
tabulations, you can most likely gain insights into your data.

You can remove and redisplay the PivotTable Field List in Excel 2013 by clicking
the Field List button on the Analyze tab.
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To remove and redisplay the PivotTable Field List in Excel 2007 or Excel 2010,
right-click PivotTable and choose the Hide Field List command. To show a pre-
viously hidden field list, right-click the PivotTable again and this time choose
the Show Field List command. Predictably, whether the PivotTable shortcut
menu displays the Show Field List command or the Hide Field List command
depends on whether the field list shows. And, yes, this is the sort of insightful
commentary you can count on me to supply.

Refreshing pivot table data

In many circumstances, the data in your Excel list changes and grows over
time. This doesn’t mean, fortunately, that you need to go to the work of
re-creating your pivot table. If you update the data in your underlying Excel
table, you can tell Excel to update the pivot table information.

You have four methods for telling Excel to refresh the pivot table:

»” Click the PivotTable Tools Options ribbon’s Refresh command. Note
that the Refresh command button is visible in Figure 4-12, shown
earlier. The Refresh button appears in roughly the middle of the
Analyze ribbon.

¥ Choose the Refresh Data command from the shortcut menu that Excel
displays when you right-click a pivot table.
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1 Tell Excel to refresh the pivot table when opening the file. To do this,
click the Options command Analyze ribbon (the PivotTable Tools
Options ribbon in Excel 2007 and Excel 2010), and then after Excel dis-
plays the PivotTable Options dialog box, click the Data tab and select
the Refresh Data When Opening File check box.

BER
f’l You can point to any Ribbon command button and see its name in a pop-up
ScreenTip. Use this technique when you don’t know which command is which.

Sorting pivot table data

You can sort pivot table data in the same basic way that you sort an Excel list.
Say that you want to sort the pivot table information shown in Figure 4-13 by
product in descending order of sales to see a list that highlights the best
products.
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To sort pivot table data in this way, right-click a cell in the column that holds
the sort key. For example, in the case of the pivot table shown in Figure 4-13,
and assuming that you want to sort by sales, you click a cell in the worksheet
range C5:C10. Then, when Excel displays the shortcuts menu, choose either
the Sort Smallest to Largest or the Sort Largest to Smallest command. Excel
sorts the PivotTable data, as shown in Figure 4-14. And not surprisingly,
Raspberry Rocket sales are just taking off.



Chapter 4: Working with PivotTables 93

=
.
R | % ER]
PrvoeChan Recommended | Fiid = Fidd
PiweeTabies Lt Buttors Headers
- Raraps o
A D
x
SwmolSales$  Column Labeds ¥ v
4 Row Labels - Calfornty Grand Total
ocket 7191 79
e
6637 6637 v Saks S
s iy —— MORE TABLES .
9 " 3 5361 5361
. 17 Grand Total a8 a2
Figure 4-14: |:

A pivot | T Pe————
table after |- ¥ s "
you sort on

California |- T rws
herbal tea |
sales.

I
You can also exercise more control over the sorting of pivot table data. To do
this, follow these steps:

1. Choose Data tab’s Sort command.
Excel displays the Sort by Value dialog box shown in Figure 4-15.
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|

2. Select your sorting method.

You can select the Smallest to Largest option to sort by the selected
PivotTable field in ascending order. Or you can select the Largest to
Smallest option to sort by the selected PivotTable field in descending
order. You can also specify the Sort Direction using the Top To Bottom
and Left To Right buttons.
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Pseudo-sorting

You can manually organize the items in your pivot table, too. You might want
to do this so the order of rows or columns matches the way that you want to
present information or the order in which you want to review information.

To change the order of items in your pivot table, right-click the pivot table row
or column that you want to move. From the shortcut menu that Excel displays,
choose the Move command. You should see a list of submenu commands:
Move [X] to Beginning, Move [X] Up, Move [X] Down, and so forth. (Just so
you know, [X] will be the name of the field you clicked.) Use these commands
to rearrange the order of items in the pivot table. For example, you can move a
product down in this list. Or you can move a state up in this list.

Grouping and ungrouping data items

You can group rows and columns in your pivot table. You might want to
group columns or rows when you need to segregate data in a way that isn’t
explicitly supported by your Excel table.

In this chapter’s running example, suppose that I combine Oregon and
Washington. I want to see sales data for California, Oregon, and Washington
by salesperson. | have one salesperson who handles California and another
who handles Oregon and Washington. [ want to combine (group) Oregon

and Washington sales in my pivot table so that I can compare the two sales-
persons. The California sales (remember that California is covered by one
salesperson) appear in one column, and Oregon and Washington sales appear
either individually or together in another column.

To create a grouping, select the items that you want to group, right-click the
pivot table, and then choose Group from the shortcut menu that appears.

Excel creates a new grouping, which it names in numerical order starting
with Groupl. As shown in Figure 4-16, Excel still displays detailed individual
information about Oregon and Washington in the pivot table. However, the
pivot table also groups the Oregon and Washington information into a new
category: Groupl.

You can rename the group by clicking the cell with the Group1 label and then
typing the replacement label.

To ungroup previously grouped data, right-click the cell with the group name
(probably Groupl unless you changed it) to again display the shortcut menu
and then choose Ungroup. Excel removes the grouping from your pivot table.
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Important point: You don’t automatically get group subtotals. You get them
when you filter the pivot table to show just that group. (I describe filtering
earlier, in the section “Filtering pivot table data.™) You also get group subtotals,
however, when you collapse the details within a group. To collapse the detail
within a group, right-click the cell labeled with the group name (probably
Groupl), and choose Expand/Collapse=>Collapse from the shortcut menu

that appears. Figure 4-17 shows a collapsed group. To expand a previously
collapsed group, right-click the cell with the group name again and choose
Expand/Collapse=>Expand from the shortcut menu that appears. Or just
double-click the group name.
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Selecting this, selecting that

At your disposal is the Analyze ribbon’s Select submenu of commands: Labels
and Values, Labels, Values, Entire Table, and Entire Selection. To display the
Select submenu, click the drop-down arrow button to the right of the Select
command button. When Excel displays the Select menu, choose the command
you want.

In Excel 2007 and Excel 2010, the Select commands appear on the PivotTable
Tools Options tab when you click the drop-down arrow button to the right of
the Options command button. Also, Excel 2007 and Excel 2010 uses the term
data rather than the term values.

Essentially, when you choose one of these submenu commands, Excel selects
the referenced item in the table. For example, if you choose Select=>Label,
Excel selects all the labels in the pivot table. Similarly, choose Select=>Values
command, and Excel selects all the values cells in the pivot table.

The only Select menu command that’s a little tricky is the Enable Selection
command. That command tells Excel to expand your selection to include
all the other similar items in the pivot table. For example, suppose that you
create a pivot table that shows sales of herbal tea products for California,
Oregon, and Washington over the months of the year. If you select the

item that shows California sales of Amber Waves and then you choose

the Enable Selection command, Excel selects the California sales of all the
herbal teas: Amber Waves, Blackbear Berry, Purple Mountains, Shining
Seas, and so on.

Where did that cell’s number come from?

Here’s a neat trick. Right-click a cell and then choose the Show Details com-
mand from the shortcuts menu. Excel adds a worksheet to the open workbook
and creates an Excel table that summarizes individual records that together
explain that cell’s value.

For example, I right-click cell C8 in the workbook shown earlier in Figure 4-16
and choose the Show Details command from the shortcut menu. Excel creates
a new table, as shown in Figure 4-18. This table shows all the information that
gets totaled and then presented in cell C8 in Figure 4-16.

You can also show the detail that explains some value in a pivot table by
double-clicking the cell holding the value.
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Setting value field settings

The value field settings for a pivot table determine what Excel does with a
field when it’s cross-tabulated in the pivot table. This process sounds com-
plicated, but this quick example shows you exactly how it works. If you right-
click one of the sales revenue amounts shown in the pivot table and choose
Value Field Settings from the shortcut menu that appears, Excel displays the
Value Field Settings dialog box, as shown in Figure 4-19.

Using the Summarize Values By tab of the Data Field Settings dialog box, you
can indicate whether the data item should be summed, counted, averaged,
and so on, in the pivot table. By default, data items are summed. But you can
also arithmetically manipulate data items in other ways. For example, you
can calculate average sales by selecting Average from the list box. You can
also find the largest value by using the Max function, the smallest value by
using the Min function, the number of sales transactions by using the Count
function, and so on. Essentially, what you do with the Data Field Settings
dialog box is pick the arithmetic operation that you want Excel to perform on
data items stored in the pivot table.

If you click the Number Format button in the Data Field Settings dialog box,
Excel displays a scaled-down version of the Format Cells dialog box (see
Figure 4-20). From the Format Cells dialog box, you can pick a numeric format
for the data item.
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Click the Show Values As tab of the Value Field Settings dialog box, and Excel
provides several additional boxes (see Figure 4-21) that enable you to specify
how the data item should be manipulated for fancy-schmancy summaries. I
postpone a discussion of these calculation options until Chapter 5. There’s
some background stuff that I should cover before moving on to the subject of
custom calculations, which is what these boxes are for.
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Customizing How Pivot
Tables Work and Look

Excel gives you a bit of flexibility over how pivot tables work and how they look.
You have options to change their names, formatting, and data manipulation.

Setting pivot table options

Right-click a pivot table and choose the PivotTable Options command from
the shortcut menu to display the PivotTable Options dialog box, as shown in
Figure 4-22.
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The PivotTable Options dialog box provides several tabs of check and text
boxes with which you tell Excel how it should create a pivot table. [ do a
quick run-through on these tab’s options.

Layout & Format tab options

Use the Layout & Format tab’s choices (refer to Figure 4-22) to control the
appearance of your pivot table. For example, select the Merge And Center
Cells with Labels check box to horizontally and vertically center outer row
and outer column labels. Use the When in Compact Form Indent Row Labels
[X] Character(s) to indent rows with labels when the PivotTable report is dis-
played using the compact format. Use the Display Fields in Report Filter Area
and Report Filter Fields Per Column boxes to specify the ordering of multiple
PivotTable filters and the number of filter fields per column.

The Format check boxes appearing on the Layout & Format tab all work pretty
much as you would expect. To turn on a particular formatting option —
specifying, for example, that Excel should show some specific label or value

if the cell formula returns an error or results in an empty cell — select the

For Error Values Show or For Empty Cells Show check boxes. To tell Excel to
automatically size the column widths, select the Autofit Column Widths on
Update check box. To tell Excel to leave the cell-level formatting as is, select
the Preserve Cell Formatting On Update check box.

Perhaps the best way to understand what these layout and formatting options
do is simply to experiment. Just an idea. . . .

Totals & Filters options

Use the Totals & Filters tab (see Figure 4-23) to specify whether Excel should
add grand total rows and columns, whether Excel should let you use more
than one filter per field and should subtotal filtered page items, and whether
Excel should let you use custom lists when sorting. (Custom sorting lists
include the months in a year or the days in the week.)

Display options

Use the Display tab (see Figure 4-24) to specify whether Excel should add
expand/collapse buttons, contextual ScreenTips, field captions and filter drop-
down list boxes, and similar such PivotTable bits and pieces. The Display tab
also lets you return to Excel’s old-fashioned (so-called “classic™) PivotTable
layout, which lets you design your pivot table by dragging fields to an empty
PivotTable template in the worksheet.

Again, your best bet with these options is to just experiment. If you're curi-
ous about what a check box does, simply mark (select) the check box. You
can also click the Help button (the question mark button, top-left corner of
the dialog box) and then click the feature that you have a question about.
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[¥] Show contextual tooltips

Show properties in tooltips

T_/] Display field captions and filter drop downs
[ Classic PivotTable layout (enables dragging of fields in the grid)
[¥] Show the Values row

¥\ Display item labels when no fields are in the values area

Field List
O SortAteZ
@) Sort in data source order

oK Cancel

Printing options

Use the Printing tab (see Figure 4-25) to specify whether Excel should print
expand/collapse buttons, whether Excel should repeat row labels on each
printed page, and whether Excel should set print titles for printed versions
of your PivotTable so that the column and row that label your PivotTable
appear on each printed page.

Data options

The Data tab’s check boxes (see Figure 4-26) enable you to specify whether
Excel stores data with the pivot table and how easy it is to access the data
upon which the pivot table is based. For example, select the Save Source
Data with File check box, and the data is saved with the pivot table. Select
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Figure 4-25:
The Printing
tab of the
PivotTable
Options
dialog box.
|

Figure 4-26:
The Data
tab of the

PivotTable
Options
dialog box.
|

the Enable Expand to Detail check box, and you can get the detailed infor-
mation that supports the value in a pivot table cell by right-clicking the cell
to display the shortcut menu and then choosing the Show Detail command.
Selecting the Refresh Data When Opening the File check box tells Excel to
refresh the pivot table’s information whenever you open the workbook that

holds the pivot table.

PivotTable Options » IEM|
FivotTable Name: PivotTablel
Layout & Format | Totals & Filters | Display | Printing' Data | AltText
Print
[T print expand/collapse buttons when displayed on PivotTable
[V] Repeat row labels on each printed page
|__] Set print titles
oK Cancel
PivotTable Options ? “

PivotTable Name: PivotTable1

Layout & Format | Totals & Filters | Display | Printing | Data || Alt Text
PivotTable Data

(] save source dats with file

[] Enable show details

|| Refresh data when opening the file
Retain items deleted from the data source

Number of items to retain per field: | Automatic | v

What-If Analysis

Enable cell editing in the values area

oK Cancel
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Figure 4-27:
The Alt
Texttab
provides a
tool you can
use to help
people with
impaired
vision or
other cogni-
tive issues
understand
PivotTable
information.
]

The Number of Items to Retain Per Field box probably isn’t something you
need to pay attention to. This box lets you set the number of items per field
to temporarily save, or cache, with the workbook.

Alt Text options

Use the Alt Text tab (see Figure 4-27) to provide textual descriptions of the
information a PivotTable provides. The idea here (and this tab appears in
Excel 2013 and later versions) is to help people with vision or cognitive
impairment understand the PivotTable.

PivotTable Options » IE
PivotTable Name: PivotTablel

Layout & Format | Totals & Filters | Display | Printing Data Alt Text
Title

This is alternate text for people with impaired vision
Description

This pivot table tells an interesting story about sales by slale‘.l

Titles and descriptions provide alterative, text-based representations of the

inf f contai in tables. This is useful for people with vision
or cognitive impairments who may not be able to see or understand the table, A
title can be read to a person with a disability and is used to determine whether
they wish to hear the description of the content.

oK Cancel

Formatting pivot table information

You can and will want to format the information contained in a pivot table.
Essentially, you have two ways of doing this: using standard cell formatting
and using an autoformat for the table.

Using standard cell formatting

To format a single cell or a range of cells in your pivot table, select the range,
right-click the selection, and then choose Format Cells from the shortcut menu.
When Excel displays the Format Cells dialog box, as shown in Figure 4-28, use
its tabs to assign formatting to the selected range. For example, if you want to
assign numeric formatting, click the Number tab, choose a formatting category,
and then provide any other additional formatting specifications appropriate —
such as the number of decimal places to be used.
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—
Figure 4-28:
Format one

cellora
range of
cells here.
|

Figure 4-29:
Choose a

format for |-

an entire
pivot table.

Format Cells

{fiumber | Alignment | Font | Border | Fil | Protection
Category:

Sample

Number i
Currency
Accounting
Date
Time
Percentage
Fraction
Sclenting
Text
Spedsl
Custom

General format cells have no specific number format.

oK Cancel

Using PivotTable styles for automatic formatting

You can also format an entire pivot table. Just select the Design tab and then
click the command button that represents the predesigned PivotTable report
format you want. (See Figure 4-29.) Excel uses this format to reformat your
pivot table information. Look at Figure 4-30 to see how my running example
pivot table of this chapter looks after | apply a PivotTable style.

5 x
Staphan Nebon
A E L
-x
2 -
3 SwmolSales$  Column abels
a “Galifornis = Group1 Grand Total oot
5 Row Labels ~ Calfornis Ovegon  Washington Produc
¢ Amiber Waves e e s 2 Stase
659 6465 6301 19725 Sales §
4193 6337 6510 1% State2
3 Purpse Mouas 64 as0s 668 11 1o hne
10 Raspberry Rocket nn 0008 ns 18488
17 Shining Seas 37 0029 Qo1 10547
12 Grand Total a2 w27 s 106383
Dragfekds between
Y FueRs

shee?

Sheets | Sheet

Sheetz | Sheet3




Chapter 4: Working with PivotTables

<\¥

Figure 4-30: |-
My pivot |-
table for- |-

matted from |2

AutoFormat.

I

If you don’t look closely at the Design tab, you might not see something that’s
sort of germane to this discussion of formatting PivotTables: Excel provides
several rows of PivotTable styles. Do you see the scrollbar along the right
edge of this part of the ribbon? If you scroll down, Excel displays a bunch
more rows of predesigned PivotTable report formats — including some report
formats that just go ape with color. And if you click the More button below the
scroll buttons, the list expands so you can see the Light, Medium, and Dark
categories.

3 Swmolsaless  Column abeds
4 = Califorris =Groupl Grand Total
5 Rowlabels - Californts Oregon__ Washington

Mibticory vt |

12 Grand Total wam w7 WM 10038

Using the Other Design tab tools

The Design tab provides several other useful tools you can use with your
pivot tables. For example, the tab’s ribbon includes Subtotals, Grand Totals,
Report Layout, and Blank Rows command buttons. Click one of these buttons
and Excel displays a menu of formatting choices related to the command but-
ton’s name. If you click the Grand Totals button, for example, Excel displays
a menu that lets you add and remove grand total rows and columns to the
PivotTable.

Finally, just so you don’t miss them, notice that the PivotTable Tools Design
tab also provides four check boxes — Row Headers, Column Headers, Banded
Rows, and Banded Columns — that also let you change the appearance of
your PivotTable report. If the check box labels don't tell you what the box
does (and the check box labels are pretty self-descriptive), just experiment.
You'll easily figure things out, and you can’t hurt anything by trying.
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Chapter 5
Building PivotTable Formulas

In This Chapter
Adding another standard calculation
Creating custom calculations
Using calculated fields and items
Retrieving data from a pivot table

M ost of the techniques that I discuss in this chapter aren’t things that
you need to do very often. Most frequently, the cross-tabulated data
that appears in a pivot table after you run the PivotTable Wizard are almost
exactly what you need. And if not, a little bit of fiddling around with the item
buttons gets the information into the perfect arrangement for your needs.
(For more on the PivotTable Wizard, read through Chapter 4.)

On occasion, however, you'll find that you need to either grab information
from a pivot table so that you can use it someplace else or that you need to
hard-code calculations and add them to a pivot table. In these special cases,
the techniques thatI describe in this chapter might save you much wailing
and gnashing of teeth.

Adding Another Standard Calculation

Take a look at the pivot table shown in Figure 5-1. This pivot table shows
coffee sales by state for an imaginary business that you can pretend that

you own and operate. The data item calculated in this pivot table is sales.
Sometimes, sales might be the only calculation that you want made. But what
if you also want to calculate average sales by product and state in this pivot
table?



] O8 Ppartii: PivotTables and PivotCharts

|
Figure 5-1:
Add
standard
calculations
to basic
pivot tables
for more
complex
data
analysis.
|

|
Figure 5-2:
Replace
calculations
here.
|
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Note: You can find this Excel Data List of Coffees with Pivottable Custom
Calculations Workbook, available in the Zip file of sample Excel workbooks
related to this book, at the companion site for this book. (See this book’s
Introduction for more on how to access the companion site.) You might want
to download this list in order to follow along with the discussion here.

To do this, right-click the pivot table and choose Value Field Settings from the
shortcut menu that appears. Then, when Excel displays the Value Field Settings
dialog box, as shown in Figure 5-2, select Average from the Summarize Value
Field By list box.

Value Field Settings » HEN |

Source Name: Sales §

Custom Name: Sum of Sales §

Summarize Values By | Show Values As

Summarize value field by

Choose the type of calculation that you want to use to summarize
data from the selected field

BT

Count

Average

Max

Min

Product v

Number Format [ OK Cancel
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Now assume, however, that you don’t want to replace the data item that sums
sales. Assume instead that you want to add average sales data to the worksheet.
In other words, you want your pivot table to show both total sales and average
sales.

Note: 1If you want to follow along with this discussion, start over from scratch
with a fresh copy of the worksheet shown in Figure 5-1.

To add a second summary calculation, or standard calculation, to your pivot
table, drag the data item from the PivotTable Field list box to the X Values box.
Figure 5-3 shows how the roast coffee product sales by state pivot table looks
after you drag the sales data item to the pivot table a second time. You may
also need to drag the X Values entry from the Columns box to the Row box.
(See the Columns and Rows boxes at the bottom of the PivotTable Field List.)

PivotTable Fields = *

Vinshington Graed Tetal

‘‘‘‘‘‘‘
6165 19528 Product
5165 13528 Ste

4Hn 165367
10 4313 15367 MOPE TABLES .
. 1"
F|g|||'e B5-3: [ s 3 7 s
12 Sum of Sales §2 613 r b5 209
14 Koma Koast
Adda | "z, T
d 16 Sum of Sales §2 042 kL) 4315 133%
17 Turkish Delight Rosst .
secon 18 uamqrs}nsu' 5453 6408 533 17393 Drag fukds batw
19 S %52 5658 6408 k) 1ms
standard |- e
2 5485 6028 6351 18465
S $2 Ex10) K28 51 13465
summary 23 Total SumulSd‘"’ 69 @9 umm 109543
. 24 Total Sum of Saks $2 34369 M9 u 104543
calculation |= ’ e
to a pivot |2 v~ [smasass
tﬂble. ‘. Sheet! | Dutebase -
I

After you add a second summary calculation — in Figure 5-3, this shows as
the Sum of Sales $2 data item — right-click that data item, choose Value Field
Settings from the shortcut menu that appears, and use the Value Field Settings
dialog box to name the new average calculation and specify that the average
calculation should be made. In Figure 5-4, you can see how the Value Field
Settings dialog box looks when you make these changes for the pivot table
shown in Figure 5-3.
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Value Field Settings » HEN |

Source Name: Sales §

Custom Name: Average of Sales 52

Summarize Values By | Show Values As

Summarize value field by
I Choose the type of calculation that you want to use to summarize
Fig“re 5-4: data from the selected field )
Sum ~
Add a Count
second s
standard Min
. Product ¥
calculation
to a pivot
table. Number Format oK Cancel
p/
|

See Figure 5-5 for the new pivot table. This pivot table now shows two cal-
culations: the sum of sales for a coffee product in a particular state and the
average sale. For example, in cell B6, you can see that sales for the Best Blend
of the Arabia coffee are $6,186 in California. And in cell B7, the pivot table
shows that the average sale of the Best Blend of Arabia coffee in California

is $476.
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If you can add information to your pivot table by using a standard calculation,
that'’s the approach you want to take. Using standard calculations is the easiest
way to calculate information, or add formulas, to your pivot tables.

Creating Custom Calculations

Figure 5-6: |
Use custom |-
calculations |7
to compare |-
pivot table |

data. |~

Excel pivot tables provide a feature called Custom Calculations. Custom
Calculations enable you to add many semi-standard calculations to a pivot
table. By using Custom Calculations, for example, you can calculate the differ-
ence between two pivot table cells, percentages, and percentage differences.

To illustrate how custom calculations work in a pivot table, take a look at
Figure 5-6. This pivot table shows coffee product sales by month for the
imaginary business that you own and operate. Suppose, however, that you
want to add a calculated value to this pivot table that shows the difference
between two months’ sales. You may do this so that you easily see large
changes between two months’ sales. Perhaps this data can help you identify
new problems or important opportunities.

3 Sum of Sales § Colwmn Labels ~
1 Row Labels -
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Sheet! | Datebose 3 3 - Defee Layout Update

I

111



] 12 Partii: PivotTables and PivotCharts

3

To add a custom calculation to a pivot table, you need to complete two tasks:
You need to add another standard calculation to the pivot table, and you
need to then customize that standard calculation to show one of the custom
calculations listed in Table 5-1.

Table 5-1 Custom Calculation Options for Pivot Tables
Calculation Description

Normal You don't want a custom calculation.
Difference From This is the difference between two pivot table

cell values; for example, the difference between
this month’s and last month’s value.

% of This is the percentage that a pivot table cell
value represents compared with a base value.

% Difference From This is the percentage difference between two
pivot table cell values; for example, the percent-
age difference between this month's and last
month’s value.

Running Total In This shows cumulative or running totals of pivot
table cell values; for example, cumulative year-
to-date sales or expenses.

% of Row This is the percent that a pivot table cell value
represents compared with the total of the row
values.

% of Column This is the percentthat a pivottable cell value rep-
resents compared with the total of the column
values.

% of Total This is the pivot table cell value as a percent of
the grand total value.

Index Kind of complicated, dude. The index custom cal-
culation uses this formula: ((cell value) x (grand
total of grand totals)) / ((grand total row) x (grand
total column)).

To add a second standard calculation to the pivot table, add a second data
item. For example, in the case of the pivot table shown in Figure 5-6, if you
want to calculate the difference in sales from one month to another, you need
to drag a second sales data item from the field list to the pivot table. Figure 5-7
shows how your pivot table looks after you make this change.
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After you add a second standard calculation to the pivot table, you must cus-
tomize it by telling Excel that you want to turn the standard calculation into a
custom calculation. To do so, follow these steps:

1. Click the new standard calculation field from the X Values box, and
then choose Value Field Settings from the shortcut menu that appears.

2. When Excel displays the Value Field Settings dialog box, as shown in
Figure 5-8, click the Show Values As tab.

The Show Values As tab provides three additional boxes: Show Values
As, Base Field, and Base Item.

A\
The Base Field and Base Item list box options that Excel offers depend
on which type of custom calculation you're making.
Value Field Settings » HEM |
Source Name: Sales §
Custom Name: | Sum of Sales $2
Summarize Values By  Show Values As
Show values as
DifferenceFrom |4
Base field: Base ftem: o
I Month (previous) A
Figure 5-8: | oy
Customize | &2 Breakfast Blastoft Decat
a standard Kona Koast
calculation
here. Number Format | ok Cancel
P
—
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Figure 5-9:
Define a
custom
calculation
here.
|

3. Select a custom calculation by clicking the down-arrow at the right
side of the Show Values As list box and then selecting one of the
custom calculations available in that drop-down list.

For example, to calculate the difference between two pivot table cells,
select the Difference From entry. Refer to Table 5-1 for explanation of the
possible choices.

4. Instruct Excel about how to make the custom calculation.

After you choose the custom calculation that you want Excel to make in
the pivot table, you make choices from the Base Field and Base Item list
boxes to specify how Excel should make the calculation. For example,
to calculate the difference in sales between the current month and the
previous month, select Month from the Base Field list box and Previous
from the Base Item list box. Figure 5-9 shows how this custom calcula-
tion gets defined.

Value Field Settings » HIEN |

Source Name: Sales §

Custom Name:  Sum of Sales $2

Summarize Values By  Show Values As

Show values as

Difference From v
Base field: Base item:
Month Ml iorevious) N
Product (next)
State January
Sales § February
March
April v
Number Format oK Cancel

P

5. Appropriately name the new custom calculation in the Custom Name
text box of the Data Field Settings dialog box.

For example, to calculate the change between two pivot table cells and
the cells supply monthly sales, you may name the custom calculation
Change in Sales from Previous Month. Or, more likely, you may name the
custom calculation Mthly Change.

6. Click OK.

Excel adds the new custom calculation to your pivot table, as shown in
Figure 5-10.
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Using Calculated Fields and ltems

Excel supplies one other opportunity for calculating values inside a pivot table.
You can also add calculated fields and items to a table. With these calculated
fields and items, you can put just about any type of formula into a pivot table.
But, alas, you need to go to slightly more work to create calculated fields and
items.

Adding a calculated field

Adding a calculated field enables you to insert a new row or column into a
pivot table and then fill the new row or column with a formula. For example,
if you refer to the pivot table shown in Figure 5-10, you see that it reports on
sales both by product and month. What if you want to add the commissions
expense that you incurred on these sales?

Suppose for the sake of illustration that your network of independent sales
representatives earns a 25 percent commission on coffee sales. This commis-
sion expense doesn’t appear in the data list, so you can't retrieve the infor-
mation from that source. However, because you know how to calculate the
commissions expense, you can easily add the commissions expense to the
pivot table by using a calculated field.

115



] 16 Parti: PivotTables and PivotCharts

To add a calculated field to a pivot table, take the following steps:

1. Identify the pivot table by clicking any cell in that pivot table.
2. Tell Excel that you want to add a calculated field.

Click the Analyze ribbon’s Fields, Items & Sets command, and then
choose Calculated Field from the Formulas menu. Excel displays the
Insert Calculated Field dialog box, as shown in Figure 5-11.

In Excel 2007and Excel 2010, you choose the PivotTable Tools Option
tab’s Formulas command and then choose Calculated Field from the
Formulas menu.

W207,

Insert Calculated Field > HEM |
Name: Commissions v | Add |
Formula: | =.25% ‘Sales §
Flelds:
Month
Product
I |
Figure 5-11:
Add a
calculated Insert Figld
field here. oK Close
]
3. In the Name text box, name the new row or column that you want to
show the calculated field.
For example, if you want to add a row that shows commissions expense,
you might name the new field Commissions.
o 4. Write the formula in the Formula text box.

Calculated field formulas work the same way as formulas for regular
cells:

a. Begin the formula by typing the equal (=) sign.
b. Enter the operator and operands that make up the formula.

If you want to calculate commissions and commissions equal 25
percent of sales, enter =.25*.

c. The Fields box lists all the possible fields that can be included in
your formula. To include a choice from the Fields list, click the Sales
$ item in the Fields list box and then click the Insert Field button.

See in Figure 5-11 how the Insert Calculated Field dialog box looks after
you create a calculated field to show a 25 percent commissions expense.
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|
Figure 5-12:
A pivot
table with a
calculated
field.
|

3

5. Click OK.

Excel adds the calculated field to your pivot table. Figure 5-12 shows the
pivot table with coffee product sales with the Commissions calculated
field now appearing.
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After you insert a calculated field, Excel adds the calculated field to the
PivotTable field list. You can then pretty much work with the calculated item
in the same way that you work with traditional items.

Adding a calculated item

You can also add calculated items to a pivot table. Now, frankly, adding a cal-
culated item usually doesn’t make any sense. If, for your pivot table, you have
retrieved data from a complete, rich Excel list or from some database, creating
data by calculating item amounts is more than a little goofy. However, in the
spirit of fair play and good fun, here I create a scenario where you might need
to do this using the sales of roast coffee products by months.

Assume that your Excel list omits an important product item. Suppose that

you have another roast coffee product called Volcano Blend Decaf. And even
though this product item information doesn’t appear in the source Excel list,
you can calculate this product item’s information by using a simple formula.
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Figure 5-13:
Insert a
calculated
item here.
|

Also assume that sales of the Volcano Blend Decaf product equal exactly

and
you

always 25 percent of the Volcano Blend product. In other words, even if
don’t know or don’t have Volcano Blend Decaf product item information

available in the underlying Excel data list, it doesn’t really matter. If you have

info

rmation about the Volcano Blend product, you can calculate the Volcano

Blend Decaf product item information.

Here are the steps that you take to add a calculated item for Volcano Blend
Decaf to the Roast Coffee Products pivot table shown in earlier figures in this
chapter:

1.

2.

Select the Product button by simply clicking the Row Labels button in
the pivot table.

Tell Excel that you want to add a calculated item to the pivot table.

Click the Analyze ribbon’s Fields, Iltems & Settings command and then
choose Calculated Items from the submenu that appears. Excel displays
the Insert Calculated Item in “Product” dialog box, as shown in Figure 5-13.

In Excel 2007 or Excel 2010, click the PivotTable Tools Options tab’s

Formulas command and then choose Calculated Items from the Formulas
submenu that appears.

Name:

Formula: =0

Flelds:

Month Best Blend of Arabia
[T | |Breakfast Blastoft

State
Sales

Insert Calculated Item in “Product” ? “_

Formulai| v] [ awa |

Delete

Items:

Breakfast Blastoff Decaf
S Kona Koast
Turkish Delight Roast
Volcano Blend

Insert Figld Insert item

oK Close

3.

Name the new calculated item in the Name text box.

In the example that I set up here, the new calculated item name is
Volcano Blend Decaf, so that’'s what you enter in the Name text box.

. Enter the formula for the calculated item in the Formula text box.

Use the Formula text box to give the formula that calculates the item. In
the example here, you can calculate Volcano Blend Decaf sales by multiply-

ing Volcano Blend sales by 25 percent. This formula then is =.25*‘Volcano
Blend'.



Figure 5-14:
The Insert
Calculated
Item dialog

box after
you do your
dirty work.

|
Figure 5-15:
The new
pivot table
with the
inserted
calculated
item.
|
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a. To enter this formula into the Formula text box, first type =.25%.

b. Then select Volcano Blend from the Items list box and click the
Insert Item button.

See Figure 5-14 for how the Insert Calculated Item in “Product” dialog
box looks after you name and supply the calculated item formula.

Insert Calculated Item in “Product” » HEM |
Name:  Volcano Blend Decaf| vl | Add |
Formula: = .25 'Volcano Blend'
Flelds: Items:
Month Best Blend of Arabia
CET I | (Breaitast Bisstoft
State Breakfast Blastoff Decaf
Sales § Kona Koast
Turkish Delight Roast
Volcano Blend
Insert Figld
oK Close
5. Add the calculated item.
After you name and supply the formula for the calculated item, click OK.
Excel adds the calculated item to the pivot table. Figure 5-15 shows the
pivot table of roast coffee product sales by month with the new calculated
item, Volcano Blend Decaf. This isn’t an item that comes directly from the
Excel data list, as you can glean from the preceding discussion. This data
item is calculated based on other data items: in this case, based on the
Volcano Blend data item.
(GG Dutakst of coffem with pivottable custom cdculation - Excel PIDTTARE TOCLS 7 ® 8 x
e BT Y- A &8 EMegeacmn - §-9% 0 9% C :i‘;
811 =02 v
A B D E F H ] K
> Table Fields v*
) SemcfSskes$  Colemn Labels - ot sddtonper: |
4 Row Labels - Jammary Febeuary  Maech Apil May June July Awgust Saptember  Grand Toesl
5 Bast Bend of Araba B [ 1] 7610 229 1306 1350 554 2385 et 18628 Month
6 Brenkiyst Blostofl 127 1.038 7.005 1546 1,066 1084 2117 1182 741 16,857 Product
7 oo B vt W Mo qm ‘s vme i 2ok s
8 Kona Koast G!ﬂ .40 4041 1197 T8 1456 1,062 15712 2m 13898 4 Sies$
9 Turkeh Delight Roast 15 1576 7274 1796 93 1165 w7 23 1.3 790
1o o B Um g vm wdm DB b Goe i nes
1] 432 130 03 368 506 206 261 k2 4616
;‘ A 1640 43554 9,567 e 0125 1873 0539 EALH 100.26¢
e
- ‘. Sheet! | Datsbase 4 0 v : Defer Layoust Update
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Figure 5-16:
Use the
Insert
Calculated
Field dialog
box to
remove
calculated
fields from
the pivot
table.
|

V2019

Removing calculated fields and items

You can easily remove calculated fields and items from the pivot table.

To remove a calculated field, click a cell in the pivot table. Then click the
Analyze tab’s Fields, Items & Sets command and choose Calculated Field from
the submenu that appears. When Excel displays the Insert Calculated Field
dialog box, as shown in Figure 5-16, select the calculated field that you want to
remove from the Name list box. Then click the Delete button. Excel removes
the calculated field.

In Excel 2007 or Excel 2010, click the PivotTable Tools Options tab’s Formulas
command and choose Calculated Field from the Formulas submenu to display
the Insert Calculated Field dialog box shown in Figure 5-16.

Insert Calculated Field ? “

Name: Commissions| v | Modity I
Formula:  =0.25%Sales §' Delete

Flelds:

\Month
Product

State

Sales §

Commissions

Insert Figld

oK Close

To remove a calculated item from a pivot table, perform the following steps:

1. Click the button of the calculated item that you want to remove.

For example, if you want to remove the Volcano Blend Decaf item from
the pivot table shown in Figure 5-15, click the Product button.

2. Click the Analyze tab’s Fields, Items 7 Settings button and then click
Calculated Item from the menu that appears.

The Insert Calculated Item dialog box appears.

In Excel 2007 or Excel 2010, you click the Options tab’s Formulas button
and then choose Calculated Item from the menu in order to display the
Insert Calculated Item dialog box.

3. Select the calculated item from the Name list box that you want to
delete.

4. Click the Delete button.
5. Click OK.
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Figure 5-17 shows the Insert Calculated Item in “Product” dialog box as it
looks after you select the Volcano Blend Decaf item to delete it.

Insert Calculated Item in “Product” ? “
Name:  Valcano Blend Decaf v I Modity I
I
Formula: | = 0.25"Volcano Blend’ Delete
Figure 5-17:
Delete | e ttems:
Month Best Blend of Arabia
unwanted | EEr—— Breaktast Blastoft
. State Breakfast Blastoff Decaf
IteITIS frlJm Sales § Kona Koast
Turkish Delight Roast
the Insert Volcano Blend
Volcano Blend Decat
Calculated
Item d|a|0g Insert Figld Insert ltem
bOX. oK Close
I

Reviewing calculated field and
calculated item formulas

If you click the Analyze tab’s Fields, Iltems & Settings command and choose
List Formulas from the submenu that appears, Excel adds a new sheet to
your workbook. This new sheet, as shown in Figure 5-18, identifies any of the
calculated field and calculated item formulas that you add to the pivot table.

od
Sohva Ovdar___ Fiald Formla

4 Cafculsted bem
5 Sehe Oudar Iem Formwls
[ 1 Vokano Bend Decaf = 025"Vokano Blend

Figure 5-18: |:
The |
Calculated |
Field and
Calculated
Item list of |~
formulas |-
worksheet, |*
I

ated tems or felds.
ns group. dlick Fisdds, ltems. & Sits, and then chck Saky Ordar
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Figure 5-19:
Set solve
order here.
|

In Excel 2007 or Excel 2010, you click the PivotTable Tools Options tab’s Formulas
button and then choose List Formulas from the menu in order to display the new
sheet and its list of calculated fields.

For each calculated field or item, Excel reports on the solve order, the field or
item name, and the actual formula. If you have only a small number of fields or
items, the solve order doesn’t really matter. However, if you have many fields
and items that need to be computed in a specific order, the Solve Order field
becomes relevant. You can pick the order in which fields and items are calcu-
lated. The Field and Item columns of the worksheet give a field or item name.
The Formula column shows the actual formula.

Reviewing and changing solve order

If you click the Analyze tab’s Fields, I[tems & Settings command and choose
Solve Order from the submenu that appears, Excel displays the Calculated
Item Solve Order dialog box, as shown in Figure 5-19. In this dialog box, you
tell Excel in what order the calculated item formulas should be solved.

In Excel 2007 or Excel 2010, you click the PivotTable Tools Options tab’s
Formulas button and then choose Calculated Item from the menu in order to
display the Insert Calculated Item dialog box.

Calculated Item Solve Order  ? IR |

;orve order:
LVelcang Blend Decaf = 0,257 Volcano Blend. _.....e

If the value in a PivotTable cell is affected by two or more calculated
items, the value is determined by the last formula in the solve order.

Close

In many cases, the solve order doesn’t matter. But if, for example, you add
calculated items for October, November, and December to the Kona Koast
coffee product sales pivot table shown earlier in the chapter (refer to
Figure 5-6), the solve order might just matter. For example, if the October
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calculated item formula depends on the previous three months and the same
thing is true for November and December, you need to calculate those item
values in chronological order. Use the Calculated Item Solve Order dialog box
to do this. To use the dialog box, simply click a formula in the Solve Order
list box. Click the Move Up and Move Down buttons to put the formula at the
correct place in line.

Retrieving Data from a Pivot Table

@7@]0

You can build formulas that retrieve data from a pivot table. Like, I don’t
know, say that you want to chart some of the data shown in a pivot table. You
can also retrieve an entire pivot table.

Getting all the values in a pivot table

To retrieve all the information in a pivot table, follow these steps:

1. Select the pivot table by clicking a cell within it.

2. Click the Analyze tab’s Select command and choose Entire PivotTable
from the menu that appears.

Excel selects the entire pivot table range.

In Excel 2007 or Excel 2010, click the PivotTable Tools Options tab’s
Options command, click Select, and choose Entire Table from the Select
submenu that appears.

3. Copy the pivot table.

You can copy the pivot table the same way that you would copy any
other text in Excel. For example, you can click the Home tab’s Copy
button or by pressing Ctrl+C. Excel places a copy of your selection onto
the Clipboard.

4. Select a location for the copied data by clicking there.
5. Paste the pivot table into the new range.

You can paste your pivot table data into the new range in the usual
ways: by clicking the Paste button on the Home tab or by pressing
Ctrl+V. Note, however, that when you paste a pivot table, you get
another pivot table. You don’t actually get data from the pivot table.

123
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Figure 5-20:
Paste
information
from a pivot
table rather
than the
entire pivot
table.
|

If you want to get just the data and not the pivot table — in other words,
you want a range that includes labels and values, not a pivot table with
pivot table buttons — you need to use the Paste Special command. (The
Paste Special command is available from the menu that appears when
you click the down-arrow button beneath the Paste button.) When you
choose the Paste Special command, Excel displays the Paste Special
dialog box, as shown in Figure 5-20. In the Paste section of this dialog box,
select the Values radio button to indicate that you want to paste just a
range of simple labels and values and not a pivot table itself. When you
click OK, Excel pastes only the labels and values from the pivot table and
not the actual pivot table.

- 2
Paste Special ‘ “_

Paste

.':All,: () All using Source theme

() Formulas () Al except borders

O Values () Column widths

O Formats O Formulas and number formats

O Comments O Valyes and number formats

O validation All merging conditional formats
Operation

(®) Ngne (O Multiply

O Add O Divide

O Subtract

[ ] skip blanks [ Transpose

Paste Link OK Cancel

Getting a value from a pivot table

To get a single value from a pivot table using a formula, create a cell reference.
For example, suppose that you want to retrieve the value shown in cell C8 in
the worksheet shown in Figure 5-21. Further suppose that you want to place
this value into cell C15. To do this, click cell C15, type the = sign, click cell C8,
and then press Enter. Figure 5-21 shows how your worksheet looks before you
press Enter. The formula shows.

As you can see in Figure 5-21, when you retrieve information from an Excel
pivot table, the cell reference isn’t a simple cell reference as you might
expect. Excel uses a special function to retrieve data from a pivot table
because Excel knows that you might change the pivot table. Therefore, upon
changing the pivot table, Excel needs more information about the cell value
or data value that you want than simply its previous cell address.
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Figure 5-21:
How the
worksheet
looks after
you tell
Excel you
want to
place the
Kona Koast
sales for
Oregon
value into

cell C15. |

|
Figure 5-22:
The
Function
Arguments
dialog box
forthe
GETPIVOT
DATA
function.
|
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Look a little more closely at the GET pivot table formula shown in Figure 5-21.
The actual formula is

=GETPIVOTDATA ("Sales$",$A$3, "Product", "KonaKoast", "State",
"Oregon")

The easiest way to understand the GETPIVOTDATA function arguments is by
using the Insert Function command. To show you how this works, assume that
you enter a GETPIVOTDATA function formula into cell C15. This is the formula
that Figure 5-21 shows. If you then click cell C15 and choose the Formulas tab’s
Function Wizard command, Excel displays the Function Arguments dialog box,
as shown in Figure 5-22. The Function Arguments dialog box, as you might
already know if you're familiar with Excel functions, enables you to add or
change arguments for a function. In essence, the Function Arguments dialog
box names and describes each of the arguments used in a function.

Function Arguments ? “
GETPIVOTDATA
Data field | iSales' st 55| = tSeless ~
Pivot table |53 | - sumorsales 8
Fleid] | “Broduct” [ - -Proouer
tem1 | Kona Koast 5| = “KonaKoast
Field2 |“state | = state v
- 3941410819
Extracts data stored in & PvotTable.
Data_feld: Isthe name of the data field to extract data from.
Formula result = 394
Help on this function oK Cancel
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Arguments of the GETPIVOTDATA function

Here I quickly go through and describe each of the GETPIVOTDATA function
arguments. The bulleted list that follows names and describes each argument:

v data_field: The data field argument names the data field that you
want to grab information from. The data_ field name in Figure 5-22 is
Sales s. This simply names the item that you drop into the Values area
of the pivot table.

¥ pivot table: The pivot table argument identifies the pivot table.
All you need to do here is to provide a cell reference that’s part of the
pivot table. In the GETPIVOTDATA function that I use in Figure 5-21, for
example, the pivot table argument is $A$3. Because cell A3 is at the
top-left corner of the pivot table, this is all the identification that the
function needs in order to identify the correct pivot table.

v fieldl and iteml: The fieldl and iteml arguments work together
to identify which product information that you want the GETPIVOTDATA
function to retrieve. Cell C8 holds Kona Koast sales information.
Therefore, the £ieldl argument is product, and the iteml argument
is Kona Koast. Together, these two arguments tell Excel to retrieve the
Kona Koast product sales information from the pivot table.

v field2 and item2: The field2 and item2 arguments tell Excel to
retrieve just Oregon state sales of the Kona Koast product from the pivot
table. field2 shows the argument state. item2, which isn’t visible in
Figure 5-22, shows as Oregon.



Chapter 6
Working with PivotCharts

In This Chapter
Why in the world would you use a pivot chart?
Running the PivotChart Wizard
Fooling around with your pivot chart
Customizing how pivot charts work and look

A\\J

’ n Chapter 4, I discuss how cool it is that Excel easily cross-tabulates data
in pivot tables. In this chapter, I cover a closely related topic: how to
cross-tabulate data in pivot charts.

You might notice some suspiciously similar material in this chapter com-
pared with Chapter 4. But that’s all right. The steps for creating a pivot chart
closely resemble those that you take to create a pivot table.

If you've just read the preceding paragraphs and find yourself thinking,
“Hmmm. Cross<abulate is a familiar-sounding word, but I can’t quite put my
finger on what it means,” you might want to first peruse Chapter 4. Let me also
say that, as is the case when constructing pivot tables, you build pivot charts
by using data stored in an Excel table. Therefore, you should also know what
Excel tables are and how they work and should look. I discuss this information
a little bit in Chapter 4 and a bunch in Chapter 1.

Why Use a Pivot Chart?

Before I get into the nitty-gritty details of creating a pivot chart, stop and ask
areasonable question: When would you or should you use a pivot chart? Well,

the correct answer to this question is, “Heck, most of the time you won’t use
a pivot chart. You'll use a pivot table instead.”

Pivot charts, in fact, work only in certain situations: Specifically, pivot charts
work when you have only a limited number of rows in your cross-tabulation.
Say, less than half a dozen rows. And pivot charts work when it makes sense
to show information visually, such as in a bar chart.
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You can chart a pivot table, too. | mean, if you the Paste Special command to just grab values.
just wantto use pivot table data in aregularold  Then chart the data by clicking the Insert tab’s
chart, you can do so. Here's how. First, copy charting commands.

the pivot table data to a separate range, using

How about just charting pivot table data?

These two factors mean that for many cross-tabulations, you won’t use pivot
charts. In some cases, for example, a pivot chart won’t be legible because the
underlying cross-tabulation will have too many rows. In other cases, a pivot
chart won’t make sense because its information doesn’t become more under-
standable when presented visually.

Getting Ready to Pivot

Figure 6-1:

A simple
Excel data
table that

shows sales |:

for your
imaginary
coffee
business.

As with a pivot table, in order to create a pivot chart, your first step is to
create the Excel table that you want to cross-tabulate. You don’t have to

put the information into a table, but working with information that’s already
stored in a table is easiest, so that’s the approach that [ assume you'll use.

Figure 6-1 shows an example data table — this time, a list of specialty coffee
roasts that you can pretend sell to upscale, independent coffeehouses along
the West Coast.

1 [Worti Product State Saks §
2 [Januar  Velcaro Blang Cafumia 50
J Januory  Turkisk Defight Roset  Calfamia $531
4 Jmnuary  Turkisk Dabght Roast $365
5 [Januar  Breabfast Blastof 591
6 January  Best Blend of Asbs  Calfamin $69
7 Januar  Kona Koast Catima 575
3 January  Best Blnd of Arabia su3
9 January  Breakfast Blastof Decaf Oregon $169
10|Fobnuay  Breabast Blastof Ogcal Wiadhington 5235
11 Febumy  Breabast Blastof  Wasngon S
12 |Febnaxry  Turisk Debight Roset  Calfamia a5
13| Fesnuay Kot Cafumia 44
14|Febnary  Best Blend of Aabis  Califam; $65
13 |Fesruay  Voicaro Biend Canma 5307
15 |Febnuay  Breakfast Blastof Decal Cragen a4
17|Febnary  Breakfact Blastof 21
13|Febnay  Tukish Dabght Roast  Ovagen 5423
19 |Fednay  Kena Oragen 5184
2 |Februry  Best Blend of Asba  Oregon $3%5
21| Fasuay i Ovagen 53
22 |Febnexy  Breakfast Blastof Decof Winsington 361
2)|Ferury  Breakfast Blastof Vishingon  $542
24|Febouay  Turkiah Dabght Roast  Washington  Sa78
25 |Febmury  Kona Koost Wasingon

2 |Fobuay  Bost Bland o Aok Wiasngon 5205
21 |Fesnuay  Velcaro Bland Wihngon 5123
7 March  Breakfaet Blastof Decf Calfamia $910
|March  BreaMastBlstof  Calfima e
5 |Masch  Tukia Dubghn Ruast  Cadtamia s

Ostabase
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The roast coffee list workbook is available in the example Excel workbooks
related to this book that you can find on this book’s companion website. You
might want to download this list in order to follow along with the discussion
here. See this book’s Introduction for more on how to access the companion site.

Running the PivotTable Wizard

W20z

11207,

|

Figure 6-2:
Create pivot
tables here.
]

Because you typically create a pivot chart by starting with the Create PivotChart
Wizard, I describe that approach first. At the very end of the chapter, however, |
describe briefly another method for creating a pivot chart: using the Insert Chart
command on an existing pivot table.

In Excel 2007 and Excel 2010, you use the PivotTable and PivotChart Wizard to
create a pivot chart, but despite the seemingly different name, that wizard is
the same as the Create PivotChart Wizard.

To run the Create PivotChart Wizard, take the following steps:

1. Select the Excel table.

To do this, just click a cell in the table. After you've done this, Excel
assumes you want to work with the entire table.

2. Tell Excel that you want to create a pivot chart by choosing the Insert
tab’s PivotChart button.

In Excel 2007 and Excel 2010, to get to the menu with the PivotChart
command, you need to click the down-arrow button that appears
beneath the PivotTable button. Excel then displays a menu with two
commands: PivotTable and PivotChart.

No matter how you choose the PivotChart command, when you choose
the command, Excel displays the Create PivotChart dialog box, as shown
in Figure 6-2.

Create PivotChart 7 HEM |

Choose the data that you want to analyze
(®) Select a table or range

Table/Range:  DatabaselSAS1:5D5225 1
O Use an external data source

Connection name
Choose where you want the PivotChart to be placed
(® New Worksheet
() Existing Worksheet
Location: 29

Choose whether you want to analyze multiple tables

["] Add this data to the Data Model
oK Cancel

4
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|
Figure 6-3:
Enter a pivot
table range
here.
|

3. Answer the question about where the data that you want to analyze

is stored.

[ recommend you store the to-be-analyzed data in an Excel Table/Range.
If you do so, click the Select a Table or Range radio button.

. Tell Excel in what worksheet range the to-be-analyzed data is stored.

If you followed Step 1, Excel should already have filled in the Range text

box with the worksheet range that holds the to-be-analyzed data, but you
should verify that the worksheet range shown in the Table/Range text box is
correct. Note that if you're working with the sample Excel workbook shown
in Figure 6-1, Excel actually fills in the Table/Range box with Database!
$AS$1:8D$225 because Excel can tell this worksheet range is a list.

If you skipped Step 1, enter the list range into the Table/Range text box.
You can do so in two ways. You can type the range coordinates. For
example, if the range is cell Al to cell D225, you can type $A$1:8D$225.
Alternatively, you can click the button at the right end of the Range

text box. Excel collapses the Create PivotChart dialog box, as shown in
Figure 6-3. Now use the mouse or the navigation keys to select the work-
sheet range that holds the list you want to pivot.

After you select the worksheet range, click the range button again. Excel
redisplays the Create PivotChart dialog box. (Refer to Figure 6-2.)

Create PivotChart

Database!SAS1:5D5225 =]

5. Tell Excel where to place the new pivot table report that goes along

with your pivot chart.

Select either the New Worksheet or Existing Worksheet radio button to
select a location for the new pivot table that supplies the data to your
pivot chart. Most often, you want to place the new pivot table onto a
new worksheet in the existing workbook — the workbook that holds
the Excel table that you’re analyzing with a pivot chart. However, if you
want, you can place the new pivot table into an existing worksheet. If
you do this, you need to select the Existing Worksheet radio button and
also make an entry in the Existing Worksheet text box to identify the
worksheet range. To identify the worksheet range here, enter the cell
name in the top-left corner of the worksheet range.

You don'’t tell Excel where to place the new pivot chart, by the way.
Excel inserts a new chart sheet in the workbook that you use for the
pivot table and uses that new chart sheet for the pivot table.
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6. When you finish with the Create PivotChart dialog box, click OK.

Excel displays the new worksheet with the partially constructed pivot
chart in it, as shown in Figure 6-4.
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7. Select the data series.

You need to decide first what you want to plot in the chart — or what
data series should show in a chart.

P If you haven’t worked with Excel charting tools before, determining what
the right data series are seems confusing at first. But this is another one
of those situations where somebody’s taken a ten-cent idea and labeled
it with a five-dollar word. Charts show data series. And a chart legend
names the dafa series that a chart shows. For example, if you want to
plot sales of coffee products, those coffee products are your data series.

After you identify your data series — suppose that you decide to plot
coffee products — you drag the field from the PivotTable Field List box
to the Legend Field (Series) box. To use coffee products as your data
series, for example, drag the Product field to the Legend Field (Series)
box. Using the example data from Figure 6-1, after you do this, the par-
tially constructed, rather empty-looking Excel pivot chart looks like the
one shown in Figure 6-5.

<P People with sharper vision than I possess may notice that sitting behind
the empty pivot chart in Figure 6-5 is something that looks like a half-
baked pivot table. If you're one of these sharp-eyed readers, good job. If
like me you're a reader who can hardly make out this new unasked-for
addition to your workbook, don’t worry. Just know that Excel builds a
pivot table to supply data to the pivot chart.
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8. Select the data category.

Your second step in creating a pivot chart is to select the data category.
The data category organizes the values in a data series. That sounds
complicated, but in many charts, identifying the data category is easy. In
any chart (including a pivot chart) that shows how some value changes
over time, the data category is ime. In the case of this example pivot
chart, to show how coffee product sales change over time, the data cat-
egory is fime. Or, more precisely, the data category uses the Month field.

After you make this choice, you drag the data category field item from the
PivotTable Field list to the box marked Axis Fields. Figure 6-6 shows the
way that the partially constructed pivot chart looks after you specify the
data category as Months.

9. Select the data item that you want to chart.

After you choose the data series and data category for your pivot chart,
you indicate what piece of data that you want plotted in your pivot
chart. For example, to plot sales revenue, drag the Sales $ item from the
PivotTable Field List to the box labeled X Values.

Figure 6-7 shows the pivot table after the Data Series (Step 7), Data
Category (Step 8), and Data (Step 9) items have been selected. This is a
completed pivot chart. Note that it cross-tabulates information from the
Excel list shown in Figure 6-1. Each bar in the pivot chart shows sales
for a month. Each bar is made up of colored segments that represent
the sales contribution made by each coffee product. Obviously, you
can’t see the colors in a black-and-white image like the one shown in
Figure 6-7. But on your computer monitor, you can see the colored seg-
ments and the bars that they make.
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Fooling Around with Your Pivot Chart

After you construct your pivot chart, you can further analyze your data. Here
[ briefly describe some of the cool tools that Excel provides for manipulating

information in a pivot chart.
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Pivoting and re-pivoting

The thing that gives the pivot tables and pivot charts their names is that
you can continue cross-tabulating, or pivoting, the data. For example, you
could take the data shown in Figure 6-7 and by swapping the data series and
data categories — you do this merely by dragging the State and Product
buttons — you can flip-flop the organization of the pivot chart.

One might also choose to pivot new data. For example, the chart in Figure 6-8
shows the same information as Figure 6-7. The difference is that the new pivot
chart uses the State field rather than the Month field as the data category.
The new pivot chart continues to use the Product field as the data series.

Filtering pivot chart data

You can also segregate data by putting information on different charts. For
example, if you drag the Month data item to the Report Filter box (in the
bottom half of the PivotTable Field List), Excel adds a Month button to the
worksheet (in Figure 6-9, this button appears in cells Al and B1). This button,
which is part of the pivot table behind your pivot chart, lets you view sales
information for all the months, as shown in Figure 6-9, or just one of the
months. This box is by default set to display all the months (All), so the chart
in Figure 6-9 looks just like Figure 6-8. Things really start to happen, however,
when you want to look at just one month’s data.
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To show sales for only a single month, click the down-arrow button to the
right of the Month drop-down list. When Excel displays the drop-down list,
select the month that you want to see sales for and then click OK. Figure 6-10
shows sales for just the month of January. This is a little hard to see in
Figure 6-10, but try to see the words Month and January in cells Al and Bl.
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To remove an item from the pivot chart, simply drag the item’s button back to
the PivotTable Field list.

You can also filter data based on the data series or the data category. In the
case of the pivot chart shown in Figure 6-10, you can indicate that you want
to see only a particular data series information by clicking the arrow button
to the right of the Column Labels drop-down list. When Excel displays the
drop-down list of coffee products, select the coffee that you want to see sales
for. You can use the Row Labels drop-down list in a similar fashion to see
sales for only a particular state.

Let me mention one other tidbit about pivoting and re-pivoting. If you've
worked with pivot tables, you might remember that you can cross-tabulate
by more than one row or column items. You can do something very similar
with pivot charts. You can become more detailed in your data series or
data categories by dragging another field item to the Legend Fields or Axis
Fields box.

Figure 6-11 shows how the pivot table looks if you use State to add granular-
ity to the Product data series.
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Sometimes lots of granularity in a cross-tabulation makes sense. But having
multiple row items and multiple column items in a pivot table makes more
sense than adding lots of granularity to pivot charts by creating superfine data
series or data categories. Too much granularity in a pivot chart turns your
chart into an impossible-to-understand visual mess, a bit like the disaster that
I show in Figure 6-11.

Refreshing pivot chart data

As the data in an Excel table changes, you need to update the pivot chart.
You have two methods for telling Excel to refresh your chart:

+ You can click the Refresh command on the PivotTable Tools Options
tab. (See Figure 6-12.)

+ You can choose the Refresh Data command from the shortcut menu
that Excel displays when you right-click a pivot chart.

Point to an Excel ribbon button, and Excel displays pop-up ScreenTips that
give the command button name.

Click to refresh your chart
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Grouping and ungrouping data items

You can group together and ungroup values plotted in a pivot chart. For exam-
ple, suppose that you want to take the pivot chart shown in Figure 6-13 — which
is very granular — and hide some of the detail. You might want to combine the
detailed information shown for Breakfast Blend and Breakfast Blend Decaf and
show just the total sales for these two related products. To do this, select a Row
Labels cell or the Column Labels cell that you want to group, right-click your
selection, and choose Group from the shortcut menu. Next, right-click the new
group and choose Collapse from the shortcut menu.
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After you group and collapse, Excel shows just the group totals in the Pivot
chart (and in the supporting pivot table). As shown in Figure 6-14, the com-
bined Breakfast Blast sales are labeled as Groupl.

To show previously collapsed detail, right-click the Row Labels or Column
Labels cell that shows the collapsed grouping. Then choose Expand/
Collapse=>Expand from the menu that appears.

To show previously grouped detail, right-click the Row Labels or Column
Labels cell that shows the grouping. Then choose Ungroup from the menu
that appears.
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Using Chart Commands to
Create Pivot Charts

You can also use Excel’s standard charting commands to create charts of
pivot table data. You might choose to use the Charts toolbar on the Insert tab

when you've already created a pivot table and now want to use that data in a
chart.

To create a regular old chart using pivot table data, follow these steps:

1. Create a pivot table.

For help on how to do this, refer to Chapter 4 for the blow-by-blow
account.

2. Select the worksheet range in the pivot table that you want to chart.

3. Tell Excel to create a pivot chart by choosing the appropriate charting
command from the Insert tab.

The Chart Wizard creates a pivot chart that matches your pivot table.
Figure 6-15, for example, shows a column chart created from the Excel
worksheet that summarizes sales from your imaginary coffee business.
[ created a pivot table for the data and then told Excel to put the pivot
table’s data into a column chart.

139
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Figure 6-15:
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For normal charting, by the way, you set up a worksheet with the data that
you want to plot in a chart. Then you select the data and tell Excel to plot the
data in a chart by choosing one of the Insert tab’s chart commands.

By the way, in this chapter, I don’t describe how to customize the actual pivot
chart... butIdidn’t forget that topic. Pivot chart customization as a subject
is so big that it gets its own chapter: Chapter 7.



Chapter 7
Customizing PivotCharts

In This Chapter
Selecting chart types and options
Changing a chart’s location
Formatting the plot and chart area
Formatting 3-D charts

A Ithough you usually get pretty good-looking pivot charts by using the
wizard, you'll sometimes want to customize the charts that Excel cre-

ates. Sometimes you’ll decide that you want a different type of chart . . . per-
haps to better communicate the chart’s message. And sometimes you want
to change the colors so that they match the personality of the presentation
or the presenter. In this chapter, I describe how to make these and other
changes to your pivot charts.

Selecting a Chart Type

The first step in customizing a pivot chart is to choose the chart type that
you want. When the active sheet in an Excel workbook shows a chart or when
a chart object in the active sheet is selected, Excel adds the Design tab to the
Ribbon to allow you to customize the chart. The second command from the
right on the Design tab is Change Chart Type. If you click the Change Chart
Type command button, Excel displays the Change Chart Type dialog box, as
shown in Figure 7-1.

In Excel 2007 and Excel 2010, you use the Design and Layout tabs to fiddle
around with your charts, so the location of the command buttons you click
appear in different places. The Change Chart Type command button, for
example, appears as the leftmost command on the Design tab.
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The Change Chart Type dialog box has two lists from which you pick the type
of chart that you want. The left chart type list identifies each of the 11 chart
types that Excel plots. You can choose chart types such as Column, Line, Pie,
Bar, and so on. For each chart type, Excel also displays several subtypes;
pictographs of these subtypes display on the right side of the Change Chart
Type dialog box. You can think of a chart subtype as a flavor or model or
mutation. You choose a chart type and chart subtype by selecting a chart
from the chart type list and then clicking one of the chart subtype buttons.

In the area beneath the chart subtypes, Excel displays a picture of how the
selected chart and subtype look.

Working with Chart Styles

w207,

Excel provides several dozen chart styles on the Design tab. As with chart
layouts, you select a chart style by clicking its button. Also as with chart
styles, the Design tab provides space for only a subset of the available chart
style buttons to be displayed at a time. You need to scroll down to see the
other chart style options.

Excel 2007 and 2010 also provides several chart layouts on the Design tab
of the Ribbon. You choose a chart layout by clicking its button. Do note that
although the Design tab provides space for a limited chart layout buttons

to be displayed at a time, you can scroll down and see other chart layout
options, too.
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Changing Chart Layout

Excel provides a nifty set of commands you can use to customize just about
any element of your pivot chart, including titles, legends, data labels, data
tables, axes, and gridlines.

Chart and ayis titles

The Chart Title and Axis Titles commands, which appear when you click the
Design tab’s Add Chart Elements command button, let you add a title to your
chart titles to the vertical, horizontal, and depth axes of your chart.

W01,

y In Excel 2007 and Excel 2010, you use the Chart Title and Axis Titles com-

mands on the Layout tab to add chart and axis titles.

After you choose the Chart Title or Axis Title command, Excel displays a
submenu of commands you use to select the title location. After you choose
one of these location-related commands, Excel adds a placeholder box to the
chart. Figure 7-2, for example, shows the placeholder added for a chart title.
To replace the placeholder title text, click the placeholder and type the title
you want.

If you click the chart title once you've replaced the placeholder, Excel opens
a Format Chart Title pane along the right edge of the Excel program window
(see Figure 7-3). This pane provides buttons you can use to control the
appearance of the title and the box the title sits in.
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The Format Chart Title pane, for example, provides a set of Fill options that
let you fill in the chart title box with color or a pattern. (If you do select a fill
color or pattern, Excel adds buttons and boxes to the set of Fill options so
you can specify what the color or pattern should be.)

The Format Chart Title pane also provides buttons and boxes for you to
specify how you want any lines drawn or fill for the title or its box to look in
terms of thickness, color, and style. The pane provides buttons and boxes for
specifying any special effects, including shadowing, glow, edge softening, and
the illusion of three-dimensionality. And the pane provides buttons and boxes
for controlling the sizing and setting other properties of the title.

You click the little icons at the top of a pane to flip between the different set-
tings a pane supplies. In the case of the Format Chart Title pane, for example,
you click the icons that look like a paint can, a pentagon and a box with
measurement marks to access the Fill & Line, the Effects and then the Size &
Properties settings. Different Excel formatting panes provide different sets of
formatting options. So go ahead and experiment with your options here to get
comfortable with the options you have for your pivot charts.

In Excel 2007 and Excel 2010, you use the Format Chart Title dialog box rather
than the Format Chart Title pane to customize the appearance of the chart
title. To display the Format Chart Title dialog box, click the Layout tab’s Chart
Title command button and then choose the More Title Options command from
the menu Excel displays.
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Figure 7-&: |
The Format |-
Legend |2
pane. |*

Chart legend

Use the Add Chart Element=>Legend command on the Design tab to add or
remove a legend to a pivot chart. When you click this command button, Excel
displays a menu of commands with each command corresponding to a loca-
tion in which the chart legend can be placed. A chart legend simply identifies
the data series plotted in your chart.

You can also choose the More Legend Options command, which is the last
command on the Legend menu, to display the Format Legend pane. (See
Figure 7-4.) The Format Legend dialog box allows you to select a location for
the legend and also to specify how Excel should draw the legend.
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In Excel 2007 or Excel 2010, you use the Legend command on the Layout tab to
add or remove a legend to a pivot chart and to customize a legend. Note that
in Excel 2007 or Excel 2010, the More Legend Options command displays a
format Legend dialog box rather than a Format Legend pane.

Chart data labels

The Data Labels command on the Design tab’s Add Chart Element menu
allows you to label data markers with values from your pivot table. When
you click the command button, Excel displays a menu with commands

145
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Figure 7-5: |-
A chartwith |2
data labels. |-

corresponding to locations for the data labels: None, Center, Left, Right,
Above, and Below. None signifies that no data labels should be added to the
chart and Show signifies heck yes, add data labels. The menu also displays a
More Data Label Options command. To add data labels, just select the com-
mand that corresponds to the location you want. To remove the labels, select
the None command. Figure 7-5 shows a chart with data labels.
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If you want to specify what Excel should use for the data label, choose the
More Data Labels Options command from the Data Labels menu. Excel dis-
plays the Format Data Labels pane (see Figure 7-6). Check the box that cor-
responds to the bit of pivot table or Excel table information that you want to
use as the label. For example, if you want to label data markers with a pivot
table chart using data series names, select the Series Name check box. If you
want to label data markers with a category name, select the Category Name
check box. To label the data markers with the underlying value, select the
Value check box.

In Excel 2007 and Excel 2010, the Data Labels command appears on the Layout
tab. Also, the More Data Labels Options command displays a dialog box rather
than a pane.

Different chart types supply different data label options. Your best bet, there-
fore, is to experiment with data labels by selecting and deselecting the check
bozxes in the Label Contains area of the Data Labels tab.
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The Label Options tab also provides a Separator drop-down list box, from
which you can select the character or symbol (a space, comma, colon, and so
on) that you want Excel to use to separate data labeling information.

Selecting the Legend Key check box tells Excel to display a small legend key
next to data markers to visually connect the data marker to the legend. This
sounds complicated, but it’s not. Just select the check box to see what it
does. (You have to select one of the Label Contains check boxes before this
check box is active.)

Chart data tables

A data table just shows the plotted values in a table and adds the table to the
chart. A data table might make sense for non-pivot charts, but not for pivot
charts. (A data table duplicates the pivot table data that Excel creates as an
intermediate step in creating the pivot chart.) Nevertheless, just because

[ have an obsessive-compulsive personality, I'll explain what the Data Table
tab does.

When you choose the Data Table command from the Add Chart Element
menu, Excel displays a menu of commands: None, Show Data Table, Show
Data Table With Legend Keys, and More Data Table Options. To add a data
table to your chart, select the Show Data Table or the Show Data Table with
Legend Keys command. Figure 7-7 shows you what a data table looks like.
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After you add a data table, Excel opens the Format Data Table pane to the
window (see Figure 7-8). You can use its buttons to add horizontal and verti-
cal lines and a border to the data table. And the pane also includes a check
box you can use to use add and remove a legend.
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Chart axes

The Axes command on the Add Chart Element menu provides access to a sub-
menu of that let you add, remove, and control the scaling of the horizontal and
vertical axes for your chart simply by choosing the command that corresponds
to the axis placement and scaling you want. The Primary Horizontal and
Primary Vertical commands on the Axes submenu work like toggle switches,
alternatively adding and then removing an axis from your chart.

You can also choose the More Axis Options command to display the Format
Axis pane (see Figure 7-9).
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The best way to find out what the Format Axis pane’s radio buttons do is to
just experiment with them. In some cases, selecting the different axis radio
button has no effect. For example, you can’t select the Date Axis option under
Axes Type unless your chart shows time series data — and Excel realizes it.

1/207,
2= If you're working with Excel 2007 or Excel 2010, you use the Axes command
on the Layout tab (which displays the Format Axis dialog box) to change the
appearance of the chart axes.
P You can select the Format Axis pane’s Categories in Reverse Order check

box to tell Excel to flip the chart upside down and plot the minimum value at
the top of the scale and the maximum value at the bottom of the scale. If this
description sounds confusing — and I guess it is — just try this reverse order
business with a real chart. You'll instantly see what I mean.
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Chart gridlines

The Gridlines command on the Add Chart Element menu displays a submenu
of commands that enables you to add and remove horizontal and vertical
gridlines to your chart. To add or remove gridlines to either axis, simply
select the appropriate command from the Primary Horizontal Gridlines or
Primary Vertical Gridlines menu. Note, too, that the More Gridlines Options
command, the last one listed on the Gridlines menu, displays the Format
Major Gridlines pane (see Figure 7-10). Use this pane’s boxes and buttons to
customize the appearance of the gridlines.
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In Excel 2007 and Excel 2010, the Gridlines command on the Layout tab dis-
plays the menu of commands that enables you to add and remove horizontal
and vertical gridlines to your chart.

Changing a Chart’s Location

When you choose the Design tab’s Move Chart Location command, Excel dis-
plays the Move Chart dialog box, as shown in Figure 7-11. From here, you tell
Excel where it should move a chart. In the case of a pivot chart, this means
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]
Figure 7-11:
Move a
pivot chart
from here.
|

|
Figure 7-12:
Give a chart
its own
sheet.

that you're telling Excel to move the pivot chart to some new chart sheet or
to a worksheet. When you move a pivot chart to a worksheet, the pivot chart
becomes a chart object in the worksheet.

Move Chart 7 HEM |

Choose where you want the chart to be placed:

jth O New gneet: | cnamt
(dLf] @® Objectin: EIEEN E]

oK Concel |

To tell Excel to place the pivot table on to a new sheet, select the New Sheet
radio button. Then name the new sheet that Excel should create by entering
some clever sheet name in the New Sheet text box.

To tell Excel to add the pivot chart to some existing chart sheet or worksheet
as an object, select the Object In radio button. Then select the name of the
chart sheet or worksheet from the Object In drop-down list box.

Check out Figure 7-12 to see how a pivot chart looks when it appears on its
own sheet.
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Formatting the Plot Area

Figure 7-13:
Add fill
colors for

a plotarea
here.

If you right-click a pivot chart’s plot area — the area that shows the plotted

data — Excel displays a shortcut menu. Choose the last command on this menu,
Format Plot Area, and Excel displays the Format Plot Area pane, as shown in
Figure 7-13. This dialog box provides several collections of buttons and boxes
you can use to specify the line background fill color and pattern, the line and line
style, any shadowing, and any third-dimension visual effect for the chart.
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For example, to add a background fill to the plot area, select Fill from the list
box on the left side of the Format Plot Area pane. Then make your choices
from the radio buttons and drop-down lists available.

I could spend pages describing in painful and tedious detail the buttons

and boxes that these formatting choices provide, but I have a better idea. If
you're really interested in fiddling with the pivot chart plot area fill effects,
just noodle around. You'll easily be able to see what effect your changes and
customizations have.

Formatting the Chart Area

If you right-click a chart sheet or object outside of the plot area and then
choose the Format Chart Area command from the shortcuts menu, Excel dis-
plays the Format Chart Area pane (see Figure 7-14). From here, you can set
chart area fill patterns, line specifications and styles, shadowing effects, and
3-D effects for your charts.
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Chart fill patterns

The Fill options of the Format Chart Area pane look and work like the Fill
options of the Format Plot area pane. (Refer to Figure 7-13.) To choose a fill
pattern, select the Solid Fill, Gradient Fill, or Picture or Texture Fill options.
Use the Color drop-down list to select the fill color and the Transparency
slider button or spin box to select the color transparency.

Note: Different fill pattern options have different buttons and boxes.

Chart area fonts

To format chart text, right-click the text. When you do, Excel displays the
formatting menu — which means you have access to its buttons and boxes
for changing the font, adding boldfacing and italics, resizing the font, coloring
the font, and so forth.

If you have questions about which formatting buttons and boxes do what,
don’t worry. As you make your changes, Excel updates the chart text.
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Formatting 3-D Charts

W207,

A\

If you choose to create a three-dimensional (3-D) pivot chart, you should
know about a couple of commands that apply specifically to this case: the
Format Walls command and the 3-D View command.

Formatting the walls of a 3-D chart

After you create a 3-D pivot chart, you can format its walls if you want. Just
right-click the wall of the chart and choose the Format Walls command from
the shortcut menu that appears. Excel then displays the Format Walls pane.
The Format Walls pane provides the expected fill, line, line style, and shadow
formatting options as well as a couple of formatting options related to the
third dimension of the chart: 3-D Format and 3-D Rotation.

In Excel 2007 or Excel 2010, when you choose the Format Walls command,
Excel displays a dialog box and not a pane. The dialog box works just like the
pane, however.

The walls of the 3-D chart are its sides and backs — the sides of the 3-D cube,
in other words.

Use the 3-D Format options to specify the beveling, illusion of depth, contour-
ing, and surface of the 3-D chart. Use the 3-D Rotation options to specify how
you want to rotate, or turn, the chart to show off its three-dimensionality to
maximum effect. Note that the 3-D Rotation options also include buttons you
can click to incrementally rotate the chart.

Using the 3-D Uiew command

After you create a 3-D pivot chart, you can also change the appearance of its
3-D view. Just right-click the chart and choose the 3-D View command from
the shortcut menu that appears. Excel then displays the Format Chart Area
dialog box (as shown earlier in Figure 7-14 and which I discussed earlier).
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In this part . . .

Use database statistical functions to analyze selected information
in atable or list

Tap into the power of Excel’s more than 70 statistical functions
to calculate averages, determine ranking and percentiles,
measure dispersions, and analyze distributions.

Gain extra insights into your data by using the Data Analysis
add-on tool for creating histograms, calculating moving averages,
using exponential smoothing, and performing smart sampling.

Use the regression and correlation tools, the ANOVA data anal-
ysis tool, and the z-test, t-test, and Fourier data analysis tools
to perform inferential statistics analysis.




Chapter 8

Using the Database Functions

In This Chapter
Reviewing function basics
Using the DAVERAGE function
Using the DCOUNT and DCOUNTA functions
Using the DGET function
Using the DMAX and DMIN functions
Using the DPRODUCT function
Using the DSTDEV and DSTDEVP functions
Using the DSUM function
Using the DVAR and DVARP functions

3

E(cel provides a special set of functions, called database functions, espe-
cially for simple statistical analysis of information that you store in Excel
tables. In this chapter, I describe and illustrate these functions.

Are you interested in statistical analysis of information that’s not stored in an
Excel table? Then you can use this chapter as a resource for descriptions of
functions that you use for analysis when your information isn’t in an Excel table.

Note: Excel also provides a rich set of statistical functions, which are also
wonderful tools for analyzing information in an Excel table. Skip to Chapter 9
for details on these statistical functions.

Ouickly Reviewing Functions

The Excel database functions work like other Excel functions. In a nutshell,
when you want to use a function, you create a formula that includes the
function. Because I don’t discuss functions in detail anywhere else in this
book — and because you need to be relatively proficient with the basics of
using functions in order to employ them in any data analysis — I review some
basics here, including function syntax and entering functions.
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Understanding function syntax rules

Most functions need arguments, or inputs. In particular, all database functions
need arguments. You include these arguments inside parentheses. If a func-
tion needs more than one argument, you can separate arguments by using
commas.

For illustration purposes, here are a couple of example formulas that use
simple functions. These aren’t database functions, by the way. I get to those
in later sections of this chapter. Read through these examples to become
proficient with the everyday functions. (Or just breeze through these as a
refresher.)

You use the SUM function to sum, or add up, the values that you include as
the function arguments. In the following example, these arguments are 2, 2,
the value in cell Al, and the values stored in the worksheet range B3:G5.

=SUM(2,2,A1,B3:G5)

Here’s another example. The following AVERAGE function calculates the aver-
age, or arithmetic mean, of the values stored in the worksheet range B2:B100.

=AVERAGE (B2 :B100)

Simply, that’s what functions do. They take your inputs and perform some
calculation, such as a simple sum or a slightly more complicated average.

Entering a function manually

How you enter a function-based formula into a cell depends on whether
you're familiar with how the function works — at least roughly.

If you're familiar with how a function works — or at the very least, you know
its name — you can simply type an equals sign followed by the function name
into the cell. SUM and AVERAGE are good examples of easy-to-remember
function names. When you type that first parenthesis [(] after entering the
full function name, Excel displays a pop-up ScreenTip that names the func-
tion arguments and shows their correct order. (Refer to the previous section,
“Understanding function syntax rules,” if you need to brush up on some
mechanics.) In Figure 8-1, for example, you can see how this looks in the case
of the loan payment function, which is named PMT.
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If you point to the function name in the ScreenTip, Excel turns the function
name into a hyperlink. Click the hyperlink to open the Excel Help file and see
its description and discussion of the function.

Entering a function with the
Function command

If you're not familiar with how a function works — maybe you're not even
sure what function that you want to use — you need to use the Formulas
tab’s Insert Function command to find the function and then correctly iden-
tify the arguments.

To use the Function Wizard command in this manner, follow these steps:
1. Position the cell selector at the cell into which you want to place the

function formula.

You do this in the usual way. For example, you can click the cell. Or you
can use the navigation keys, such as the arrow keys, to move the cell
selector to the cell.

2. Choose the Formulas tab’s Function Wizard command.

Excel displays the Insert Function dialog box, as shown in Figure 8-2.
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Insert Function

Search for a function:

Or select a category: Most Recently Used
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3. In the Search for a Function text box, type a brief description of what

For example, if you want to calculate a standard deviation for a sample,

In the Select a Function list box, Excel displays a list of the functions that

Note: The STDEVPA function in Figure 8-3 isn’t a database function, so
[ don’t describe it in this chapter. Read through Chapter 9 for more on

SUM
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| MAX v
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here. | Help on this function oK Cancel
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you want to calculate by using a function.
type something like standard deviation.
4. Click the Go button.
might just work for you, as shown in Figure 8-3.
this function.
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Select a function:
[STDEVA ~
— STDEVP
STDEV
Figure8-3: | oo
soeveA_ |
LetExcel | ot v
helpyou | smevpAaiuetvalve>...)
Calculates standard deviation based on an entire population, induding
narrow logical values and text. Text and the logical value FALSE have the value 0; the
dUWI'l the logical value TRUE has the value 1.
function
choices. | Helo on this fundion oK Cancel
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5. Find the right function.

To find the right function for your purposes, first select a function in
the Select a Function list. Then read the full description of the func-
tion, which appears beneath the function list. If the function you select
isn’t the one you want, select another function and read its description.
Repeat this process until you find the right function.

« If you get to the end of the list of functions and still haven’t found what

you want, consider repeating Step 3, but this time use a different (and
hopefully better) description of the calculation you want to make.

6. After you find the function you want, select it and then click OK.

Excel displays the Function Arguments dialog box, as shown in
Figure 8-4.

Function Arguments ? “

STDEVPA
Value1 | | -

Valuez | -

[ Calculates standard dewiation based on an entire population, including logical values and text, Text and the
loglcal value FALSE have the value 0; the logical value TRUE has the value 1.

Figl"'e 8_4: Valuet: valuelvalue2,.. are 1 to 255 values comresponding to 3 population and
can be values, names, arrays, or references that contain values.
Supply func-
tion argu- Formula result =
ments here' Help on this function oK Cancel
I

7. Supply the arguments.

To supply the arguments that a function needs, click an argument text
box (Valuel and Value2 in Figure 84). Next, read the argument descrip-
tion, which appears at the bottom of the dialog box. Then supply the
argument by entering a value, formula, or cell or range reference into the

o argument text box.

If a function needs more than one argument, repeat this step for each
argument.

Excel calculates the function result based on the arguments that you
enter and displays this value at the bottom of the dialog box next to
Formula Result =, as shown in Figure 8-5.
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Figure 8-5:
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Calculates standard dewiation based on an entire population, including logical values and text, Text and the
loglcal value FALSE have the value 0; the logical value TRUE has the value 1.

Valuet: valuelvalue2,.. are 1 to 255 values corresponding to a population and
can be values, names, arrays, of references that contain values.

Formula resuit = 134.187369

Help on this function oK Cancel

8. (Optional) If you need help with a particular function, browse the
Excel Help information.

If you need help using some function, your first resource — yes, even
before you check this chapter — should be to click the Help on This
Function hyperlink, which appears in the bottom-left corner of the
Function Arguments dialog box. In Figure 8-6, you can see the help infor-
mation that Excel displays for the STDEVPA function.

- o x

Excel Help - -
& & A | Searchonline help e

STDEVPA function A

This article describes the formula syntax and usage of the
STDEVPA function in Microsoft Excel

Description

Calculates standard deviation based on the entire
population given as arguments, including text and logical
values. The standard deviation is a measure of how widely
values are dispersed from the average value (the mean).

Syntax
STDEVER(valuel, [valueZ], ...)

The STDEVPA function syntax has the following
arguments:

= Valuel, value2, .. Valuel is required, subsequent

values are optional. 1 to 255 values corresponding to a
population. You can also use 3 single array or a

reference to an array instead of arguments separated

by commas. v
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The Or Select a Category drop-down list

After you learn your way around Excel and
develop some familiarity with its functions,
you can also narrow down the list of func-
tions by selecting a function category from
the Or Select a Category drop-down list in
the Insert Function dialog box. For example, if
you select Database from this drop-down list,
Excel displays a list of its database functions.
In some cases, this category-based approach
works pretty darn well. It all depends, really,

on how many functions Excel puts into a
category. Excel provides 12 database func-
tions, so that’s a pretty small set. Other sets,
however, are much larger. For example, Excel
supplies more than 70 statistical functions.
For large categories, such as the statistical
functions category, the approach that | sug-
gest in the section “Entering a function with
the Function command” (see Step 3 there)
usually works best.

9. When you're satisfied with the arguments that you enter in the
Function Arguments dialog box, click OK.

And now it’s party time. In the next section, I describe each of the database
statistical functions that Excel provides.

Using the DAVERAGE Function

B3

The DAVERAGE function calculates an average for values in an Excel list. The
unique and truly useful feature of DAVERAGE is that you can specify that you
want only list records that meet specified criteria included in your average.

If you want to calculate a simple average, use the AVERAGE function. In
Chapter 9, I describe and illustrate the AVERAGE function.

The DAVERAGE function uses the following syntax:
=DAVERAGE (database, field, criteria)

where database is a range reference to the Excel table that holds the value you
want to average, field tells Excel which column in the database to average, and
criteriais a range reference that identifies the fields and values used to define
your selection. The field argument can be a cell reference holding the field
name, the field name enclosed in quotation marks, or a number that identifies
the column (1 for the first column, 2 for the second column, and so on).

As an example of how the DAVERAGE function works, suppose that you've
constructed the worksheet shown in Figure 8-7. Notice that the worksheet
range holds a small table. Row 1 predictably stores field names: Name, State,
and Donation. Rows 2-11 store individual records.
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If you're a little vague on what an Excel table (or list) is, you should take a
peek at Chapter 1. Excel database functions analyze information from Excel
tables, so you need to know how tables work in order to easily use database
functions.

Rows 14 and 15 store the criteria range. The criteria range typically duplicates
the row of field names. The criteria range also includes at least one other row
of labels or values or Boolean logic expressions that the DAVERAGE func-
tion uses to select records from the list. In Figure 8-7, for example, note the
Boolean expression in cell C15, <500, which tells the function to include only
records where the Donation field shows a value less than 500.

The DAVERAGE function, which appears in cell F3, is
=DAVERAGE (A1:C11, "Donation",Al4:C15)

and it returns the average donation amount shown in the database list,
excluding the donation from Jeannie in California because that amount isn’t
less than 500. The actual function result is 63.88889.

Although [ mention this in a couple of other places in this book, I want to
repeat something important: Each row in your criteria range is used to select
records for the function. For example, if you use the criteria range shown in
Figure 8-8, you select records using two criteria. The criterion in row 15 tells
the DAVERAGE function to select records where the donation is less than 500.
The criterion in row 16 tells the DAVERAGE function to select records where



Chapter 8: Using the Database Functions ’ 6 5

Figure 8-8:
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the state is California. The DAVERAGE function, then, uses every record in
the list because every record meets at least one of the criteria. The records
in the list don’t have to meet both criteria; just one of them.
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To combine criteria — suppose that you want to calculate the DAVERAGE for
donations from California that are less than 500 — you put both the criteria
into the same row, as shown in row 15 of Figure 89.
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Using the DCOUNT and
DCOUNTA Functions

3

Figure 8-10:
Use the

DCOUNT |

and

DCOUNTA |-

database
statistical
functions

to count

recordsin |-
a database |

list.

I

The DCOUNT and DCOUNTA functions count records in a database table
that match criteria that you specify. Both functions use the same syntax, as
shown here:

=DCOUNT (database, field, criteria)
=DCOUNTA (database, field,criteria)

where database is a range reference to the Excel table that holds the value that
you want to count, £field tells Excel which column in the database to count, and
criteria is a range reference that identifies the fields and values used to define
your selection criteria. The fieldargument can be a cell reference holding the
field name, the field name enclosed in quotation marks, or a number that identi-
fies the column (1 for the first column, 2 for the second column, and so on).

Excel provides several other functions for counting cells with values or labels:
COUNT, COUNTA, COUNTIF, and COUNTBLANK. Refer to Chapter 9 or the
Excel online help for more information about these tools.

The functions differ subtly, however. DCOUNT counts fields with values;
DCOUNTA counts fields that aren’t empty.

As an example of how the DCOUNT and DCOUNTA functions work, suppose
that you've constructed the worksheet shown in Figure 8-10, which contains
a list of players on a softball team. Row 1 stores field names: Player, Age, and
Batting Average. Rows 2-11 store individual records.

DOOUNT 5]

DOOUNTA 9
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Rows 14 and 15 store the criteria range. Field names go into the first row.
Subsequent rows provide labels or values or Boolean logic expressions that
the DCOUNT and DCOUNTA functions use to select records from the list for
counting. In Figure 8-10, for example, there’s a Boolean expression in cell B15,
>8, which tells the function to include only records where the Age shows a
value greater than eight. In this case, then, the functions count players on the
team who are older than 8.

The DCOUNT function, which appears in cell F3, is
=DCOUNT (A1:C11,C1,A14:C15)

The function counts the players on the team who are older than 8. But
because the DCOUNT function looks only at players with a batting average in
the Batting Average field, it returns 8. Another way to say this same thing is
that in this example, DCOUNT counts the number of players on the team who
are older than 8 and have a batting average.

If you want to get fancy about using Boolean expression to create your selec-
tion criteria, take a peek at the earlier discussion of the DAVERAGE function.
In that section, “Using the DAVERAGE Function,” I describe how to create com-
pound selection criteria.

A\\J

The DCOUNTA function, which appears in cell F5, is
=DCOUNTA (A1:C11,3,A14:C15)

The function counts the players on the team who are older than 8 and have
some piece of information entered into the Batting Average field. The func-
tion returns the value 9 because each of the players older than 8 have some-
thing stored in the Batting Average field. Eight of them, in fact, have batting
average values. The fifth player (Christina) has the text label NA.

If you just want to count records in a list, you can omit the field argument
from the DCOUNT and DCOUNTA functions. When you do this, the function
just counts the records in the list that match your criteria without regard to
whether some field stores a value or is nonblank. For example, both of the fol-
lowing functions return the value 9:

B3

=DCOUNT (A1:C11, ,A14:C15)
=DCOUNTA (A1:C11, ,Al14:C15)

Note: To omit an argument, you just leave the space between the two
commas empty.



’ 68 Part lll: Advanced Tools

Using the DGET Function
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The DGET function retrieves a value from a database list according to selec-
tion criteria. The function uses the following syntax:

=DGET (database, field, criteria)

where database is a range reference to the Excel table that holds the value
you want to extract, fieldtells Excel which column in the database to
extract, and criteriais arange reference that identifies the fields and
values used to define your selection criteria. The field argument can be a
cell reference holding the field name, the field name enclosed in quotation
marks, or a number that identifies the column (1 for the first column, 2 for
the second column, and so on).

Go back to the softball players list example in the preceding section. Suppose
that you want to find the batting average of the single eight-year-old player.
To retrieve this information from the list shown in Figure 8-11, enter the fol-
lowing formula into cell F3:

=DGET (A1:C11,3,A14:C15)

This function returns the value 0. 444 because that’s the eight-year-old’s bat-
ting average.

[ =] Figure for DGET - Bzl 7T & x

3

By the way, if no record in your list matches your selection criteria, DGET
returns the #VALUE error message. For example, if you construct selection
criteria that look for a 12-year-old on the team, DGET returns #VALUE because
there aren’t any 12-year-old players. Also, if multiple records in your list match
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your selection criteria, DGET returns the #NUM error message. For example, if
you construct selection criteria that look for a ten-year-old, DGET returns the
#NUM error message because four ten-year-olds are on the team.

Using the DMAX and DMAX Functions

The DMAX and DMIN functions find the largest and smallest values, respec-
tively, in a database list field that match the criteria that you specify. Both
functions use the same syntax, as shown here:

=DMAX (database, field, criteria)
=DMIN (database, field, criteria)

where database is a range reference to the Excel table, field tells Excel
which column in the database to look in for the largest or smallest value, and
criteria is a range reference that identifies the fields and values used to define
your selection criteria. The fieldargument can be a cell reference holding the
field name, the field name enclosed in quotation marks, or a number that identi-
fies the column (1 for the first column, 2 for the second column, and so on).
< Excel provides several other functions for finding the minimum or maximum
value, including MAX, MAXA, MIN, and MINA. Turn to Chapter 9 for more infor-
mation about using these related functions.

As an example of how the DMAX and DMIN functions work, suppose you
construct a list of your friends and some important statistical information,
including their typical golf scores and their favorite local courses, as shown
in Figure 8-12. Row 1 stores field names: Friend, Golf Score, and Course. Rows
2-11 store individual records.

I | e w0 —— .
- Harold 105 Carnation
Figure 8-12: [*lo- — ]
Usethe .G T -
DMAX | & AR
and DMIN |- & 2 s
d tabase e 36 Sechomish
a 2
statistical |:™= == oo
functions |
to find the |-
largestand |-
smallest |
values. |” ——

I
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Rows 14 and 15 store the criteria range. Field names go into the first row.
Subsequent rows provide labels or values or Boolean logic expressions that
the DMAX and DMIN functions use to select records from the list for count-
ing. In Figure 8-12, for example, note the text label in cell C15, Snohomish,
which tells the function to include only records where the Course field shows
the label Snohomish.

The DMAX function, which appears in cell F3, is
=DMAX (A1:C11,"Golf Score",Al4:C1l5)

The function finds the highest golf score of the friends who favor the
Snohomish course, which happens to be 98.

If you want to get fancy about using Boolean expression to create your selec-
tion criteria, take a peek at the earlier discussion of the DAVERAGE function.
In that section, “Using the DAVERAGE Function,” I describe how to create com-
pound selection criteria.
The DMIN function, which appears in cell F5, is

=DMIN (A1:C11,"Golf Score",Al4:C15)

The function counts the lowest score of the friends who favor the Snohomish
course, which happens to be 96.

Using the DPRODUCT Function

The DPRODUCT function is weird. And I'm not sure why you would ever use
it. Oh sure, I understand what it does. The DPRODUCT function multiplies the
values in fields from a database list based on selection criteria. I just can’t
think of a general example about why you would want to do this.

The function uses the syntax
=DPRODUCT (database, field, criteria)

where database is a range reference to the Excel table that holds the value
you want to multiply, fieldtells Excel which column in the database to
extract, and criteriais a range reference that identifies the fields and
values used to define your selection criteria. If you've been reading this
chapter from the very start, join the sing-along: The field argument can be
a cell reference holding the field name, the field name enclosed in quotation
marks, or a number that identifies the column (1 for the first column, 2 for
the second column, and so on).
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[ can’t construct a meaningful example of why you would use this function, so
no worksheet example this time. Sorry.

Note: Just so you don’t waste time looking, the Excel Help file doesn’t provide
a good example of the DPRODUCT function either.

Using the DSTDEV and
DSTDEVP Functions

3

The DSTDEV and DSTDEVP functions calculate a standard deviation. DSTDEV
calculates the standard deviation for a sample. DSTDEVP calculates the stan-
dard deviation for a population. As with other database statistical functions,
the unique and truly useful feature of DSTDEV and DSTDEVP is that you can
specify that you want only list records that meet the specified criteria you
include in your calculations.

If you want to calculate standard deviations without first applying selection
criteria, use one of the Excel non-database statistical functions such as STDEV,
STDEVA, STDEVP, or STDEVPA. In Chapter 9, [ describe and illustrate these
other standard deviation functions.

The DSTDEV and DSTDEVP functions use the same syntax:

=DSTDEV (database, field, criteria)
=DSTDEVP (database, field,criteria)

where database is a range reference to the Excel table that holds the values
for which you want to calculate a standard deviation, field tells Excel which
column in the database to use in the calculations, and criteriais a range
reference that identifies the fields and values used to define your selection
criteria. The fieldargument can be a cell reference holding the field name,
the field name enclosed in quotation marks, or a number that identifies the
column (1 for the first column, 2 for the second column, and so on).

As an example of how the DSTDEV function works, suppose you construct
the worksheet shown in Figure 8-13. (This is the same basic worksheet as
shown in Figure 8-7, in case you're wondering.)
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The worksheet range holds a small list with row 1 storing field names (Name,
State, and Donation) and rows 2 through 11 storing individual records.

Rows 14 and 15 store the criteria range. The criteria range typically duplicates
the row of field names. The criteria range also includes at least one other row
of labels or values or Boolean logic expressions that the DSTDEV and DSTDEVP
functions use to select records from the list. In Figure 8-13, for example, note
the Boolean expression in cell C15, <250, which tells the function to include
only records where the Donation field shows a value less than 250.

The DSTDEV function, which appears in cell F3, is

=DSTDEV (A1:C11, "Donation" ,6A14 :C15)
and it returns the sample standard deviation of the donation amounts
shown in the database list, excluding the donation from Jeannie in California
because that amount is not less than 250. The actual function result is
33.33333.
The DSTDEVP function, which appears in cell F5, is

=DSTDEVP (A1:C11, "Donation" ,A14:C15)
and returns the population standard deviation of the donation amounts
shown in the database list excluding the donation from Jeannie in California

because that amount isn’t less than 250. The actual function result is
31.42697.
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You wouldn’t, by the way, simply pick one of the two database standard
deviation functions willy-nilly. If you're calculating a standard deviation using
a sample, or subset of items, from the entire data set, or population, you use
the DSTDEV function. If you're calculating a standard deviation using all the
items in the population, use the DSTDEVP function.

Using the DSUM Function

I
Figure 8-14: |:
Addvalues |-
from a data- |-

baselist |*
with DSUM. |*
-

The DSUM function adds values from a database list based on selection crite-
ria. The function uses the syntax:

=DSUM (database, field, criteria)

where database is a range reference to the Excel table, field tells Excel
which column in the database to sum, and criteriais a range reference
that identifies the fields and values used to define your selection criteria.
The fieldargument can be a cell reference holding the field name, the field
name enclosed in quotation marks, or a number that identifies the column (1
for the first column, 2 for the second column, and so on).

Figure 8-14 shows a simple bank account balances worksheet that illustrates
how the DSUM function works. Suppose that you want to find the total of the
balances that you have in open accounts paying more than 0.02, or 2 percent,
interest. The criteria range in A14:D15 provides this information to the func-
tion. Note that both criteria appear in the same row. This means that a bank
account must meet both criteria in order for its balance to be included in the
DSUM calculation.

L]

173
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The DSUM formula appears in cell F3, as shown here:
=DSUM(A1:C11,3,A14 :D15)

This function returns the value 39000 because that’s the sum of the balances
in open accounts that pay more than 2 percent interest.

Using the DUAR and DUARP Functions

3

The DVAR and DVARP functions calculate a variance, which is another mea-
sure of dispersion — and actually, the square of the standard deviation.
DVAR calculates the variance for a sample. DVARP calculates the variance for
a population. As with other database statistical functions, using DVAR and
DVARP enable you to specify that you want only those list records that meet
selection criteria included in your calculations.

If you want to calculate variances without first applying selection criteria,
use one of the Excel non-database statistical functions such as VAR, VARA,
VARP, or VARPA. In Chapter 9, I describe and illustrate these other variance
functions.

The DVAR and DVARP functions use the same syntax:

=DVAR (database, field, criteria)
=DVARP (database, field, criteria)

where database is a range reference to the Excel table that holds the values
for which you want to calculate a variance, field tells Excel which column
in the database to use in the calculations, and criteria is a range reference
that identifies the fields and values used to define your selection criteria. The
field argument can be a cell reference holding the field name, the field name
enclosed in quotation marks, or a number that identifies the column (1 for
the first column, 2 for the second column, and so on).

As an example of how the DVAR function works, suppose you've constructed
the worksheet shown in Figure 8-15. (Yup, this is the same worksheet as
shown in Figure 8-12.)

The worksheet range holds a small list with row 1 storing field names and
rows 2-11 storing individual records.

Rows 14-17 store the criteria, which stipulate that you want to include
golfing buddies in the variance calculation if their favorite courses are
Snohomish, Snoqualmie, or Carnation. The first row, row 14, duplicates the
row of field names. The other rows provide the labels or values or Boolean
logic expressions — in this case, just labels — that the DVAR and DVARP
functions use to select records from the list.
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The DVAR function, which appears in cell F3, is
=DVAR (A1:C11,"Golf Score",Al1l4:C17)

and it returns the sample variance of the golf scores shown in the database
list for golfers who golf at Snohomish, Snoqualmie, or Carnation. The actual
function result is 161.26786.

The DVARP function, which appears in cell F5, is
=DVARP (A1:C11, "Golf Score",Al14:C17)

and it returns the population variance of the golf scores shown in the data-
base list for golfers who golf at Snohomish, Snoqualmie, and Carnation. The
actual function result is 141.10938.

As when making standard deviation calculations, you don’t simply pick one
of the two database variances based on a whim, the weather outside, or how
you're feeling. If you're calculating a variance using a sample, or subset of
items, from the entire data set, or population, you use the DVAR function. To
calculate a variance using all the items in the population, you use the DVARP
function.
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Chapter 9
Using the Statistics Functions

In This Chapter
Counting items in a data set
Using means, modes, and medians
Finding values, ranks, and percentiles
Calculating standard deviations and variances
Using normal distributions
Using t-distributions and f-distributions
Understanding binomial distributions
Using chi-square distributions

Excel supplies a bunch of statistical functions . . . more than 70, in fact.
These functions help you dig more deeply into the characteristics of
data that you've stored in an Excel worksheet, list, or pivot table. In this
chapter, [ discuss and illustrate each of the statistical functions that you're
likely to use. I also briefly describe some of the very esoteric statistical
functions.

Counting Items in a Data Set

Excel provides four useful statistical functions for counting cells within a
worksheet or list: COUNT, COUNTA, COUNTBLANK, and COUNTIF. Excel also
provides two useful functions for counting permutations and combinations:
PERMUT and COMBIN.
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COUNT: Counting cells with values

The COUNT function counts the number of cells within a specified range that
hold values. The function, however, doesn’t count cells containing the logical
values TRUE or FALSE or cells that are empty. The function uses the syntax
=COUNT (valuel, [value2])
If you want to use the COUNT function to count the number of values in
the range B2:B10 in the worksheet shown in Figure 9-1, you might enter the
formula
=COUNT (B2:B10)

into cell G2, as shown in the figure. The function returns the value 9.

1 cownt [ 3
1 COUNTA
COUNTBLANK

2 counmF 5

Sheet! | Shewt2 | Sheels

Note: You can include several arguments as part of the range argument in the
COUNT function. For example, in Figure 9-1, you might also use the syntax
=COUNT (B2,B3:B5,B6 :B7,B8,B9), which would return the same result as
the formula shown in the figure.
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COUNTA: Alternative counting
cells with values

The COUNTA function counts the number of cells within a specified range
that aren’t empty. The function uses the syntax

=COUNTA (valuel, [value2])
If you want to use the COUNTA function to count the number of non-empty
cells in the range A1:B2 in the worksheet shown in Figure 9-1, for example,
enter the formula

=COUNTA (A1:B2)

into cell G4. The function returns the value 3.

COUNTBLANK: Counting empty cells

The COUNTBLANK function counts the number of cells within a specified
range that are empty. The function uses the syntax

=COUNTBLANK (valuel, [value2])
To use the COUNTBLANK function to count the number of empty cells in the
range Al:B2 in the worksheet shown in Figure 9-1, for example, you could
enter the formula

=COUNTBLANK (A1:B2)

into cell G6. The function returns the value 1.

COUNTIF: Counting cells
that match critevia

The COUNTIF function counts the number of cells within a specified range
that match criteria that you specify. The function uses the syntax

=COUNTIF (range, criteria)
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where range is the worksheet range in which you count cells and criteria
is a Boolean expression, enclosed in quotation marks, that describes your
criteria.

As an example of how this works, suppose you want to use the COUNTIF
function to count the number of cells within the worksheet range C1:C10 that
hold values greater than 4. To make this count, you use the following formula:

=COUNTIF (C1:C10,">4")
This formula appears in cell G8 of the worksheet shown in Figure 9-1.

You can use other Boolean operators to construct other match criteria: Use
the < operator for a less-than comparison, the <= operator for a less-than-or-
equal-to comparison, the >= operator for a greater-than-or-equal-to compari-
son, the = operator for the equal-to comparison, and the <> operator for a
not-equal-to comparison.

PERMUT: Counting permutations

The PERMUT function counts the number of permutations possible when
selecting a sample from a population. Note that for a permutation, the order
does matter in which items are selected. The function uses the syntax

=PERMUT (number, number._chosen)
where number is the number of items in the population and number._chosen
is the number of items selected. Given a population of six items and three
selections, for example, you calculate the number of permutations by using
the formula

=PERMUT (6, 3)

The function returns the value 120, indicating that 120 different ways exist in
which three items can be selected from a set of six.

COMBIN: Counting combinations

If the order in which items are selected doesn’t matter, you use the combina-
tion function, COMBIN, which uses the syntax

=COMBIN (number, number._chosen)
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The number of combinations possible when three items are selected from a
set of six can be calculated using the formula

=COMBIN (6, 3)

This function returns the value 20. The COMBIN function isn’t technically an
Excel statistical function, by the way, but it seems so closely related to the
PERMUT function that I include a description here.

Means, Modes, and Medians

Excel provides a handful of functions for calculating means, modes, and
medians.

AVEDEU: An average absolute deviation

The AVEDEV function provides a measure of dispersion for a set of values. To
do this, the function looks at a set of values and calculates the average abso-
lute deviation from the mean of the values. The function uses the syntax

=AVEDEV (numberl, [number2] )

where numberi1, [number2] is a worksheet reference to the range that
stores the values.

Note: As is the case with many other simple statistical functions, you can
include several arguments as part of the range argument in the AVEDEV
function. For example, the formulas =AVEDEV(B1,B2:B5,B6:B7,B8,B9) and
=AVEDEV(B1:B9) are equivalent.

Suppose you have three values — 100, 200, and 300 — in the worksheet range
that you supply to the AVEDEV function. The average of these three values

is 200, calculated as (100+200+300) /3. The average of the deviations from
the mean is 66.6667, calculated as:

(]100-200|+|200-200]|+|300-200]) /3
Note: The AVEDEV function calculates the average of the absolute value of

the deviation. For this reason, the function calculates absolute differences, or
deviations, from the mean.
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The AVEDEV function isn’t used in practice. Mostly a teaching tool, educators
and trainers sometimes use the average deviation measure of dispersion to
introduce the more useful but also more complicated measures of dispersion:
the standard deviation and variance.

AVERAGE: Average

The AVERAGE function calculates the arithmetic mean for a set of values. The
function uses the syntax

=AVERAGE (numberl, [number2] )

where numberi1, [number2] is a worksheet reference to the range that
stores the values.

If your argument includes the three values — 100, 200, and 3 00— the func-
tion returns the value 200 because (100+200+300) /3 equals 200.

AVERAGEA: An alternate average

The AVERAGEA function, like the AVERAGE function, calculates the arith-
metic mean for a set of values. The difference with the AVERAGEA function,
however, is that AVERAGEA includes cells with text and the logical value for
FALSE in its calculations as 0. The AVERAGEA function includes the logical
value for TRUE in its calculations as 1. The function uses the syntax

=AVERAGEA (numberl, [number2])

where numberi1, [number2] is a worksheet reference to the range that
stores the values — and possibly text as well as logical values.

If your argument includes three values — 100, 200, and 300— and three
text labels in the worksheet range that you supply to the AVERAGEA func-
tion, the function returns the value 100 because (100+200+300+0+0+0) /6
equals 100.

Note: As is the case with the AVERAGE function, you can supply up to 255
arguments to the AVERAGEA function.
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TRIMMEAN: Trimming to a mean

The TRIMMEAN function calculates the arithmetic average of a set of values
but only after discarding a specified percentage of the lowest and highest
values from the set. The function uses the syntax

=TRIMMEAN (array, percent)

where array is the range holding the values and percent is the decimal
value that gives the percentage of values that you want to discard. For exam-
ple, to calculate the arithmetic mean of the values stored in the worksheet
range C2:C10 in Figure 9-2 only after discarding 10 percent of the data — the
top 5 percent and the bottom 5 percent — you use the following formula:

=TRIMMEAN (C2:C10,0.1)

| =TRIMMEAN|C2.C30.0.1

C E F G H
1 TRWMER  [E33333]

e
Figure9-2: |
Awork- |1
sheet frag- |-
mentthat |*
shows how |=
TRIMMEAN |=
works. |*
I

MEDIAN: Median value

The MEDIAN function finds the middle value in a set of values: Half the values
fall below and half the values fall above the median. The function uses the
syntax

=MEDIAN (numberl, [number2] )
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If you use the MEDIAN function to find the median of a range holding the
values 1, 2, 3, 4, and 5, for example, the function returns the value 3.

Note: You can supply up to 255 arguments to the MEDIAN function.
If you use the MEDIAN function to find the median of a range holding the
values 1, 2, 3, and 4, the function returns the value 2 . 5. Why? Because if you

have an even number of data entries, Excel calculates a median by averaging
the two middle values.

MODE: Mode value

The MODE function finds the most common value in your data set, but the
function ignores empty cells and cells that store text or return logical values.
The function uses the syntax

=MODE (numberl, [number2] )

If you use the MODE function to find the most common value in a range hold-
ing the values 1, 2, 3, 4, 4, and 4, the function returns the value 4.

Note: You can supply up to 255 arguments to the MODE function.

GEOMEAN: Geometric mean

The GEOMEAN function calculates the geometric mean of a set of values. The
geomelric mean equals the nth root of the product of the numbers. The func-
tion uses the syntax

=GEOMEAN (numberl, [number2] ...)

where number1 and, optionally, other similar arguments supply the values
that you want to geometrically average.

HARMEAN: Harmonic mean

The HARMEAN function calculates the reciprocal of the arithmetic mean of
the reciprocals of a data set. The function uses the syntax

=HARMEAN (numberl, [number2] ...)

where number1 and, optionally, other similar arguments supply the values
that you want to harmonically average.
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Finding Values, Ranks, and Percentiles

Excel provides functions for finding the largest or smallest values in a data
set and also for finding values with a particular rank and for ranking values
within the data set. Excel also provides a couple of tangentially related func-
tions for calculating frequency distributions and simple probabilities for data
sets. [ describe all these function tools in the next sections.

MAX: Maximum value

The MAX function finds the largest value in your data. The function ignores
blank cells and cells containing text or logical values such as TRUE and
FALSE and uses the syntax

=MAX (numberl, [number2] )

If the largest value in the range A1:G500 is 50, the function =MAX(A1:G500)
returns the value 50.

Note: You can supply up to 255 arguments to the MAX function.

MAXA: Alternate maximum value

In a fashion similar to the MAX function, the MAXA function also finds the
largest value in your data. However, unlike the MAX function, the MAXA func-
tion includes logical values and text. The logical value TRUE equals 1, the
logical value FALSE equals 0, and text also equals 0. The MAXA function uses
the syntax

=MAXA (numberl, [number2] )

MIN: Minimum value

The MIN function finds the smallest value in your data. The function ignores
blank cells and cells containing text or logical values such as TRUE and FALSE
and uses the syntax

=MIN (numberl, [number2] )

If the smallest value in the range A1:G500 is 1, the function =MIN(A1:G500)
returns the value 1.



’ 8 6 Part lll: Advanced Tools

MINA: Alternate minimum value
The MINA function also finds the smallest value in your data, but the MINA
function includes logical values and text. The logical value TRUE equals 1, the
logical value FALSE equals 0, and text also equals 0. The MINA function uses
the syntax

=MINA (numberl, [number2] )

If the smallest value in the range A1:G500 is 1 but this range also includes text
values, the function =MINA(A1:G500) returns the value 0.

LARGE: Finding the
kth largest value

You can use the LARGE function to find the kth largest value in an array. The
function uses the syntax

=LARGE (array, k)
where array is the array of values and k identifies which value you want the
function to return. For example, if you store the values 1, 3, 5, 8, and 9 in the
worksheet range A1:A5 and you want the function to return the second larg-
est value, use the following formula:

=LARGE (A1:A5,2)

The function returns the value 8 because that’s the second largest value in
the array.

SMALL: Finding the
kth smallest value

The SMALL function finds the kth smallest value in an array. The function
uses the syntax

=SMALL (array, k)



Chapter 9: Using the Statistics Functions ’ 8 7

]
Figure 9-3:

A worksheet
fragment
with the
array 1, 2,

3,4,4,5, |3
6,7,8. |
I

where array is the array of values and k identifies which value you want to
find and have the function return. For example, if you store the values 1, 3,
5, 8, and 9 in the worksheet range Al:A5 and you want the function to return
the second smallest value, use the following formula:

=SMALL (A1:A5, 2)

The function returns the value 3 because that’s the second smallest value in
the array.

RANK: Ranking an array value

The RANK function determines the rank, or position, of a value in an array.
The formula uses the syntax

=RANK (number, ref, [order])

where number is the value you want to rank, ref is the array of values, and
optionally order indicates whether array values should be arranged in
descending order (indicated with a 0 or logical FALSE value) or in ascend-
ing order (indicated with a 1 or logical TRUE value). By the way, Excel ranks
duplicate values the same, but these duplicates do affect the rank of subse-
quent numbers. If you leave out the order argument, Excel ranks values in
descending order.

To demonstrate how the RANK function works, suppose you want to rank the
values shown in the worksheet range A1:A9 in Figure 9-3.

RANK (dascending) 3]
7

RANK (ascanding)

PERCENTRANK 075

PERCENTILE 3

Sheet! | Shewt2 | Sheels
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The formula in cell G2
=RANK (6 ,A1:A9)

returns the value 3, indicating that when a descending order is used, the
value 6 is the third value in the array.

The formula in cell G4
=RANK (6 ,A1:A9,1)

returns the value 7, indicating that when an ascending order is used, the
value 6 is the seventh value in the array.

PERCENTRANK: Finding
a percentile ranking

The PERCENTRANK function determines the percentage rank, or percentile,
of avalue in an array. The formula uses the syntax

=PERCENTRANK (array, x, [significance])

where array gives the array of values, x identifies the value you want to
rank, and significance identifies the number of decimal places that you
want in the percentage. The significance argument is optional. If you omit
the argument, Excel assumes that you want three significant digits.

To demonstrate how the PERCENTRANK function works, again sup-
pose you want to rank the values shown in the worksheet range A1:A9 in
Figure 9-3 — only this time, you rank the values using percentages.

The formula in cell G6
=PERCENTRANK (A1:A9,6,2)
returns the value 0. 75, which is the same thing as 75 percent.

Excel calculates the percentage rank by looking at the number of array values
greater than the x value and the number of array values smaller than the x
value. The array shown earlier in Figure 9-3 includes the values 1, 2, 3, 4, 4, 5,
6, 7, 8. The percent rank of 6 in the array equals 0.75 because six array values
are smaller than 6 and two array values are larger than 6. The actual formula
that the function calculates is 6/ (2+6) , which equals 0.75.
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PERCENTILE: Finding a percentile ranking

The PERCENTILE function determines the array value at a specified percen-
tile in an array. The formula uses the syntax

=PERCENTILE (array, k)

where array gives the array of values and k gives the percentile of the value
that you want to find.

To find the value at the 75-percent percentile in the array of values shown in
the worksheet range A1:A9 in Figure 9-3, use the formula

=PERCENTILE (A1:A9, .75)

The function returns the value 6 because the value 6 is at the 75th percen-
tile in this array. This formula appears in cell G8 in the worksheet shown in
Figure 9-3.

To repeat something in the earlier discussion of the PERCENTRANK function,
note that Excel calculates the percentage rank by looking at the number of
array values greater than the x value and the number of array values smaller
than the x value. For the array shown in Figure 9-3, the array includes the
values 1, 2, 3, 4, 4, 5, 6, 7, 8. The percent rank of 6 in the array equals 0.75
because six array values are smaller than 6 and two array values are larger
than 6.

FREQUENCY: Frequency
of values in a range

The FREQUENCY function counts the values in an array that fall within a
range, or bin. The function uses the syntax

=FREQUENCY (data_array,bins_array)

where data_array is the worksheet range that holds the values that you
want to count and bins_arrayis a worksheet range that identifies the
ranges of values, or bins, that you want to use to create a frequency distribu-
tion. Take a look at Figure 94, for example.
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To categorize the values in the worksheet range A2:A20 using the bins shown
in B2:B6, select the worksheet range C2:C6 and enter the formula

=FREQUENCY (A2:A20,B2:B6)

Then press Ctrl+Shift+Enter to tell Excel that the function formula should be
entered as an array. Excel enters your formula into each of the cells in the
worksheet range C2:C6, with the result shown in Figure 9-4.

In cell C2, the function uses the bin value in cell B2 to count up all the data
values greater than o and less than or equal to 80. In cell C3, the function
counts up all the data values greater than 80 but less than 90, and so on.
Note that you need to arrange your bin range values in ascending order.

PROB: Probability of values

The PROB function uses a set of values and associated probabilities to calcu-
late the probability that a variable equals some specified value or that a vari-
able falls with a range of specified values. The function uses the syntax

=PROB (x_range, prob_range, lower_limit, [upper l1imit])
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Working with array formulas

You can use array formulas to return arrays.
For example, you can create an array formula
that adds the array 1, 2, 3 to the array 4, 5, 6.
This formula produces an array result: 5, 7, 9.
The worksheet fragment below shows this. The
array in range A1:.C1 is added to the array in
range A2:C2, and the resulting array is placed
into the range A3:C3.

If you want to try entering this formula your-
self, create a worksheet that holds the values
shown in A1:C2. Then, select the range A3:C3,

type the formula =A1:C1+A2:C2, and press
Ctrl+Shift+Enter. Excel enters the same for-
mula, {=A1:C1+A2:C2}, into each of the cells
in the worksheet range A3:C3. You don't enter
the braces, by the way. Excel enters those for
you when you press Ctrl+Shift+Enter. The array
formula tells Excel to calculate different values
for different cells. Excel calculates the value
for cell A3 by adding the values in Al and A2.
Excel calculates the value in cell B3 by adding
the values in B1 and B2, and so on.

Sheet!

A Staphan Nebsen -

where x_range equals the worksheet range that holds your values and
prob_range holds the worksheet range that specifies the probabilities for

the values from x_range. To calculate the probability that a variable equals

a specified value, enter that value using the Iower._1imit argument. To cal-

culate the probability that a variable falls within a range, enter the bounds of
that range using the lower_ 1imit and upper limit arguments.

Although the PROB function seems complicated at first blush, take a peek at
the worksheet shown in Figure 9-5. The worksheet range A1:A10 holds the
values, and the worksheet range B1:B10 holds the probability of those values.
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Figure 9-5:
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To calculate the probability that a value equals 4, use the formula

=PROB (A1:A10,B1:B10,4)
In what shouldn’t be a surprise to you, given the value shown in cell B4, this
function returns the value 15.00%, as shown in cell G3 in Figure 9-5. To calcu-
late the probability that a value falls from 4 to 7, use the formula

=PROB (A1:A10,B1:B10,4,7)

The function returns the value 68.00%, which is the sum of the values in the
range B4:B7. Figure 9-5 also shows this formula result in cell G5.

Standard Deviations and Variances

I'm sure that this will be a big surprise to you. Excel provides almost a dozen
functions for calculating standard deviations and variances. A sfandard devia-
tion, by the way, describes dispersion (spread of data) about (around) the
data set’s mean. You can kind of think of a standard deviation as an average
deviation from the mean. A variance is just the squared standard deviation.
You often use variances and standard deviations in other statistical calcula-
tions and as arguments to other statistical functions.
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Population statistics compared
with sample statistics

How do you know whether you're supposed
to be using sample versions of statistical
functions (such as STDEV and STDEVA) or
population versions of statistical functions
(such as STDEVP and STDEVPA)? If you're
looking at all the values — the key word is

all — you're working with the entire popula-
tion. In this case, use one of the population
standard deviation functions. If you're working
with samples — which are just portions of the
population — use one of the sample standard
deviation functions.

STDEV: Standard deviation of a sample

The STDEV function calculates the standard deviation of a sample, a measure
of how widely values in a data set vary around the mean — and a common
input to other statistical calculations. The function uses the syntax

=STDEV (numberl, [number2])

To calculate the standard deviation of the worksheet range Al:A5 using the
STDEV function, for example, use the formula

=STDEV (A1:A5)

If the worksheet range holds the values 1, 4, 8, 9, and 11, the function
returns the standard deviation value 4.037326.

The STDEV function lets you include up to 255 arguments as inputs; those
arguments can be values, cell references, formulas, and range references. The
STDEV function ignores logical values, text, and empty cells.

STDEVA: Alternate standard
deviation of a sample

The STDEVA function calculates the standard deviation of a sample, but
unlike the STDEV function, STDEVA doesn’t ignore the logical values TRUE
(which is 1) and FALSE (which is 0). The function uses the syntax

=STDEVA (numberl, [number2] )
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STDEVA arguments, which can number up to 255, can be values, cell refer-
ences, formulas, and range references.

STDEVP: Standard deviation
of a population

The STDEVP function calculates the standard deviation of a population to
measure how widely values vary around the mean. The function uses the
syntax

=STDEVP (numberl, [number2] )

To calculate the standard deviation of the worksheet range A1:A5 using the
STDEVP function, for example, use the formula

=STDEVP (A1:A5)

If the worksheet range holds the values 1, 4, 8, 9, and 11, the function
returns the standard deviation value 3.611094.

The STDEVP function lets you include up to 255 arguments as inputs; the
arguments can be values, cell references, formulas, and range references. The
STDEV function ignores logical values, text, and empty cells.

STDEVPA: Alternate standard
deviation of a population

The STDEVPA function calculates the standard deviation of a population, but
unlike the STDEVP function, STDEVPA doesn’t ignore the logical values TRUE
(which is 1) and FALSE (which is 0). The function uses the syntax

=STDEVPA (numberl, [number2] )

STDEVPA arguments, which can number up to 255, can be values, cell refer-
ences, formulas, and range references.

VAR: Variance of a sample

The VAR function calculates the variance of a sample, another measure of
how widely values in a data set vary around the mean. The VAR function uses
the syntax
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< =VAR (numberl, [number2] )
A standard deviation is calculated by finding the square root of the variance.

To calculate the variance of the worksheet range A1:A5 using the VAR func-
tion, for example, use the formula

=VAR (A1:A5)

If the worksheet range holds the values 1, 4, 8, 9, and 11, the function
returns the standard deviation value 16 . 3.

The VAR function lets you include up to 255 arguments as inputs; the argu-

ments can be values, cell references, formulas, and range references. The VAR
function ignores logical values, text, and empty cells.

VARA: Alternate variance of a sample

The VARA function calculates the variance of a sample, but unlike the VAR
function, VARA doesn’t ignore the logical values TRUE (which is 1) and FALSE
(which is 0). The function uses the syntax

=VARA (numberl, [number2] )

VARA arguments, which can number up to 255, can be values, cell references,
formulas, and range references.

VARP: Variance of a population

The VARP function calculates the variance of a population. The function uses
the syntax

=VARP (numberl, [number2] )

To calculate the variance of the worksheet range Al:A5 using the VARP func-
tion, for example, use the formula

=VARP (A1:A5)

If the worksheet range holds the values 1, 4, 8, 9, and 11, the function
returns the standard deviation value 13 .04.
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The VARP function lets you include up to 255 arguments as inputs; the argu-
ments can be values, cell references, formulas, and range references. The
VARP function ignores logical values, text, and empty cells.

VARPA: Alternate variance of a population
The VARPA function calculates the variance of a population, but unlike the

VARP function, VARPA doesn’t ignore the logical values TRUE (which is 1) and
FALSE (which is 0). The function uses the syntax

=VARPA (numberl, [number2])

VARPA arguments, which can number up to 255, can be values, cell refer-
ences, formulas, and range references.

COUARIANCE.P and COVARIANCE.S:
Covariances
Excel supplies two covariance functions: COVARIANCE.S and COVARIANCE.P.
The COVARIANCE.S function calculates the covariance of a sample and the
COVARIANCE.P function calculates the covariance of a population. The cova-
riance statistics, then, calculate the average of the products of the deviations
between pairs of values and uses the syntax

=COVARIANCE.S (arrayl, array2)
Or

=COVARIANCE.P (arrayl, array2)

where arrayi is the worksheet range holding the first values in the pair and
array2 is the worksheet range holding the second values in the pair.

DEUSQ: Sum of the squared deviations

The DEVSQ function calculates the deviations of values from a mean, squares
those deviations, and then adds them up. The function uses the syntax

=DEVSQ (numberl, [number2] ...)

where number1 and, optionally, number2 are worksheet ranges or arrays
that hold your values.
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Normal Distributions
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Excel provides five useful functions for working with normal distributions.
Normal distributions are also known as bell curves or Gaussian distributions.

Pssst. Hey buddy, wanna to see how a normal distribution changes when you
noodle with its mean and standard deviation? Visit the Stanford University
web page at

http://statweb.stanford.edu/~naras/jsm/NormalDensity/
NormalDensity.html

NORM.DIST: Probability X falls
at or below a given value

The NORM.DIST function calculates the probability that variable X falls below
or at a specified value. The NORM.DIST function uses the syntax

=NORM.DIST (x, mean, standard_dev, cumulative)

where x is the variable that you want to compare, mean is the population
mean, standard_dev is the population standard deviation, and cumulative
is a logical value that tells Excel whether you want a cumulative probability
or a discrete probability.

Here’s an example of how you might use the NORM.DIST function: Suppose
you want to calculate the probability that some goofball with whom you work
actually does have an IQ above 135 like he’s always bragging. Further sup-
pose that the population mean IQ equals 100 and that the population stan-
dard deviation for IQs is 15. (1 don’t know whether these numbers are true.

I do vaguely remember reading something about this in Zen and the Art of
Motorcycle Maintenance when [ was in high school.)

In this case, you use the following formula:

=NORM.DIST (135,100, 15, 1)
The function returns the value .990185, indicating that if the inputs are
correct, roughly 99 percent of the population has an IQ at or below 135. Or,
slightly restated, this means the chance that your co-worker has an IQ above

135 is less than 1 percent.

If you want to calculate the probability that your co-worker has an IQ equal
to exactly 135, use the following formula:

=NORM.DIST (135,100,15,0)
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This function returns the value .001748 indicating that .1748 percent, or
roughly one-sixth of a percent, of the population has an IQ equal to 135.

To be very picky, statisticians might very well tell you that you can’t actually
calculate the probability of a single value, such as the probability that some-
body’s IQ equals 135. When you set the cumulative argument to 0, therefore,
what actually happens is that Excel roughly estimates the probability by using
a small range about the single value.

NORM.INV: X that gives
specified probability

The NORM.INV function makes the inverse calculation of the NORM.DIST
function. NORM.INV calculates the variable X that gives a specified probabil-
ity. The NORM.INV function uses the syntax

=NORM. INV (probability, mean, standard dev)

where probability is the percentage that you want the variable X value
to fall at or below, mean is the population mean, and standard devis the
population standard deviation.

Okay, here’s something that I do remember from Zen and the Art of Motorcycle
Maintenance. In that book, the protagonist says that he has an IQ that occurs

only once in every 50,000 people. You can turn this into a percentile using the
formula 1-1/50000, which returns the value .99998.

To calculate the IQ level (which is the variable X) that occurs only every
50,000 people and again assuming that the IQ mean is 100 and that the stan-
dard deviation is 15 IQ points, you use the following formula:

=NORM.INV(.99998,100,15)

The formula returns the value 162, when rounded to the nearest whole
number.

NORM.S.DIST: Probability variable
within z-standard deviations

For normal distributions, the NORM.S.DIST function calculates the probabil-
ity that a random variable is within z-standard deviations of the mean. The
function uses the syntax

=NORM.S.DIST(Zz)
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To find the probability that a randomly selected variable from a data set is
within 2 standard deviations from the mean, use the following formula:

=NORM.S.DIST(2)

which returns the value 0.97725, indicating that there is a 97.725-percent
chance that the variable falls within 2 standard deviations of the mean.

NORM.S.INV: z-value equivalent
to a probability

The NORM.S.INV function is the inverse of the NORM.S.DIST function. If you
know the probability that a randomly selected variable is within a certain
distance of the mean, you can calculate the z-value by using the NORM.S.INV
function to describe the distance in standard deviations. The function uses
the syntax

=NORM. S.INV (probability)

where probability is a decimal value between 0 and 1. To find the z-value
for 99 percent, for example, you use the following formula:

=NORM.S.INV(0.99)
The function returns the z-value 2.326348, indicating that there is a 99-percent

chance that a randomly selected variable is within 2.326348 standard deviations
of the mean.

STANDARDIZE: z-value for a specified value

The STANDARDIZE function returns the z-value for a specified variable. The
z-value describes the distance between a value and the mean in terms of stan-
dard deviations. The function uses the syntax

=STANDARDIZE (X, mean, standard_dev)

where x is the variable for which you want to calculate a z-value, mean is the
arithmetic mean, and standard_dev is the standard deviation.

For example, to calculate the z-value for the variable 6600 given a mean equal
to 6000 and a standard deviation equal to 800, you use the following formula:

=STANDARDIZE (6600,6000,800)

The function returns the z-value 0.75.
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With a z-value, you can use the NORM.S.DIST function to calculate the prob-
ability that a randomly selected variable falls within the area calculated as the
mean plus or minus the z-value. The probability that a randomly selected vari-
able falls within the area that equals the mean plus or minus the z-value 0. 75
is calculated using the formula =NORM.S.DIST(0.75). This function returns the
probability value 0 . 773373, indicating that there’s a 77.3373 chance that a
variable will fall within 0.75 standard deviations of the mean.

CONFIDENCE: Confidence interval
for a population mean

The CONFIDENCE.NORM and CONFIDENCE.T functions calculate a value that
you can use to create a confidence intervals for population means based on
the sample mean. These definitions amount to a mouthful, but in practice
what these functions do is straightforward.

Suppose that, based on a sample, you calculate that the mean salary for a
chief financial officer for a particular industry equals $100,000. You might
wonder how close this sample mean is to the actual population mean.
Specifically, you might want to know what range of salaries, working at a
95-percent confidence level, includes the population mean.

The CONFIDENCE.NORM function calculates the number that you use to
create this interval using the syntax

=CONFIDENCE .NORM(alpha, standard dev, size)

where alpha equals 1 minus the confidence level, standard dev equals the
standard deviation of the population, and size equals the number of values
in your sample.

If the standard deviation for the population equals $20,000 and the sample
size equals 100, use the formula

=CONFIDENCE.NORM(1-.95,20000,100)

The function returns the value $3920 (rounded to the nearest dollar). This
interval suggests that if the average chief financial officer’s salary in your
sample equals $100,000, there’s a 95-percent chance that the population
mean of the chief financial officers’ salaries falls within the range $96,080 to
$103,920.

The CONFIDENCE.T function works in roughly the same way arguments do,
but uses a Student T-distribution rather than a normal distribution. The
CONFIDENCE.T function uses the following syntax:

=CONFIDENCE.T (alpha, standard dev, size)
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where alpha equals 1 minus the confidence level, standard dev equals the
standard deviation of the population, and size equals the number of values
in your sample.

If the standard deviation for the population equals $20,000 and the sample
size equals 100, use the formula

=CONFIDENCE.T(1-.95,20000,100)

The function returns the value $3968 (rounded to the nearest dollar). This
interval suggests that if the average chief financial officer’s salary in your
sample equals $100,000, there’s a 95-percent chance that the population
mean of the chief financial officers’ salaries falls within the range $96,032 to
$103,968.

KURT: Kurtosis

The KURT function measures the tails in a distribution. The function uses the
syntax

=KURT (numberl, [number2] ...)
where number1 is a value, cell reference, or range reference. Optionally, you
can include additional arguments that provide values, cell references, and
ranges.
The kurtosis of a normal distribution equals 0. A kurtosis greater than 0
means the distribution’s tails are larger than for a normal distribution. A kur-

tosis less than 0 means the distribution’s tails are smaller than for a normal
distribution.

SKEW and SKEW.P: Skewness

of a distribution

The SKEW and SKEW.P functions measure the symmetry of a distribution of
values. Both functions use the same syntax, so I'm just going to describe the
SKEW.P function here.

The SKEW.P function uses the syntax

=SKEW.P (numberl, [number2] )
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To illustrate this function, suppose that you want to measure the skewness of
a perfectly symmetrical distribution, such as the uniformly distributed values
1,2,3,4,5,6,7and 8. No skewness exists here, right? You can prove this lack
of skewness using the formula

=SKEW.P(1,2,3,4,5,6,7,8)
Which returns the value 0.

If a distribution’s values tail (that is, stretch out) to the right, it means the
distribution includes greater numbers of large values (or larger values) than a
symmetrical distribution would. Thus the skewness is positive. For example,
the formula

=SKEW.P(1,2,3,4,5,6,8,8)
returns the value 0.07925.

If the distribution’s values tail (stretch out) to the left, meaning that the dis-
tribution includes greater numbers of small values or smaller values than a
symmetrical observation would, the skewness is negative. For example, the
formula

=SKEW(1,1,3,4,5,6,7,8)

returns the value -0.07924.

t-distributions

When you're working with small samples — less than 30 or 40 items — you
can use what’s called a student Fvalue to calculate probabilities rather than
the usual z-value, which is what you work with in the case of normal distribu-
tions. Excel provides six t-distribution functions, which I discuss in the fol-
lowing paragraphs.

LDIST: Left-tail Student t-distribution

The T.DIST function returns the student’s left-tailed distribution and uses the
syntax

=T.DIST(x,deg freedom,cumulative)
where x equals the t-value, deg_freedom equals the degrees of freedom, and

cumulative is alogical value that determines whether the function returns
cumulative distribution value or a probability density. You set the cumulative
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argument to o0 to return a probability density and to 1 to return a cumula-
tive distribution. For example, to calculate the left-tailed probability density
of the t-value 2.093025 given 19 degrees of freedom, you use the following
formula:

=T.DIST(2.093025,19,0)
which returns the value 0.049455, or roughly 5-percent.
Student t-distribution measures let you estimate probabilities for normally dis-
tributed data when the sample size is small (say, 30 items or fewer). You can

calculate the degrees of freedom argument by subtracting 1 from the sample
size. For example, if the sample size is 20, the degrees of freedom equal 19.

LDIST.RT: Right-tail Student t-distribution

The T.DIST.RT function returns the student’s right-tailed distribution and uses
the syntax

=T.DIST.RT(x,deg freedom)
where x equals the t-value and deg_freedomequals the degrees of freedom.
For example, to calculate the right-tailed probability density of the t-value
2.093025 given 19 degrees of freedom, you use the following formula:

=T.DIST.RT(2.093025,19)

which returns the value 0.02500, or roughly 2.5-percent.

T.DIST.2T: Two-tail Student t-distribution

The T.DIST.2T function returns the two-tailed student t-distribution and uses
the syntax

=T.DIST.2T(x,deg freedom)
where x equals the t-value and deg_freedomequals the degrees of freedom.
For example, to calculate the two-tailed probability density of the t-value
2.093025 given 19 degrees of freedom, you use the following formula:

=T.DIST.2T(2.093025,19)

which returns the value 0.049999, or roughly 5-percent.

203
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LINUV: Left-tailed Inverse
of Student t-distribution

The T.INV function calculates the left-tailed inverse of a student t-distribution.
The function uses the syntax

=T.INV (probability, deg freedom)
where probability is the probability percentage and deg freedomequals
the degrees of freedom. To calculate the t-value given a 5-percent probability
and 19 degrees of freedom, for example, use the following formula:

=T.INV(0.05,19)

which returns the t-value -1.729132.

TINU.2T: Two-tailed Inverse
of Student t-distribution

The T.INV.2T function calculates the two-tailed inverse of a student t-distribution.
The function uses the syntax

=T.INV.et (probability,deg freedom)
where probability is the probability percentage and deg freedomequals
the degrees of freedom. To calculate the two-tailed t-value given a 5-percent
probability and 19 degrees of freedom, for example, use the following
formula:

=T.INV.2T(0.05,19)

which returns the t-value -2.093024.

I.TEST: Probability two samples
from same population

The T.TEST function returns the probability that two samples come from the
same populations with the same mean. The function uses the syntax

=T.TEST (arrayl,array2,tails, type)
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where array1 is a range reference holding the first sample, array2is a
range reference holding the second sample, tailsis either the value 1
(representing a one-tailed probability) or 2 (representing a two-tailed prob-
ability), and type tells Excel which type of t-test calculation to make. You set
type to 1 to perform a paired t-test, to 2 to perform a homoscedastic test (a
test with two samples with equal variance), or to 3 to perform a heferoscedas-
tic test (a test with two samples with unequal variance).

f-distributions

f-distributions are probability distributions that compare the ratio in vari-
ances of samples drawn from different populations. That comparison
produces a conclusion regarding whether the variances in the underlying
populations resemble each other.

FDIST: Left-tailed (-distribution
probability

The EDIST function returns the left-tailed probability of observing a ratio of
two samples’ variances as large as a specified f-value. The function uses the
syntax

=F.DIST(x,deg freedoml,deg freedom2,cumulative)

where x is specified f-value that you want to test; deg_freedom1 is the degrees
of freedom in the first, or numerator, sample; deg_freedomz is the degrees of
freedom in the second, or denominator, sample, and cumulative is alogical
value (either 0 or 1) that tells Excel whether you want to calculate the cumula-
tive distribution (indicated by setting cumulative to 0) or the probability
density (indicated by setting cumulative to 1).

As an example of how the FEDIST function works, suppose you compare two
sample’s variances, one equal to 2 and one equal to 4. This means the f-value
equals 0. 5. Further assume that both samples number 10 items, which
means both samples have degrees of freedom equal to 9 and that you want to
calculate a cumulative probability. The formula

=F.DIST(2/4,9,9,0)

returns the value 0.6851816.
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FDIST.RT: Right-tailed (-distribution
probability

The FDIST.RT function resembles the F.DIST function. FDIST.RT returns the
right-tailed probability of observing a ratio of two samples’ variances as large
as a specified f-value. The function uses the syntax

=F.DIST.RT (x,deg_ freedoml,deg freedom2,cumulative)

where x is specified f-value that you want to test; deg_freedomi is the degrees
of freedom in the first, or numerator, sample; deg freedomz2 is the degrees of
freedom in the second, or denominator, sample, and cumulative is a logical
value (either 0 or 1) that tells Excel whether you want to calculate the cumu-
lative distribution (indicated by setting cumulative to 0) or the probability
density (indicated by setting cumulative to 1).

As an example of how the FDIST.RT function works, suppose you compare
two sample’s variances, one equal to 2 and one equal to 4. This means the
f-value equals 0. s. Further assume that both samples number 10 items,
which means both samples have degrees of freedom equal to 9 and that you
want to calculate a cumulative probability. The formula

=F.DIST.RT(2/4,9,9)

returns the value 0.841761 suggesting that there’s roughly an 84-percent
probability that you might observe an f-value as large as 0.5 if the samples’
variances were equivalent.

FINU:Left-tailed (-value given
f-distribution probability

The FINV function returns the left-tailed f-value equivalent to a given
f-distribution probability. The function uses the syntax

=F.INV(probability,deg freedoml,deg freedomz2)

where probability is probability of the f value that you want to find;
deg_freedom1 is the degrees of freedom in the first, or numerator, sample;
and deg_freedomz is the degrees of freedom in the second, or denominator,
sample.
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FINU.RT:Right-tailed f-value given
{-distribution probability

The FINV.RT function returns the right-sided f-value equivalent to a given
f-distribution probability. The function uses the syntax

=F.INV.RT(probability,deg freedoml,deg freedomz2)
where probability is probability of the f-value that you want to find;
deg_freedoml is the degrees of freedom in the first, or numerator, sample;

and deg_freedomz is the degrees of freedom in the second, or denominator,
sample.

F.TEST: Probability data set
variances not different

The FETEST function compares the variances of two samples and returns the
probability that variances aren’t significantly different. The function uses the
syntax

=F.TEST (arrayl,arrayz2)

where arrayi is a worksheet range holding the first sample and array2is a
worksheet range holding the second sample.

Binomial Distributions

Binomial distributions let you calculate probabilities in two situations:
»* When you have a limited number of independent trials, or tests, which
can either succeed or fail
» When success or failure of any one trial is independent of other trials
[ also discuss Excel’s sole hypergeometric distribution function here with the

binomial functions because, as you'll see if you slog through this discussion,
hypergeometric distributions are related to binomial distributions.
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BINOM.DIST: Binomial probability
distribution

The BINOM.DIST function finds the binomial distribution probability. The
function uses the syntax

=BINOM.DIST (number_s, trials,probability s,cumulative)

where number._s is the specified number of successes that you want, trials
equals the number of trials you'll look at, probability s equals the prob-
ability of success in a trial, and cumulative is a switch that’s set to either
the logical value TRUE (if you want to calculate the cumulative probability) or
the logical value FALSE (if you want to calculate the exact probability).

For example, if a publisher wants to know the probability of publishing three
best-selling books out of a set of ten books when the probability of publishing
a best-selling book is ten percent, the formula is

=BINOM.DIST (3,10, .1, FALSE)
which returns the value 0. 0574. This indicates that there’s roughly a 6-percent
chance that in a set of ten books, a publisher will publish exactly three best-
selling books.

To calculate the probability that a publisher will publish either one, two, or
three bestsellers in a set of ten books, the formula is

=BINOM.DIST (3,10, .1, TRUE)
which returns the value 0.9872, which indicates that there is roughly a

99-percent chance that a publisher will publish between one and three best-
sellers in a set of ten books.

BINOM.INV: Binomial probability
distribution

The BINOM.INV function find smallest value for which the cumulative bino-
mial distribution equals or exceeds a specified criterion, or alpha, value. The
function uses the syntax

=BINOM. INV (trials, probability s,alpha)
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where trials equals the number of Bernoulli trials you'll look at,
probability s equals the probability of success in a trial, and alpha
equals the criterion value you want to meet or beat.

If you set the trials to 10, the probability to .5 and the criterion value to .75,
for example, the formula is

=BINOM.INV(10,0.5,0.75)

which returns the value 6.

BINOM.DIST.RANGE: Binomial
probability of Trial Result

The BINOM.DIST.RANGE function finds the probability of a trial result or a
range of trial results for a binomial distribution. The function uses the syntax

=BINOM.DIST.RANGE (trials, probability s,number_s, [number s2])

where trials equals the number of trials you'll look at, probability s
equals the probability of success in a trial, number _s sets the number of
successful trials, and number._s2 (which is an optional argument) sets the
maximum number of successful trials. (If you do set the maximum number
of successful trials using the number_s2 argument, number._s sets the mini-
mum number of trials.)

If you set the trials to 10, the probability to .5 and the number of successful
trials to 3, for example, the formula is

=BINOM.DIST.RANGE(10,0.5,3)

which returns the value 0.11718, meaning the probability of having exactly
three successful trials equals roughly 12%.

If you set the trials to 10, the probability to .5 and the number of successful
trials to anything from 3 to 10, for example, the formula is

=BINOM.DIST.RANGE(10,0.5,3,10)

which returns the value 0.9453, meaning the probability of the number of
successful trials range anywhere from 3 to 10 equals roughly 95%.
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NEGBINOM.DIST: Negative
binominal distribution

The NEGBINOM.DIST function finds the probability that a specified number
of failures will occur before a specified number of successes based on a
probability-of-success constant. The function uses the syntax

=NEGBINOM.DIST (number_f,number_s,probability s)

where number._f is the specified number of failures, number._sis the speci-
fied number of successes, probability s is the probability of success, and
cumulative is a switch you set to 0 or FALSE if you want a cumulative dis-
tribution and to 1 or TRUE if you want a probability distribution.

For example, suppose you're a wildcat oil operator and you want to know the
chance of failing to find oil in exactly ten wells before you find oil in exactly
one well. If the chance for success is 5 percent, you can find the chance that
you'll fail ten times before drilling and finding oil by using the formula

=NEGBINOM.DIST (10,2, .05, 0)

which returns the value 0.016465266, indicating that there’s less than a
2-percent chance that you'll fail ten times before hitting a gusher.

CRITBINOM: Cumulative
binomial distribution

The CRITBINOM function, which is really an old Excel function and avail-
able in recent versions of Excel for reasons of backwards compatibility, finds
the smallest value for which the cumulative binomial distribution equals or
exceeds a criterion value. The function uses the syntax

=CRITBINOM (trials, probability s,alpha)
where trialsis the number of Bernoulli trials, probability sis the prob-

ability of success for each trial, and alpha equals your criterion value. Both
the probability sand alpha arguments must fall between 0 and 1.
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HYPGEOM.DIST: Hypergeometric
distribution

The HYPERGEOMETRIC function returns the probability of a specified
number of sample successes. A hypergeometric distribution resembles a
binomial distribution except with a subtle difference. In a hypergeometric
distribution, the success in one trial affects the success in another trial.
Typically, you use a the HYPGEOM.DIST function when you take samples
from a finite population and don’t replace the samples for subsequent trials.
The function uses the syntax

=HYPGEOM.DIST (sample_s,number sample,population s,number
pop, cumulative)

where sample_s equals the specified number of sample successes, number.
sample gives the size of the sample, population_s gives the number of suc-
cesses in the population, number._pop gives the size of the population, and
cumulative is a switch which tells Excel to return either a cumulative distri-
bution (indicated with a 1 or TRUE argument value) or a probability density
(indicated with a 0 or FALSE argument value).

As an example of a hypergeometric distribution, suppose you want to calcu-
late the probability that in a sample of 30 items, 5 will be successful. Further
suppose you know that within a 4,000-item population, 1,000 are successful.
You use the following formula to make this calculation:

=HYPGEOM.DIST (5,30,1000,4000,0)
which returns the value 0.0104596, indicating that the chances that exactly

5 items will be successful in a set of 30 items given the characteristics of the
population equals roughly 10 percent.

Chi-Square Distributions

3

[ get very confused, personally, when I start working with statistical measures
that are more complicated than those simple calculations that you learn in
junior high. Yet the chi-square functions, which I discuss next, really are prac-
tical. [ take this one slow and use an easy-to-understand example.

Even if you're going to use only one of the chi-square functions, read through
all three function descriptions. Viewed as a set of statistical tools, the func-
tions make quite a bit more sense.
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Figure 9-6:
A worksheet

fragment |-

we'll use

to look at |
chi-square |3

measures.

CHISO.DIST.RT: Chi-square distribution

The CHISQ.DIST.RT function, which calculates the right-tailed probability of
a chi-squared distribution, calculates a level of significance using the chi-
square value and the degrees of freedom. The chi-square value equals the
sum of the squared standardized scores. The function uses the syntax

=CHISQ.DIST.RT(x,deg freedom)

where x equals the chi-square value and deg_freedomequals the degrees of
freedom.

As an example of how all this works, suppose you're more than a little suspi-
cious of some slot machine that shows one of six pictures: diamonds, stars,
cowboy boots, cherries, oranges, or pots of gold. With six possibilities, you
might expect that in a large sample, each of the six possibilities would appear
roughly one-sixth of the time. Say the sample size is 180, for example. In this
case, you might expect that each slot machine possibility appears 30 times
because 180/6 equals 30. If you built a worksheet fragment like the one shown
in Figure 9-6, you could analyze the one-armed bandit.

0 0433333
35 0 0433333
& Oranges 0 2313
7 Pots O’ Gold a0 W 3333333
3 180 160 15

10| chi-scuare Distribution 0.010202)
12 Chi-square Distribution ewerse 13

4 |Chi-squara Tast 0.610362

Sheet!

To calculate the level of significance using the data shown in Figure 9-6 and
the chi-square distribution function, you could enter the following formula
into D10:

=CHISQ.DIST.RT (D8, 5)
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The function returns the value 0.010362338, which is the level of signifi-
cance that a chi-square value of 15 is due to sampling error.

Cell D8 holds the chi-square value, which is simply the sum of the squared
differences between the observed and expected values. For example, the
value in cell D2 is calculated using the formula =+ (B2-C2) *2/C2 to return
the value 3.333333333. Predictably, similar formulas in the range D3:D7 cal-
culate the squared differences for the other slot machine symbols. And, oh,
by the way, the formula in cell D8 is =sUM (D2 :D7).

The bottom line: It doesn’t look good, does it? I mean, that there’s only a
1-percent chance that the slot machine that you're worried about could actu-
ally produce the observed values due to chance. Very suspicious. . . .

CHISO.DIST: Chi-square distribution

The CHISQ.DIST function resembles the CHISQ.DIST.RT function but calcu-
lates the left-tailed probability of a chi-squared distribution. The function uses
the syntax

=CHISQ.DIST (x, deg freedom, cumulative)
where x equals the chi-square value, deg_freedom equals the degrees of
freedom, and cumulative is a switch you set to 0 or FALSE if you want to

calculate a probability density and to 1 or TRUE if you want to calculate a
cumulative probability.

CHISQ.INU.RT: Right-tailed chi-square
distribution probability

The CHISQ.INV.RT function returns the inverse of the right-tailed probability
of a chi-square distribution. The function uses the syntax

=CHISQ.INV.RT (probability, deg freedom)

where probability equals the level of significance and deg_freedom
equals the degrees of freedom.
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To show you an example of the CHISQ.INV.RT function, refer to the work-
sheet fragment shown in Figure 9-6. With six possible outcomes on the slot
machine, you have five degrees of freedom. Therefore, if you want to calcu-
late the chi-square that’s equivalent to a 0.010362338 level of significance, you
could enter the following formula into cell D12:

=CHISQ.INV.RT (D10, 5)
This function returns the value 14 .99996888, which is pretty darn close
to 15...solcallit 15. Note that [ use D10 as the first probability argument

because that cell holds the level of significance calculated by the CHISQ.DIST
function.

CHISO.INV: Left-tailed chi-square
distribution probability

The CHISQ.INV function returns left-tailed probability of a chi-square distribu-
tion. The function uses the syntax

=CHISQ.INV (probability,deg freedom)

where probability equals the level of significance and deg_freedom
equals the degrees of freedom.

To calculate the chi-square value that’s equivalent to a 0.010362338 level of

significance with 5 degrees of freedom, you could enter the following formula

into a cell in the worksheet shown in Figure 9-6:
=CHISQ.INV(0.010362338,5)

This function returns the value .562927.

CHISO.TEST: Chi-square test

The chi-square test function lets you assess whether differences between the
observed and expected values represent chance, or sampling error. The func-
tion uses the syntax

=CHISQ.TEST (actual_ range, expected range)
Again referring to the example of the suspicious slot machine shown in
Figure 9-6, you could perform a chi-square test by entering the following formula
into cell D14 and then comparing what you observe with what you expect:

=CHISQ.TEST (B2:B7,C2:C7)
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The function returns the p-value, or probability, shown in Figure 9-6 in cell
D14, indicating that only a 1.0362-percent chance exists that the differences
between the observed and expected outcomes stem from sampling error.

A common feature of a chi-square test is comparison of the p-value — again
the value that the CHISQ.TEST function returns — to a level of significance.
For example, in the case of the suspicious slot machine, you might say,
“Because it’s not possible to be 100-percent sure, we’ll say that we want

a 95-percent probability, which corresponds to a 5-percent level of sig-
nificance.” If the p-value is less than the level of significance, you assume
that something is fishy. Statisticians, not wanting to sound so earthy, have
another phrase for this something-is-fishy conclusion: rejecting the null
hypothesis.

Regression Analysis

3

Excel’s regression functions let you perform regression analysis. In a nutshell,
regression analysis involves plotting pairs of independent and dependent vari-
ables in an XY chart and then finding a linear or exponential equation that
describes the plotted data.

FORECAST: Forecast dependent
variables using a best-fit line

The FORECAST function finds the y-value of a point on a best-fit line pro-
duced by a set of x- and y-values given the x-value. The function uses the
syntax

=FORECAST (x, known_y's,known _x's)

where x is the independent variable value, known_y 'sis the worksheet
range holding the dependent variables, and known_x's is the worksheet
range holding the independent variables.

The FORECAST function uses the known _y's and known_x's values that
you supply as arguments to calculate the y=mx+b equation that describes the
best-fit straight line for the data. The function then solves that equation using
the x argument that you supply to the function.

To use the linear regression functions such as the FORECAST function, remem-
ber the equation for a line is y=mx+b. y is the dependent variable, b is the
y-intercept or constant, m is the slope, and x gives the value of the indepen-
dent variable.
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INTERCEPT: y-axis intercept of a line

The INTERCEPT function finds the point where the best-fit line produced by a
set of x- and y-values intersects the y-axis. The function uses the syntax

=INTERCEPT (known_y's, known_x's)

where known_y ' s is the worksheet range holding the dependent variables
and known_x 's is the worksheet range holding the independent variables.

If you've ever plotted pairs of data points on an XY graph, the way the
INTERCEPT function works is pretty familiar. The INTERCEPT function uses
the known_y's and known_x's values that you supply as arguments to
calculate the best-fit straight line for the data — essentially figuring out the
y=mx+b equation for the line. The function then returns the b value because
that’s the value of the equation when the independent, or x, variable equals
zZero.

LINEST

The LINEST function finds the m and b values for a line based on sets of
known_y's and known_x's variables. The function uses the syntax

=LINEST (known_y's, [known x's], [const], [stats])

where known_y 's equals the array of y-values that you already know,
known_x's supplies the array of x-values that you may already know, const
is a switch set to either TRUE (which means the constant b equals 0) or to
TRUE (which means the constant b is calculated), and stats is another
switch set to either TRUE (which means the function returns a bunch of other
regression statistics) or FALSE (which means enough already).

SLOPE: Slope of a regression line

The SLOPE function calculates the slope of a regression line using the x- and
y-values. The functions uses the syntax

=SLOPE (known_y's,known_x's)

An upward slope indicates that the independent, or x, variable positively
affects the dependent, or y, variable. In other words, an increase in x pro-
duces an increase in y. A downward slope indicates that the independent, or
X, variable negatively affects the dependent, or y, variable. The steeper the
slope, the greater the effect of the independent variable on the dependent
variable.
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3

STEYX: Standard error

The STEYX function finds the standard error of the predicted y-value of each
of the x-values in a regression. The function uses the syntax

=STEYX (known_y's,known_x's)

TREND

The TREND function finds values along a trend line, which the function con-
structs using the method of least squares. The syntax looks like this:

=TREND (known_y's, [known x's], [new_x's], [const])

LOGEST: Exponential regression

The LOGEST function returns an array that describes an exponential curve
that best fits your data. The function uses the syntax

=LOGEST (known_y's, [known_x's], [const], [stats])

where known_y'sis the set of y-values, known x'sis the set of x-values,
const is a switch set to either TRUE (which means that b is calculated nor-
mally) or FALSE (which means that b is forced to equal 1), and statsis a
switch that’s set to either TRUE (in which case, the LOGEST function returns
a bunch of additional regression statistics) or FALSE (which tells the function
to skip returning all the extra information).

In an exponential regression, Excel returns an equation that takes the form
y=abx that best fits your data set.

GROWTH: Exponential growth

The GROWTH function calculates exponential growth for a series of new
x-values based on existing x-values and y-values. The function uses the
syntax

=GROWTH (known_y's, [known _x's], [new_x's], [const])

where known_y'sis the set of y-values, known_x'sis the set of x-values,
new_x's Is the set of x-values for which you want to calculate new y-values,
and const is a switch set to either TRUE (which means that b is calculated
normally) or FALSE (which means that b is forced to equal 1).
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Correlation

Excel’s correlation functions let you quantitatively explore the relationships
between variables.

CORREL: Correlation coefficient

The CORREL function calculates a correlation coefficient for two data sets.
The function uses the syntax

=CORREL (arrayl,arrayz2)

where array1i is a worksheet range that holds the first data set and array2
is a worksheet range that holds the second data set. The function returns a
value between -1 (which would indicate a perfect, negative linear relation-
ship) and +1 (which would indicate a perfect, positive linear relationship).

PEARSON: Pearson correlation coefficient

The PEARSON calculates a correlation coefficient for two data sets by using a
different formula than the CORREL function does but one that should return
the same result. The function uses the syntax

=PEARSON (arrayl, array2)

where array1i is a worksheet range that holds the first data set and array2
is a worksheet range that holds the second data set. The function returns a
value between -1 (which would indicate a perfect, negative linear relation-
ship) and +1 (which would indicate a perfect, positive linear relationship).

RSQ: r-squared value for a Pearson
correlation coefficient

The RSQ function calculates the r-squared square of the Pearson correlation
coefficient. The function uses the syntax

=RSQ (known_y's, known _x's)

where known_y 'sis an array or worksheet range holding the first data set
and known_x 'sis an array or worksheet range holding the second data set.
The r-squared value describes the proportion of the variance in y stemming
from the variance in x.
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FISHER

The FISHER function converts Pearson’s r-squared value to the normally dis-
tributed variable z so you can calculate a confidence interval. The function
uses the syntax

=FISHER (r)

FISHERINV

The FISHERINV function, the inverse of the FISHER function, converts z to
Pearson’s r-squared value. The function uses the syntax

=FISHERINV (y)

Some Really Esoteric Probability
Distributions

Excel supplies several other statistical functions for working with probability
distributions. It'’s very unlikely, it seems to me, that you'll ever work with any
of these functions except in an upper-level college statistics course, thus I

go over these tools quickly. A couple of them, though — the ZTEST and the
POISSON functions, in particular — are actually pretty useful.

BETA.DIST: Cumulative beta
probability density

The BETA.DIST function finds the cumulative beta probability density —
something that you might do to look at variation in the percentage of some
value in your sample data. The Excel online Help file, for example, talks about
using the function to look at the fraction of the day that people spend watch-
ing television. And I recently read a fisheries management study that uses
beta probability distributions to report on the effects of setting aside a per-
centage of marine habitat for reserves. The function uses the syntax

=BETA.DIST (x,alpha, beta, cumulative, [A], [B])
where x is a value between the optional bounds A and B, alpha and beta

are the two positive parameters, and cumulative is a switch you set to 0 or
FALSE if you want to calculate a cumulative distribution and to 1 or TRUE if
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you want to calculate a probability density. If x equals .5, alpha equals 75,
beta equals 85, you set the cumulative switch to 1 to calculate a probabil-
ity density, and A equals 0, and B equals 1, use following formula:

=BETA.DIST(.5,75,85,1,0,1)
This function returns the value 0.786080098.

If you leave out the optional bounds arguments, Excel assumes that A equals 0
and that B equals 1. The function =BETADIST(.5,75,85), for example, is equiva-
lent to =BETADIST(.5,75,85,0,1).

BETA.INU: Inverse cumulative
beta probability density

The BETA.INV function returns the inverse of the cumulative beta probability
density function. That is, you use the BETA.DIST function if you know x and
want to find the probability; and you use the BETA.INV function if you know
the probability and want to find x. The BETA.INV function uses the syntax

=BETA.INV (probability,alpha, beta, [A], [B])

EXPON.DIST: Exponential
probability distribution

The EXPON.DIST function calculates an exponential distribution, which can
be used to describe the probability that an event takes a specified amount of
time. The function uses the syntax

=EXPON.DIST (x, lambda, cumulative)

where x is the value you want to evaluate, 1ambda is the inverse of the mean,
and cumulative is a switch set to either TRUE (if you want the function to
return the probability up to and including the x value) or FALSE (if you want
the function to return the exact probability of the x value).

For example, suppose that at a certain poorly run restaurant, you usually
have to wait 10 minutes for your waitperson to bring a glass of water. That's
the average wait time, in other words. To determine the probability that you'll
get your water in 5 minutes or less, use the formula

=EXPON.DIST(5,1/10, TRUE)
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which returns the value 0.393469, indicating you have (roughly) a 39-percent
chance of getting something to drink in 5 minutes or less.

To determine the probability that you'll get your water in exactly 5 minutes,
you use the formula

=EXPON.DIST(5,1/10,FALSE)

which returns the value 0.060653, indicating there’s roughly a 6-percent
chance that you'll get something to drink in exactly 5 minutes.

GAMMA.DIST: Gamma distribution
probability

The GAMMA.DIST function finds the gamma distribution probability of the
random variable x. The function uses the syntax

=GAMMA .DIST (x, alpha, beta, cumulative)
where x equals the random variable, alpha and beta describe the constant
rate, and cumulative is a switch set to TRUE if you want a cumulative prob-

ability and FALSE if you want an exact probability.

If x equals 20, alpha equals 5, beta equals 2, and cumulative is set to
TRUE, you use the formula

=GAMMA .DIST (20,5, 2, TRUE)

which returns the value 0.97075, indicating the probability equals roughly
97 percent.

If x equals 20, alpha equals 5, beta equals 2, and cumulativeis set to
FALSE, you use the formula

=GAMMA .DIST (20,5, 2, FALSE)

which returns the value 0.0094s, indicating the probability is less than
1 percent.
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GAMMAINU: X for a given gamma
distribution probability

The GAMMAINV function finds the x value associated with a given gamma
distribution probability. The function uses the syntax

=GAMMAINV (probability,alpha, beta)

where probability equals the probability for the x value you want to find
and alpha and beta are the parameters to the distribution.

GAMMALN: Natural logarithm
of a gamma distribution

The GAMMALN function finds the natural logarithm of the gamma function.
The GAMMALN function uses the syntax

=GAMMALN (x)

LOGNORMDIST: Probability
of lognormal distribution

The LOGNORMDIST function calculates the probability associated with a log-
normal distribution. The function uses the syntax

=LOGNORMDIST (x, mean, standard_dev)
where x is the value for which you want to find the probability, mean is

the arithmetic mean, and standard_dev, of course, equals the standard
deviation.

LOGINV: Value associated with lognormal
distribution probability

The LOGINV function calculates the value associated with a lognormal distri-
bution probability. The function uses the syntax

=LOGINV (probability, mean, standard dev)
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where probability is the probability of a lognormal distribution, mean is
the arithmetic mean, and standard_dev is the standard deviation.

POISSON: Poisson distribution
probabilities

The POISSON function calculates probabilities for Poisson distributions. The
function uses the syntax

=POISSON (x, mean, cumulative)

where x is the number of events, mean is the arithmetic mean, and cumulative
is a switch. If set to TRUE, this switch tells Excel to calculate the Poisson prob-
ability of a variable being less than or equal to x; if set to FALSE, it tells Excel to
calculate the Poisson probability of a variable being exactly equal to x.

To illustrate how the Poisson function works, suppose you want to look at
some probabilities associated with cars arriving as a drive-through car wash.
(This type of analysis of events occurring over a specified time interval is a
common application of Poisson distributions.) If on average, 20 cars drive up
an hour, you can calculate the probability that exactly 15 cars will drive up
using the formula

=POISSON (15,20, FALSE)

This function returns the value 0.051648854, indicating that there’s roughly
a 5-percent chance that exactly 15 cars will drive up in an hour.

To calculate the probability that 15 cars or fewer will drive up in an hour, use
the following formula:

=POISSON (15,20, TRUE)

This function returns the value 0.156513135, indicating that there’s roughly
a l6-percent chance that 15 or fewer cars will drive up in an hour.

WEIBULL: Weibull distribution

The WEIBULL function returns either the cumulative distribution or the prob-
ability mass for a Weibull distribution. The function uses the syntax

=WEIBULL(x, alpha, beta, cumulative)
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where x is the value for which you want to calculate the distribution; alpha
and beta are, respectively, the alpha and beta parameters to the Weibull
equation, and cumulative is a switch. That switch, if set to TRUE, tells the
function to return the cumulative distribution function; if set to FALSE, it tells
the function to return the probability mass function.

Visit the web page at

http://keisan.casio.com/hasl0/SpecExec.cgi?id=system/
2006/1180573173

to find a calculator that lets you play around with making different graphs
plotting Weibull distributions.

ZTEST: Probability of a z-test

The ZTEST function calculates the probability that a value comes from the
same population as a sample. The function uses the syntax

=ZTEST (array, x, [sigmal )
where array is the worksheet range holding your sample, x is the value you
want to test, and (optionally) sigma is the standard deviation of the popula-
tion. If you omit sigma, Excel uses the sample standard deviation.
For example, to find the probability that the value 75 comes from the popula-
tion as the sample stored in the worksheet range A1:A10, use the following
formula:

=ZTEST (A1:A10,75)



Chapter 10
Descriptive Statistics

In This Chapter
Using the Descriptive Statistics tool
Creating a histogram
Ranking by percentile
Calculating moving averages
Using the Exponential Smoothing tool
Sampling a population
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’ n this chapter, I describe and discuss the simple descriptive statistical
data analysis tools that Excel supplies through the Data Analysis add-in.

[ also describe some of the really simple-to-use and easy-to-understand infer-
ential statistical tools provided by the Data Analysis add-in — including the
tools for calculating moving and exponential averages as well as the tools for
generating random numbers and sampling.

Descriptive statistics simply summarizes large (sometimes overwhelming)
data sets with a few, key calculated values. For example, when you say some-
thing like, “Well, the biggest value in that data set is 345,” that’s a descriptive
statistic.

The simple-yet-powerful Data Analysis tools can save you a lot of time. With
a single command, for example, you can often produce a bunch of descrip-
tive statistical measures such as mean, mode, standard deviation, and so on.
What’s more, the other cool tools that you can use for preparing histograms,
percentile rankings, and moving average schedules can really come in handy.

Perhaps the best thing about these tools, however, is that even if you've had
only a little exposure to basic statistics, none of them are particularly difficult
to use. All the hard work and all the dirty work gets done by Excel. All you
have to do is describe where the input data is.
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Note: You must usually install the Data Analysis tools before you can use
them. To install them, go to File>Options. When Excel displays the Excel
Options dialog box, select the Add-Ins item from the left box that appears
along the left edge of the dialog box. Excel next displays a list of the possible
add-ins — including the Analysis ToolPak add-in. (The Analysis ToolPak is
what the Data Analysis tools are called.) Select the Analysis ToolPak item and
click Go. Excel displays the Add-Ins dialog box. Select Analysis ToolPak from
this dialog box and click OK. Excel installs the Analysis ToolPak add-in.

In Excel 2007, you choose the Office=>Excel Options command to display the
Excel Options dialog box.

Using the Descriptive Statistics Tool

— |
Figure 10-1: |-
Asample |7
data set. |*

Perhaps the most common Data Analysis tool that you’ll use is the one

for calculating descriptive statistics. To see how this works, take a look at

the worksheet shown in Figure 10-1. It summarizes sales data for a book
publisher. In column A, the worksheet shows the suggested retail price (SRP).
In column B, the worksheet shows the units sold of each book through one
popular bookselling outlet. You might choose to use the Descriptive Statistics
tool to summarize this data set.
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|
Figure 10-2:
The Data
Analysis
dialog box.
I

Figure 10-3:
The
Descriptive
Statistics
dialog box.
|

To calculate descriptive statistics for the data set shown in Figure 10-1, follow
these steps:

1. Click the Data tab’s Data Analysis command button to tell Excel that
you want to calculate descriptive statistics.

Excel displays the Data Analysis dialog box, as shown in Figure 10-2.

Data Analysis

Analysis Tools

Anova: Two-Factor Without Replication
Correlation

Covariance

Exponential Smoothing

F-Test Two-Sample for Variances
Fourier Analysis

Histogram

Moving Average

Random Number Generation

? HEN |

ok |

Cancel

Help

2. In Data Analysis dialog box, highlight the Descriptive Statistics entry
in the Analysis Tools list and then click OK.

Excel displays the Descriptive Statistics dialog box, as shown in

Figure 10-3.

Descriptive Statistics

Input
Input Range: $AS1:5C538) 3
Grouped By: (® Columns
) Rows
[7] Labels in First Row

Output options

() Qutput Range: 55
(®) New Worksheet Ply:

) New Workbook

[7] summary statistics

[] Confidence Level for Mean: 95 %

[] kth Largest: 1

[_] kth Smallest: 1

» HEN|

Cancel

Help
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3. In the Input section of the Descriptive Statistics dialog box, identify
the data that you want to describe.

e To identify the data that you want to describe statistically: Click the
Input Range text box and then enter the worksheet range refer-
ence for the data. In the case of the worksheet shown earlier in
Figure 10-1, the input range is $A$1:$C$38. Note that Excel wants
the range address to use absolute references — hence, the dollar
signs.

To make it easier to see or select the worksheet range, click the
worksheet button at the right end of the Input Range text box.
When Excel hides the Descriptive Statistics dialog box, select
the range that you want by dragging the mouse. Then click the
worksheet button again to redisplay the Descriptive Statistics
dialog box.

To identify whether the data is arranged in columns or rows: Select
either the Columns or the Rows radio button.

To indicate whether the first row holds labels that describe the data:
Select the Labels in First Row check box. In the case of the work-
sheet shown in Figure 10-1, the data is arranged in columns, and
the first row does hold labels, so you select the Columns radio
button and the Labels in First Row check box.

4. In the Output Options area of the Descriptive Statistics dialog box,
describe where and how Excel should produce the statistics.

¢ To indicate where the descriptive statistics that Excel calculates

should be placed: Choose from the three radio buttons here —
Output Range, New Worksheet Ply, and New Workbook. Typically,
you place the statistics onto a new worksheet in the existing
workbook. To do this, simply select the New Worksheet Ply radio
button.

To identify what statistical measures you want calculated: Use the
Output Options check boxes. Select the Summary Statistics check
box to tell Excel to calculate statistical measures such as mean,
mode, and standard deviation. Select the Confidence Level for
Mean check box to specify that you want a confidence level cal-
culated for the sample mean. (Nofe: If you calculate a confidence
level for the sample mean, you need to enter the confidence level
percentage into the text box provided.) Use the Kth Largest and
Kth Smallest check boxes to indicate you want to find the largest
or smallest value in the data set.

After you describe where the data is and how the statistics should
be calculated, click OK. Figure 10-4 shows a new worksheet with
the descriptive statistics calculated, added into a new sheet, Sheet 2.
Table 10-1 describes the statistics that Excel calculates.
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Table 10-1 The Measures That the Descriptive
Statistics Tool Calculates

Statistic Description

Mean Shows the arithmetic mean of the sample data.

Standard Error

Shows the standard error of the data set (a measure of the
difference between the predicted value and the actual value).

Median Shows the middle value in the data set (the value that
separates the largest half of the values from the smallest
half of the values).

Mode Shows the most common value in the data set.

Standard Deviation

Shows the sample standard deviation measure for the
data set

Sample Variance

Shows the sample variance for the data set (the squared
standard deviation).

Kurtosis Shows the kurtosis of the distribution.

Skewness Shows the skewness of the data set’s distribution.

Range Shows the difference between the largest and smallest
values in the data set.

Minimum Shows the smallest value in the data set.

Maximum Shows the largest value in the data set.

Sum Adds all the values in the data set together to calculate

the sum.

(continued)
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Table 10-1 (continued)

Statistic Description

Count Counts the number of values in a data set.

Largest(X) Shows the largest Xvalue in the data set.

Smallest{X) Shows the smallest Xvalue in the data set.

Confidence Level(X) Shows the confidence level at a given percentage for the
Percentage data set values.

Creating a Histogram

Use the Histogram Data Analysis tool to create a frequency distribution and,
optionally, a histogram chart. A frequency distribution shows just how values
in a data set are distributed across categories. A histogram shows the same
information in a cute little column chart. Here’s an example of how all this
works — everything will become clearer if you're currently confused.

To use the Histogram tool, you first need to identify the bins (categories)
that you want to use to create a frequency distribution. The histogram plots
out how many times your data falls into each of these categories. Figure 10-5
shows the same worksheet as Figure 10-1, only this time with bins information
in the worksheet range E1:E12. The bins information shows Excel exactly
what bins (categories) you want to use to categorize the unit sales data. The
bins information shown in the worksheet range E1:E12, for example, create
hundred-unit bins: 0-100, 101-200, 201-300, and so on.

TH 5
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X, Cut 2 » AN
,
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Figure 10-5: |:
Another |
version of |-
the book |2
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information
worksheet. |* -
I
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To create a frequency distribution and a histogram using the data shown in
Figure 10-5, follow these steps:

1. Click the Data tab’s Data Analysis command button to tell Excel that
you want to create a frequency distribution and a histogram.

2. When Excel displays the Data Analysis dialog box (refer to Figure 10-2),
select Histogram from the Analysis Tools list and click OK.

3. In the Histogram dialog box that appears, as shown in Figure 10-6,
identify the data that you want to analyze.

Use the Input Range text box to identify the data that you want to use
to create a frequency distribution and histogram. If you want to create
a frequency distribution and histogram of unit sales data, for example,
enter the worksheet range $B$1:$B$38 into the Input Range text box.

Histogram ? “—
Input
= oK
Input Range: $BS1:58538 %
Cancel
Bin Range: SES1:SES12 B
V] Labels Help
Output options
_) Qutput Range: 3
I -
(®) New Worksheet Ply:
Figure 10-6: ) New Workbook
Create a [T] Pareto (sorted histogram)
histogram [V] Cumulative Percentage
[¥] Chart Output
here. | ¢ g
I

To identify the bins that you use for the frequency distribution and
histogram, enter the worksheet range that holds the bins into the
Bin Range text box. In the case of the example worksheet shown in
Figure 10-5, the bin range is $E$1:$E$12.

If your data ranges include labels (as they do in Figure 10-5), select the
Labels check box.

4. Tell Excel where to place the frequency distribution and histogram.

Use the Output Options buttons to tell Excel where it should place the
frequency distribution and histogram. To place the histogram in the
current worksheet, for example, select the Output Range radio button
and then enter the range address into its corresponding Output Range
text box.
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To place the frequency distribution and histogram in a new worksheet,
select the New Worksheet Ply radio button. Then, optionally, enter a
name for the worksheet into the New Worksheet Ply text box. To place the
frequency distribution and histogram information in a new workbook,
select the New Workbook radio button.

. (Optional) Customize the histogram.

Make choices from the Output Options check boxes to control what sort of
histogram Excel creates. For example, select the Pareto (Sorted Histogram)
check box, and Excel sorts bins in descending order. Conversely, if you don’t
want bins sorted in descending order, leave the Pareto (Sorted Histogram)
check box clear.

Selecting the Cumulative Percentage check box tells Excel to plot a line
showing cumulative percentages in your histogram.

Optionally, select the Chart Output check box to have Excel include a
histogram chart with the frequency distribution. If you don’t select this
check box, you don’t get the histogram — only the frequency distribution.

. Click OK.

Excel creates the frequency distribution and, optionally, the histogram.
Figure 10-7 shows the frequency distribution along with a histogram for
the workbook data shown in Figure 10-5.
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Note: Excel also provides a Frequency function with which you use can use
arrays to create a frequency distribution. For more information about how
the Frequency function works, see Chapter 9.

Ranking by Percentile

The Data Analysis collection of tools includes an option for calculating rank
and percentile information for values in your data set. Suppose, for example,
that you want to rank the sales revenue information shown in Figure 10-8. To
calculate rank and percentile statistics for your data set, take the following
steps.

IET
e |
Figure 10-8: |-
The book |7
sales infor- |-
mation (yes,
again). |
I

1. Begin to calculate ranks and percentiles by clicking the Data tab’s
Data Analysis command button.

2. When Excel displays the Data Analysis dialog box, select Rank and
Percentile from the list and click OK.

Excel displays the Rank and Percentile dialog box, as shown in
Figure 10-9.
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3. Identify the data set.

Enter the worksheet range that holds the data into the Input Range text
box of the Ranks and Percentile dialog box.

To indicate how you have arranged data, select one of the two Grouped
By radio buttons: Columns or Rows. To indicate whether the first cell
in the input range is a label, select or deselect the Labels In First Row
check box.

4. Describe how Excel should output the data.

Select one of the three Output Options radio buttons to specify where
Excel should place the rank and percentile information.

5. After you select an output option, click OK.

Excel creates a ranking like the one shown in Figure 10-10.
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Calculating Moving Averages

The Data Analysis command also provides a tool for calculating moving and
exponentially smoothed averages. Suppose, for sake of illustration, that
you've collected daily temperature information like that shown in Figure 10-11.
You want to calculate the three-day moving average — the average of the
last three days — as part of some simple weather forecasting. To calculate
moving averages for this data set, take the following steps.

b ")
— (i
Figure 10-11: |
Aworksheet |*
for calculat- |-
ing a moving |
average of
tempera- |%
tures. |*
I
1. To calculate a moving average, first click the Data tab’s Data Analysis
command button.
2. When Excel displays the Data Analysis dialog box, select the Moving
Average item from the list and then click OK.
Excel displays the Moving Average dialog box, as shown in Figure 10-12.
Moving Average ? _—
Input
Input Range: SAS1:8AS10 .3 ok
[¥] Labels in First Row Cance|
| intenat Liclp
Figllfe 10-12. Output options
Calculate Qutput Range: SBS2:3B510 5.5
mOVing New Worksheet Ply:
averﬂges New Workbook
here. | [¥chartOutput (Vlf§tandard Errors:
I
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3. Identify the data that you want to use to calculate the moving average.

Click in the Input Range text box of the Moving Average dialog box. Then
identify the input range, either by typing a worksheet range address or
by using the mouse to select the worksheet range.

Your range reference should use absolute cell addresses. An absolute cell
address precedes the column letter and row number with $ signs, as in
$A$1:$A$10.

If the first cell in your input range includes a text label to identify or
describe your data, select the Labels in First Row check box.

4. In the Interval text box, tell Excel how many values to include in the
moving average calculation.

You can calculate a moving average using any number of values. By
default, Excel uses the most recent three values to calculate the moving
average. To specify that some other number of values be used to calcu-
late the moving average, enter that value into the Interval text box.

5. Tell Excel where to place the moving average data.

Use the Output Range text box to identify the worksheet range into
which you want to place the moving average data. In the worksheet
example shown in Figure 10-11, for example, I place the moving average
data into the worksheet range B2:B10. (See Figure 10-12.)

6. (Optional) Specify whether you want a chart.

If you want a chart that plots the moving average information, select the
Chart Output check box.

7. (Optional) Indicate whether you want standard error information
calculated.

If you want to calculate standard errors for the data, select the Standard
Errors check box. Excel places standard error values next to the moving
average values. (In Figure 10-11, the standard error information goes into
C2:C10.)

8. After you finish specifying what moving average information you
want calculated and where you want it placed, click OK.

Excel calculates moving average information, as shown in Figure 10-13.

Note: 1f Excel doesn’t have enough information to calculate a moving aver-
age for a standard error, it places the error message #N/A into the cell. In
Figure 10-13, you can see several cells that show this error message as a
value.
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Exponential Smoothing

The Exponential Smoothing tool also calculates the moving average. However,
exponential smoothing weights the values included in the moving average
calculations so that more recent values have a bigger effect on the average
calculation and old values have a lesser effect. This weighting is accom-
plished through a smoothing constant.

To illustrate how the Exponential Smoothing tool works, suppose that you're

again looking at the average daily temperature information. (I repeat this
worksheet in Figure 10-14.)

To calculate weighted moving averages using exponential smoothing, take
the following steps:

1. To calculate an exponentially smoothed moving average, first click the
Data tab’s Data Analysis command button.

2. When Excel displays the Data Analysis dialog box, select the Exponential
Smoothing item from the list and then click OK.

Excel displays the Exponential Smoothing dialog box, as shown in
Figure 10-15.
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3. Identify the data.

To identify the data for which you want to calculate an exponentially
smoothed moving average, click in the Input Range text box. Then iden-
tify the input range, either by typing a worksheet range address or by
selecting the worksheet range. If your input range includes a text label to
identify or describe your data, select the Labels check box.

. Provide the smoothing constant.

Enter the smoothing constant value in the Damping Factor text box. The
Excel Help file suggests that you use a smoothing constant of between
0.2 and 0.3. Presumably, however, if you're using this tool, you have
your own ideas about what the correct smoothing constant is. (If you're
clueless about the smoothing constant, perhaps you shouldn’t be using
this tool.)
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5. Tell Excel where to place the exponentially smoothed moving
average data.

Use the Output Range text box to identify the worksheet range into which
you want to place the moving average data. In the worksheet example
shown in Figure 10-14, for example, you place the moving average data
into the worksheet range B2:B10.

6. (Optional) Chart the exponentially smoothed data.

To chart the exponentially smoothed data, select the Chart Output
check box.

7. (Optional) Indicate that you want standard error information calculated.

To calculate standard errors, select the Standard Errors check box. Excel
places standard error values next to the exponentially smoothed moving
average values.

8. After you finish specifying what moving average information you
want calculated and where you want it placed, click OK.

Excel calculates moving average information, as shown in Figure 10-16.
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Generating Random Numbers

The Data Analysis command also includes a Random Number Generation
tool. The Random Number Generation tool is considerably more flexible
than the =rRand () function, which is the other tool that you have available
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Figure 10-17:
Generate
random
numbers
here.
]

3

within Excel to produce random numbers. The Random Number Generation
tool isn’t really a tool for descriptive statistics. You would probably typically
use the tool to help you randomly sample values from a population, but

[ describe it here in this chapter, anyway, because it works like the other
descriptive statistics tools.

To produce random numbers, take the following steps:
1. To generate random numbers, first click the Data tab’s Data Analysis
command button.

Excel displays the Data Analysis dialog box.

2. In the Data Analysis dialog box, select the Random Number Generation
eniry from the list and then click OK.

Excel displays the Random Number Generation dialog box, as shown in
Figure 10-17.

Random Number Generation ? n_

Number of Variables: | | ok
Number of Random Numpbers: Cancel
Distribution: Discrete v Help

Parameters
Value and Probability Input Range:
7

Random Seed:

Output options

O Qutput Range: %
(®) New Worksheet Ply:

() New Workbook

3. Describe how many columns and rows of values that you want.

Use the Number of Variables text box to specify how many columns

of values you want in your output range. Similarly, use the Number of
Random Numbers text box to specify how many rows of values you want
in the output range.

You don’t absolutely need to enter values into these two text boxes, by
the way. You can also leave them blank. In this case, Excel fills all the
columns and all the rows in the output range.
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4. Select the distribution method.

Select one of the distribution methods from the Distribution drop-down
list. The Distribution drop-down list provides several distribution methods:
Uniform, Normal, Bernoulli, Binomial, Poisson, Patterned, and Discrete.
Typically, if you want a pattern of distribution other than Uniform, you’ll
know which one of these distribution methods is appropriate. For example,
if you want to pull random numbers from a data set that’s normally distrib-
uted, you might select the Normal distribution method.

5. (Optional) Provide any parameters needed for the distribution method.

If you select a distribution method that requires parameters, or input
values, use the Parameters text box (Value and Probability Input Range)
to identify the worksheet range that holds the parameters needed for
the distribution method.

6. (Optional) Select a starting point for the random number generation.

You have the option of entering a value that Excel will use to start its
generation of random numbers. The benefit of using a Random Seed
value, as Excel calls it, is that you can later produce the same set of
random numbers by planting the same “seed.”

7. Identify the output range.

Use the Output Options radio buttons to select the location that you
want for random numbers.

8. After you describe how you want Excel to generate random numbers
and where those numbers should be placed, click OK.

Excel generates the random numbers.

Sampling Data

One other data analysis tool — the Sampling tool — deserves to be discussed
someplace. I describe it here, even if it doesn’t fit perfectly.

Truth be told, both the Random Number Generation tool (see the preceding
section) and the Sampling tool are probably what you would use while pre-
paring to perform inferential statistical analysis of the sort that [ describe in
Chapter 11. But because these tools work like (and look like) the other descrip-
tive statistics tools, I describe them here.

With the Sampling tool that’s part of the Data Analysis command, you can
randomly select items from a data set or select every nth item from a data
set. For example, suppose that as part of an internal audit, you want to
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randomly select five titles from a list of books. To do so, you could use the
Sampling tool. For purposes of this discussion, pretend that you're going to
use the list of books and book information shown in Figure 10-18.
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To sample items from a worksheet like the ones shown in Figure 10-18, take
the following steps:
1. To tell Excel that you want to sample data from a data set, first click
the Data tab’s Data Analysis command button.
2. When Excel displays the Data Analysis dialog box, select Sampling
from the list and then click OK.
Excel displays the Sampling dialog box, as shown in Figure 10-19.
Sampling ? IEN |
Input
!f:)ut Range: SAS1:5AS38 5.3
Labels Cancel
Sampling Method Help
(®) Periodic
Period: 5
(0 Random
I Number of Samples: 5
ngl’e 10-19: Output options
Seta data O Qutput Range: 2
sampling (®) New Worksheet Ply:
hem. () New Workbook
|
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3. Identify the input range.

Use the Input Range text box to describe the worksheet range that
contains enough data to identify the values in the data set. For example,
in the case of the data set like the one shown in Figure 10-18, the infor-
mation in column A — TitleID — uniquely identifies items in the data
set. Therefore, you can identify (or uniquely locate) items using the
input range A1:A38. You can enter this range into the Input Range text
box either by directly typing it or by clicking in the text box and then
dragging the cursor from cell Al to cell A38.

If the first cell in the input range holds the text label that describes the
data — this is the case in Figure 10-18 — select the Labels check box.

. Choose a sampling method.

Excel provides two sampling methods for retrieving or identifying items
in your data set:

e Periodic: A periodic sampling method grabs every nth item from
the data set. For example, if you choose every fifth item, that’s
periodic sampling. To select or indicate that you want to use peri-
odic sampling, select the Periodic radio button. Then enter the
period into its corresponding Period text box.

e Random: To randomly choose items from the data set, select the
Random radio button and then enter the number of items that you
want in the Number of Samples text box.

. Select an output area.

Select from the three radio buttons in the Output Options area to select
where the sampling result should appear. To put sampling results into
an output range in the current worksheet, select the Output Range radio
button and then enter the output range into the text box provided. To
store the sampling information in a new worksheet or on a new work-
book, select either the New Worksheet Ply or the New Workbook radio
button.

Note that Excel grabs item information from the input range. For example,
Figure 10-20 shows the information that Excel places on a new worksheet
if you use periodic sampling and grab every fifth item. Figure 10-21 shows
how Excel identifies the sample if you randomly select five items. Note
that the values shown in both Figures 10-20 and 10-21 are the title ID num-
bers from the input range.
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Chapter 11
Inferential Statistics

In This Chapter
Discovering the Data Analysis t-test tools

Performing a z-test

Creating a scatter plot

Using the Regression tool that comes with Data Analysis

Using the Correlation tool that comes with Data Analysis

Implementing the ANOVA data analysis tools

Comparing variances from populations with the f-test Data Analysis tool
Using the Fourier Data Analysis tool

&'W“"o

’ n this chapter, I talk about the more sophisticated tools provided by

the Excel Data Analysis add-in, such as t-test, z-test, scatter plot, regres-
sion, correlation, ANOVA, f-test, and Fourier. With these other tools, you can
perform inferential statistics, which you use to first look at a set of sample
observations drawn from a population and then draw conclusions — or make
inferences — about the population’s characteristics. (To read about the sim-
pler descriptive statistical data analysis tools that Excel supplies through the
Data Analysis add-in, skip back to Chapter 10.)

Obviously, in order to use these tools, you need pretty developed statistical
skills, a good basic statistics course in college or graduate school, and then
probably one follow-up course. But with some reasonable knowledge of statis-
tics and a bit of patience, you can use some of these tools to good advantage.

Note: You must install the Data Analysis add-in before you can use it. To
install the Data Analysis add-in, choose File>Excel Options. When Excel dis-
plays the Excel Options dialog box, select the Add-Ins item from the left box
that appears along the left edge of the Excel Options dialog box. Excel next
displays a list of the possible add-ins, including the Analysis ToolPak add-
in. Select the Analysis ToolPak item and click Go. Excel displays the Add-Ins
dialog box. Select Analysis ToolPak from this dialog box and click OK. Excel
installs the Analysis ToolPak add-in.

In Excel 2007, you choose Office=>Excel Options to install the Data Analysis
add-in.
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The sample workbooks used in the examples in this chapter can be down-
loaded from the book’s companion website. See this book’s Introduction for
instructions on how to access the website.

Using the t-test Data Analysis Tool

Figure 11-1: |:
Some fake |
datayou |
canuseto |2
perform |
ttest |2

calculations.

The Excel Data Analysis add-in provides three tools for working with t-values
and t-tests, which can be useful when you want to make inferences about
very small data sets:

v t-Test: Paired Two Sample for Means

v t-Test: Two-Sample Assuming Equal Variances

1 t-Test: Two-Sample Assuming Unequal Variances

Briefly, here’s how these three tools work. For sake of illustration, assume
that you're working with the values shown in Figure 11-1. The worksheet
range Al:A21 contains the first set of values. The worksheet range B1:B21
contains the second set of values.

[

To perform a t-test calculation, follow these steps:

1. Choose Data tab’s Data Analysis.

2. When Excel displays the Data Analysis dialog box, as shown in
Figure 11-2, select the appropriate t-test tool from its Analysis
Tools list.



Chapter 11: Inferential Statistics 24 7

Figure 11-2:
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Figure 11-3:
The t-Test;
Paired Two-
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e rTest: Paired Two-Sample For Means: Choose this tool when you
want to perform a paired two-sample t-test.

e tTest: Two-Sample Assuming Equal Variances: Choose this tool

when you want to perform

a two-sample test and you have reason

to assume the means of both samples equal each other.

e tTest: Two-Sample Assuming Unequal Variances: Choose this tool

when you want to perform

a two-sample test but you assume that

the two-sample variances are unequal.

Data Analysis 7 HEM |
Analysis Tools
ok |
Histogram ~
Moving Average Cancel

Random Number Generation

Rank and Percentile

Regression

sampling

t-Test: Paired Two Sample for Means

t-Test: Two-Sample Assuming Unequal Variances
z-Test: Two Sample for Means

Help

3. After you select the correct t-test tool, click OK.

Excel then displays the appropriate t-test dialog box. Figure 11-3 shows
the t-Test: Paired Two Sample Assuming Equal Variances dialog box.

The other t-test dialog boxes look very similar.

t-Test: Two-Sample Assuming Equal Variances ? “_
Input
Variable 1 Range: SAS1:SAS21 E

23
Variable 2 Range: $BS1:5B521 25
Hypothesized Mean Difference:
[ Labels
Alpha: 0.05
Qutput options
(®) Qutput Range: spsi|
() New Worksheet Ply:
() New Workbook

L

Cancel

Help

4. In the Variable 1 Range and Variable 2 Range input text boxes, iden-
tify the sample values by telling Excel in what worksheet ranges

you’'ve stored the two samples.

You can enter a range address into these text boxes. Or you can click in
the text box and then select a range by clicking and dragging. If the first
cell in the variable range holds a label and you include the label in your
range selection, of course, select the Labels check box.
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5. Use the Hypothesized Mean Difference text box to indicate whether
you hypothesize that the means are equal.

If you think the means of the samples are equal, enter 0 (zero) into this
text box. If you hypothesize that the means are not equal, enter the
mean difference.

6. In the Alpha text box, state the confidence level for your t-test
calculation.

The confidence level is between 0 and 1. By default, the confidence level
is equal to 0.05, which is equivalent to a 5-percent confidence level.

7. In the Output Options section, indicate where the t-test tool results
should be stored.

Here, select one of the radio buttons and enter information in the text
boxes to specify where Excel should place the results of the t-test analy-
sis. For example, to place the t-test results into a range in the existing
worksheet, select the Output Range radio button, and then identify

the range address in the Output Range text box. If you want to place

the t-test results someplace else, select one of the other option radio
buttons.

8. Click OK.

Excel calculates the t-test results. Figure 11-4 shows the t-test results for
a Paired Two Sample Assuming Equal Variances test. The t-test results
show the mean for each of the data sets, the variance, the number of
observations, the pooled variance value, the hypothesized mean differ-
ence, the degrees of freedom (abbreviated as df), the t-value (or t-stat),
and the probability values for one-tail and two-tail tests.
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Performing z-test Calculations

|
Figure 11-5:
Perform a
z-test from
here.
|

If you know the variance or standard deviation of the underlying popula-
tion, you can calculate z-test values by using the Data Analysis add-in. You
might typically work with z-test values to calculate confidence levels and
confidence intervals for normally distributed data. To do this, take these
steps:

1. To select the z-test tool, click the Data tab’s Data Analysis command
button.

2. When Excel displays the Data Analysis dialog box (refer to Figure 11-2),
select the z-Test: Two Sample for Means tool and then click OK.

Excel then displays the z-Test: Two Sample for Means dialog box, as
shown in Figure 11-5.

z-Test: Two Sample for Means ? “

Input = |
Variable 1 Range: SAS1:5A521 = o
Variable 2 Range: $BS1:58521 3 Cancel
Hypothesized Mean Difference: Help

Variable 1 Variance (knownj: 0.09
Variable 2 Variance (known): 0.08
(V] Labels
Alpha: | 0.05
OQutput options
® Qutput Range: SDs1 £
() New Worksheet Ply:
_) New Workbook

3. In the Variable 1 Range and Variable 2 Range text boxes, identify the
sample values by telling Excel in what worksheet ranges you’ve stored
the two samples.

You can enter a range address into the text boxes here or you can click
in the text box and then select a range by clicking and dragging. If the
first cell in the variable range holds a label and you include the label in
your range selection, select the Labels check box.

4. Use the Hypothesized Mean Difference text box to indicate whether
you hypothesize that the means are equal.

If you think that the means of the samples are equal, enter 0 (zero) into
this text box or leave the text box empty. If you hypothesize that the
means are not equal, enter the difference.
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20 070722 Q24175

5. Use the Variable 1 Variance (Known) and Variable 2 Variance (Known)
text boxes to provide the population variance for the first and second
samples.

6. In the Alpha text box, state the confidence level for your z-test
calculation.

The confidence level is between 0 and 1. By default, the confidence level
equals 0.05 (equivalent to a 5-percent confidence level).

7. In the Output Options section, indicate where the z-test tool results
should be stored.

To place the z-test results into a range in the existing worksheet, select
the Output Range radio button and then identify the range address in
the Output Range text box. If you want to place the z-test results some-
place else, use one of the other options.

8. Click OK.

Excel calculates the z-test results. Figure 11-6 shows the z-test results for
a Two Sample for Means test. The z-test results show the mean for each
of the data sets, the variance, the number of observations, the hypothe-
sized mean difference, the z-value, and the probability values for one-tail
and two-tail tests.

15 ommarz a3mont
16 0154976 0408396

1| D4T0224 0257536

Figure 11-6: |2
The z-test |-
calculation |
results. |-
I

0.9 035579




Chapter 11: Inferential Statistics 2 5 ’

Creating a Scatter Plot

One of the most interesting and useful forms of data analysis is regression
analysis. In regression analysis, you explore the relationship between two

sets of values, looking for association. For example, you can use regression
analysis to determine whether advertising expenditures are associated with
sales, whether cigarette smoking is associated with heart disease, or whether
exercise is associated with longevity.

Often your first step in any regression analysis is to create a scatfter plot,
which lets you visually explore association between two sets of values. In
Excel, you do this by using an XY (Scatter) chart. For example, suppose that
you want to look at or analyze the values shown in the worksheet displayed
in Figure 11-7. The worksheet range Al:Al11 shows numbers of ads. The work-
sheet range B1:B11 shows the resulting sales. With this collected data, you
can explore the effect of ads on sales—or the lack of an effect.

@~ o
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|
Figure 11-7:
A worksheet
with data
you might
analyze

by using |-
regression. |’
I

Sheet!

To create a scatter chart of this information, take the following steps:

1. Select the worksheet range A1:B11.
2. On the Insert tab, click the XY (Scatter) chart command button.
3. Select the Chart subtype that doesn’t include any lines.
Excel displays your data in an XY (scatter) chart, as shown in Figure 11-8.
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Figure 11-8: |2
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4. Confirm the chart data organization.

Confirm that Excel has in fact correctly arranged your data by looking at
the chart.

If you aren’t happy with the chart’s data organization — maybe the data
seems backward or flip-flopped — click the Switch Row/Column com-
mand button on the Chart Tools Design tab. (You can even experiment
with the Switch Row/Column command, so try it if you think it might
help.) Note that in Figure 11-8, the data is correctly organized. The chart
shows the common-sense result that increased advertising seems to
connect with increased sales.

. Annotate the chart, if appropriate.

Add those little flourishes to your chart that will make it more attractive
and readable. For example, you can use the Chart Title and Axis Titles
buttons to annotate the chart with a title and with descriptions of the
axes used in the chart.

In Chapter 7, I discuss in detail the mechanics of customizing a chart
using the Chart Options dialog box. Refer there if you have questions
about how to work with the Titles, Axes, Gridlines, Legend, or Data
Labels tabs.

. Add a trendline by clicking the Add Chart Element menu’s Trendline

command button.

To display the Add Chart Element menu, click the Design tab and then
click the Add Chart Element command. For the Design tab to be dis-
played, you must have either first selected an embedded chart object or
displayed a chart sheet.
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Excel displays the Trendline menu. Select the type of trendline or regres-
sion calculation that you want by clicking one of the trendline options
available. For example, to perform simple linear regression, click the
Linear button.

In Excel 2007, you add a trendline by clicking the Chart Tools Layout
tab’s Trendline command.

. Add the Regression Equation to the scatter plot.

To show the equation for the trendline that the scatter plot uses, choose
the More Trendline Options command from the Trendline menu.

Then select both the Display Equation on Chart and the Display R-Squared
Value on Chart check boxes. This tells Excel to add the simple regres-
sion analysis information necessary for a trendline to your chart. Note
that you may need to scroll down the pane to see these check boxes.

In Excel 2007 and Excel 2010, you click the Charting Layout tab’s
Trendline button and choose the More Trendlines Option to display the
Format Trendline dialog box.

Use the radio buttons and text boxes in the Format Trendline pane
(shown in Figure 11-9) to control how the regression analysis trendline is
calculated. For example, you can use the Set Intercept = check box and
text box to force the trendline to intercept the x-axis at a particular point,
such as zero. You can also use the Forecast Forward and Backward

text boxes to specify that a trendline should be extended backward or
forward beyond the existing data or before it.

Format Trendline v

TRENDLINE OPTIONS ¥

5000 Dol

Sheet!
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Figure 11-10:
The Scatter
Plot chart
with the

regression |

data.

8. Click OK.

You can barely see the regression data in Figure 11-9, so in Figure 11-10,
[ remove the Format Trendline pane, resize the chart, and move the
regression data so it’s more legible.
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Using the Regression Data Analysis Tool

You can move beyond the visual regression analysis that the scatter plot
technique provides. (Read the previous section for more on this technique.)
You can use the Regression tool provided by the Data Analysis add-in. For
example, say that you used the scatter plotting technique, as I describe ear-
lier, to begin looking at a simple data set. And, after that initial examination,
suppose that you want to look more closely at the data by using full blown,
take-no-prisoners, regression. To perform regression analysis by using the
Data Analysis add-in, do the following:

1. Tell Excel that you want to join the big leagues by clicking the Data
Analysis command button on the Data tab.

2. When Excel displays the Data Analysis dialog box, select the
Regression tool from the Analysis Tools list and then click OK.

Excel displays the Regression dialog box, as shown in Figure 11-11.
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3. Identify your Y and X values.

Use the Input Y Range text box to identify the worksheet range holding
your dependent variables. Then use the Input X Range text box to iden-
tify the worksheet range reference holding your independent variables.

Each of these input ranges must be a single column of values. For
example, if you want to use the Regression tool to explore the effect of
advertisements on sales (this is the same information shown earlier in
the scatter plot discussion in Figure 11-10), you enter $A$1:$A8$11 into
the Input X Range text box and $B$1:8B$11 into the Input Y Range text
box. If your input ranges include a label, as is the case of the worksheet
shown earlier in Figure 11-10, select the Labels check box.

4. (Optional) Set the constant to zero.

If the regression line should start at zero — in other words, if the
dependent value should equal zero when the independent value equals
zero — select the Constant Is Zero check box.

5. (Optional) Calculate a confidence level in your regression analysis.

To do this, select the Confidence Level check box and then (in the
Confidence Level text box) enter the confidence level you want to use.

6. Select a location for the regression analysis results.

Use the Output Options radio buttons and text boxes to specify where
Excel should place the results of the regression analysis. To place the
regression results into a range in the existing worksheet, for example,
select the Output Range radio button and then identify the range
address in the Output Range text box. To place the regression results
someplace else, select one of the other option radio buttons.
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7. Identify what data you want returned.

Select from the Residuals check boxes to specify what residuals results
you want returned as part of the regression analysis.

Similarly, select the Normal Probability Plots check box to add residuals
and normal probability information to the regression analysis results.

. Click OK.

Excel shows a portion of the regression analysis results for the work-
sheet shown earlier in Figure 11-7, as depicted in Figure 11-12 including
three, stacked visual plots of data from the regression analysis.

There is a range that supplies some basic regression statistics, including
the R-square value, the standard error, and the number of observations.
Below that information, the Regression tool supplies analysis of variance
(or ANOVA) data, including information about the degrees of freedom,
sum-of-squares value, mean square value, the f-value, and the significance
of F. Beneath the ANOVA information, the Regression tool supplies informa-
tion about the regression line calculated from the data, including the coef-
ficient, standard error, t-stat, and probability values for the intercept — as
well as the same information for the independent variable, which is the
number of ads in the example I discuss here. Excel also plots out some of
the regression data using simple scatter charts. In Figure 11-12, for exam-
ple, Excel plots residuals, predicted dependent values, and probabilities.
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Using the Correlation Analysis Tool

The Correlation analysis tool (which is also available through the Data
Analysis command) quantifies the relationship between two sets of data.
You might use this tool to explore such things as the effect of advertising on
sales, for example. To use the Correlation analysis tool, follow these steps:

1. Click Data tabs Data Analysis command button.

2. When Excel displays the Data Analysis dialog box, select the Correlation
tool from the Analysis Tools list and then click OK.

Excel displays the Correlation dialog box, as shown in Figure 11-13.

Correlation 2 BEM ]
Input
Input Range: SAS1:5B511 B3
Cancel
Grouped By: @) Columns
O Rows Help
I [v] Labels in first row
Flgllfe 1113 Qutput options
The (® Output Range: $Ds1| B4
Correlation | O NewWorksheet ply:
dialog box. | O Newworkbook
I

3. Identify the range of X and Y values that you want to analyze.

For example, if you want to look at the correlation between ads and sales —
this is the same data that appears in the worksheet shown in Figure 11-7 —
enter the worksheet range $A$1:$B$11 into the Input Range text box.

If the input range includes labels in the first row, select the Labels in
First Row check box. Verify that the Grouped By radio buttons — Columns
and Rows — correctly show how you’ve organized your data.

4. Select an output location.

Use the Output Options radio buttons and text boxes to specify where
Excel should place the results of the correlation analysis. To place the
correlation results into a range in the existing worksheet, select the
Output Range radio button and then identify the range address in the
Output Range text box. If you want to place the correlation results some-
place else, select one of the other option radio buttons.

5. Click OK.

Excel calculates the correlation coefficient for the data that you identified
and places it in the specified location. Figure 11-14 shows the correlation
results for the ads and sales data. The key value is shown in cell E3.

The value 0.897497 suggests that 89 percent of sales can be explained
through ads.
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Using the Covariance Analysis Tool

The Covariance tool, also available through the Data Analysis add-in, quantifies
the relationship between two sets of values. The Covariance tool calculates the
average of the product of deviations of values from the data set means.

To use this tool, follow these steps:

1. Click the Data Analysis command button on the Data tab.

2. When Excel displays the Data Analysis dialog box, select the
Covariance tool from the Analysis Tools list and then click OK.

Excel displays the Covariance dialog box, as shown in Figure 11-15.

Covariance 2 IEM |
Input
Input Range: SAS1:5B511 B
Cancel
Grouped By: ®) Columns
) Rows Help
I [v] Labels in first row
Flglll'e 11'15: Output options
The ®) Output Range: $DS1 B
Covariance | (O New Worksheet Ply:
dialog box. | O Newworkoook
|
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3. Identify the range of X and Y values that you want to analyze.

To look at the correlation between ads and sales data from the work-
sheet shown in Figure 11-7, for example, enter the worksheet range
$AS$81:$B$11 into the Input Range text box.

Select the Labels in First Row check box if the input range includes labels
in the first row.

Verify that the Grouped By radio buttons — Columns and Rows — correctly
show how you've organized your data.

4. Select an output location.

Use the Output Options radio buttons and text boxes to specify where
Excel should place the results of the covariance analysis. To place the
results into a range in the existing worksheet, select the Output Range
radio button and then identify the range address in the Output Range

text box. If you want to place the results someplace else, select one of
the other Output Options radio buttons.

5. Click OK after you select the output options.

Excel calculates the covariance information for the data that you identi-
fied and places it in the specified location. Figure 11-16 shows the covari-
ance results for the ads and sales data.

-
Figure 11-16: |.
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Using the ANOVUA Data Analysis Tools

Figure 11-17:
The Anova:
Single
Factor
dialog box.
|

The Excel Data Analysis add-in also provides three ANOVA (analysis of vari-
ance) tools: ANOVA: Single Factor, ANOVA: Two-Factor With Replication, and
ANOVA: Two-Factor Without Replication. With the ANOVA analysis tools, you
can compare sets of data by looking at the variance of values in each set.

As an example of how the ANOVA analysis tools work, suppose that you want
to use the ANOVA: Single Factor tool. To do so, take these steps:

1. Click Data tab’s Data Analysis command button.

2. When Excel displays the Data Analysis Dialog box, choose the appro-
priate ANOVA analysis tool and then click OK.

Excel displays the appropriate ANOVA dialog box. (In this particular exam-
ple, I chose the ANOVA: Single Factor tool, as shown in Figure 11-17.) But
you can also work with two other versions of the ANOVA tool: a two-factor
with replication version and a two-factor without replication version.

Anova: Single Factor ? “_

P [ ox ]
Input Range: | %

y Cancel
Grouped By: (®) Columns

O Rows Help
[] Labels in First Row
Alpha: |0.05
Output options
(O Qutput Range: %
(®) New Worksheet Ply:
() New Workbook

3. Describe the data to be analyzed.

Use the Input Range text box to identify the worksheet range that holds
the data you want to analyze. Select from the Grouped By radio buttons —
Columns and Rows — to identify the organization of your data. If the first
row in your input range includes labels, select the Labels in First Row
check box. Set your confidence level in the Alpha text box.
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4. Describe the location for the ANOVA results.

Use the Output Options buttons and boxes to specify where Excel should
place the results of the ANOVA analysis. If you want to place the ANOVA
results into a range in the existing worksheet, for example, select the
Output Range radio button and then identify the range address in the
Output Range text box. To place the ANOVA results someplace else,
select one of the other Output Options radio buttons.

5. Click OK.
Excel returns the ANOVA calculation results.

Creating an [-test Analysis

Figure 11-18:
The F-Test
Two-
Sample for
Variances
dialog box.
|

B3

The Excel Data Analysis add-in also provides a tool for calculating two-sample
f-test calculations. f-test analysis enables you to compare variances from two
populations. To use the f-Test Analysis tool, click the Data Analysis command
button on the Data tab, select {-Test Two-Sample for Variances from the Data
Analysis dialog box that appears, and click OK. When Excel displays the F-Test
Two-Sample for Variances dialog box, as shown in Figure 11-18, identify the
data the tools should use for the f-test analysis by using the Variable Range
text boxes. Then specify where you want the f-test analysis results placed
using the Output Options radio buttons and text boxes. Click OK and Excel
produces your f-test results.

F-Test Two-Sample for Variances ? "

Input

Variable 1 Range: B
Variable 2 Range: | Cancel
[ Labels Help
Alpha: | 0.05

Output options

O) Output Range: 5.5

(®) New Worksheet Ply:

) New Workbook

f-test analysis tests to see whether two population variances equal each other.
Essentially, the analysis compares the ratio of two variances. The assumption
is that if variances are equal, the ratio of the variances should equal 1.
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Using Fourier Analysis

Figure 11-19:
The Fourier
Analysis
dialog box.
]

The Data Analysis add-in also includes a tool for performing Fourier analysis.
To do this, click the Data tab’s Data Analysis command button, select Fourier
Analysis from the Data Analysis dialog box that appears, and click OK. When
Excel displays the Fourier Analysis dialog box, as shown in Figure 11-19,
identify the data that Excel should use for the analysis by using the Input
Range text box. Then specify where you want the analysis results placed by
selecting from the Output Options radio buttons. Click OK; Excel performs
your Fourier analysis and places the results at the specified location.

Fourier Analysis ? “_
Input [ﬁ
Input Range: = o

r Cancel
[7] Labels in First Row

Help
Output options
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Chapter 12
Optimization Modeling with Solver

In This Chapter
Understanding optimization modeling
Setting up a Solver worksheet
Solving an optimization modeling problem
Reviewing the Solver reports
Noodling around with the Solver options
Setting a limit on Solver
Understanding the Solver error messages

’ n the preceding chapters of this book, I discuss how to use Excel tools to
analyze data stored in an Excel workbook. However, you can also perform
another sort of data analysis. You can perform data analysis that looks not at
labels and values stored in cells but rather at formulas that describe business
problems. In fact, Excel includes just such a tool for working on these kinds
of problems: the Solver.

When you use optimization modeling and the Excel Solver, you aren’t prob-
lem solving or analyzing based on raw data. You are problem-solving and ana-
lyzing based on formulaic descriptions of a situation. Nevertheless, although
the abstraction takes some getting used to, analyzing situations or problems
based on formulaic descriptions of objective functions and constraints can
be a powerful tool. And powerful tools can lead to powerful new insights.

In this chapter, I describe the sorts of data analysis problems that Solver
helps you figure out. I show you a simple example of how the Solver works
in action. Although Solver seems terribly complicated, it’s actually an easier
tool to use than you might think, so stick with me here.

Understanding Optimization Modeling

Suppose that you're a one-person business. This example is sort of artificial,
but [ need to take some liberties in order to make optimization modeling and
what the Solver does easy to understand.
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Optimizing your imaginary profits

In your business, you make money two ways: You write books and you give
seminars. Imagine that when you write a book, you make $15,000 for roughly
six weeks of work. If you work out the math on that — dividing $15,000 by
240 hours — you see that you make roughly $62.50 an hour by writing a book.

Also assume that you make $20,000 for giving a one-day seminar on some
subject on which you're an expert. You make about $830.00 an hour for giving
the seminar. I calculate this number by dividing the $20,000 that you make by
the 24 hours that presenting the seminar requires you to invest.

In many situations, you might be able to figure out how many books you
want to write and how many seminars you want to give simply by look-

ing at the profit that you make in each activity. If you make roughly $62 an
hour writing a book and you make roughly $830 an hour giving a seminar,
the obvious answer to the question, "How many books should I write and
how many seminars should I give?" is, do as many seminars as possible and
as few books as possible. You make more money giving seminars, so you
should do that more.

Recognizing constraints

In many situations, however, you can’t just look at the profit per activity or
the cost per activity. You typically need to consider other constraints in your
decision-making. For example, suppose that you give seminars on the same
subject that you write books about. In this case, it might be that in order to
be in the seminar business, you need to write at least one book a year. And so
that constraint of writing one book a year needs to be considered while you
think about what makes most sense about how you maximize your profits.

Commonly, other constraints often apply to a problem like this. For
example — and [ know this because one of my past jobs was publishing
books — book publishers might require that you give a certain number of
seminars a year in order to promote your books. So it might also be that in
order to write books, you need to give at least four seminars a year. This
requirement to give at least four book-promoting seminars a year becomes
another constraint.

Consider other constraints, too, when you look at things such as financial
resources available and the capacity of the tools that you use to provide your
products or services. For example, perhaps you have only $20,000 of work-
ing capital to invest in things like writing books or in giving seminars. And if
a book requires $500 to be tied up in working capital but a seminar requires
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$2,500 to be tied up in working capital, you're limited in the number of books
that you can write and seminars that you can give by your $20,000 of working
capital balance.

Another common type of constraint is a capacity constraint. For example,
although there are 2,080 hours in a working year, assume that you want to
work only 1,880 hours in a year. This would mean, quite conventionally, that
you want to have ten holidays a year and three weeks of vacation a year. In
this case, if a book requires 240 hours and a seminar requires 24 hours, that
working-hours limit constrains the number of books and seminars that you
can give, too.

This situation is exactly the kind of problem that Solver helps you figure out.
What Solver does is find the optimum value of what's called your objective
function. In this case, the objective function is the profit function of the busi-
ness. But Solver, in working through the numbers, explicitly recognizes the
constraints that you describe.

Setting Up a Solver Worksheet

Figure 12-1 shows an Excel workbook set up to solve an optimization model-
ing problem for the one-person business that I describe earlier in this chap-

ter. Here [ describe the pieces and parts of this workbook. If you've carefully
read the earlier discussion in the chapter about what optimization modeling
is, you should have no trouble seeing what’s going on here.

2 [an
Figure 12-1:
Asample |
workbook |
setupto
solve an
optimization
modeling
problemfora |-
one-person |,
business. |-
I

Sheet! | Shest2 | Sheed
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The Solver workbook is available on this book’s companion website. (Find
out how to access it in the Introduction.) You might want to retrieve this
workbook before you begin noodling around with the optimization modeling
problem that [ describe here. Having a workbook set up for you makes things
easier, especially if you're working with the Solver for the first time.

If you choose to construct the Solver workbook example yourself (a fine idea),
you want to tell Excel to display actual formulas rather than formula results

in the workbook. This is what the workbook shown in Figure 12-1 does, by the
way. To do this, select the worksheet range in which you want to display the
actual formulas rather than the formula results and then simultaneously press
the Ctrl and the * (grave accent) keys. By pressing Ctrl+", you tell Excel to
display the formula rather than the formula result within the selected range.

Setting up a Solver workbook requires three steps:

1. Identify the Solver variables.

First, you want to identify the variables in your optimization modeling
problem. In the case of trying to figure out the number of books to
write and seminars to give to make the most money in your one-person
business, the two Solver variables are books and seminars.

In Figure 12-1, I enter the labels shown in range Al:A3 and then the
starting variable values shown in range B2:B3. This part of the work-
sheet isn’t anything magical. It simply identifies which variables go into
the objective function. The objective function is the formula that you
want to maximize or minimize. The values stored in the worksheet range
B2:B3 are my starting guesses about what the optimal variable values
should be. In Figure 12-1, for example, I'm just guessing that the optimal
number of books to write is two and that the optimal number of semi-
nars to give is eight. You won’t know what the optimal number of books
and seminars actually is until you work out the problem.

Although you don’t have to name the cells that hold the variable values —
in this case, cells B2 and B3 — naming those cells makes your objective
function formula and your constraint formulas much easier to understand.
So I recommend that you name the cells.

If you set up a workbook like the one shown in Figure 12-1, you can name
the variable value cells by selecting the worksheet range A2:B3 and then
clicking the Formula tab’s Create from Selection command button. When
Excel displays the Create Names from Selection dialog box, as shown

in Figure 12-2, select the Left Column check box and click OK. This

tells Excel to use the labels in the left column: This would be the range
A2:A3 — to name the range B2:B3. In other words, by following these
steps, you name cell B2 Books and you name cell B3 Seminars.
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|
Figure 12-2:
The Create
Names from
Selection
dialog box.
|

Create Names from Selection ? “

Create names from values in the:
(Jop row
Left column
O Bottom row
[T] right column

OK Cancel

2. Describe the objective function.

The objective function, shown in cell B5 in Figure 12-1, gives the formula
that you want to optimize. In the case of a profit formula, you want to
maximize a function because you want to maximize profits, of course.

[ should note and you should remember that not all objective functions
should be maximized. Some objective functions should be minimized.
For example, if you create an objective function that describes the cost
of some advertising program or the risk of some investment program,
you can logically choose to minimize your costs or minimize your risks.

To describe the objective function, create a formula that describes the
value that you want to optimize. In the case of a profit function for the
one-person business that I detail in the earlier section “Recognizing
constraints,” you make $15,000 for every book that you write and
$20,000 for every seminar that you give. You can describe this by enter-
ing the formula =15000*Books+20000*Seminars. In other words, you
can calculate the profits of your one-person business by multiplying
the number of books that you write times $15,000 and the number of
seminars that you give times $20,000. This is what shows in cell B5.

3. Identify any objective function constraints.

In the worksheet range A8:C11, I describe and identify the constraints
on the objective function. As I note earlier, four constraints can limit the
profits that you can make in your business:

e Cash required limit: The first constraint shown in Figure 12-1 (cell
A8) quantifies the cash required constraint. In this example, each
book requires $500 cash, and each seminar requires $2,500 cash.

If you have $20,000 cash to invest (I assume to temporarily invest)
in books and seminars, you're limited in the number of books that
you can write and the number of seminars that you can give by the
cash, up-front investment that you need to make in these activities.
The formula in cell B8, =Books*500+Seminars*2500, describes
the cash required by your business. The value shown in cell C8,
20000, identifies the actual constraint.
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e Working hours limit: The working hours limit constraint is quanti-
fied by having the formula =Books*24 0+Seminars*24 in cell B9
and the value 1880 in cell C9. Use these two pieces of information,
the formula and the constant value, to describe a working hours
limit. In a nutshell, this constraint says that the number of hours
that you spent on books and seminars needs to be less than 1880.

e Minimum number of books policy: The constraint that you must
write at least one book a year is set up in cells B10 and C10. The
formula =Books goes into cell B10. The minimum number of books, 1,
goes into cell C10.

e Minimum number of seminars policy: The constraint that you must
give at least four seminars a year is set up in cells B11 and C11.
The formula =seminars goes into cell Bl11. The minimum number
of seminars constant value, 4, goes into cell C11.

After you give the constraint formulas and provide the constants to which
the formula results will be compared, you're ready to solve your optimization
modeling problem. With the workbook set up (refer to Figure 12-1), solving
the function is actually very easy.

Setting up the workbook and defining the problem of objective function and
constraint formulas is the hard part.

Solving an Optimization
Modeling Problem

<\®

After you have your workbook set up, you solve the optimization modeling
problem by identifying where you've stored the solver variables, the
objective function formula, the constraint formulas, and the constant values
to which constraint formulas need to be compared. This is actually very
straightforward. Here are the steps that you follow:

1. Tell Excel to start the Solver by clicking the Data tab’s Solver
command button.

Excel displays the Solver Parameters dialog box, as shown in Figure 12-3.

If the Tools menu doesn’t supply the Solver command, you need to
install the Solver add-in. To do this, choose the File => Options com-
mand. When Excel displays the Excel Options dialog box, select the
Add-Ins item from the left box that appears along the left edge of the
Excel Options dialog box. Excel next displays a list of the possible
add-ins — including the Solver add-in. Select the Solver add-in item and
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|
Figure 12-3:
The Solver
Parameters
dialog box.
|
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click Go. Excel apparently doesn’t think you're serious about this Solver
Add-in business because it displays another dialog box, called the Add-
Ins dialog box. Select the Solver add-in from this dialog box and click OK.
Excel installs the Solver add-in. Whew. From this point on, you can use
the Solver without trouble.

Solver Parameters |

Set Objective: $BSS =
Ter @ May O min ) Value Of:

By Changing Yaniable Cells:

Books, Seminars &=

Subject to the Constraints:

Add
Change

Deiete

Beset All
Load/Save
[V Make Unconstrained Variables Non-Negative
Sglect a Solving Method: GRG Nonlinear ot Options

Sahing Metnod

Select the GRG Nonlinear engine for Solver Problems that are smooth nonlinear. Select the LP
Simplex engine for linear Sohver Froblems, and select the Evolutionary engine for Solver
problems that are non-smooth,

Help Sowe Ciose

2. In the Set Objective text box of the Solver Parameters dialog box,

identify the cell location of the objective function formula.

In the case of the example workbook shown earlier in Figure 12-1, the
objective function formula is stored in cell B5. If you were solving an
optimization modeling problem using the workbook from Figure 12-1,
therefore, you enter $B$5 into the Set Objective text box.

3. Describe what optimization means.

As I note earlier, not every objective function should be maximized in
order to be optimized. In the case of a profit function, because you want
to maximize profits — which is the case here — you want to make the
objective function formula result as big as possible. But other objective
functions might need to be minimized or even set to some specific value.

Select one of the To radio buttons available in the Solver Parameters
dialog box to define what optimization means. For example, in the case
of a profit function that you want to maximize, select the Max radio
button. If instead you're working with a cost function and you want to
save costs, you select the Min radio button. In the special case in which
optimizing the objective function means getting the function to return
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Figure 12-4:
The Add
Constraint
dialog box.
]

a specific value, you can even select the Value Of radio button and
then make an entry in the Value Of text box to specify exactly what the
objective function formula should return.

. In the By Changing Variable Cells text box of the Solver Parameters

dialog box, identify the Solver variables.

You need to identify the variables that can be adjusted in order to
optimize the objective function. In the case of a one-person business in
which you're noodling around with the number of books that you should
write and the number of seminars that you should give, the Solver
variables are books and seminars.

To identify the Solver variables, you can enter either the cell addresses
into the By Changing cells text box or the cell names. In Figure 12-3,

[ enter Books, a comma, and then Seminars into the By Changing Cells
text box. Note that these labels refer to cells B2 and B3. I could have also
entered $B$2, $BS$3 into the By Changing Cells text box.

. Click the Add button in the Solver Parameters dialog box to describe

the location of the constraint formulas and the constant values to
which the constraint formulas should be compared.

Excel displays the Add Constraint dialog box, as shown in Figure 12-4.
From the Add Constraint dialog box, you identify the constraint for-
mula and the constant value for each of your constraints. For example,
to identify the cash requirements constraint, you need to enter $B$8
into the Cell Reference text box. Select the less-than or equal-to logical
operator from the drop-down list (between the Cell Reference and the
Constraint text boxes). Then enter $C$8 into the Constraint text box. In
Figure 12-4, you can see how you indicate that the cash requirements
constraint formula is described in cells B8 and C8.

Note that the logical operator is very important. Excel needs to know
how to compare the constraint formula with the constant value.

After you describe the constraint formula, click the Add button. To add
another constraint, you click the Add button and follow the same steps.
You need to identify each of the constraints.

Add Constraint

Cell Reference: Copstraint:
$BS8 B8 <= |v||=scs8 23

oK Add Cancel
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6. (Optional) Identify any integer constraints.

Sometimes you have implicit integer constraints. In other words, you
might need to set the Solver variable value to an integer value. In the
example of the one-person business, to get paid for a book, you need to
write an entire book. The same thing might be true for a seminar, too.

(Or it might not be true for a seminar — perhaps you can do, for example,
half of a seminar and have a consulting-buddy do the other half. . . .)

To identify integer constraints, you follow the same steps that you take
to identify a regular constraint except that you don’t actually need to
store integer constraint information in your workbook. What you can do
is click the Add button on the Solver Parameters dialog box. In the Add
Constraint dialog box that appears, enter the Solver variable name into
the Cell Reference box and select int from the drop-down list, as shown

in Figure 12-5.
Add Constraint

]

Figure 125: Cgll Reference: Copstraint:

SEt Up an Books| S| int v | linteger 2]

integer con-

straint here. oK Ada Cancel
|

7. (Optional) Define any binary constraints.

In the same manner that you define integer constraints, you can also
describe any binary constraints. A binary constraint is one in which the
solver variable must equal either 0 or 1.

To set up a binary constraint, click the Add button in the Solver
Parameters dialog box. When Excel displays the Add Constraint dialog
box, enter the Solver variable name into the Cell Reference box. Select
Bin from the drop-down list and then click OK.

8. (Optional) Tell Excel you would accept negative value variables.

By default, Excel checks the Make Unconstrained Values Non-negative
box. This means Excel only considers “real” those solutions where your
input values end up as either zero or positive numbers. Usually, this
makes sense.

If you were solving for the optimal number of books and seminars, for
example, you might accept as a practical suggestion the value zero or
some positive value. But obviously you can’t write -2 books and you
can’t give -3 seminars. Those suggestions would be just plain goofy.
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In some optimization modeling, though, you can practically work with
negative values. If you were optimizing the investment amounts you
wanted to make in, say, some new oil field, the optimal value could be a
negative number. In other words, the right choice could just be to divest
money (subtract money) rather than invest money (add money).

If you will accept negative variable values, therefore, you can uncheck
the Make Unconstrained Variables Non-negative box.

9. (Optional) Select a Solving Method.

The Solver Parameters dialog box provides a Select a Solving Method
drop-down list box that provides three engines to solving your optimiza-
tion problem: GRG Nonlinear (which you can usually use and works for
smooth but nonlinear problems), Simplex LP (which works for linear
problems), and Evolutionary (which works for nonsmooth problems).

Microsoft didn’t design and program the Solver commands algorithms.
Another company, Frontline Solvers, did. Which doesn’t seem all

that relevant except for the fact that the www. solver. com website
provides some great discussions of when you might want to use the
Simplex LP or Evolutionary solving method rather than the default GRG
Nonlinear method. To get to this information, visit the www.solver.com
website and type the solving method you have a question about into the
search box.

10. Solve the optimization modeling problem.

After you identify the objective function, identify the Solver variables,
and describe the location of the constraint formulas, you're ready to
solve the problem. To do this, simply click the Solve button.

Assuming that Excel can solve your optimization problem, it displays the
Solver Results dialog box, as shown in Figure 12-6. The Solver Results
dialog box provides two radio buttons. To have Solver retain the optimal
solution, select the Keep Solver Solution radio button and then click OK.
In the case of the one-person book and seminar business, for example,
the optimal number of books to write a year is 7 and the optimal number
of seminars to give is 6.6 (shown in cells B2 and B3 in the sample work-
book shown in Figure 12-6).

The Solver Parameters dialog box also includes two presumably self-descriptive
command buttons: Change and Delete. To remove a constraint from the
optimization model, select the constraint from the Subject to the Constraints
list box and then click the Delete button. If you want to change a constraint,
select the constraint and then click the Change button. When Excel displays
the Change Constraint dialog box, which resembles the Add Constraint dialog
box, use the Cell Reference text box, the operator drop-down list, and the
Constant text box to make your change.
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Figure 12-6: |*
Get Solver |2
results here. |~
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Reviewing the Solver Reports

Refer to the Solver Results dialog box in Figure 12-6 to see the Reports list
box. The Reports list box identifies three solver reports you can select:
Answer, Sensitivity, and Limits. You might be able to use these to collect
more information about your Solver problem.

The Answer Report

Figure 12-7 shows an Answer Report for the one-person business optimization
modeling problem. I should tell you that [ needed to remove the integer con-
straints to show all the Solver reports, so these values don’t jibe perfectly with
the Solver results shown in Figure 12-6. Don’t worry about that but instead look
at the information provided by the Answer Report.

The main piece of information provided by the Answer Report is the value
of the optimized objective function. This information appears in cell E16 in
Figure 12-7. In the case of the one-person book writing and seminar business,
for example, the final value, which is the value of the optimized objective
function, equals 238945 .5778. This tells you that the best mix of book-
writing and seminar-giving produces roughly $238,946 of profit.
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Figure 12-7: |-
The Answer |-
Report. |*

a c D t
Microseft Excal 15.0 Asswer feport

2 Worksheot: [Sohvir workbook examngie (version 1)xdb]Sheett

3 Report Crested: 12/5/2013 12:51:30 M

4 Result: Solves found a solution, AN Constraints and optimality conditions are satisfied.

ance 1%, Assume NorNegative

4 Objective Call (Max)
13 el Name
16] 5335 Objectme function

Original Vakae _Final Vahe

130000 238385 5778

3 Variable Cells

call Name Original Voo Final Vako _ Integer
2 7.176870751 Contin

3 esesemize comin

The Answer Report also shows the original value of the objective function.

If you set your original Solver variable values to your first guess or your cur-
rent configuration, you could compare the original value and the final value
to see by what amount Solver improves your objective function value. In this
case, such a comparison could show you by what amount Solver helped you
increase your profits, which is pretty cool.

The Variable Cells area of the Answer Report compares the original value and
final values of the solver variables. In the case of the one-person book-writing
and seminar-giving business, this area of the worksheet compares the origi-
nal value for the number of books written (two) with the final value for the
number of books written (roughly seven books). The Adjustable Cells area
also shows the original value of the number of seminars given (eight) and the
final value of the number of seminars given (roughly six and a half seminars).

The Constraints area of the Answer Report is really interesting. Though you
can’t see this in Figure 12-7 — so you need to be following along on your com-
puter and then scrolling down the workbook — the Constraints area shows
you what constraint limits the objective function. You might, in the simple
case of the one-person business, be able to guess what the limiting factors
were intuitively. But in many realdife optimization modeling problems, guess-
ing about what constraint is binding or limiting is more difficult.

In the case of the simple one-person business problem, the Constraints area
shows that the first two constraints, cash requirements and working hours, are
the ones that limit, or bind, the optimization modeling problem. You can easily
see this by looking at the Slack column (shown in cells G27:G30 if you're using
the example workbook available from the companion website). Slack equals
zero for both the cash requirements function and the working hours limit.

This means that the objective function value uses up all the cash and all the



Chapter 12: Optimization Modeling with Solver 2 75

Figure 12-8: |-
A Sensitivity |-
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working hours to produce the final value of $238946. The other two constraints
concerning the minimum number of books written and the minimum number
of seminars given aren’t limiting because they show slack.

The Sensitivity Report

Figure 12-8 shows the Sensitivity Report. A Sensitivity Report shows reduced
gradient values and Lagrange multipliers, which sounds like a whole lot of
gobbledygook. But actually these values aren’t that hard to understand and
can be quite useful.

A reduced gradient value quantifies the change in the objective function if the
variable value increases by one. The Lagrange multiplier quantifies how the
objective function changes if a constant constraint value increases by one.

In the Sensitivity Report shown in Figure 12-8, the reduced gradient values
equal zero. This zero indicates that the variable value can’t be increased. For
example, the reduced gradient value of zero for books indicates that you can’t
write more books because of the limiting effect of the constraints. The same
thing is true for the reduced gradient value of zero for the seminars variable.
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The Lagrange multiplier values sometimes show as zero, too. When the
Lagrange multiplier value shows as zero, that means that constraint isn’t lim-
iting. For example, in Figure 12-8, the Lagrange multiplier for both the mini-
mum number of books policy formula and the minimum number of seminars
policy formula show as zero. As you may recall from the earlier discussion of
the Solver results, neither of these two constraints is binding. The Lagrange
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Figure 12-9: |-
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multiplier value of 7.55102041 in cell E17 shows the amount by which the
objective function would increase if the cash requirements constant value
increased by one dollar. The Lagrange multiplier value of 46.7687075 in cell
E18 shows the amount by which the objective function value would increase
if you had one additional hour in which to work.

The Limits Report

The Limits Report, an example of which is shown in Figure 12-9, shows the
objective function optimized value, the Solver variable values that produce
the optimized objective function value, and the upper and lower limits pos-
sible for the Solver variables.

The upper and lower limits show the possible range of Solver variable values
along with the resulting objective function values. For example, if you take a

close look at Figure 12-9, you see that the lower limit for the number of semi-
nars (shown in cell F14) equals 4 and that at this level the objective function

equals 187653.0613, or roughly $187,653 dollars.
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The upper limit for the number of seminars (shown in cell I14) equals
6.56462585 and, at this level, the objective function returns 238945.5778, or
$238,945, which is the optimal value.

To produce a Sensitivity Report or a Limits Report, the solver problem cannot
have integer constraints. Accordingly, to produce the reports shown in

Figures 12-7, 12-8 and 12-9, I had to remove the integer constraints on books.
Removing this integer constraint changed the objective function optimal value.



Chapter 12: Optimization Modeling with Solver

Some other notes about Solver reports

You can run the Solver multiple times and get new sets of Answer, Sensitivity,
and Limits reports each time that you do. The first set of Solver reports that
you get is numbered with a 1 on each sheet tab. The second set, cleverly, is
numbered with a 2.

If you want to delete or remove Solver report information, just delete the
worksheet on which Excel stores the Solver report. You can delete a report
sheet by right-clicking the sheet’s tab and then choosing Delete from the
shortcut menu that appears.

Working with the Solver Options

Figure 12-10:
The All
Methods tab
of the Solver
Options
dialog box.
]

If you're an observant reader, you might have noticed that the Solver
Parameters dialog box includes an Options button. Click this button, and
Excel displays the Solver Options dialog box, as shown in Figure 12-10. You
might never need to use this dialog box. But if you want to fine-tune the way
that Solver works, you can use the buttons and boxes provided by the Solver
Options dialog box to control and customize the way that Solver works. Here
[ briefly describe how these options work.

Options > IEM |
All Methods IGRG Nonlinear | Evolutionary |

Constraint Precision: 0.000001

[ use Automatic Scaling
[ show Iteration Results
Solving with Integer Constraints
[ 1znore integer Constraints
Integer Optimality (%): 1
Solving Limits
Max Time (Seconds):
Iterations:
Evolutionary and Integer Constraints:
Max Subproblems:

Max Feasible Solutions:

oK

277
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Using the All Methods options

The All Methods tab’s options (the tab shows in Figure 12-10) provides boxes
you can use for any solving method. Accordingly, I'll go over these babies first.

Using automatic scaling

You can select the Use Automatic Scaling check box when you’re working
with variables that greatly differ in magnitude. For example, if you're working
with interest rates and multimillion dollar account balances, you might want
to use the automatic scaling option to tell Excel, "Hey dude, the Solver vari-
able values greatly differ in magnitude, so you ought to automatically scale
these babies."

Showing iteration results

If you don’t have anything better to do, select the Show Iteration Results
check box. When you do this, Excel stops after it calculates each objective
function using a new set of Solver variable values and shows you the interme-
diate calculation results. Most people won’t and shouldn’t care about seeing
intermediate calculation results. But heck, | suppose that in some cases,

you might want to see how Solver is working toward the objective function
optimal result.

Solving with integer constraints

Using integer constraints may complicate your optimization modeling, so
Excel’s Solver provides some tweaks you can make to models that “techni-
cally” should return integer values. For example, you can check the Ignore
Integer Constraints box to tell Excel you want to try solving the problem (just
for giggles) without the integer constraints.

Another integer-constraint-related tweak: The Integer Optimality % box lets
you specify the maximum percentage difference that you’ll accept between
the best solution that uses integer constraints and the best solution that
ignores integer constraints.

Setting a limit on Solver

Use the Max Time and Iterations text boxes to limit the amount of work that
Solver does to solve an optimization modeling problem. Now, the simple
example that I discuss here doesn’t take much time to solve. But real-life
problems are often much more complicated. A real-life problem might have
many more Solver variables to deal with. The constraints might be more
numerous and more complicated. And you might complicate optimization by
doing things such as working with lots of integer or binary constraints.
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When you work with large, complex, real-life problems, the time that Solver

takes to optimize might become very lengthy. In these cases, you can set a

maximum time limit that Solver takes by using the Max Time text box. You

can also set a maximum number of iterations that Solver makes by using the
") Iterations text box.

You can stop the Solver’s calculations by pressing Esc.

If you're using the Evolutionary solving method in a situation with integer
constraints, you can also specify the maximum number of subproblems you
want the Solver to work on using the Max Subproblems box and then the
maximum number of feasible integer solutions you want Solver to produce
using the Max Feasible Solutions box.

Using the GRG Nonlinear tab

The GRG Nonlinear tab (see Figure 12-11) provides buttons and boxes for
managing the way Solver works when you'’re using the GRG Nonlinear solving
method.

Options » IEE

All Methods GRG Nonlinear IEvqu!ianarv |

Copvergence: 0.0001
Derivatives
@© Forward Q central
Multistart
[J use Multistart
Population Size: 100
Random Seed: 0

M Require Bounds on Variables

Figure 12-11:
GRG
Nonlinear
tab of the
Solver
Options

dialog box. oK | Gancel
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Saying when

Have you ever been to a restaurant where your server wanders around at
some point in the meal with a huge peppermill asking whether you want
black pepper on your salad? If you have, you know that part of the ritual is
that at some point, you tell the server when she has ground enough pepper
for your green salad.

The Convergence text box provided on the GRG Nonlinear tab of the Solver
Options dialog box works in roughly the same way. If you are using the GRG
Nonlinear Solving method, you use the Convergence box to tell Excel when it
should stop looking for a better solution. The Convergence text box accepts
any value between 0 and 1. When the change in the objective function for-
mula result is less then the value shown in the convergence text box, Excel
figures that things are getting close enough, so additional iterations aren’t
necessary.

Oh, and something that I should mention: With larger convergence values,
Excel reaches a reasonable solution more quickly and with less work. And
with smaller or very precise convergence values, Excel works harder and
takes more time.

Forward versus central derivatives

Select from the two Derivatives radio buttons — Forward and Central — to
tell Excel how to estimate partial derivatives when it’s working with the
objective function and constraint formulas. In most cases, everything works
just fine if Excel uses forward derivatives. But, in some cases, forward deriva-
tives don’t work. And in this situation, you might be able to specify that Excel
use central derivatives.

Using central derivatives requires much more work of Excel, but some highly
constrained problems can more easily and more practically be solved using
central derivatives.

Working with the Multistart settings

If you check the Multistart box on the GRG Nonlinear tab, you tell Solver to,
in effect, solve the optimization problem by beginning from several different
starting points. The Population Size box lets you specify the number of start-
ing points. The Random Seed box lets you provide an integer to be used as
the seed for a random number generator that produces the actual starting
points. Finally, you can check and uncheck the Require Bounds On Variables
box to specify that this whole multistart craziness only occurs when you've
had the decency to define both upper and lower limits for the variables.
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Using the Evolutionary tab

Okay, now here’s something that is probably going to come as a big surprise
to you: The Evolutionary tab (see Figure 12-12) provides buttons and boxes
for managing the way Solver works when you’re using the Evolutionary
solving method.

Options ? “

All Methods | GRG Nonlinear Evolutionary |

Copvergence: 0.0001

Mutation Rate: 0075
Population Size: 100
Random Seed: 0
Maximum Time without 30

improvement:

[ Require Bounds on Variables

Figure 12-12:
The
Evolutionary
tab of the
Solver
Options
dialog box. oK concel |
I

For example, you can use the Convergence box to specify how closely Solver
needs to get to the optimal function value in order for you to call the job
done. In precise terms, the value you enter into the Convergence text box
specifies the maximum percentage difference in the objective function values
that Solver should allow in order to justify stopping its search for an optima.

The Mutation Rate box, which accepts values between 0 and 1, lets you
control how much variables are altered (or “mutated™) in a search for an
optimal solution. And the Population Size box lets you specify how many
different data points the Solver maintains at a time in its search for an
optimal solution.
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Figure 12-13:
The Load/
Save Model
dialog box.
I

The Random Seed box lets you supply a starting integer for the random
number generator used by the Evolutionary method.

The Maximum Time (In Seconds) box lets you do just what you’d guess: Tell
Excel to stop wasting time at some point if it’s not making progress.

Finally, as with the GRG Nonlinear solving method, you can check and uncheck
the Require Bounds On Variables box to specify that the evolutionary solving
only occurs when you set both upper and lower limits for the variables.

Saving and reusing model information

The Solver Options dialog box provides a Save/Load button that you can to
use to save and then later reload optimization modeling problem information.
If you click the Load/Save Model button, Excel displays the Load/Save Model
dialog box, as shown in Figure 12-13.

Load/Save Model n—

To Load, select a range holding a saved model.
To Save, select an empty range with the following number of cells: 8
SES1 %

Load Save Cancel

To save the current optimization modeling information, you enter a work-
sheet range address or the upper left corner cell of a worksheet range
address in the text box that Excel can use to save the model information and
then click Save.

To later reuse that model information, display the Load/Save Model dialog
box, enter the full worksheet range holding the previously saved model, and
then click Load.

Understanding the Solver Error Messages

For simple problems, Solver usually quickly finds the optimal Solver variable

values for the objective function. However, in some cases — in fact, maybe

quite frequently in the real world — Solver has trouble finding the Solver

variable values that optimize the objective function. In these cases, however,
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Solver typically displays a message or an error message that describes or dis-
cusses the trouble that it’s having with your problem. Quickly, before I wrap
up this chapter, I briefly identify and comment on the most common mes-
sages and error messages that Solver might display as it finishes or gives up
on the work that it’s doing.

Solver has found a solution

The Solver has found a solution message tells you that Solver has
done is job and found a set of variable values that satisfy your constraints.
You rock man.

Solver has converged to
the current solution

The Solver has converged to the current solution message tells
you that Excel has found a solution but isn’t particularly confident in the
solution. In essence, this message alerts you to the possibility that a better
solution to your optimization modeling problem might exist. To look for a
better solution, adjust the Convergence setting in the Solver Options dialog
box so that Excel works at a higher level of precision. I describe how you do
this in the earlier sections on the GRG Nonlinear and Evolutionary tabs.

Solver cannot improve the current solution

The Solver cannot improve the current solution message tells
you that, well, Excel has calculated a rough, pretty darn accurate solution,
but, again, you might be able to find a better solution. To tell Excel that it
should look for a better solution, you need to increase the precision setting
that Solver is using. This means, of course, that Excel will take more time. But
that extra time might result in it finding a better solution. To adjust the preci-
sion, you again use the Solver Options dialog box.

Stop chosen when maximum
time limit was reached

The Stop chosen when maximum time limit was reached message
tells you that Excel ran out of time. You can retry solving the optimization

modeling problem with a larger Max Time setting. (Read more about this in
the earlier section, “Setting a limit on Solver.”) Note, however, that if you do
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see this message, you should save the work that Excel has already performed
as part of the optimization modeling problem solving. Save the work that
Excel has already done by clicking the Keep Solver Results button when Excel
displays this message. Excel will be closer to the final solution the next time
that it starts looking for the optimal solution.

Solver stopped at user’s request

Er, obvious right? Solver good dog. Solver stopped because master told it to
stop. Solver get treat.

Stop chosen when maximum
iteration limit was reached

The Stop chosen when maximum iteration limit was reached
message tells you that Excel ran out of iterations before it found the optimal
solution. You can get around this problem by setting a larger iterations
value in the Solver Options dialog box. Read the earlier section, “Showing
iteration results.”

Objective Cell values do not converge

The Objective Cell values do not converge message tells you that
the objective function doesn’t have an optimal value. In other words, the
objective function keeps getting bigger (or keeps getting smaller) even though
the constraint formulas are satisfied. In other words, Excel finds that it keeps
getting a better objective function value with every iteration, but it doesn’t
appear any closer to a final objective function value.

If you encounter this error, you’'ve probably not correctly defined and
described your optimization modeling problem. Your objective function
might not make a lot of sense or might not be congruent with your constraint
formulas. Or maybe one or more of your constraint formulas — or probably
several of them — don’t really make sense.

Solver could not find a feasible solution

The Solver could not find a feasible solution message tells you
that your optimization modeling problem doesn’t have an answer. As a practi-
cal matter, when you see this message, it means that your set of constraints
excludes any possible answer.
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For example, returning one last time to the one-person business, suppose
that it takes 3,000 hours to write a book and that only 2,000 hours for work
are available in a year. If you said that you wanted to write at least one book
a year, there’s no solution to the objective function. A book requires up to
3,000 hours of work, but you only have 2,000 hours in which to complete a
3,000-hour project. That’s impossible, obviously. No optimal value for the
objective function exists.

Linearity conditions required by
this LP Solver are not satisfied

The Linearity conditions required by this LP Solver are
not satisfied message indicates that although you selected the Simplex
LP solving method, Excel has now figured out that your model isn’t actually
linear. And it’s mad as heck. So it shows you this message to indicate that it
can’t solve the problem if it has to assume that your objective function and
constraint formulas are linear.

If you do see this message, by the way, go ahead and try the GRG Nonlinear
solving method.

The problem is too large
for Solver to handle

The Problem is too large for Solver to handle message means
that you've got a problem too large for solver either because you've tried to
model with more than 200 decision variable or more than 100 constraints. To
work around this problem, you may be able to try minimizing the number of
variables or constraints so their counts fall below the “hey buddy that’s just
too large” constraint.

Solver encountered an error value
in a target or constraint cell

The Solver encountered an error value in a target or
constraint cell message means that one of your formula results in an
error value or that you goofed in describing or defining some constraint. To
work around this problem, you need to fix the bogus formula or the goofy
constraint.
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There is not enough memory available
to solve the problem

The There is not enough memory available to solve the
problem message is self-descriptive. If you see this message, Solver doesn’t
have enough memory to solve the optimization modeling problem that you're
working on. Your only recourse is to attempt to free up memory, perhaps

by closing any other open programs and any unneeded documents or work-
books. If that doesn’t work, you might also want to add more memory to your
computer, especially if you're going to commonly do optimization modeling
problems. Memory is cheap.

Error in model. Please verify that all
cells and constraints are valid

The Error in model. Please verify that all cells and
constraints are valid message means that you've got something
goofy — probably also something fixable — in your optimization problem.
Check your formulas and your input values. Make sure there’s nothing obvi-
ously wrong. Oh, and one other thing: Make sure you're not using the word
“solver” in any of your named variables. That can confuse Solver.
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In this part . . .

v Buff up your basic statistics skills so you're more easily and
more comfortably doing data analysis with Excel.

v Boost your effectiveness in analyzing data and communicating
the results with clever tricks and techniques.

v Get secrets for visually analyzing and presenting your data.




Chapter 13

Ten Things You Ought to Know
about Statistics

In This Chapter
Descriptive statistics are straightforward
Averages aren’t so simple sometimes
Standard deviations describe dispersion
Probability distribution functions aren’t always confusing
Parameters aren’t so complicated
Skewness and kurtosis describe a probability distribution’s shape
An observation is an observation
A sample is a subset of values
Inferential statistics are cool but complicated
Confidence intervals are super-useful

’ n as much that I discuss how to use Excel for statistical analysis in a
number of chapters in this book, I thought it might make sense to cover
some of the basics.

Don’t worry. I'm not going to launch into some college-level lecture about
things like chi-square or covariance calculations. You’'ll see no Greek symbols
in this chapter.

If you've never been exposed to statistics in school or it’s been a decade or
two since you were, let this chapter to help you use (comfortably) some of
the statistical tools that Excel provides.
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Descriptive Statistics
Are Straightforward

The first thing that you ought to know is that some statistical analysis and
some statistical measures are pretty darn straightforward. Descriptive sta-
tistics, which include things such as the pivot table cross-tabulations (that
I present in Chapters 3 and 4), as well as some of the statistical functions,
make sense even to somebody who’s not all that quantitative.

For example, if you sum a set of values, you get a sum. Pretty easy, right? And
if you find the biggest value or the smallest value in a set of numbers, that’s
pretty straightforward, too.

[ mention this point about descriptive statistics because a lot of times people
freak out when they hear the word statistics. That’s too bad because many of
the most useful statistical tools available to you are simple, easy-to-understand
descriptive statistics.

Averages Aren’t So Simple Sometimes

Here’s a weird thing that you might remember if you ever took a statistics
class. When someone uses the term average, what he usually refers to is
the most common average measurement, which is a mean. But you ought to
know that several other commonly accepted average measurements exist,
including mode, median, and some special mean measurements such as the
geometric mean and harmonic mean.

[ want to quickly cover some of these . . . not because you need to know all
this stuff, but because understanding that the term average is imprecise
makes some of the discussions in this book and much of Excel’s statistical
functionality more comprehensible.

To make this discussion more concrete, assume that you’re looking at a small
set of values: 1, 2, 3, 4, and 5. As you might know, or be able to intuitively
guess, the mean in this small set of values is 3. You can calculate the mean by
adding together all the numbers in the set (1+2+3+4+5) and then dividing this
sum (15) by the total number of values in the set (5).

Two other common average measurements are mode and median. [ start
with the discussion of the median measurement first because it’s easy to
understand using the data set that [ introduce in the preceding paragraph.
The median value is the value that separates the largest values from the
smallest values. In the data set 1, 2, 3, 4, and 5, the median is 3. The value 3
separates the largest values (4 and 5) from the smallest values (1 and 2). In
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other words, the median shows the middle point in the data. Half of the data
set values are larger than the median value, and half of the data set values are
smaller than the median value.

<F When you have an even number of values in your data set, you calculate the
median by averaging the two middle values. For example, the data set 1, 2, 3,
and 4 has no middle value. Add the two middle values — 2 and 3 — and then
divide by 2. This calculation produces a median value of 2.5. With the median
value of 2.5, half of the values in the data set are above the median value, and
half of the values in the data set are below the median value.

The mode measurement is a third common average. The mode is the most
common value in the data set. To show you an example of this, I need to intro-
duce a new data set. With the data set 1, 2, 3, 5, and 5, the mode is 5 because
the value 5 occurs twice in the set. Every other value occurs only once.

BER As I mention earlier, other common statistical measures of the average exist.
f The mean measurement that [ refer to earlier in this discussion is actually an
arithmetic mean because the values in the data set get added together arith-
metically as part of the calculation. You can, however, combine the values
in other ways. Financial analysts and scientists sometimes use a geometric
mean, for example. There is also something called a harmonic mean.

You don’t need to understand all these other different average measure-
ments, but you should remember that the term average is pretty imprecise.
And what people usually imply when they refer to an average is the mean.

Standard Deviations Describe Dispersion

Have you ever heard the term standard deviation? You probably have. Any
statistical report usually includes some vague or scary reference to either
standard deviation or its close relative, the variance. Although the formula
for standard deviation is terrifying to look at — at least if you're not com-
fortable with the Greek alphabet — intuitively, the formula and the logic are
pretty easy to understand.

A standard deviation describes how values in a data set vary around the
mean. Another way to say this same thing is that a standard deviation
describes how far away from the mean the average value is. In fact, you can
almost think of a standard deviation as being equal to the average distance
from the mean. This isn’t quite right, but it's darn close.

Suppose you're working with a data set, and its mean equals 20. If the data
set standard deviation is 5, you can sort of think about the average data set
value as being 5 units away from the mean of 20. In other words, for values
less than the mean of 20, the average is sort of 15. And for values that are
larger than the mean, the average value is kind of 25.
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The standard deviation isn’t really the same thing as the average deviation,
but it’s pretty darn close in some cases. And thinking about the standard
deviation as akin to the average deviation — or average difference from the
mean — is a good way to tune into the logic.

The neat thing about all this is that with statistical measures like a mean and
a standard deviation, you often gain real insights into the characteristics of
the data that you're looking at. Another thing is that with these two bits of
data, you can often draw inferences about data by looking at samples.

[ should tell you one other thing about the standard deviation. The statistical
terms variance and standard deviation are related. A standard deviation equals
the square root of a variance. Another way to say this same thing is that a
variance equals the square of a standard deviation.

It turns out that when you calculate things such as variances and standard
deviations, you actually arrive at the variance value first. In other words, you
calculate the variance before you calculate the standard deviation. For this
reason, you'll often hear people talk about variances rather than standard
deviations. Really, however, standard deviations and variances are almost the
same thing. In one case, you're working with a square root. In another case
you are working with a square.

It’s six of one, half a dozen of the other . .. sort of.

An Observation Is an Observation

Observation is one of the terms that you’ll encounter if you read anything
about statistics in this book or in the Excel online Help. An observation is
just an observation. That sounds circular, but bear with me. Suppose that
you're constructing a data set that shows daily high temperatures in your
neighborhood. When you go out and observe that the temperature some fine
July afternoon is 87° F, that measurement (87°) is your first observation. If
you go out and observe that the high temperature the next day is 88° F, that
measurement is your second observation.

Another way to define the term observation is like this: Whenever you actu-
ally assign a value to one of your random variables, you create an observa-
tion. For example, if you're building a data set of daily high temperatures

in your neighborhood, every time that you go out and assign a new tem-
perature value (87° one day, 88° the next day, and so on) you're creating an
observation.
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A Sample Is a Subset of Values

A sample is a collection of observations from a population. For example, if
you create a data set that records the daily high temperature in your neigh-
borhood, your little collection of observations is a sample.

In comparison, a sample is not a population. A population includes all
the possible observations. In the case of collecting your neighborhood’s
high temperatures, the population includes all the daily high tempera-
tures — since the beginning of the neighborhood’s existence.

Inferential Statistics Are
Cool but Complicated

As I note earlier in this chapter, some statistics are pretty simple. Finding the
biggest value in a set of numbers is a statistical measurement. But it’s really
pretty simple. Those simple descriptive statistical measures are called, clev-
erly, descriptive statistics.

Another more complicated but equally useful branch of statistics is inferen-
tial statistics. Inferential statistics are based on this very useful, intuitively
obvious idea. If you look at a sample of values from a population and the
sample is representative and large enough, you can draw conclusions about
the population based on characteristics of the sample.

For example, for every presidential election in the United States, the major
television networks (usually contrary to their earlier promises) predict the
winner after only a relatively small number of votes have been calculated or
counted. How do they do this? Well, they sample the population. Specifically,
they stand outside polling places and ask exiting voters how they voted. If
you ask a large sample of voters whether they voted for the one guy or the
other guy, you can make an inference about how all the voters voted. And
then you can predict who has won the election.

Inferential statistics, although very powerful, possess two qualities that I
need to mention:

v Accuracy issues: When you make a statistical inference, you can never
be 100 percent sure that your inference is correct. The possibility always
exists that your sample isn’t representative or that your sample doesn’t
return enough precision to estimate the population value.

This is partly what happened with the 2000 presidential election in the
United States. Initially, some of the major news networks predicted that
Al Gore had won based on exit polls. Then based on other exit polls,
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they predicted that George W. Bush had won. Then, perhaps finally real-
izing that maybe their statistics weren’t good enough given the close-
ness of the race. .. or perhaps just based on their own embarrassment
about bobbling the ball .. . they stopped predicting the race. In retro-
spect, it’s not surprising that they had trouble calling the race because
the number of votes for the two candidates was extremely close.

1~ Steep learning curve: Inferential statistics quickly gets pretty compli-
cated. When you work with inferential statistics, you immediately start
encountering terms such as probability distribution functions, all sorts of
crazy (in some cases) parameters, and lots of Greek symbols.

As a practical matter, if you haven't at least taken a statistics class — and
probably more than one statistics class — you'll find it very hard to move into
inferential statistics in a big way. You probably can, with a single statistics
class and perhaps the information in this book, work with inferential statistics
based on normal distributions and uniform distributions. However, working
with inferential statistics and applying those inferential statistics to other
probability distributions becomes very tricky. At least, that’s my observation.

Probability Distribution Functions
Aren’t Always Confusing

One of the statistical terms that you’ll encounter a little bit in this book — and
a whole bunch if you dig into the Excel Help file — is probability distribution
function. This phrase sounds pretty tricky; in some cases, granted, maybe it
is. But you can actually understand intuitively what a probability distribution
function is with a couple of useful examples.

One common distribution that you hear about in statistics classes, for exam-
ple, is a T distribution. A T distribution is essentially a normal distribution
except with heavier, fatter tails. There are also distributions that are skewed
(have the hump tilted) one way or the other. Each of these probability distri-
butions, however, has a probability distribution function that describes the
probability distribution chart.

Here are two probability distribution functions that you probably already
understand: uniform distribution and normal distribution.

Uniform distribution

One common probability distribution function is a uniform distribution. In a
uniform distribution, every event has the same probability of occurrence. As
a simple example, suppose that you roll a six-sided die. Assuming that the
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die is fair, you have an equal chance of rolling any of the values: 1, 2, 3, 4, 5,
or 6. If you roll the die 60,000 times, what you would expect to see (given the
large number of observations) is that you'll probably roll a 1 about 10,000
times. Similarly, you'll probably also roll a 2, 3, 4, 5, or 6 about 10,000 times
each. Oh sure, you can count on some variance between what you expect
(10,000 occurrences of each side of the six-sided die) and what you actually
experience. But your actual observations would pretty well map to your
expectations.

The unique thing about this distribution is that everything is pretty darn
level. You could say that the probability or the chance of rolling any one
of the six sides of the die is even, or uniform. This is how uniform distribu-
tion gets its name. Every event has the same probability of occurrence.
Figure 13-1 shows a uniform distribution function.
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Normal distribution

Another common type of probability distribution function is the normal distri-
bution, also known as a bell curve or a Gaussian distribution.

A normal distribution occurs naturally in many situations. For example, intel-
ligence quotients (IQs) are distributed normally. If you take a large set of
people, test their IQs, and then plot those IQs on a chart, you get a normal
distribution. One characteristic of a normal distribution is that most of the
values in the population are centered around the mean. Another character-
istic of a normal distribution is that the mean, the mode, and the median all
equal each other.
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Figure 13-2:
A normal
distribution
function.
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Do you kind of see now where this probability distribution function business
is going? A probability distribution function just describes a chart that, in
essence, plots probabilities. Figure 13-2 shows a normal distribution function.
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The following is the plot of the standard normal probability
density function.
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Note that this integral does not exist in a simple closed
formula. It is computed numerically.

A probability distribution function is just a function, or equation, that
describes the line of the distribution. As you might guess, not every probabil-
ity distribution looks like a normal distribution or a uniform distribution.

Parameters Aren’t So Complicated

A\\J

After you grasp the concept that a probability distribution function is essen-
tially an equation or formula that describes the line in a probability distribu-
tion chart, it’s pretty easy to understand that a parameter is an input to the
probability distribution function. In other words, the formula or function or
equation that describes a probability distribution curve needs inputs. In sta-
tistics, those inputs are called parameters.

Refer to Figure 13-2 to see its probability function. Most of those crazy Greek
symbols refer to parameters.

Some probability distribution functions need only a single simple parameter.
For example, to work with a uniform distribution, all you really need is the
number of values in the data set. A six-sided die, for example, has only six pos-
sibilities. Because you know that only six possibilities exist, you can pretty
easily calculate that there’s a 1-in-6 chance that any possibility will occur.
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BER
3@" A normal distribution uses two parameters: the mean and the standard
deviation.

Other probability distribution functions use other parameters.

Skewness and Kurtosis Describe a
Probability Distribution’s Shape

A couple of other useful statistical terms to know are skewness and kurtosis.
Skewness quantifies the lack of symmetry in a probability distribution. In

a perfectly symmetrical distribution, like the normal distribution (refer to
Figure 13-2), the skewness equals zero. If a probability distribution leans to
the right or the left, however, the skewness equals some value other than
zero, and the value quantifies the lack of symmetry.

Kurtosis quantifies the heaviness of the tails in a distribution. In a normal dis-
tribution, kurtosis equals zero. In other words, zero is the measurement for
a tail that looks like a tail in a normal distribution. The fail is the thing that
reaches out to the left or right. However, if a tail in a distribution is heavier
than a normal distribution, the kurtosis is a positive number. If the tails in a
distribution are skinnier than in a normal distribution, the kurtosis is a nega-
tive number.

Confidence Intervals Seem Complicated
at First, but Are Useful

Probabilities often confuse people, and perhaps this happens most when
during the U.S. presidential elections. Pundits talk in all sorts of confusing
ways about one candidate’s chances of winning (often in ways confusing to
even the pundits themselves).

Say, for example, some talking head on television says “The results of a recent
poll show that Barack Obama would receive 51% of the vote were the election
held today; the margin of error was +/- 3% with a confidence level of 95%.”

Okay, this sounds like a mouthful, but break it down and things get a little
clearer. What the survey really means is this: the pollsters took a sample of
the U.S. population and asked them who they would vote for today, and 51%
of the sample said they would vote for Mr. Obama.
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Now here’s where this gets interesting. Largely because of the size of the
sample, the pollsters can do some fancy math and infer that there’s sort-of
a 95% chance (more on this later) that the real percent of people who would
answer “Obama” in the entire population is between 48% and 54%. Note
“margin of error” is basically just another way to describe the confidence
interval.

An important thing to understand about confidence levels is that they’re
linked with the margin of error. If the pollsters in the example above had
wanted a range of values with a confidence level of 99%, the margin of error
they calculated would be larger.

To put it another way, perhaps there’s a 95% chance (sort-of) that the real
percent of people in the whole population who would answer “Obama” is
between 48% and 54%, but there’s a 99% chance (again, sort-of) that the real
percent of people with that answer is between 45% and 57%. The wider your
range of possible values, the more confidence you have that the real data
point falls within your range. Conversely, the more confident you want to be
that the real data point is included in your range, the wider you have to make
your range.

This is why it’s a bit of a pet peeve of mine that news organizations reporting
on polls will often report the margin of error for a poll, but not the confidence
level. Without knowing the confidence level the pollster used to calculate the
margin of error, the information on margin of error is pretty meaningless.

Another important thing to understand about confidence levels is that the
bigger you make your sample size, the smaller your margin of error will be
using the same confidence level. If you sample two people on the sidewalk by
asking them who they’re going to vote for, and one says “the challenger” and
one says “the incumbent,” you can’t then assert with much confidence that
when the whole country votes it will be a perfect 50-50 split. Data from this
sample would have an enormous margin of error, unless you use an incred-
ibly low confidence level for your calculations.

However, if you go out and randomly sample 5,000 people by asking who
they’re voting for, then you have some pretty solid ground to stand on when
making a prediction about who’s going to win the presidential race. Put
another way, a sample of 5,000 people leads to a much smaller margin of
error than a sample of 2, assuming you want for both samples the same level
of confidence for your range.

At this point, | should make a slight correction: When I said that what the
confidence interval means is that there’s a “95% chance the real number falls
within this range,” that’s not quite accurate, although it was easier to use
as an explanation when first describing the basic concept of a confidence
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interval. What an interval with 95% confidence really means, technically, is
that if, hypothetically, you were to take different samples from the same pop-
ulation over and over and over again, and then you calculated the confidence
interval for those samples in the exact same way for each new sample, about
95% of the time the confidence intervals you calculated from the samples
would include the real number (because your data from each sample will be
slightly different each time, and therefore the interval you calculate as well).
So when I say phrases like “95% chance” or “99% chance,” that’s what I really
meant. (I need to include this clarification so that my old statistics professors
don’t start shaking their heads in shame if they read this book.)

And my final point is this: Predicting election results is far from the only
useful thing you can do with confidence intervals. As just one example, say
you had some Google Analytics data on two different web ads you're running
to promote your small business, and you want to know which ad is more
effective. You can use the confidence interval formula to figure out how long
your ads need to run before Google’s collected enough data for you to know
which ad is really better. (In other words, the formula tells you how big your
sample size needs to be to overcome the margin of error.)
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Chapter 14

Almost Ten Tips for Presenting
Table Results and Analyzing Data

In This Chapter
Working hard to import data
Designing information systems to produce rich data
Remembering to forget about third-party sources
Always exploring descriptive statistics
Watching for trends
Cross-tabulating and re-cross-tabulation
Charting it, baby
Being aware of inferential statistics

r)roughout the pages of this book, here and there [ scatter tips on analyzing
data with Excel. In this chapter, however, [ want to take a step back from
the details of data analysis and offer a handful of general tips. Mostly, these
tips summarize and generalize the things that I discuss in the preceding chap-
ters of this book.

Work Hard to Import Data

Working to import good, rich data into Excel workbooks really is worthwhile.
[ know that sometimes importing data can be problematic. Headaches and
heartbreaks can happen when trying to grab data from other management
information systems and when trying to work with a database administrator
to get the right data into a format that provides for useful data analysis with
Excel.
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But in spite of the hassles of obtaining the data, you will find — I promise — that
importing good data into Excel is well worth the effort. Traditionally, people
make decisions by using very standard information sources . . . like the account-
ing system, or some third-party report, or newsletter, or publication. And those
traditional sources produce traditional insights, which is great. But when you
can work with a richer, deeper data set of raw information, you often glean
insights that simply don’t appear in the traditional sources.

Design Information Systems
to Produce Rich Data

More than 20 years ago now, as a young systems consultant with Arthur
Andersen (yes, that Arthur Andersen), I designed accounting systems and
financial information systems for large companies. In those days, we con-
centrated on creating systems that produced the reports that managers and
decision-makers wanted and that produced forms (such as invoices and
checks and purchase orders) that businesses required to operate.

Those items are still obviously key things to think about while you design
and install and manage information systems, such as an accounting system.
But I think that you also need to recognize that there will probably be
unplanned, unorthodox, unusual but still very valuable ways in which the
data that is collected by these management information systems can be ana-
lyzed. And so, if you work with or design or participate in implementing infor-
mation systems, you should realize that raw data from the system can and
should be passed to data analysis tools like Excel.

A simple example of this will show you what I mean. It applies even to the
smallest businesses. The QuickBooks accounting system, which I discuss a
little bit in earlier chapters in this book, is an extremely popular accounting
tool for small businesses. Hundreds of thousands of small businesses use
QuickBooks for their accounting, for example. And the one thing that [ would
say about QuickBooks users in general is that they often want to use the
QuickBooks system simply for accounting. They want to use it as a tool for
producing things like checks and invoices and for creating documents that
report on profits or estimate cash flow information.

And that’s good. If you're a business owner or manager, you definitely want
that information. But even with a simple system like QuickBooks, businesses
should collect richer sets of data . . . very detailed information about the
products or services a firm sells, for example. By doing this, even if you don’t
want to report on this information within QuickBooks, you create a very rich
data set that you can later analyze for good effect with Excel.
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Having rich, detailed records of the products or services that a firm sells
enables that firm to see trends in sales by product or service. Additionally,
it allows a firm to create cross-tabulations that show how certain customers
choose and use certain products and services.

The bottom line, I submit, is that organizations need to design information
systems so that they also collect good, rich, raw data. Later on, this data can
easily be exported to Excel, where simple data analysis — such as the types
that I describe in the earlier chapters of this book — can lead to rich insights
into a firm’s operation, its opportunities, and possible threats.

Don’t Forget about Third-Party Sources

3

One quick point: Recognize that many third-party sources of data exist. For
example, vendors and customers might have very interesting data available
in a format accessible to Excel that you can use to analyze their market or
your industry.

Earlier in the book, for example, | mention that the slowdown in computer
book sales and in computer book publishing first became apparent to me
based on an Excel workbook supplied by one of the major book distributors
in North America. Without this third-party data source, | would have contin-
ued to find myself bewildered about what was happening in the industry in
which [ work.

A quick final comment about third-party data sources is this: the Web Query
tool available in Excel (and as I describe in Chapter 2) makes extracting infor-
mation from tables stored on web pages very easy.

Just Add It

You might think that powerful data analysis requires powerful data analysis
techniques. Chi-squares. Inferential statistics. Regression analysis.

But [ don’t think so. Some of the most powerful data analysis that you can do
involves simply adding up numbers. If you add numbers and get sums that
other people don’t even know about — and if those sums are important or
show trends — you can gain important insights and collect valuable informa-
tion through the simplest data analysis techniques.

303
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Again, in echoing earlier tips in this chapter, the key thing is collecting really
good information in the first place and then having that information stored in
a container, such as an Excel workbook, so that you can arithmetically manip-
ulate and analyze the data.

Always Explore Descriptive Statistics

3

The descriptive statistical tools that Excel provides — including measure-
ments such as a sum, an average, a median, a standard deviation, and so
forth — are really powerful tools. Don’t feel as if these tools are beyond your
skill set, even if this book is your first introduction to these tools.

Descriptive statistics simply describe the data you have in some Excel work-
sheet. They're not magical, and you don’t need any special statistical training
to use them or to share them with the people to whom you present your data
analysis results.

Note, too, that some of the simplest descriptive statistical measures are often
the most useful. For example, knowing the smallest value in a data set or the
largest value can be very useful. Knowing the mean, median, or mode in a
data set is also very interesting and handy. And even seemingly complicated
sophisticated measures such as a standard deviation (which just measures
dispersion about the mean) are really quite useful tools. You don’t need to
understand anything more than this book describes to use or share this
information.

Watch for Trends

Peter Drucker, perhaps the best-known and most insightful observer of
modern management practices, noted in several of his last books that one of
the most significant things data analysis can do is spot a change in trends. |
want to echo this here, pointing out that trends are almost the most signifi-
cant thing you can see. If your industry’s combined revenues grow, that’s
significant. If they haven’t been growing or if they start shrinking, that’s prob-
ably even more significant.

In your own data analysis, be sure to construct your worksheets and col-
lect your data in a way that helps you identify trends and, ideally, identify
changes in trends.
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Slicing and Dicing: Cross-Tabulation

The PivotTable command, which I describe in Chapter 4, is a wonderful tool.
Cross-tabulations are extremely useful ways to slice and dice data. And as

I note in Chapter 4, the neat thing about the PivotTable tool is that you can
easily re-cross-tabulate and then re-cross-tabulate again.

[ go into a lot of detail in Chapter 4 about why cross-tabulation is so cool,

so I don’t repeat myself here. But [ do think that if you have good rich data
sources and you're not regularly cross-tabulating your data, you're probably
missing absolute treasures of information. There’s gold in them thar hills.

Chart It, Baby

A\\J

In Chapter 15, I provide a list of tips that you might find useful to graphically
or visually analyze data. In a nutshell, though, I think that an important com-
ponent of good data analysis is presenting and examining your data visually.

By looking at a line chart of some important statistic or by creating a column
chart of some set of data, you often see things that aren’t apparent in a tabular
presentation of the same information. Basically, charting is often a wonderful
way to discover things that you won’t otherwise see.

Be Aware of Inferential Statistics

To varying degrees in Chapters 9, 10, and 11, I introduce and discuss some of
the inferential statistics tools that Excel provides. Inferential statistics enable
you to collect a sample and then make inferences about the population from
which the sample is drawn based on the characteristics of the sample.

In the right hands, inferential statistics are extremely powerful and useful
tools. With good skills in inferential statistics, you can analyze all sorts of
things to gain all sorts of insights into data that mere common folk never get.
However, quite frankly, if your only exposure to inferential statistical tech-
niques is this book, you probably don’t possess enough raw statistical knowl-
edge to fairly perform inferential statistical analysis.
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Chapter 15

Ten Tips for Visually Analyzing
and Presenting Data

In This Chapter
Using the right chart type
Using your chart message as the chart title
Being wary of pie charts
Considering pivot charts for small data sets
Avoiding 3-D charts
Never using 3-D pie charts
Being aware of the phantom data markers
Using logarithmic scaling
Remembering to experiment
Getting Tufte

rlis isn’t one of those essays about how a picture is worth a thousand
words. In this chapter, | just want to provide some concrete suggestions
about how you can more successfully use charts as data analysis tools and
how you can use charts to more effectively communicate the results of the
data analysis that you do.

Using the Right Chart Type

What many people don’t realize is that you can make only five data compari-
sons in Excel charts. And if you want to be picky, there are only four practical
data comparisons that Excel charts let you make. Table 15-1 summarizes the
five data comparisons.
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Table 15-1 The Five Possible Data Comparisons in a Chart
Comparison Description Example
Part-to- Compares individual values Comparing the sales gener-
whole with the sum of those values. ated by individual products
with the total sales enjoyed
by a firm.
Whole-to- Compares individual data Comparing sales revenues of
whole values and sets of data different firms in your industry.

values (or what Excel calls
data series) to each other.

Time-series Shows how values change A chart showing sales rev-

over time. enues over the lastb years
or profits over the last 12
months.

Correlation Looks at different data series Comparing information about
in an attempt to explore the numbers of school-age
correlation, or association, children with sales of toys.
between the data series.

Geographic Looks at data values using a Examining sales by country
geographic map. using a map of the world.

If you decide or can figure out which data comparison you want to make,
choosing the right chart type is very easy:

v Pie, doughnut, or area: If you want to make a part-fo-whole data com-
parison, choose a pie chart (if you're working with a single data series)
or a doughnut chart or an area chart (if you're working with more than
one data series).

v Bar, cylinder, cone, or pyramid: If you want to make a whole-to-whole
data comparison, you probably want to use a chart that uses horizontal
data markers. Bar charts use horizontal data markers, for example, and
so do cylinder, cone, and pyramid charts. (You can also use a doughnut
chart or radar chart to make whole-to-whole data comparisons.)

v Line or column: To make a time-series data comparison, you want to use
a chart type that has a horizontal category axis. By convention, western
societies (Europe, North America, and South America) use a horizontal
axis moving from left to right to denote the passage of time. Because of
this culturally programmed convention, you want to show time-series
data comparisons by using a horizontal category axis. This means you
probably want to use either a line chart or column chart.
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»* Scatter or bubble: If you want to make a correlation data comparison in
Excel, you have only two choices. If you have two data series for which
you're exploring correlation, you want to use an XY (Scatter) chart. If
you have three data series, you can use either an XY (Scatter) chart or a
bubble chart.

v Surface: If you want to make a geographic data comparison, you're
very limited in what you can do in Excel. You might be able to make a
geographic data comparison by using a surface chart. But, more likely,
you need to use another data mapping tool such as MapPoint from
Microsoft.
< The data comparison that you want to make largely determines what chart
type you need to use. You want to use a chart type that supports the data
comparison that you want to make.

Using Your Chart Message
as the Chart Title

Chart titles are commonly used to identify the organization that you're pre-
senting information to or perhaps to identify the key data series that you're
applying in a chart. A better and more effective way to use the chart title,
however, is to make it into a brief summary of the message that you want
your chart to communicate. For example, if you create a chart that shows
that sales and profits are increasing, maybe your chart title should look like
the one shown in Figure 15-1.
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Using your chart message as the chart title immediately communicates to
your audience what you're trying to show in the chart. This technique also
helps people looking at your chart to focus on the information that you want
them to understand.

Beware of Pie Charts

3

You really want to avoid pie charts. Oh, I know, pie charts are great tools to
teach elementary school children about charts and plotting data. And you
see them commonly in newspapers and magazines. But the reality is that pie
charts are very inferior tools for visually understanding data and for visually
communicating quantitative information.

Almost always, information that appears in a pie chart would be better dis-
played in a simple table.

Pie charts possess several debilitating weaknesses:

+ You're limited to working with a very small set of numbers.

This makes sense, right? You can’t slice the pie into very small pieces or
into very many pieces without your chart becoming illegible.

v Pie charts aren’t visually precise.

Readers or viewers are asked to visually compare the slices of pie, but
that’s so imprecise as to be almost useless. This same information can be
shown much better by just providing a simple list or table of plotted values.

+ With pie charts, you’re limited to a single data series.

For example, you can plot a pie chart that shows sales of different prod-
ucts that your firm sells. But almost always, people will find it more
interesting to also know profits by product line. Or maybe they also
want to know sales per sales person or geographic area. You see the
problem. Because they’re limited to a single data series, pie charts very
much limit the information that you can display.

Consider Using Pivot Charts
for Small Data Sets

Although using pivot tables is often the best way to cross-tabulate data and
to present cross-tabulated data, remember that for small data sets, pivot
charts can also work very well. The key thing to remember is that a pivot
chart, practically speaking, enables you to plot only a few rows of data. Often
your cross-tabulations will show many rows of data.
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Figure 15-2:
A pivot
table cross-
tabulation.
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Figure 15-3:
A pivot
chart cross-
tabulation.
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However, if you create a cross-tabulation that shows only a few rows of data,
try a pivot chart. Figure 15-2 shows a cross-tabulation in a pivot table form;
Figure 15-3 shows a cross-tabulation in a pivot chart form. I wager that for
many people, the graphical presentation shown in Figure 15-3 shows the
trends in the underlying data more quickly, more conveniently, and more
effectively.
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Avoiding 3-D Charts

In general, and perhaps contrary to the wishes of the Microsoft marketing
people, you really want to avoid three-dimensional charts.

The problem with 3-D charts isn’t that they don’t look pretty: They do. The
problem is that the extra dimension, or illusion, of depth reduces the visual
precision of the chart. With a 3-D chart, you can’t as easily or precisely mea-
sure or assess the plotted data.

Figure 15-4 shows a simple column chart. Figure 15-5 shows the same infor-
mation in a 3-D column chart. If you look closely at these two charts, you can
see that it’s much more difficult to precisely compare the two data series in
the 3-D chart and to really see what underlying data values are being plotted.

Now, I'll admit that some people — those people who really like 3-D charts —
say that you can deal with the imprecision of a 3-D chart by annotating the
chart with data values and data labels. Figure 15-6 shows the way a 3-D
column chart would look with this added information. I don’t think that’s a
good solution because charts often too easily become cluttered with extrane-
ous and confusing information. Adding all sorts of annotation to a chart to
compensate for the fundamental weakness in the chart type doesn’t make a
lot of sense to me.
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Never Use 3-D Pie Charts

Hey, here’s a quick, one-question quiz: What do you get if you combine a pie
chart and three-dimensionality? Answer: A mess!

Pie charts are really weak tools for visualizing, analyzing, and visually com-
municating information. Adding a third dimension to a chart further reduces
its precision and usefulness. When you combine the weakness of a pie chart
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Figure 15-7:
Pie charts |-

canbe |-
misleading. |*

with the inaccuracy and imprecision of three-dimensionality, you get some-
thing that really isn’t very good. And, in fact, what you often get is a chart
that is very misleading.

Figure 15-7 shows the cardinal sin of graphically presenting information in a
chart. The pie chart in Figure 15-7 uses three-dimensionality to exaggerate
the size of the slice of the pie in the foreground. Newspapers and magazines
often use this trick to exaggerate a story’s theme.
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You never want to make a pie chart 3-D.

Be Aware of the Phantom Data Markers

One other dishonesty that you sometimes see in charts — okay, maybe some-
times it’s not dishonesty but just sloppiness — is phantom data markers.

A phantom data marker is some extra visual element on a chart that exagger-
ates or misleads the chart viewer. Figure 15-8 shows a silly little column chart
that I created to plot apple production in the state of Washington. Notice that
the chart legend, which appears off to the right of the plot area, looks like
another data marker. It’s essentially a phantom data marker. And what this
phantom data marker does is exaggerate the trend in apple production.
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Use Logarithmic Scaling

[ don’t remember much about logarithms, although I think I studied them
in both high school and college. Therefore, I can understand if you hear the
word logarithms and find yourself feeling a little queasy. Nevertheless, loga-
rithms and logarithmic scaling are tools that you want to use in your charts
because they enable you to do something very powerful.

With logarithmic scaling of your value axis, you can compare the relative
change (not the absolute change) in data series values. For example, say that
you want to compare the sales of a large company that's growing solidly but
slowly (10 percent annually) with the sales of a smaller firm that’s growing
very quickly (50 percent annually). Because a typical line chart compares
absolute data values, if you plot the sales for these two firms in the same
line chart, you completely miss out on the fact that one firm is growing much
more quickly than the other firm. Figure 15-9 shows a traditional simple line
chart. This line chart doesn’t use logarithmic scaling of the value axis.

Now, take a look at the line chart shown in Figure 15-10. This is the same
information in the same chart type and subtype, but I changed the scaling

of the value axis to use logarithmic scaling. With the logarithmic scaling,

the growth rates are shown rather than the absolute values. And when you
plot the growth rates, the much quicker growth rate of the small company
becomes clear. In fact, you can actually extrapolate the growth rate of the two
companies and guess how long it will take for the small company to catch up
with the big company. (Just extend the lines.)
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To tell Excel that you want to use logarithmic scaling of the value axis, follow

these steps:

1. Right-click the value (Y) axis and then choose the Format Axis com-

mand from the shortcut menu that appears.

2. When the Format Axis dialog box appears, select the Axis Options

entry from the list box.
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3. To tell Excel to use logarithmic scaling of the value (Y) axis, simply
select the Logarithmic Scale check box and then click OK.

Excel re-scales the value axis of your chart to use logarithmic scaling.
Note that initially Excel uses base 10 logarithmic scaling. But you can
change the scaling by entering some other value into the Logarithmic
Scale Base box.

Don’t Forget to Experiment

All the tips in this chapter are, in some ways, sort of restrictive. They suggest
that you do this or don’t do that. These suggestions — which are tips that
I've collected from writers and data analysts over the years — are really good
guidelines to use. But you ought to experiment with your visual presentations
of data. Sometimes by looking at data in some funky, wacky, visual way, you
gain insights that you would otherwise miss.

There’s no harm in, just for the fun of it, looking at some data set with a pie
chart. (Even if you don’t want to let anyone know you're doing this!) Just fool
around with a data set to see what something looks like in an XY (Scatter)
chart.

In other words, just get crazy once in a while.

Get Tufte

3

[ want to leave you with one last thought about visually analyzing and visu-
ally presenting information. I recommend that you get and read one of
Edward R. Tufte’s books. Tufte has written seven books, and these three are
favorites of mine: The Visual Display of Quantitative Information, 2nd Edition,
Visual Explanations: Images and Quantities, Evidence and Narrative, and
Envisioning Information.

These books aren’t cheap; they cost between $40 and $50. But if you regu-
larly use charts and graphs to analyze information or if you regularly present
such information to others in your organization, reading one or more of these
books will greatly benefit you.

By the way, Tufte’s books are often hard to get. However, you can buy them from
major online bookstores. You can also order Tufte’s books directly from his web-
site: www.edwardtufte.com. If you're befuddled about which of Tufte’s books
to order first, | recommend The Visual Display of Quantitative Information.
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Appendix

Glossary of Data Analysis
and Excel Terms

3-D pie charts: Perhaps the very worst way to share the results of your data
analysis — and often inexcusable.

absolute reference: A cell address used in a formula that Excel doesn’t adjust
if you copy the formula to some new location. To create an absolute cell refer-
ence, you precede the column letter and row number with a dollar sign ($).

Access: A database program developed and sold by Microsoft. Use Access to
build and work with large, sophisticated, relational databases; you can easily
export information from Access databases to Excel. Just choose the Access
Microsoft Office menu’s Export command.

arithmetic operators: The standard operators that you use in Excel formulas.
To add numbers, use the addition (+) operator. To subtract numbers, use

the subtraction (-) operator. To multiply numbers, use the multiplication

(*) operator. To divide numbers, use the division (/) operator. You can also
perform exponential operations by using the exponential operator (). See
operator precedence.

ascending order: A sorting option that alphabetizes labels and arranges
values in smallest-value-to-largest-value order. See also chronological order;
descending order.

ASCII text file: A type of text file that in essence is just straight text and
nothing else. See also delimited text file; importing.

AutoFilter: An Excel tool (available from the Data tab’s Filter command)

that helps you produce a new table that’s a subset of your original table. For
example, in the case of a grocery list table, you could use AutoFilter to create
a subset that shows only those items that you'll purchase at a particular
store, in specified quantities, or that exceed a certain price.
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average: Typically, the arithmetic mean for a set of values. Excel supplies
several averaging functions. See also median; mode.

binomial distributions: Used to calculate probabilities in situations in which
you have a limited number of independent trials, or tests, which can either
succeed or fail. Success or failure of any one trial is independent of other
trials.

Boolean expressions: Also known as logical expressions, these expressions
describe a comparison that you want to make. For example, to compare
fields with the value 1,000,000, you use a Boolean expression. To construct a
Boolean expression, you use a comparison operator and then a value used in
the comparison.

calculated field: Used to insert a new row or column into a pivot table and
then fill the new row or column with a formula.

calculated item: An amount shown in a pivot table that you create by
calculating a formula. Frankly, adding a calculated item usually doesn’t
make any sense. But, hey, strange things happen all the time, right?

cells: In Excel, the intersections of rows and columns. A cell location is
described using the column letter and row number. For example, the cell in
the upper-left corner of the workbook is labeled A1.

chart data labels: Annotate data markers with pivot table information or list
information.

chart legend: Identifies the data series that you plot in your chart.
chart titles: Text that you use to label the parts of a chart.

chart type: Includes column, bar, line, pie, XY, surface, and so on. In Excel,
you can create a bunch of different types of charts.

chi-square: Used to compare observed values with expected values, returning
the level of significance, or probability (also called a p-value). That p-value lets
you assess whether differences between the observed and expected values
represent chance.

chronological order: A sorting option that arranges labels or values in
chronological order such as Monday, Tuesday, Wednesday, and so on.
See also ascending order; descending order.
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comparison operator: A mathematical operator used in a Boolean
expression. For example, the > comparison operator makes greater than
comparisons. The = operator makes equal to comparisons. The <= operator
makes less than or equal to comparisons. Cool, huh? See also Boolean
expressions.

counting: Used for useful statistical functions for counting cells within a
worksheet or list. Excel provides four counting functions: COUNT, COUNTA,
COUNTBLANK, and COUNTIF. Excel also provides two useful functions for
counting permutations and combinations: PERMUT and COMBIN.

cross-tabulation: An analysis technique that summarizes data in two or more
ways. For example, if you run a business and summarize sales information
both by customer and by product, that’s a cross-tabulation because you
tabulate the information in two ways. See also pivot table.

Custom Calculations: Used to add many semi-standard calculations to a
pivot table. By using Custom Calculations, for example, you can calculate the
difference between two pivot table cells, percentages, and percentage differ-
ences. See also pivot table.

Data Analysis: An Excel add-in with which you perform statistical analysis.

data category: Organizes the values in a data series. That sounds complicated;
however, in many charts, identifying the data category is easy. In any chart
(including a pivot chart) that shows how some value changes over time, the
data category is time. See also data series.

data list: Another name for an Excel table.

data series: Oh geez, this is another one of those situations where somebody’s
taken a ten-cent idea and labeled it with a five-dollar word. Charts show data
series. And a chart legend names the data series that a chart shows. For exam-
ple, if you want to plot sales of coffee products, those coffee products are your
data series. See also data category.

data validation: An Excel command with which you describe what information
can be entered into a cell. The command also enables you to supply messages
that give data input information and error messages to help users correct
data entry errors.

database functions: A special set of functions for simple statistical analysis of
information that you store in Excel tables.
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delimited text file: A type of text file. Delimited text files use special characters,
called delimiters, to separate fields of information in the report. For example,
such files commonly use the Tab character to delimit. See also ASCII text file;
importing.

descending order: A sorting order that arranges labels in reverse alpha-
betical order and values in largest-value-to-smallest-value order. See also
ascending order; chronological order.

descriptive statistics: Describe the values in a set. For example, if you sum a
set of values, that sum is a descriptive statistic. If you find the largest value
or the smallest value in a set of numbers, that’s also a descriptive statistic.

exponential smoothing: Calculates the moving average but weights the
values included in the moving average calculations so that more recent
values have a bigger effect. See also moving average.

exporting: In the context of databases, moving information to another
application. If you tell your accounting system to export a list of vendors that
Excel can later read, for example, you're exporting. Many business applica-
tions, by the way, do easily export data to Excel. See also importing.

F distributions: Compare the ratio in variances of samples drawn from
different populations and draw a conclusion about whether the variances
in the underlying populations resemble each other.

field: In a database, stores the same sort of information. In a database that
stores people’s names and addresses, for example, you'll probably find a
Street Address field. In Excel, by the way, each column shows a particular
sort of information and therefore represents a field.

field settings: Determine what Excel does with a field when it’s cross-tabulated
in the pivot table. See also cross-tabulation; pivot table.

formulas: Calculation instructions entered into worksheet cells. Essentially,
this business about formulas going into workbook cells is the heart of Excel.
Even if an Excel workbook did nothing else, it would still be an extremely
valuable tool. In fact, the first spreadsheet programs did little more than
calculate cell formulas. See also text labels; value.

function: A pre-built formula that you can use to more simply calculate some
amount, such as an average or standard deviation.

function arguments: Needed in most functions; also called inputs. All database
functions need arguments, which you include inside parentheses. If a function
needs more than one argument, you separate arguments by using commas.
See also database functions.
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header row: A top row of field names in your table range selection that
names the fields.

histogram: A chart that shows a frequency distribution.

importing: In the context of databases, grabbing information from some other
application. Excel rather easily imports information from popular databases
(such as Microsoft Access), other spreadsheets (such as Lotus 1-2-3), and
from text files. See also exporting.

inferential statistics: Based on a very useful, intuitively obvious idea that if
you look at a sample of values from a population and if the sample is repre-
sentative and large enough, you can draw conclusions about the population
based on characteristics of the sample.

kurtosis: A measure of the tails in a distribution of values. See also skewness.

list: Another name for table, a list is, well, a list. This definition sounds circu-
lar, I guess, but if you make a list (sorry) of the things that you want to buy at
the grocery store, that’s a list. Excel lists, or tables, usually store more infor-
mation than just names of items. Usually, Excel tables also store values. In the
case of a grocery list, the Excel table might include prices and quantities of
the items that you’re shopping for.

logarithmic scale: Used in a chart to view rates of change, rather than
absolute changes, in your plotted data.

median: The middle value in a set of values. Half the values fall below the
median, and half the values fall above the median. See also average; mode.

Microsoft Access: See Access.

Microsoft Query: See Query.

mode: The most common value in a set. See also average; median.
moving average: An average that’s calculated by using only a specified set
of values, such as an average based on just the last three values. See also

exponential smoothing.

normal distribution: The infamous bell curve. Also known as a Gaussian
distribution.

objective function: The formula that you want to optimize when performing
optimization modeling. In the case of a profit formula, for example, you want
to maximize a function. But some objective functions should be minimized.
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For example, if you create an objective function that describes the cost of
some advertising program or the risk of some investment program, you
may logically choose to minimize your costs or risks. See also optimization
modeling.

observation: Suppose that you're constructing a data set that shows daily
high temperatures in your neighborhood. When you go out and observe that
the temperature some fine July afternoon is 87°, that measurement is your
observation.

operator precedence: Standard rules that determine the order of arithmetic
operations in a formula. For example, exponential operations are performed first.
Multiplication and division operations are performed second. Addition and sub-
traction operations are performed third. To override these standard rules, use
parentheses. See also formulas.

optimization modeling: A problem-solving technique in which you look
for the optimum value of an objective function while explicitly recognizing
constraints. See also objective function.

parameter: An input to a probability distribution function.

phantom data marker: Some extra visual element on a chart that exagger-
ates the chart message or misleads the chart viewer. Usually, phantom data
markers are embellishments that someone has added (hopefully, not you!)
that sort of resemble the chart’s real data markers — especially to the eyes of
casual chart viewers.

pivot chart: A cross-tabulation that appears in a chart. See also cross-
tabulation.

pivoting and re-pivoting: The thing that gives the pivot table its name. You
can continue cross-tabulating the data in the pivot table. You can pivot, and
re-pivot, and re-pivot again. . . .

pivot table: Perhaps the most powerful analytical tool that Excel provides.
Use the PivotTable command to cross-tabulate data stored in Excel lists.
See also cross-tabulation.

primary key: In sorting, the field first used to sort records. See also
secondary key; sort; and if you're really interested, tertiary key.

probability distribution: A chart that plots probabilities. See also normal
distribution; uniform distribution.

probability distribution function: An equation that describes the line of the
probability distribution. See also probability distribution.
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p-value: The level of significance, or probability.

Query: A program that comes with Excel. Use Query to extract information
from a database and then place the results into an Excel workbook.

QuickBooks: The world’s most popular small business accounting program —
and one of the many business applications that easily, happily, and without
complaint exports information to Excel. In QuickBooks, for example, you
simply click a button cleverly labeled Excel.

range: In terms of Excel data analysis, refers to two different items. A range
can be a reference to a rectangle of cells in a worksheet, or a range can show
the difference between the largest and smallest values in the data set.

record: A collection of related fields in a table. In Excel, each record goes into
a separate row.

refreshing pivot data: Updating the information shown in a pivot table
or pivot chart to reflect changes in the underlying data. You can click the
Refresh data tool provided by the PivotTable toolbar button to refresh.

regression analysis: Plotting pairs of independent and dependent variables
in an XY chart and then finding a linear or exponential equation that best
describes the plotted data.

relational database: Essentially, a collection of tables or lists. See also
table; list.

relative reference: A cell reference used in a formula that Excel adjusts if you
copy the formula to a new cell location. See also absolute reference.

scatter plot: An XY chart that visually compares pairs of values. A scatter
plot is often a good first step when you want to perform regression analysis.
See also regression analysis.

secondary key: In sorting, the second field used to sort records. The secondary
key comes into play only when the primary keys of records have the same
value. See also primary key; sort.

skewness: A measure of the symmetry of a distribution of values. See also
kurtosis.

solve order: The order in which calculated item formulas should be solved.
See also calculated item.

Solver: An Excel add-in with which you perform optimization modeling.
See also optimization modeling.
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Solver variables: The variables in an optimization modeling problem. See
optimization modeling.

sort: To arrange list records in some particular order, such as alphabetically
by last name. Excel includes easy-to-use tools for doing this, by the way.

standard deviation: Describes dispersion about the data set’s mean. You
can think of a standard deviation as an average deviation from the mean.
See also average, variance.

table: In relational databases and also in Excel, where information is stored.
Tables are essentially spreadsheets, or lists, that store database information.

tertiary key: In sorting, the third field used to sort records. The tertiary key
comes into play only when the primary and secondary keys of records have
the same value. See also primary key; secondary key; sort.

text file: A file that’s all text. Many programs export text files, by the way,
because other programs (including Excel) often easily import text files.

text functions: Used to manipulate text strings in ways that enable you

to easily rearrange and manipulate the data that you import into an Excel
workbook. Typically, these babies are extremely useful tools for scrubbing
or cleaning the data that you want to later analyze.

text labels: Includes letters and numbers that you enter into worksheet cells
but that you don’t want to use in calculations. For example, your name, a
budget expense description, and a telephone number are all examples of text
labels. None of these pieces of information get used in calculations.

time-series chart: Shows how values change over time. A chart that shows
sales revenues over the last 5 years or profits over the last 12 months, for
example, is a time-series chart.

Tufte, Edward: The author of a series of wonderful books about visually
analyzing and visually presenting information. I recommend that you read at
least one of Tufte’s books.

t-value: Sort of like a poor-man’s z-value. When you’re working with small
samples — fewer than 30 or 40 items — you can use what'’s called a student
t-value to calculate probabilities rather than the usual z-value, which is what
you work with in the case of normal distributions. Not coincidentally, Excel
provides three T distribution functions. See also z-value.

uniform distribution: Having the same probability of occurrence in
every event. One common probability distribution function is a uniform
distribution.
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value: Some bit of data that you enter into a workbook cell and may want to
later use in a calculation. For example, the actual amount that you budget for
some expense would always be a number or value. See also formulas, text
labels; workbook.

variance: Describes dispersion about the data set’s mean. The variance is the
square of the standard deviation. Conversely, the standard deviation is the
square root of the variance. See also average; standard deviation.

Web query: Grabbing data from a table that’s stored in a web page. Excel
provides a very slick tool for doing this, by the way.

workbook: An Excel spreadsheet document or file. A spreadsheet comprises
numbered rows and lettered columns. See also cells.

x-values: The independent values in a regression analysis.

y-values: The dependent values in a regression analysis.

z-value: In statistics, describes the distance between a value and the mean in
terms of standard deviations. (How often does one get to include a legitimate

Z entry in a glossary! Not often, but here I do.) See also average, standard
deviation.
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< (less than) Boolean operator, 27, 180
<= (less than or equal to) Boolean
operator, 27, 180

<> (not equal to) Boolean operator, 27, 180

= (equals) Boolean operator, 27, 180
> (greater than) Boolean operator, 27
>= (greater than or equal to) Boolean
operator, 27, 180

3-D charts

avoiding, 312-313

changing view, 154

formatting walls, 154

pie charts, 313-314, 319
3-D View command, 154

o/ o

A argument
BETA.DIST function, 219
BETA. INV function, 220
absolute references, 228, 319
Access. See Microsoft Access
actual_range argument, CHISQ.TEST
function, 214
Advanced Excel Options dialog box,
QuickBooks, 33
Advanced Filter dialog box, 28
Advanced Text Import Settings
dialog box, 4041, 44
alpha argument
BETA.DIST function, 219-220
BETA. INV function, 220
BINOM. INV function, 208-209
CONFIDENCE.NORM function, 199
CONFIDENCE. T function, 199-200
CRITBINOM function, 210
GAMMA . DIST function, 221
GAMMAINV function, 222
WEIBULL function, 223-224

American National Standards Institute
(ANSD), 65
analysis of variance (ANOVA), 256, 260-261
Analysis ToolPak (Data Analysis add-in).
See also descriptive statistics;
inferential statistics
defined, 321
installing, 226, 245
Andersen, Arthur, 302
ANOVA (analysis of variance), 256, 260-261
ANOVA dialog boxes, 260-261
ANSI (American National Standards
Institute), 65
Answer Report, 273-275
area charts, 308
arguments
AVEDEYV function, 181
AVERAGE function, 182
AVERAGEA function, 182
BETA.DIST function, 219-220
BETA. INV function, 220
BINOM.DIST function, 208
BINOM.DIST.RANGE function, 209
BINOM. INV function, 208-209
CHISQ.DIST function, 213
CHISQ.DIST.RT function, 212
CHISQ. INV function, 214
CHISQ. INV.RT function, 213
CHISQ.TEST function, 214
CLEAN function, 65
COMBIN function, 180
CONCATENATE function, 65-66
CONFIDENCE.NORM function, 199
CONFIDENCE. T function, 199-200
CORREL function, 218
COUNT function, 178
COUNTA function, 179
COUNTBLANK function, 179
COUNTIF function, 179-180
COVARIANCE. P function, 196
COVARIANCE. S function, 196
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CRITBINOM function, 210
DAVERAGE function, 163-164
DCOUNT function, 166-167
DCOUNTA function, 166-167
defined, 322

DEVSQ function, 196

DGET function, 168

DMAX function, 169

DMIN function, 169
DPRODUCT function, 170
DSTDEV function, 171
DSTDEVP function, 171
DSUM function, 173

DVAR function, 174

DVARP function, 174
EXACT function, 66
EXPON.DIST function, 220
F.DIST function, 205
F.DIST.RT function, 206
FIND function, 67

F.INV function, 206
F.INV.RT function, 207
FISHER function, 219
FISHERINV function, 219
FIXED function, 67
FORECAST function, 215
FREQUENCY function, 189
F.TEST function, 207
GAMMA . DIST function, 221
GAMMAINV function, 222
GAMMALN function, 222
GEOMEAN function, 184
GETPIVOTDATA function, 126
GROWTH function, 217
HARMEAN function, 184
HYPGEOM.DIST function, 211
INTERCEPT function, 216
KURT function, 200

LARGE function, 186

LEFT function, 68

LEN function, 68

LINEST function, 216
LOGEST function, 217
LOGINV function, 222-223
LOGNORMDIST function, 222
LOWER function, 68-69

MAX function, 185
MAXA function, 185
MEDIAN function, 183
MID function, 69
MIN function, 185
MINA function, 186
MODE function, 184
NEGBINOM.DIST function, 210
NORM.DIST function, 197
NORM. INV function, 198
NORM. S .DIST function, 198
NORM. S . INV function, 199
overview, 158

PEARSON function, 218
PERCENTILE function, 189
PERCENTRANK function, 188
PERMUT function, 180
POISSON function, 223
PROB function, 190-191
PROPER function, 69

RANK function, 187
REPLACE function, 70

REPT function, 70

RIGHT function, 70-71

RSQ function, 218

SEARCH function, 71

SKEW function, 201

SKEW. P function, 201
SLOPE function, 216

SMALL function, 186-187
STANDARDIZE function, 199
STDEV function, 193
STDEVA function, 193-194
STDEVP function, 194
STDEVPA function, 194
STEYX function, 217
SUBSTITUTE function, 71-72
supplying, 161

T function, 72

T.DIST function, 202-203
T.DIST.2T function, 203
T.DIST.RT function, 203
TEXT function, 72-73

T . INV function, 204
T.INV.2T function, 204
TREND function, 217

TRIM function, 73



TRIMMEAN function, 183
T.TEST function, 204-205
UPPER function, 73
VALUE function, 73-74
VAR function, 195
VARA function, 195
VARP function, 195-196
VARPA function, 196
WEIBULL function, 223-224
ZTEST function, 224
arithmetic operators, 319
array argument
CORREL function, 218
COVARIANCE. P function, 196
COVARIANCE. S function, 196
F.TEST function, 207
LARGE function, 186
PEARSON function, 218
PERCENTILE function, 189
PERCENTRANK function, 188
SMALL function, 186-187
TRIMMEAN function, 183
T.TEST function, 204-205
ZTEST function, 224
array formulas, 191
ascending order, 19, 319
ASCII text files
defined, 319
headers, 38
importing, 37-41
opening, 37-38
previewing, 39
AutoFill feature, 15
AutoFilter feature
customizing, 23-25
defined, 319
process for using, 21-22
turning off filters, 23
undoing filters, 23
AutoFit Column Width command, 58
AVEDEV function, 181-182
AVERAGE function, 158, 182
AVERAGEA function, 182
averages
arithmetic mean, 158, 182
calculating for selected range, 16-17

defined, 320
moving, 235-237, 323
overview, 290-291
value field setting, 97
for values in lists, 163-165
Axes command, 149
Axis Titles command, 143-144
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B argument
BETA.DIST function, 219
BETA. INV function, 220
BAHTEXT function, 65
bar charts, 308
bell curves. See normal distributions
beta argument
BETA.DIST function, 219-220
BETA. INV function, 220
GAMMA .DIST function, 221
GAMMAINV function, 222
WEIBULL function, 223-224
beta probability
cumulative beta probability density,
219-220
inverse cumulative beta probability
density, 220
BETA.DIST function, 219-220
BETA. INV function, 220
BINOM.DIST function, 208
BINOM.DIST.RANGE
function, 209
binomial distributions
binomial probability distribution,
208-209

binomial probability of trial result, 209

cumulative, 210
defined, 320
hypergeometric distribution, 211
negative, 210
overview, 207
BINOM. INV function, 208-209
bins array argument, FREQUENCY
function, 189
Boolean expressions, 26-27, 320
bubble charts, 309

Index 33 ’
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calculated fields
defined, 320
inserting, 115-117
removing, 120
reviewing and changing solve order,
122-123
reviewing formulas, 121-122
Calculated Item Solve Order dialog box,
122-123
calculated items
defined, 320
inserting, 117-119
removing, 120-121
reviewing and changing solve order,
122-123
reviewing formulas, 121-122
cells
aligning contents, 61
borders, 61
copying data, 62
counting by matching criteria, 179-180
counting empty, 179
counting with values, 178-179
defined, 320
formatting contents, 61
moving data, 62
replacing data, 62-63
showing details of, 96-97
Change Chart Type dialog box, 141-142
CHAR function, 65
chart data labels, 145-147, 320
chart legends, 131, 145, 320
Chart Options dialog box, 252
Chart Title command, 143-144
chart titles, 143-144, 309-310, 320
charts. See also pivot charts
3-D, 154, 312-314, 319
data comparisons made with, 307-308
experimentation with, 317
logarithmic scaling, 315-317
phantom data markers, 314-315
titles, 309-310
types of, 308-309, 320
usefulness of, 305

Charts toolbar, 139
CHISQ.DIST function, 213
CHISQ.DIST.RT function, 212-213
CHISQ.INV function, 214
CHISQ.INV.RT function, 213-214
CHISQ.TEST function, 214-215
chi-square distributions
chi-square test, 214-215
defined, 320
inverse of left-tailed probability of, 214
inverse of right-tailed probability of,
213-214
left-tailed probability of, 213
overview, 211
right-tailed probability of, 212-213
Choose Data Source dialog box, 50
chronological order, 123, 320
CLEAN function, 65
cleaning data
with Data Validation command, 74-77
editing imported workbooks, 57-63
with text functions, 63-74
Clear All command, 61
Clear Filter command, 23
CODE function, 65
column charts, 308
Column Width command, 60
Column Width dialog box, 60
columns
banded, 105
defined, 11
deleting unnecessary, 58
grand total, 100, 105
resizing, 58-60, 100
selecting data for pivot tables, 85-86
COMBIN function, 180-181
combinations, counting, 180-181
comma-delimited files, 36
comparison operators, 27, 180, 321
CONCATENATE function, 65-66
cone charts, 308
confidence intervals
FISHER function, 219
overview, 297-299
for population mean, 200-201
z-test calculations, 249
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Confidence Level(X) Percentage statistical
measure, 230
CONFIDENCE .NORM function, 200
CONFIDENCE.T function, 200-201
const argument
GROWTH function, 217
LINEST function, 216
LOGEST function, 217
TREND function, 217
Copy command, 62, 74
CORREL function, 218
correlation
convert Pearson’s r-squared
value to z, 219
convert z to Pearson’s r-squared
value, 219
correlation coefficient, 218
correlation comparison, 308-309
Correlation tool, 257-258
Pearson correlation coefficient, 218
r-squared value for Pearson correlation
coefficient, 218
Correlation dialog box, 257-258
COUNT function, 178
Count Numerical function, 17-18
COUNTA function, 179
COUNTBLANK function, 179
COUNTIF function, 179-180
counting
cells by matching criteria, 179-180
cells with values, 178-179
combinations, 180-181
defined, 321
empty cells, 179
permutations, 180
in selected range, 16-18
statistical measure, 230
value field setting, 97
Covariance dialog box, 258-259
Covariance tool, 258-259
COVARIANCE. P function, 196
COVARIANCE. S function, 196
Create Disk File dialog box, QuickBooks, 36
Create Names from Selection dialog box,
266-267
Create PivotChart dialog box, 129-131
Create PivotTable dialog box, 83-84

Create Table dialog box, 13-14
CRITBINOM function, 210
criteria argument
COUNTIF function, 179-180
DAVERAGE function, 163-164
DCOUNT function, 166
DCOUNTA function, 166
DGET function, 168
DMAX function, 169
DMIN function, 169
DPRODUCT function, 170
DSTDEV function, 171
DSTDEVP function, 171
DSUM function, 173
DVAR function, 174
DVARP function, 174
cross-tabulations. See also pivot charts;
pivot tables
defined, 81, 321
example of, 81-82
usefulness of, 305
cumulative argument
BETA.DIST function, 219-220
BINOM.DIST function, 208
CHISQ.DIST function, 213
EXPON.DIST function, 220
F.DIST function, 205
F.DIST.RT function, 206
GAMMA .DIST function, 221
HYPGEOM.DIST function, 211
NORM.DIST function, 197
POISSON function, 223
T.DIST function, 202-203
WEIBULL function, 223-224
Custom AutoFilter dialog box, 23-24, 26
Custom Calculations feature
adding second standard calculation
for, 112
customizing standard calculation,
113-115
defined, 111, 321
naming, 114
options for, 112
Custom Sort command, 19
Custom Sort dialog box, 19-20
Cut command, 62
cylinder charts, 308
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Data Analysis add-in (Analysis ToolPak).
See also descriptive statistics;
inferential statistics

defined, 321
installing, 226, 245

Data Analysis dialog box, 227

data category, 132, 321

Data Field Settings dialog box, 97

Data Labels command, 145-146

data lists, defined, 321

data series, 131, 321

Data Table command, 147

Data Validation command

defined, 74, 321
defining criteria, 75
error messages, 77
input messages, 76
process for, 74-77
scope of validation, 75

Data Validation dialog box,
74-77

data_array argument, FREQUENCY
function, 189

data_field argument, GETPIVOTDATA
function, 126

database argument

DAVERAGE function, 163
DCOUNT function, 166
DCOUNTA function, 166
DGET function, 168
DMAX function, 169
DMIN function, 169
DPRODUCT function, 170
DSTDEV function, 171
DSTDEVP function, 171
DSUM function, 173
DVAR function, 174
DVARP function, 174
database functions
DAVERAGE, 163-165
DCOUNT, 166-167
DCOUNTA, 166-167
defined, 321
DGET, 168-169
DMAX, 169-170

DMIN, 169-170
DPRODUCT, 170-171
DSTDEV, 171-173
DSTDEVP, 171-173
DSUM, 173-174
DVAR, 174-175
DVARP, 174-175
entering by category, 163
entering manually, 158
entering with Function command,
159-163
general discussion, 157
syntax rules, 158
DAVERAGE function, 163-165
DCOUNT function, 166-167
DCOUNTA function, 166-167
decimals argument, FIXED function, 67
deg_ freedom argument
CHISQ.DIST function, 213
CHISQ.DIST.RT function, 212
CHISQ.INV function, 214
CHISQ.INV.RT function, 213
.DIST function, 205
.DIST.RT function, 206
. INV function, 206
. INV.RT function, 207
.DIST function, 202
.DIST. 2T function, 203
.DIST.RT function, 203
. INV function, 204
T.INV.2T function, 204
Delete command, 58
delimited text files
defined, 36, 322
headers, 42
importing, 41-44
opening, 41-42
previewing, 43-44
descending order, 19, 322
descriptive statistics
defined, 225, 322
Descriptive Statistics tool, 226-230
Exponential Smoothing tool, 237-239
Histogram tool, 230-232
Moving Averages tool, 235-237
Random Number Generation tool,
239-241
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Rank and Percentile tool, 233-234
Sampling tool, 241-244
straightforward nature of, 290
usefulness of, 304

Descriptive Statistics dialog box, 227-228

Descriptive Statistics tool
measures calculated by, 229-230
overview, 226
process for using, 227-229

DEVSQ function, 196

DGET function, 168-169

Difference From custom calculation, 112

DMAX function, 169-170

DMIN function, 169-170

doughnut charts, 308

DPRODUCT function, 170-171

Drucker, Peter, 304

DSTDEV function, 171-173

DSTDEVP function, 171-173

DSUM function, 173-174

DVAR function, 174-175

DVARP function, 174-175

oF o

Enable Selection command, 96
Entire PivotTable subcommand, Select
command, 123
Entire Selection subcommand, Select
command, 96
Entire Table subcommand, Select
command, 96
Error in model. Please
verify that all cells and
constraints are wvalid message,
Solver add-in, 286
EXACT function, 66
Excel 2007/Excel 2010
AutoFilter command, 21
Axes command, 149
Axis Titles command, 143
Calculated Item Solve Order
dialog box, 122
Chart Title command, 143
Data Labels command, 146
Excel Options dialog box, 226, 245

Format Chart Title dialog box, 144
Format Walls command, 154
Gridlines command, 150
hiding/displaying PivotTable
Field List, 91
Insert Calculated Field dialog box,
116, 120
Insert Calculated Item dialog box,
118, 120
Insert Function dialog box, 65
Legend command, 145
List Formulas command, 122
More Data Label Options command, 146
pivot chart customization, 141
pivot chart layouts, 142
PivotChart command, 129
PivotChart Wizard, 129
resizing columns, 60
resizing rows, 60
retrieving all values from pivot
tables, 123
sorting records, 19
trendlines, 253
Excel Options dialog box, 226, 245
expected range argument, CHISQ.TEST
function, 214
EXPON.DIST function, 220-221
exponential probability, 220-221
exponential smoothing
defined, 322
overview, 237
process for using, 237-239
Exponential Smoothing dialog box,
237-239
Export command, Microsoft Access, 34
Export Report dialog box, QuickBooks, 33
exporting data from databases
defined, 322
to delimited text files, 36
direct exporting from Microsoft Access,
33-34
direct exporting from QuickBooks,
32-34
general discussion, 12
overview, 12
to text files, 34-36

Index 335
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F.DIST function, 205
f-distributions
defined, 322
left-tailed f-value given
probability of, 206
left-tailed probability of, 205
overview, 205

probability data set variances not

different, 207
right-tailed f-value given
probability of, 207
right-tailed probability of, 206
F.DIST.RT function, 206
field argument
DAVERAGE function, 163
DCOUNT function, 166-167
DCOUNTA function, 166-167
DGET function, 168
DMAX function, 169
DMIN function, 169
DPRODUCT function, 170
DSTDEV function, 171
DSTDEVP function, 171
DSUM function, 173
DVAR function, 174
DVARP function, 174
GETPIVOTDATA function, 126
field settings, 97-98, 108-109,
113-114, 322
fields, defined, 11, 322
Fill command, 15-16
Fill Handle, 15-16
Filter command, 21, 23, 26
filtering data
advanced filtering, 26-29
AutoFilter feature, 21-25
filtering filtered tables, 25-26
in pivot charts, 134-136
in pivot tables, 89-90, 100

querying external databases, 53

Find & Select command, 62

Find and Replace dialog box, 62-63

FIND function, 67

find text argument
FIND function, 67
SEARCH function, 71
F. INV function, 206
F.INV.RT function, 207
FISHER function, 219
FISHERINV function, 219
FIXED function, 67
flat-file databases, 11
FORECAST function, 215
Format Axis pane, 149
Format Cells dialog box, 61, 97-98,
103-104
Format Chart Area command, 152
Format Chart Area pane, 152-153, 154
Format Chart Title pane, 143-144
Format Data Labels pane, 146-147
Format Data Table pane, 148
Format Legend pane, 145
Format Major Gridlines pane, 150
Format Plot Area command, 152
Format Plot Area pane, 152-153
Format Trendline dialog box, 253
Format Walls command, 154
Format Walls pane, 154
format_text argument,
TEXT function, 72-73
formulas
array, 191
defined, 322
reviewing, 121-122
Fourier Analysis dialog box, 262
Fourier Analysis tool, 262
frequency distributions, 230-233
FREQUENCY function, 189-190, 233
f-Test Analysis tool, 261
F.TEST function, 207
f-Test Two-Sample for Variances dialog
box, 261
Function Arguments dialog box, 125,
161-163
Function command, 159-163
Function Wizard, 159
functions, 322. See also database functions;
statistics functions; text functions
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gamma distribution
natural logarithm of, 222
probability, 221
X for given probability, 222
GAMMA . DIST function, 221
GAMMAINV function, 222
GAMMALN function, 222
Gaussian distributions. See normal
distributions
geographic comparison, 308-309
GEOMEAN function, 184
Get External Data from Access command,
45, 48
Get External Data from Text
command, 37, 45

Get External Data from Web command, 45

GETPIVOTDATA function
arguments, 126
retrieving single values from
pivot tables, 125
Gridlines command, 150
GROWTH function, 217

o H o

HARMEAN function, 184
headers

creating, 13-14

importing delimited text files, 42

importing text files, 38

pivot tables, 105
help resources

Help button, 100

Help files for functions, 159, 162
heteroscedastic tests, 205
Histogram dialog box, 231-232
histograms

defined, 323

overview, 230

process for using, 230-232
homoscedastic tests, 205
HYPGEOM.DIST function, 211

o] e

Import Data dialog box, 46-49, 55
Import Text File dialog box, 37, 41
importing data
defined, 323
editing imported workbooks, 57-63
exporting data from databases, 12,
32-36
external database queries, 49-55
importing database tables, 47-49
importing text files, 37-44
overview, 301-302
for pivot tables, 84
rawness of imported data, 55
web queries, 45-47
Index custom calculation, 112
inferential statistics
accuracy issues, 293-294
ANOVA tools, 260-261
complex nature of, 293-294, 305
Correlation tool, 257-258
Covariance tool, 258-259
defined, 245, 323
Fourier Analysis tool, 262
f-Test Analysis tool, 261
learning curve, 294
overview, 293
Regression tool, 254-256
Scatter Plot tool, 251-254
t-Test tool, 246-248
z-Test tool, 249-250
information system design, 302-303
Insert Calculated Field dialog box,
116-117, 120
Insert Calculated Item dialog box, 118,
120-121
Insert Function dialog box, 65,
159-160, 163
instances argument, SUBSTITUTE
function, 71-72
INTERCEPT function, 216
item argument, GETPIVOTDATA
function, 126
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k argument
LARGCE function, 186

PERCENTILE function, 189

SMALL function, 186-187
known_x's argument
FORECAST function, 215
GROWTH function, 217
INTERCEPT function, 216
LINEST function, 216
LOGEST function, 217
RSQ function, 218
SLOPE function, 216
STEYX function, 217
TREND function, 217
known_y'’s argument
FORECAST function, 215
GROWTH function, 217
INTERCEPT function, 216
LINEST function, 216
LOGEST function, 217
RSQ function, 218
SLOPE function, 216
STEYX function, 217
TREND function, 217
KURT function, 201
kurtosis
defined, 297, 323
KURT function, 201
statistical measure, 229

o/ o

Labels and Values subcommand, Select

command, 96

Labels subcommand, Select command, 96
lambda argument, EXPON.DIST

function, 220
LARGE function, 186

Largest(X) statistical measure, 230

LEFT function, 68

Legend command, 145

LEN function, 68

Limits Report, 276

line charts, 308

Linearity conditions required
by this LP Solver are not
satisfied message, Solver
add-in, 285

LINEST function, 216

List Formulas command, 121-122

lists, 323. See also tables

Load/Save Model dialog box, 282

logarithmic scaling, 315-317, 323

LOGEST function, 217

LOGINV function, 222-223

lognormal distribution

probability of, 222-223
value associated with probability, 222

LOGNORMDIST function, 222

LOWER function, 68-69

lower limit argument, PROB function,
190-191

ol o

MAX function, 185
MAXA function, 185
Maximum statistical measure, 17-18,
97, 229
mean argument
LOGINV function, 222-223
LOGNORMDIST function, 222
NORM.DIST function, 197
NORM. INV function, 198
POISSON function, 223
STANDARDIZE function, 199
means
geometric, 184
harmonic, 184
overview, 290
statistical measure, 229
trimming to, 183
MEDIAN function, 183-184
median value, 229, 290-291, 323
Microsoft Access
defined, 319
exporting data from, 33-34
importing database tables from, 48-49
querying databases, 50-55
relational databases, 11
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Microsoft Query, 50-55, 325
MID function, 69
MIN function, 185
MINA function, 186
Minimum statistical measure,
17-18, 97, 229
mode, 229, 291, 323
MODE function, 184
More Axis Options command, 149
More Data Label Options command,
146-147
Move Chart dialog box, 150-151
Move Chart Location command, 150
Move command, 94
moving average
defined, 323
overview, 235
process for using, 235-237
Moving Average dialog box, 235-236

o\ o

NEGBINOM.DIST function, 210
New command, 45
New Web Query dialog box, 45-46
new_text argument
REPLACE function, 70
SUBSTITUTE function, 71-72
new_x's argument
GROWTH function, 217
TREND function, 217
no_commas argument, FIXED function, 67
normal distributions
confidence interval for population mean,
200-201
defined, 295-296, 323
kurtosis, 201
overview, 197
probability falls at or below given value,
197-198
probability variable within z-standard
deviations, 198-199
skewness of distributions, 201-202
specified probability, 198
z-value equivalent to probability, 199
z-value for specified value, 199-200

NORM.DIST function, 197-198
NORM. INV function, 198
NORM. S .DIST function, 198-199
NORM. S . INV function, 199
#NUM error message, 169
num_chars argument
LEFT function, 68
MID function, 69
REPLACE function, 70
RIGHT function, 70-71
number argument
AVEDEV function, 181
AVERAGE function, 182
AVERAGEA function, 182
COMBIN function, 180
DEVSQ function, 196
FIXED function, 67
GEOMEAN function, 184
HARMEAN function, 184
KURT function, 200
MAX function, 185
MAXA function, 185
MEDIAN function, 183
MIN function, 185
MINA function, 186
MODE function, 184
PERMUT function, 180
RANK function, 187
SKEW function, 201
SKEW. P function, 201
STDEV function, 193
STDEVA function, 193-194
STDEVP function, 194
STDEVPA function, 194
VAR function, 195
VARA function, 195
VARP function, 195-196
VARPA function, 196
Number command, 61
number pop argument, HYPGEOM.DIST
function, 211
number chosen argument
COMBIN function, 180
PERMUT function, 180
number f argument, NEGBINOM.DIST
function, 210

339



340

Excel Data Analysis For Dummies, 2nd Edition

number_ s argument
BINOM.DIST function, 208
BINOM.DIST.RANGE function, 209
NEGBINOM.DIST function, 210
number sample argument, HYPGEOM.
DIST function, 211
number times argument, REPT
function, 70

o () o

Objective Cell values do not
converge message, Solver
add-in, 284
objective function, 265, 267, 323-324
observations, 292, 324
OLAP cubes
placing query result data in, 54
querying, 51

old text argument
REPLACE function, 70
SUBSTITUTE function, 71-72

online resources
Cheat Sheet (companion to book), 5
Edward R. Tufte, 317
example workbooks (companion to

book), 5

extra articles (companion to book), 5
updates to book, 5

Open command, 37, 41, 45

Open dialog box, 37-38, 41-42

Open Microsoft Excel File dialog box,
QuickBooks, 32

operator precedence, 324

optimization modeling

constraints, 264-265
defined, 324
error messages, 282-286
example of, 264
general discussion, 263
objective function, 265
options for, 277-282
reports, 273-277
setting up worksheets for, 265-268
solving problems, 268-272
order argument, RANK function, 187
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parameters, 296-297, 324
part-to-whole comparison, 308
Paste command, 62
Paste Special command, 124
Paste Special dialog box, 124
Paste Values command, 74
pathnames, defined, 36
PEARSON function, 218
percent argument, TRIMMEAN
function, 183

% Difference From custom calculation, 112

% of Column custom calculation, 112
% of custom calculation, 112
% of Row custom calculation, 112
% of Total custom calculation, 112
PERCENTILE function, 189
PERCENTRANK function, 188
PERMUT function, 180
permutations, counting, 180
phantom data markers, 314-315, 324
pie charts
3-D, 313-314, 319
uses for, 308
weaknesses of, 310
pivot charts
3-D, 154
changing location, 150-151
creating, 129-133
creating table to cross-tabulate, 128
creating using commands, 139-140
cross-tabulating multiple items,
136-137
customizing, 141-150
defined, 127, 324
filtering data, 134-136
formatting chart area, 152-153
formatting plot area, 152
grouping data, 138-139
pivoting data in, 134
placement of report, 130
refreshing data, 137
removing items from, 136
selecting data category for, 132
selecting data item for, 132-133
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selecting data series for, 130-131
for small data sets, 310-311
when to use, 127-128
pivot tables
adding second standard calculation,
108-111
calculated fields, 115-117, 120-123
calculated items, 117-123
creating, 83-87
creating table to cross-tabulate, 82
cross-tabulating multiple items, 88-90
custom calculations, 111-115
customizing, 100-103
defined, 324
filtering data, 89-90
formatting data, 103-105
grouping data, 94-95
hiding/displaying PivotTable Field List,
90-91
pivoting data in, 88
refreshing data, 91-92
removing items from, 90
retrieving data from, 123-125
selecting data for, 84
selecting data for columns, 85-86
selecting data for cross-tabulation, 86-87
selecting data for rows, 85-86
selecting items, 96
showing cell details, 96-97
sorting data, 92-94
usefulness of, 81-82, 305
value field settings, 97-99
pivot table argument, GETPIVOTDATA
function, 126
PivotChart Wizard, 129-133
pivoting/re-pivoting data, 88, 134, 324
PivotTable command. See pivot tables
PivotTable Options dialog box
Alt Text tab, 103
Data tab, 101-103
Display tab, 100-101
Layout & Format tab, 100
overview, 99-100
Printing tab, 101-102
Totals & Filters tab, 100-101
PivotTable Wizard, 83-87

PMT function, 158-159
Poisson distribution, 223
POISSON function, 223
population statistics
confidence interval for population mean,
200-201
covariance of populations, 196
overview, 193
probability two samples from same
population, 204-205
standard deviation of populations, 194
variance of populations, 195-196
population s argument, HYPGEOM.DIST
function, 211
Primary Horizontal command, 149
primary key, 20, 324
Primary Vertical command, 149
Print Reports dialog box, QuickBooks,
35-36
printing to text files, 35-36
PROB function, 190-192
prob_range argument, PROB function,
190-191
probability argument
BETA. INV function, 220
CHISQ. INV function, 214
CHISQ.INV.RT function, 213
F.INV function, 206
F.INV.RT function, 207
GAMMAINV function, 222
LOGINV function, 222-223
NORM. INV function, 198
NORM. S. INV function, 199
T . INV function, 204
T.INV.2T function, 204
probability distribution, 324
probability distribution functions, 294, 324
probability s argument
BINOM.DIST function, 208
BINOM.DIST.RANGE function, 209
BINOM. INV function, 208-209
CRITBINOM function, 210
NEGBINOM.DIST function, 210
Problem is too large for
Solver to handle message,
Solver add-in, 285



342

Excel Data Analysis For Dummies, 2nd Edition

PROPER function, 69
p-values, 215, 325
pyramid charts, 308

° Q °
Query Wizard dialog boxes, 51-54
querying
external databases, 49-55
web pages, 45-47, 303, 327
QuickBooks
defined, 325
editing imported workbooks, 57-58
exporting data from, 32-36

o R e

r argument, FISHER function, 219
Random Number Generation dialog box,
240-241
Random Number Generation tool
overview, 239-240
process for using, 240-241
range argument, COUNTIF function,
179-180
ranges, 229, 325
Rank and Percentile dialog box, 233-234
Rank and Percentile tool, 233-234
RANK function, 187-188
ranking
array values, 187-188
percentile, 188
records
adding, 13
defined, 11, 325
describing, 14
ref argument, RANK function, 187
Refresh command, 91, 137
Refresh Data command, 91, 137
refreshing pivot data
defined, 325
Refresh command, 91
Refresh Data command, 91
when opening files, 92
regression analysis
defined, 325
exponential growth, 217

exponential regression, 217
forecast dependent variables using best-
fit line, 215
m and b values for line, 216
overview, 215
scatter plots, 251-254
slope of regression line, 216
standard error, 217
values along trendlines, 217
y-axis intercept of line, 216
Regression dialog box, 254-256
Regression tool, 254-256
rejecting the null hypothesis, 215
relational databases, 11, 325
relative references, 325
REPLACE function, 70
REPT function, 70
RIGHT function, 70-71
Row Height command, 60
Row Height dialog box, 60
rows
banded, 105
defined, 11
deleting unnecessary, 58
grand total, 100, 105
header, 323
indenting labels, 100
resizing, 60
selecting data for pivot tables, 85-86
RSQ function, 218
Running Total In custom calculation, 112

oS e

Sample Variance statistical measure, 229
sample s argument, HYPGEOM.DIST
function, 211
samples
covariance of, 196
overview, 292
probability two from same population,
204-205
standard deviations of, 193-194
variances of, 194-195
Sampling dialog box, 242-243
sampling error, 213-215
Sampling tool, 241-244
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scatter plots
defined, 325
overview, 251
process for using, 251-254
uses for, 309
SEARCH function, 71
secondary key, 20, 325
Select Data Source dialog box, 48
Select Database dialog box, 51
Select Table dialog box, 48
Send Report to Excel dialog box,
QuickBooks, 32
Sensitivity Report, 275-276
Show Data Table command, 147
Show Data Table with Legend Keys
command, 147
Show Details command, 96, 102
sigma argument, ZTEST function, 224
significance argument, PERCENTRANK
function, 188
size argument
CONFIDENCE .NORM function, 199
CONFIDENCE.T function, 199-200
SKEW function, 201-202
skewness, 201-202, 229, 297, 325
SKEW. P function, 201-202
SLOPE function, 216
SMALL function, 186-187
Smallest(X) statistical measure, 230
solve order
defined, 325
reviewing and changing, 122-123
Solver add-in. See also optimization
modeling
constraints, 264-265
defined, 325
error messages, 282-286
example of, 264
general discussion, 263
installing, 268-269
objective function, 265
options for, 277-282
reports, 273-277
setting up worksheets for, 265-268
solving problems, 268-272
Solver cannot improve the
current solution message, Solver
add-in, 283

Solver could not find a feasible
solution message, Solver add-in,
284-285

Solver encountered an error value
in a target or constraint
cell message, Solver add-in, 285

Solver has converged to the
current solution message, Solver
add-in, 283

Solver has found a solution
message, Solver add-in, 283

Solver Options dialog box

All Methods tab, 278-279
Evolutionary tab, 281-282
GRG Nonlinear tab, 279-280
overview, 277

Solver Parameters dialog box, 268-272

Solver stopped at user’s request
message, Solver add-in, 284

solver variables

bounds on, 282

defined, 326

identifying, 266-267, 270
negative value, 271-272

Sort A to Z command, 18-19, 22

Sort buttons, 18

Sort by Value dialog box, 93

Sort dialog box, 19-20

Sort Largest to Smallest command, 92

Sort Options dialog box, 20

Sort Smallest to Largest command, 92

Sort Z to A command, 18-19, 22

sorting data

defined, 326

in pivot tables, 92-94, 100

querying external databases, 53-54
using Custom Sort dialog box, 19-20
using Sort buttons, 18

Standard Deviation statistical
measure, 229

standard deviations

defined, 326

dispersion, 291-292

overview, 192

of populations, 194

of samples, 193-194

sum of squared deviations, 196
Standard Error statistical measure, 229
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standard_dev argument
CONFIDENCE .NORM function, 199
CONFIDENCE. T function, 199-200
LOGINV function, 222-223
LOGNORMDIST function, 222
NORM.DIST function, 197
NORM. INV function, 198
STANDARDIZE function, 199

STANDARDIZE function, 199-200

start num argument
FIND function, 67
MID function, 69
REPLACE function, 70
SEARCH function, 71

statistical analysis, 16-18

statistics functions
beta probability, 219-220
binomial distributions, 208-211
chi-square distributions, 212-215
correlation, 218-219
counting, 178-181
exponential probability, 220-221
f-distributions, 205-207
gamma distribution, 221-222
lognormal distribution, 222-223
means, modes, and medians, 181-184
normal distributions, 197-202
Poisson distribution, 223
regression analysis, 215-217
standard deviations, 193-194, 196
t-distributions, 202-205
values, ranks, and percentiles, 185-192
variances, 194-196
Weibull distribution, 223-224
z-test, 224

stats argument
LINEST function, 216
LOGEST function, 217

status bar
customizing displayed information, 17-18
statistical information in, 16-17

STDEV function, 193

STDEVA function, 193-194

STDEVP function, 194

STDEVPA function, 162, 194

STEYX function, 217

Stop chosen when maximum
iteration limit was reached
message, Solver add-in, 284

Stop chosen when maximum time
limit was reached message, Solver
add-in, 283-284

SUBSTITUTE function, 71-72

Sum function, 16-18

SUM function, 158

Sum statistical measure, 229

sums, 303-304

surface charts, 309

o e

T function, 72
tab-delimited files, 36
Table command, 12-13
tables. See also pivot tables
components of, 11
creating, 12-16
defined, 9-10, 326
filtering data, 21-29
sorting data, 18-20
statistical analysis, 16-18
tails argument, T.TEST function,
204-205
T.DIST function, 202-203
T.DIST. 2T function, 203
t-distributions
defined, 294, 326
left-tail student t-distribution, 202-203
left-tailed inverse of student
t-distribution, 204
normal distributions, 295-296
overview, 202
probability two samples from same
population, 204-205
right-tail student t-distribution, 203
two-tail student t-distribution, 203
two-tailed inverse of student
t-distribution, 204
uniform distributions, 294-295
T.DIST.RT function, 203



tertiary key, 326
text argument
CLEAN function, 65
CONCATENATE function, 65-66
EXACT function, 66
LEFT function, 68
LEN function, 68
LOWER function, 68-69
MID function, 69
PROPER function, 69
REPT function, 70
RIGHT function, 70-71
SUBSTITUTE function, 71
TRIM function, 73
UPPER function, 73
VALUE function, 73-74
text files
ASCII, 37-41, 319
defined, 326
delimited, 36, 41-44, 322
printing to, 34-36
Text Filter command, 23
TEXT function, 72-73
text functions
BAHTEXT, 65
CHAR, 65
CLEAN, 65
CODE, 65
CONCATENATE, 65-66
converting text function
formulas to text, 74
defined, 326
EXACT, 66
FIND, 67
FIXED, 67
LEFT, 68
LEN, 68
LOWER, 68-69
MID, 69
PROPER, 69
reasons for using, 63-64
REPLACE, 70
REPT, 70
RIGHT, 70-71
SEARCH, 71

SUBSTITUTE, 71-72
T, 72
TEXT, 72-73
TRIM, 73
UPPER, 73
VALUE, 73-74
Text Import Wizard dialog boxes
importing delimited text files, 42-44
importing text files, 38-39
text labels, 65, 326
There is not enough memory
available to solve the
problem message, Solver add-in, 286
3-D charts
avoiding, 312-313
changing view, 154
formatting walls, 154
pie charts, 313-314, 319
3-D View command, 154
time-series comparison, 308, 326
T . INV function, 204
T.INV.2T function, 204
TREND function, 217
trendlines, 217, 253
trends, identifying, 304
trials argument
BINOM.DIST function, 208
BINOM.DIST.RANGE function, 209
BINOM. INV function, 208-209
CRITBINOM function, 210
TRIM function, 73
TRIMMEAN function, 183
t-Test dialog boxes, 247-248
T.TEST function, 204-205
t-Test tool, 246-248
Tufte, Edward R, 317, 326
type argument, T. TEST function, 204-205

o lf o

uniform distributions, 294-295, 326

UPPER function, 73

upper_limit argument, PROB function,
190-191
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validation

defined, 74, 321

defining criteria, 75

error messages, 77

input messages, 76

process for, 74-77

scope of validation, 75
value argument

COUNT function, 178

COUNTA function, 179

COUNTBLANK function, 179

T function, 72

TEXT function, 72-73
#VALUE error message, 168
Value Field Settings dialog box, 97-99,

108-111, 113-114

VALUE function, 73-74
values, defined, 327
Values subcommand, Select command, 96
VAR function, 194-195
VARA function, 195
variances

covariances, 196

defined, 327

overview, 192, 292

of populations, 195-196

of samples, 194-195
VARP function, 195-196
VARPA function, 196

o[/ o

web queries
defined, 327
general discussion, 45, 303
performing, 45-47
troubleshooting, 47
Weibull distribution, 223-224
WEIBULL function, 223-224
whole-to-whole comparison, 308

within_ text argument
FIND function, 67
SEARCH function, 71

workbooks, defined, 327

° X °

x argument
BETA.DIST function, 219
CHISQ.DIST function, 213
CHISQ.DIST.RT function, 212
EXPON.DIST function, 220
FORECAST function, 215
GAMMA .DIST function, 221
GAMMALN function, 222
LOGNORMDIST function, 222
NORM.DIST function, 197
PERCENTRANK function, 188
POISSON function, 223
STANDARDIZE function, 199
T.DIST function, 202
T.DIST.2T function, 203
T.DIST.RT function, 203
WEIBULL function, 223-224
ZTEST function, 224

x_range argument, PROB function,

190-191
x-values, 215-217, 327

° y °
y argument, FISHERINV function, 219
y-values, 215-217, 327

o/ o

z argument, NORM. S.DIST function, 198
z-test, 224

z-Test dialog box, 249-250

ZTEST function, 224

z-Test tool, 249-250

z-values, 199-200, 327
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